
Auteur : Chris Roberts

 DAVINCI RESOLVE 18

 DaVinci
 Resolve 18

Le guide du monteur

Téléchargez 
DAVINCI 

RESOLVE 18
gratuit !



Cette page a été laissée volontairement libre.



 DaVinci
 Resolve 18
Le guide du monteur



Le guide du monteur DaVinci Resolve 18
Chris Roberts

© 2023 Blackmagic Design Pty Ltd

Blackmagic Design

www.blackmagicdesign.com/fr

Pour signaler des erreurs, veuillez contacter : learning@blackmagicdesign.com.

Éditrice de la collection : Patricia Montesion

Éditeur : Dan Foster

Rédacteurs : Arthur Ditner, Daria Fissoun, et Dion Scoppettuolo

Conception graphique : Blackmagic Design

Notification de droits

Tous droits réservés. Toute reproduction, même partielle, et quel qu'en soit le support, est interdite sans autorisation 
écrite préalable de l'éditeur. Pour obtenir des informations concernant la réimpression ou la reproduction du contenu 
de ce livre, veuillez contacter learning@blackmagicdesign.com.

Avis de responsabilité 

Ni l'auteur ni Blackmagic Design ne sauraient être tenus responsables envers toute personne ou toute entité de la 
perte ou du dommage causé directement ou indirectement par les informations contenues dans ce livre, ou par toute 
omission commise dans ce livre, ou par le logiciel et autre matériel décrit dans ce livre.

Marques déposées

Plusieurs désignations utilisées par les fabricants et vendeurs pour distinguer leurs produits sont mentionnées comme 
des marques déposées. Lorsque ces désignations apparaissent dans le livre, et dans le cas où Blackmagic Design 
avait connaissance de cette mention de marque déposée, elles ont été écrites comme indiqué par le propriétaire de 
la marque. Tous les autres noms de marques et services identifiés dans ce livre sont utilisés uniquement à l'usage de 
la rédaction et dans l’intérêt de ces entreprises, sans intention de violer les droits relatifs à la marque. Aucun usage 
d'une marque déposée dans ce livre n'a pour intention de soutenir ou d'afficher une affiliation, quelle qu'elle soit 
avec la marque déposée.

(Mac) et (macOS) sont des marques déposées par Apple Inc., enregistrées aux États-Unis et dans le monde. Windows 
est une marque déposée par Microsoft Inc., enregistrée aux États-Unis et dans le monde.

ISBN: 979-8-9860488-3-3

http://www.blackmagicdesign.com/fr
mailto:learning%40blackmagicdesign.com?subject=
mailto:learning%40blackmagicdesign.com?subject=


iiiSommaire

Sommaire
Avant-propos vii

Remerciements viii

À propos de l'auteur ix

Mise en route x

Découvrez le Blackmagic Cloud ! xiv

1 Monter un bout à bout  1

Configurer un projet 2

La page Montage 10

Assembler les éléments audio 11

Travailler avec des sous-plans 19

Ajouter les derniers extraits sonores 24

Ajouter un plan de coupe et régler les extraits sonores  31

Enrichir l’interview 36

Montage en backtiming 43

Ajouter de la musique 48

Révision 51

2 Affiner le bout à bout 53

Configurer le projet 54

Dupliquer la timeline 55

Affiner les plans dans la timeline 58

Montage Roll 63

Effectuer un raccord fin Ripple sur plusieurs points de coupe 64

Montage par glissement 66

Remplacer les plans 67

Mixage audio 80

Baisser le volume musical (Ducking) pendant les dialogues 88

Ajouter le logo 90

Ajouter un générique 96

Changements de dernière minute 102

Visualiser en plein écran 106



iv Sommaire

Exportation rapide 108

Révision 111

3 Peaufiner une interview 113

Démarrer un projet 114

Utiliser la transition Smooth Cut 117

Importer une timeline « Selects » 119

Travailler sur plusieurs timelines 122

Affiner le radio edit 128

Monter d’une timeline à une autre 132

Travailler avec des timelines superposées 139

Révision 145

4 Découper une scène d'un film de fiction 147

Travailler sur des prises séparées 148

Montage en continuité 152

Comparer les prises 162

Nettoyer l’audio 167

Utiliser le montage Split 169

Mode Trim dynamique 173

Remplir les espaces vides 178

Révision 181

5 Montage multicaméra 183

Montage d’une interview multicaméra 184

Échanger les angles multicaméras  192

Créer un clip musical multicaméra  197

Montage Multicaméra en temps réel 203

Affiner un montage multicaméra 210

Ajuster un plan multicaméra 214

Révision 221

6 Organisation du projet 223

Créer un nouveau projet et régler les paramètres de projet 224

Importer des médias 230



vSommaire

Générer des fichiers proxys 234

Synchroniser l’audio et la vidéo 246

Configurer les préréglages des métadonnées 252

Importer et utiliser les métadonnées 257

Créer des sous-plans 281

Comprendre les chutiers partagés 290

Révision 293

7 Les effets de la page Montage  295

Configurer un projet 296

Réaliser le compositing avec des caches mobiles 298

Appliquer des changements de vitesse variable 309

Créer un arrêt sur image 318

Utiliser l’effet Incrustateur 3D 325

Utiliser l’effet Transformation 334

Comprendre le collage vidéo 339

Créer des vignettes avec le filtre Collage Vidéo 350

Révision 361

8 Monter et mixer l’audio 363

Préparer le projet 364

Quand commencer le mixage ? 366

Remplacer des répliques par d’autres prises 367

Équilibrer les plans de dialogue 373

Améliorer une scène 380

Produire un panoramique dans un espace acoustique 382

Donner vie à la scène 386

Créer un effet « radio » 393

Simplifier le mix 399

Mixer dans le mixeur 407

Utiliser les bus pour d’autres mix 408

Révision 419



vi Sommaire

9 Exporter les projets 421

Préparer les projets 422

Modifier le format d’image de la timeline 424

Recadrer une prise 430

Cadrage intelligent (Studio uniquement) 435

Personnaliser les préréglages de la page Exportation 438

Exporter le format AAF pour Pro Tools 441

Ajouter des sous-titres 444

Importer des fichiers de sous-titres 448

Régler les sous-titres 450

Changer le style des sous-titres 451

Inclure les sous-titres dans l’exportation 456

Exporter les pistes audio 457

Exporter et modifier des tâches provenant de différents projets 460

Gérer les médias des timelines 467

Révision 471



viiAvant-propos

Avant-propos
Merci d'avoir choisi le Guide du monteur DaVinci Resolve 18
DaVinci Resolve 18 est la seule solution qui rassemble sur un même logiciel le montage, 
l’étalonnage, la création de VFX, l’animation graphique et la postproduction audio ! 
Son interface moderne et élégante est à la fois simple à utiliser pour les débutants et 
performante pour les professionnels. DaVinci Resolve vous permet de travailler plus 
rapidement, car vous n’avez pas besoin d’apprendre à utiliser plusieurs applications ou de 
changer de logiciel selon la tâche. C’est comme si vous disposiez de votre propre studio de 
postproduction au sein d’une seule application.

DaVinci Resolve 18 intègre la prise en charge du Blackmagic Cloud pour collaborer à 
distance, un workflow proxy DaVinci, de nouveaux Resolve FX, mais il améliore aussi le 
sous-titrage, la conversion en FlexBus Fairlight et bien plus !

En outre, Blackmagic Design 18 dispose d’une version complètement gratuite. Dans cette 
version gratuite, vous disposez d'un nombre d'outils bien plus important que sur n’importe 
quels autres logiciels payants. Parce que chez Blackmagic Design, nous nous engageons à 
fournir à chacun des outils qui permettent de créer du contenu professionnel, sans devoir 
dépenser des fortunes.

N’oubliez pas de télécharger DaVinci Resolve 18 dès aujourd’hui et de partager vos projets 
avec nous !

Grant Petty  
Blackmagic Design
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Mise en route
Merci d'avoir choisi le Guide du monteur DaVinci Resolve 18, la formation officielle du 
logiciel conçu par Blackmagic Design. Ce guide aborde les principales étapes de montage, 
d’étalonnage, de compositing et de mixage audio afin que les monteurs, les artistes 
et les débutants apprennent à maîtriser rapidement les différentes fonctionnalités de 
DaVinci Resolve. Pour démarrer, il vous suffit d'avoir un ordinateur macOS ou Windows, la 
version gratuite de DaVinci Resolve 18 et l'envie d'apprendre.

Ce guide complet décrit en détail les étapes indispensables du montage audio et 
vidéo. Vous avez entre les mains l’outil qui vous permettra d’égaler les professionnels 
d’Hollywood.

Ce que vous apprendrez dans ce guide
 — Appliquer des techniques de montage et de rognage complexes utilisés par les pros 

de l’industrie et les utiliser à bon escient en fonction du genre de production.

 — Générer et gérer des médias proxys avec le Blackmagic Proxy Generator.

 — Appliquer des changements de vitesse variable pour mettre en valeur l’action.

 — Utiliser des astuces de rognage et modifier les plans en temps réel.

 — Appliquer des techniques de montage et de synchronisation multicaméra.

 — Organiser les grands projets efficacement avec les métadonnées et les 
chutiers paramétrables.

 — Créer des compositions complexes sur la page Montage.
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 — Utiliser des images clés pour créer des animations complexes. 

 — Monter et mixer l’audio en stéréo et en Surround Sound.

 — Créer, importer et monter les sous-titres en différentes langues.

 — Exporter les projets pour la distribution en ligne, la télé et les plateformes de diffusion 
en ligne.

 — Mais aussi des dizaines de conseils et d’astuces qui transformeront 
votre façon de travailler !

Programme de formation certifié 
par Blackmagic Design 
Blackmagic Design a publié une série de livres de formation pour développer les 
compétences des utilisateurs DaVinci Resolve. Voici les titres de la collection :

 — Le guide du débutant DaVinci Resolve 18

 — Le guide de l’étalonneur DaVinci Resolve 18

 — Le guide du monteur DaVinci Resolve 18

 — Le guide de la postproduction audio Fairlight avec DaVinci Resolve 18

 — Le guide des VFX avec DaVinci Resolve 18

Que vous vouliez apprendre à utiliser DaVinci Resolve, maîtriser les techniques de 
montage avancées, étalonner vos images, mixer votre son comme un pro ou créer des 
VFX, vous trouverez sans aucun doute la formation qu’il vous faut.

Une fois que vous aurez fait tous les exercices de ce livre, nous vous encourageons 
à passer un test en ligne d’une heure comportant 50 questions pour recevoir votre 
attestation de réussite de la part de Blackmagic Design. Le lien pour accéder à l’examen en 
ligne se trouve sur la page de formation Blackmagic Design. Vous y trouverez également 
des informations supplémentaires sur notre programme de formation. Rendez-vous sur 
www.blackmagicdesign.com/fr/products/davinciresolve/training

http://www.blackmagicdesign.com/fr/products/davinciresolve/training
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Configuration système requise
Les exercices de ce livre portent sur la version DaVinci Resolve 18 pour macOS ou 
Windows. Si vous travaillez sur une version antérieure, vous devez la mettre à jour afin de 
pouvoir utiliser toutes les nouvelles fonctionnalités.

REMARQUE Les exercices de ce livre font référence à des emplacements qui 
pourraient être différents si vous avez téléchargé le logiciel sur l’App Store. 
Pour suivre correctement les exercices, nous recommandons aux utilisateurs 
macOS de télécharger le logiciel DaVinci Resolve sur notre site internet, plutôt que 
depuis l’App Store.

Télécharger DaVinci Resolve
Pour télécharger la version gratuite de DaVinci Resolve 18 ou ultérieure, allez sur le site de 
Blackmagic Design.

1 Ouvrez le navigateur web de votre ordinateur macOS ou Windows.

2 Dans la barre d'adresse, saisissez : www.blackmagicdesign.com/fr/products/
davinciresolve.

3 Sur la page DaVinci Resolve, cliquez sur le bouton Télécharger (Download).

4 Sur la page de téléchargement, cliquez sur le système d’exploitation de votre choix 
pour télécharger le logiciel.

5 Suivez les instructions à l’écran pour terminer l'installation DaVinci Resolve.

Une fois le logiciel installé, suivez les instructions données au paragraphe ci-dessous pour 
télécharger les médias qui accompagnent les exercices de ce livre.

http://www.blackmagicdesign.com/fr/products/davinciresolve
http://www.blackmagicdesign.com/fr/products/davinciresolve
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Copier les fichiers Lessons
Afin de faire les exercices de ce livre, vous devez télécharger les fichiers contenant les 
éléments multimédias sur votre ordinateur macOS ou Windows. Après avoir sauvegardé 
les fichiers sur votre disque dur, ouvrez le fichier et copiez-le dans le dossier Movies 
(macOS) ou Vidéos (Windows) de votre ordinateur.

Pour télécharger et installer les fichiers :
Quand vous êtes prêt à télécharger les fichiers, suivez les étapes suivantes :

1 Ouvrez le navigateur web de votre ordinateur macOS ou Windows.

2 Dans la barre d'adresse, saisissez : www.blackmagicdesign.com/fr/products/
davinciresolve/training

3 Faites défiler la page jusqu’au titre Le guide du monteur DaVinci Resolve 18.

4 Cliquez sur le lien des fichiers d’exercices pour télécharger les médias. Le fichier fait 
environ 16.5 GB.

5 Une fois le téléchargement terminé, ouvrez le dossier Documents et double-cliquez 
sur R18_Editors_Lessons.zip pour le dézipper, si ce n'est pas déjà fait. Vous verrez alors 
le dossier « R18 Editors Guide ». Il contient tous les médias qui vous permettront de 
faire les exercices de ce livre.

6 Faites glisser le dossier R18 Editors Guide vers le dossier Movies (macOS) ou Vidéos 
(Windows). Ces dossiers se trouvent dans le dossier Utilisateur de votre ordinateur.

Vous pouvez d’ores et déjà commencer le chapitre 1.

Recevoir une attestation de réussite
Une fois tous les exercices de ce livre fait, nous vous encourageons à passer le test en 
ligne de 50 questions (1 heure) pour recevoir votre attestation de réussite de la part 
de Blackmagic Design. Le lien vers l’examen se trouve sur la page de formation de 
Blackmagic Design : www.blackmagicdesign.com/fr/products/davinciresolve/training.

http://www.blackmagicdesign.com/fr/products/davinciresolve/training
http://www.blackmagicdesign.com/fr/products/davinciresolve/training
http://www.blackmagicdesign.com/fr/products/davinciresolve/training
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Découvrez le Blackmagic Cloud !
DaVinci Resolve est la seule solution complète de postproduction qui permet à tous les 
membres d’une équipe de travailler sur le même projet au même moment. Le workflow 
de postproduction est généralement linéaire : chaque artiste passe le projet au suivant, 
introduisant parfois des erreurs. Cela crée aussi un grand nombre de rapports qui 
consignent les modifications apportées à chaque étape. Grâce au mode collaboratif de 
DaVinci Resolve, chacun peut travailler sur le même projet depuis sa propre page. 

Désormais, le Blackmagic Cloud permet aux monteurs, étalonneurs, artistes VFX, 
animateurs et ingénieurs son de travailler ensemble simultanément depuis n’importe où. 
De plus, ils peuvent vérifier les modifications effectuées par les autres, s’épargnant de 
nombreuses heures de conformation.

Créez simplement un compte Blackmagic Cloud, connectez-vous au serveur 
DaVinci Resolve Project Server, et suivez les instructions pour configurer une nouvelle 
bibliothèque de projets à un prix raisonnable. 

Une fois créée, vous pouvez accéder à cette bibliothèque directement dans l’onglet Cloud 
du Gestionnaire de projet (Project Manager) pour créer autant de projets que vous voulez. 
Ensuite, vous pouvez inviter jusqu’à 10 collaborateurs. En un simple clic, vous pouvez relier 
les copies locales des médias et commencer à travailler immédiatement sur le projet. Tous 
les changements sont automatiquement sauvegardés sur le Cloud.

En activant le mode collaboratif entre plusieurs utilisateurs pour ce projet, vous permettez 
à tout le monde de travailler ensemble. Les assistants monteurs, les monteurs, les 
étalonneurs, les monteurs dialogue, et les artistes VFX peuvent alors collaborer où qu’ils 
soient dans le monde.

Synchronisation des médias 
avec le Blackmagic Cloud Store
Il n’est pas nécessaire d’investir dans un espace de stockage dédié, le Blackmagic Cloud 
Store a été conçu pour plusieurs utilisateurs et permet de gérer de gros fichiers média 
utilisés par les grosses productions hollywoodiennes. Vous pouvez également travailler 
avec plusieurs Blackmagic Cloud Store synchronisés avec votre compte Dropbox pour que 
tout le monde ait accès aux médias.

Pour en savoir plus, consultez la page : blackmagicdesign.com/fr/products/davinciresolve/
collaboration

http://blackmagicdesign.com/fr/products/davinciresolve/collaboration
http://blackmagicdesign.com/fr/products/davinciresolve/collaboration


Durée
Ce chapitre nécessite environ 
60 minutes de travail.

Objectifs
Configurer un projet 2

La page Montage 10

Assembler les éléments audio 11

Travailler avec des sous-plans 19

Ajouter les derniers 
extraits sonores 24

Ajouter un plan de coupe et 
régler les extraits sonores  31

Enrichir l’interview 36

Montage en backtiming 43

Ajouter de la musique 48

Révision 51

Francis Ford Coppola a déclaré 
que « l’essence du cinéma, c’est 
le montage », illustrant ainsi le 
rôle central que joue cette étape 
de la postproduction dans l’art 
de la narration. Ce livre explore 
cette « essence » à travers les 
fonctionnalités de montage offertes 
par DaVinci Resolve 18, en s’appuyant 
sur divers types de productions.

Que vous travailliez sur le montage 
du dernier blockbuster, une publicité 
à rendre dans des délais serrés, un 
seul épisode d’une série ou toute une 
série web, les outils, les technologies 
et les fonctionnalités disponibles 
sur DaVinci Resolve, ainsi que les 
techniques mentionnées et montrées 
dans ce livre, vous permettront de 
répondre à toutes les problématiques.

Chapitre 1

Monter un 
bout à bout 



2 Chapitre 1 Monter un bout à bout 

La page Montage repose sur un montage non linéaire éprouvé par les plus grands 
monteurs du monde. Dans ce chapitre, vous apprendrez les bases de ces techniques en 
faisant le montage d’un bout à bout. Au chapitre 2, vous l’affinerez pour finaliser le projet.

Configurer un projet
Le montage est bien souvent un processus itératif, dont le but est de construire une 
histoire cohérente à partir de bouts de séquences hétérogènes. Bien que certains 
workflows aient fait leurs preuves, il n’existe malheureusement pas de « formule 
magique », car chaque montage est unique.

Le but de ce montage est de créer une vidéo d’une minute pour la marque de vêtements 
Organ Mountain Outfitters. Ainsi, vous découvrirez de nouvelles techniques et les 
« heureux hasards » qui arrivent fréquemment en postproduction.

Vous allez commencer par importer un projet qui a déjà été configuré pour vous, et qui 
contient les plans nécessaires au montage de ce projet. 

1 Ouvrez la fenêtre Gestionnaire de projet (Project Manager) de DaVinci Resolve.

Pour garder les projets séparés, vous allez créer une nouvelle bibliothèque de 
projets locale.

Les bibliothèques de projet regroupent plusieurs projets et peuvent être stockées 
sur votre ordinateur, dans un emplacement en réseau ou à distance sur le Blackmagic 
Cloud. De cette façon, les projets peuvent être ouverts par toute personne que vous 
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invitez. Grâce aux bibliothèques de projets en réseau ou sur le cloud, vous pouvez 
collaborer avec les autres utilisateurs DaVinci Resolve pour travailler sur le même 
projet, au même moment. 

Pour configurer une bibliothèque de projets sur le cloud, vous devez avoir un 
compte Blackmagic Cloud. Vous pouvez créer un compte gratuitement sur cloud.
blackmagicdesign.com. Une fois enregistré, l’abonnement mensuel annulable à 
tout moment vous permettra d’utiliser le serveur pour configurer une bibliothèque 
de projets sur le cloud. Vous pouvez accéder à toutes les bibliothèques de projets 
que vous avez créées sur le Blackmagic Cloud en cliquant sur l’option Cloud dans le 
DaVinci Resolve Project Server, puis en vous connectant à votre compte. Vous pouvez 
héberger vos bibliothèques de projets sur le Blackmagic Cloud et inviter jusqu’à 
10 personnes pour collaborer sur la même timeline simultanément dans le monde 
entier. Les bibliothèques de projets en réseau peuvent être mises à jour et gérées 
avec le DaVinci Resolve Project Server gratuit. Il peut être téléchargé depuis le site de 
Blackmagic Design www.blackmagicdesign.com/fr/support/family/davinci-resolve-
and-fusion.

Pour les besoins de ce chapitre, vous travaillerez sur une bibliothèque de 
projets locale.

2 Veillez à ce que la bibliothèque de projet soit bien réglée sur Local en haut du 
Gestionnaire de projet (Project Manager), puis cliquez sur le bouton Afficher/Masquer 
les bibliothèques de projets (Show/Hide Project Libraries).

REMARQUE Si vous n’avez pas encore créé de bibliothèque de projets, vous 
verrez uniquement la bibliothèque de projets locale par défaut, appelée Base 
de données locale (Local Database). Dans les versions précédentes de Resolve, 
les bibliothèques de projets étaient appelées bases de données.

http://cloud.blackmagicdesign.com
http://cloud.blackmagicdesign.com
http://www.blackmagicdesign.com/fr/support/family/davinci-resolve-and-fusion
http://www.blackmagicdesign.com/fr/support/family/davinci-resolve-and-fusion
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3 En bas de la barre latérale de la bibliothèque de projets, cliquez sur le bouton Ajouter 
une bibliothèque de projets (Add Project Library).

La fenêtre Ajouter une bibliothèque de projets (Add Project Library) s’ouvre.

4 Dans cette fenêtre, saisissez R18 Editors Guide dans le champ Nom (Name) et cliquez 
sur Parcourir (Browse).

Vous allez commencer par sélectionner (ou créer) un nouveau répertoire sur votre 
ordinateur pour accueillir une nouvelle bibliothèque de projets. Pour les besoins de ce 
livre, vous pouvez utiliser le dossier fourni dans le dossier R18 Editors Guide.
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5 Allez sur R18 Editors Guide/Editors Guide Project Library et cliquez sur Ouvrir (Open) 
pour sélectionner l’emplacement de la nouvelle bibliothèque de projets.

REMARQUE Si ce n’est pas la première fois que vous faites cet exercice, vous 
avez sans doute déjà créé une bibliothèque de projets. Il suffit alors de créer 
un nouveau dossier dans le dossier R18 Editors Guide.

6 Dans la fenêtre Ajouter une bibliothèque de projets (Add Project Library), cliquez sur 
Créer (Create).
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Votre nouveau projet apparaît dans la liste des bibliothèques de projets connectées à 
DaVinci Resolve.

ASTUCE Pour changer de bibliothèque de projets, cliquez sur la bibliothèque 
de votre choix dans la liste pour afficher les projets qui s’y trouvent. Vous 
pouvez utiliser le bouton Copier le projet sur (Copy Project To) en haut du 
gestionnaire de projet pour copier les projets entre les bibliothèques.

Une fois la bibliothèque de projets créée, vous pouvez importer le fichier projet 
nécessaire pour ce premier exercice.

7 Cliquez sur le bouton Importer (Import).

8 Allez sur R18 Editors Guide/Lesson 01 et sélectionnez OMO Promo.drp

REMARQUE Le fichier d’extension .drp correspond aux fichiers projet dans 
DaVinci Resolve.

9 Cliquez sur Ouvrir (Open).
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ASTUCE Pour importer un projet, vous pouvez faire glisser les fichiers .drp 
dans le Gestionnaire de projet (Project Manager), faire un clic droit sur le 
Gestionnaire de projet (Project Manager) et choisir Importer un projet (Import 
Project), ou choisir Fichier > Importer un projet (File > Import Project).

Le projet est importé dans la bibliothèque de projets et apparaît dans le Gestionnaire 
de projet (Project Manager).

DaVinci Resolve n’ouvre pas le fichier projet directement. Les fichiers .drp sont 
copiés dans la bibliothèque de projets. C’est sur ce projet importé que vous pourrez 
apporter les changements, et non sur le fichier .drp original sélectionné pour 
l’importation. Le bouton Exporter (Export) permet d’exporter un projet sélectionné 
de la bibliothèque de projets à des fichiers .drp individuels. Tout changement suivant 
peut être apporté sur le projet de la bibliothèque de projets. Pour en savoir plus sur la 
gestion des bibliothèques de projets, consultez Le guide du débutant DaVinci Resolve 18 
(blackmagicdesign.com/fr/products/davinciresolve/training).

10 Double-cliquez sur le projet OMO Promo pour l’ouvrir.

Le nouveau projet s’ouvre dans la dernière page utilisée de DaVinci Resolve.

11 Cliquez sur la page Montage si celle-ci n’est pas déjà ouverte. 

http://blackmagicdesign.com/fr/products/davinciresolve/training
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12 Sélectionnez Espace de travail > Réinitialiser l’espace de travail (Workspace > Reset UI 
Layout) afin de restaurer l’espace de travail de la page Montage sur sa configuration 
par défaut.

Vous avez importé et ouvert un projet, mais avant de commencer le montage des 
plans, vous devez les relier aux fichiers médias présents sur votre ordinateur.

Relier les fichiers médias
La raison pour laquelle les médias sont offline, c’est qu’ils ont dû être déplacés ou 
renommés. Pour éviter cela, une fois les plans importés, laissez-les au même emplacement 
sur l’ordinateur. Si vous devez les déplacer pour une raison ou une autre, utilisez la 
fonction de gestionnaire de médias de DaVinci Resolve. Vous en apprendrez plus sur le 
gestionnaire de médias au chapitre 9 « Exporter les projets ».

DaVinci Resolve permet de relier rapidement les fichiers grâce à son bouton Relier les 
médias (Relink Media) en haut de la bibliothèque de médias.

1 En haut à gauche de l’interface, au-dessus de la bibliothèque de médias, cliquez sur 
Relier les médias (Relink Media).

REMARQUE Le bouton Relier les médias (Relink Media) sera rouge si les 
fichiers médias sont offline. Les médias qui ont été déliés à dessein ne sont 
pas inclus.
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2 La fenêtre apparaît et vous indique combien de plans sont offline.

ASTUCE Placez la souris sur le nom du dossier pour afficher son emplacement 
dans Resolve.

3 Cliquez sur le bouton Rechercher (Locate) et dans la fenêtre qui apparaît, allez sur le 
dossier R18 Editors Guide et cliquez sur Ouvrir (Open).

Resolve recherche et reconnaît automatiquement la structure du fichier dans ce 
dossier, puis relie les médias pour vous.
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REMARQUE Si Resolve ne retrouve pas les bons fichiers, vous pouvez réaliser une 
recherche plus approfondie dans la fenêtre Relier les médias (Relink Media) avec le 
bouton Chercher Disque (Disk Search). Attention cependant, cette recherche peut 
prendre plus de temps, en particulier, si le disque dur comporte beaucoup de fichiers.

Une fois les plans reliés, vous pouvez commencer à organiser votre premier projet.

La page Montage
Que vous soyez débutant ou professionnel, vous trouverez dans la page Montage tous les 
outils dont vous avez besoin pour réaliser vos projets. 

Liste des chutiers - permet de 
sélectionner facilement un 

chutier pour voir son contenu

Bibliothèque de médias - affiche 
les plans du chutier sélectionné

Viewer source - affiche 
les images non montées

Viewer timeline - affiche les 
plans montés dans la timeline

Barre d'outils de la timeline - 
comprend les modes de montage 

de la timeline, les fonctions de 
montage et les paramètres du zoom

Timeline - permet de positionner 
et de régler les plans utilisés 

dans le montage

Le projet a déjà été configuré pour vous. Dans les chapitres suivants, vous explorerez les 
différentes techniques de montage.
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Assembler les éléments audio
Il paraît que lorsqu’on écrit un livre, le plus difficile c’est d’écrire le premier chapitre. Cela 
est également vrai pour le montage, à la différence que vous gérez des sons et des images 
et non des mots. Placer vos premiers plans dans une timeline vide va peut-être vous 
sembler un peu intimidant. Il est en effet difficile de savoir par où commencer. Cependant, 
une fois l’assemblage des séquences commencé, vous verrez ce qui fonctionne, ce qui ne 
fonctionne pas et ce qui vous demandera davantage d’efforts pour réaliser votre montage.

Pour commencer, vous devez créer une timeline.

1 Sélectionnez le chutier TIMELINES, puis appuyez sur Cmd-N (macOS) ou Ctrl-N 
(Windows) ou choisissez Fichier > Nouvelle timeline (File > New Timeline).

2 Dans la fenêtre Créer une nouvelle timeline (Create New Timeline), sous le champ Nom 
(Name), saisissez OMO Promo, réglez l’option Type de piste audio (Audio Track Type) 
sur Mono, car l’audio de l’interview est en mono, puis cliquez sur Créer (Create).

Une timeline se crée dans le chutier sélectionné et de nouvelles fonctions s’affichent.

REMARQUE Vous pouvez choisir le timecode de départ, le nombre de 
vidéos et de pistes audio, ainsi que le type de piste audio par défaut dans 
DaVinci Resolve > Préférences > Utilisateur > Montage (DaVinci Resolve > 
Preferences > User > Editing).
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3 Dans la liste des chutiers, cliquez sur la flèche de déroulement à côté du chutier 
INTERVIEW.

Dans ce chutier, vous verrez d’autres chutiers : un pour chaque caméra utilisée 
pour filmer l’interview (appelée A, B et C), un pour les plans audio préalablement 
synchronisés avec les plans d’interview et un pour les sous-plans (créés pour rendre 
votre travail plus facile).

REMARQUE Vous apprendrez à synchroniser les plans audio et vidéo, 
à créer des sous-plans et à monter des images multicaméras dans les 
chapitres suivants.

4 Sélectionnez le chutier A CAM pour afficher les plans.

ASTUCE Pour avoir un bon aperçu des plans, vous pouvez augmenter la taille 
des vignettes dans la bibliothèque de médias.
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Grâce à l’option Prévisualisation en direct des médias (Live Media Preview), vous 
pourrez visionner chaque plan.

5 Sans cliquer, positionnez la souris sur un des quatre plans.

Le plan apparaît dans le viewer source et est lu rapidement quand vous le survolez 
avec la souris.

ASTUCE Vous pouvez couper le son pendant le survol du plan en choisissant 
Timeline > Scrub Audio (Timeline > Audio Scrubbing), ou en appuyant sur 
Majuscule-S.

6 Double-cliquez sur le plan OMO_A_002 pour l'ouvrir dans le viewer source.

7 Dans la barre d’outils, cliquez sur le bouton Aller sur Première image (Go To First 
Frame) ou appuyez sur la touche Home pour positionner la petite tête de lecture au 
début du plan.
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8 Pour lire le plan, cliquez sur le bouton de lecture situé sous le viewer ou appuyez sur la 
barre d’espace.

Comme vous allez vous en rendre compte, ce plan d’interview est assez long et inclut 
des réponses à différentes questions. Vous n’allez pas utiliser tout le plan, mais 
uniquement une petite partie.

9 Pour arrêter la lecture, cliquez sur le bouton stop ou appuyez de nouveau sur la 
barre d’espace.

Pour vous aider à repérer l’audio dont vous avez besoin, vous pouvez afficher la forme 
d’onde audio sur l’image source. 

10 Dans le menu Options (…) du viewer source, choisissez Afficher les formes d'onde 
zoomées (Show Zoomed Audio Waveform).

La forme d’onde verte apparaît en bas du viewer source.

ASTUCE Pour voir une forme d’onde plus détaillée, vous pouvez régler le 
mode du viewer sur Piste audio (Audio Track).
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11 Cliquez de nouveau sur le bouton Aller sur Première image (Go To First Frame) ou sur 
la touche Home pour positionner la tête de lecture au début du plan.

12 Cliquez sur le bouton Lecture ou appuyez sur la barre d’espace pour lire le plan et 
entendre l’interview.

13 Lisez le plan jusqu’à ce que Chris rie, et interrompez la lecture avant qu’il dise « I’m 
Chris Lang… ».

Vous pouvez visualiser cet instant précisément sur la forme d’onde de la timeline 
inférieure.

14 Pour positionner précisément la tête de lecture (représentée par une ligne rouge 
sur la forme d’onde), cliquez sur la molette de votre souris et maintenez-la enfoncée 
ou utilisez la flèche vers la gauche ou vers la droite du clavier. Placez-la juste avant 
l’apparition de la forme d’onde.

ASTUCE Si vous avez désactivé le scrub audio, appuyez sur Majuscule-S 
pour le réactiver.
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15 Une fois que vous êtes content de l’emplacement de la tête de lecture, choisissez 
Marque > Point d’entrée (Mark > Mark In) ou appuyez sur la touche I pour indiquer le 
début du plan.

16 Cliquez sur le bouton de lecture ou appuyez sur la barre d’espace pour lire le plan 
jusqu’à ce que Chris dise « …in Las Cruces, New Mexico », puis interrompez la lecture.

17 Avec la molette de la souris, positionnez la tête de lecture juste avant que Chris cligne 
des yeux, puis choisissez Marque > Point de sortie (Mark > Mark Out) ou appuyez sur la 
touche O pour indiquer où doit se terminer le plan.
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18 Faites glisser le plan du viewer source vers le viewer timeline.

Les différentes options de montage disponibles dans DaVinci Resolve s’affichent. 
Les monteurs expérimentés reconnaîtront la plupart de ces options, également 
présentes dans d’autres logiciels NLE bien connus, mais certaines d’entre elles sont 
spécifiques à DaVinci Resolve. L’option de montage Écraser (Overwrite) est réglée 
par défaut.

19 Quand l’option Écraser (Overwrite) apparaît en surbrillance, relâchez la souris.

Vous venez de monter votre premier plan dans la timeline.
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Contrôler la lecture
Une partie importante du processus de montage repose sur le contrôle de 
la lecture de la vidéo. Pour cela, vous pouvez bien sûr utiliser les commandes 
situées sous les viewers, mais les raccourcis clavier sont bien plus efficaces. 
DaVinci Resolve propose tous les raccourcis clavier couramment utilisés par les 
logiciels de montage professionnels à travers le monde. Vous pouvez utiliser 
la barre d’espace pour lancer ou arrêter la lecture, ainsi que les flèches gauche 
et droite pour reculer ou avancer la vidéo d’une image à la fois. Les utilisateurs 
plus expérimentés seront ravis d’apprendre que les touches J, K et L permettent 
également de contrôler la lecture à des vitesses différentes.

J K L

Les touches JKL correspondent aux boutons Lire vers l’arrière, Stop et Lecture. 

Suivez les indications ci-après pour apprendre à utiliser ces touches :

 — Appuyez sur L pour lire vers l’avant.

 — Appuyez sur J pour lire vers l’arrière.

 — Appuyez sur K pour interrompre la lecture.

Vous pouvez augmenter la vitesse de x 64 de la vitesse normale en 
appuyant sur les touches J ou L.

 — Appuyez deux fois sur L pour accélérer la vitesse x 2.

 — Appuyez deux fois sur J pour lire vers l’arrière x 2.

Vous pouvez aussi utiliser ces touches pour positionner la tête de 
lecture sur une image en particulier :

 — Maintenez la touche K enfoncée et appuyez sur L pour avancer d’une image.

 — Maintenez la touche K enfoncée et appuyez sur J pour reculer d’une image.

 — Maintenez les touches K et L enfoncées pour lire au ralenti.

 — Maintenez les touches K et J enfoncées pour lire vers l’arrière au ralenti.
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Travailler avec des sous-plans
Avant d’ajouter d’autres éléments sonores sur la timeline, il est important de savoir 
combien de temps vous avez utilisé du premier plan. Si vous regardez où vous avez saisi 
les points d’entrée et de sortie sur le plan dans le viewer source, vous verrez qu’il s’agit 
d’une toute petite portion du plan (6 à 7 secondes d’un plan de plus de 2 minutes). 

ASTUCE Le timecode affiché en haut à gauche du viewer source indique la durée 
saisie entre les points d’entrée et de sortie.

La différence entre la durée du plan capturé et la quantité utilisée dans le montage 
n’est pas inhabituelle et s’appelle le rapport de métrage (shooting ratio). En fonction du 
montage, les rapports de métrage varient grandement. Il est courant qu’un programme 
d’actualité ait un rapport de 3:1 (3 minutes de prises de vue pour 1 minute utilisée), alors 
que certains programmes de télé-réalité ont un rapport de 600:1, ou plus.

Avec tant d’images capturées, il est parfois préférable de se concentrer sur des segments 
plus petits et plus ciblés. C’est là que les sous-plans interviennent.

Les sous-plans sont des plans isolés du Master, mais appartenant au fichier média 
d’origine, de manière à ne pas prendre davantage de place sur votre espace de stockage. 
Vous apprendrez à créer et gérer vos propres sous-plans au chapitre 6. Dans cet exercice, 
les sous-plans ont été créés pour vous à partir de l’interview.

1 Dans la liste des chutiers, sélectionnez le chutier SUBCLIPS pour voir les quatre 
sous-plans.
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Le nom de chaque sous-plan fait référence au plan d’origine (par ex. A 005), et 
comporte une description qui identifie le son (par ex. Design, Slogan, Marque). Vous 
apprendrez à renommer les plans au chapitre 6.

ASTUCE Si vous souhaitez voir les noms de fichiers originaux au lieu des noms 
de plans, choisissez Affichage > Afficher les noms des fichiers (View > Show 
File Names).

2 Double-cliquez sur le quatrième plan dans le chutier SUBCLIP A 008 Experiences 
 pour l’ouvrir dans le moniteur source et le lire du début. 

Comme ce sous-plan est plus court, vous verrez mieux les formes d’onde.

3 Dans le menu Options (…) du viewer source, choisissez Afficher la forme d'onde du 
plan entier (Show Full Clip Audio Waveform).

Bien que ce segment ne fasse que 30 secondes, il va falloir le raccourcir un peu.
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4 Placez la tête de lecture juste avant que Chris parle et appuyez sur I pour saisir un 
point d’entrée.

5 Appuyez sur L pour lancer la lecture du plan et interrompez-la après la phrase « …the 
landscape », mais avant que Chris détourne le regard, puis appuyez sur O pour ajouter 
un point de sortie.
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6 Dans la barre d’outils, sélectionnez Écraser le clip (Overwrite Clip) ou appuyez sur F10.

REMARQUE Si vous utilisez DaVinci Resolve sous macOS, vous devrez peut-
être configurer le paramètre du Clavier « Utiliser les touches F1, F2, etc. comme 
des touches de fonction standard » dans les Préférences Système (System 
Preferences), afin de pouvoir utiliser les raccourcis de montage par défaut. 
Autrement, vous pouvez toujours utiliser la touche fn avec n’importe quelle 
touche de fonction F pour écraser les raccourcis de macOS.

Le second plan de l’interview est inséré dans la timeline. Le plan se place au niveau 
de la tête de lecture et n’inclut que la partie comprise entre les points d’entrée et de 
sortie définis dans le viewer source.
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Défilement et zoom de la timeline
La page Montage comporte trois options pour contrôler le niveau de zoom des 
plans dans la timeline. 

Zoom min (Full Extent Zoom) affiche toujours toute la timeline,  
le zoom s’ajustant automatiquement. C’est particulièrement utile 
pour avoir une vue d’ensemble de votre montage, et vous 
permettre de naviguer dans la timeline.

Zoom détail (Detail Zoom) zoom dans la timeline pour avoir une  
vue plus précise, centrée sur la tête de lecture. Cette option est 
très utile pour mieux voir une portion de la timeline et ainsi faire 
des réglages précis sur un point de coupe ou sur un plan.

Zoom personnalisé (Custom Zoom) offre le  
niveau de zoom le plus souple. Vous pouvez 
utiliser le curseur pour zoomer ou dézoomer 
sur la tête de lecture. En maintenant le bouton 
Opt (macOS) ou Alt (Windows) enfoncé, et en utilisant la molette de la souris, vous 
pouvez centrer le zoom sur la tête de lecture. 

Voici les raccourcis clavier les plus utiles pour zoomer dans la timeline :

 — Cmd-= (signe égal) (macOS) ou Ctrl-= (signe égal) (Windows) pour zoomer 
sur la tête de lecture dans la timeline.

 — Cmd- - (signe moins) (macOS) ou Ctrl- - (signe moins) (Windows) pour dézoomer 
de la tête de lecture dans la timeline.

 — Majuscule-Z permet de basculer entre les  
différentes vues de la timeline.

La hauteur de la piste peut être ajustée grâce au  
menu Affichages de la timeline (Timeline View 
Options) ou en maintenant le bouton Majuscule 
enfoncé et en utilisant la molette sur des zones audio 
ou vidéo de la timeline.

La timeline peut être déplacée vers la gauche et vers 
la droite avec la barre de défilement sous la fenêtre 
timeline ou en maintenant le bouton Command 
(macOS) ou Ctrl (Windows) enfoncé et en utilisant la 
souris (ou le trackpad).
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Ajouter les derniers 
extraits sonores
Pour monter le reste des effets sonores, vous allez utiliser les autres options de montage.

1 Dans la timeline, cliquez sur Zoom min (Full Extent Zoom) dans la barre d’outils pour 
voir les deux plans remplir la timeline.

2 Sélectionnez le viewer source pour l’activer.

ASTUCE Appuyez sur la touche Q pour passer du viewer source au viewer timeline.

3 Appuyez sur la flèche vers le haut pour aller sur le plan précédent dans la bibliothèque 
de médias SUBCLIP A 008 Brand et, au besoin, appuyez sur le bouton Home pour 
retourner au début de ce plan.

4 Lancez la lecture du plan dans le viewer source et ajoutez un point d’entrée juste avant 
que Chris dise « Our brand is really a reflection of our community who we are ». 



25Ajouter les derniers extraits sonores

5 Faites glisser le plan du viewer source au viewer timeline pour l’écraser. Vous pouvez 
aussi cliquer sur le bouton Écraser (Overwrite) ou sur la touche F10.

Insérer des plans
L’option de montage Insérer (Insert) est souvent utilisée et permet d’ajouter des plans sur 
la timeline sans rien écraser. 

1 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez deux fois sur 
la flèche vers le haut pour sélectionner le premier plan dans le chutier SUBCLIPS, 
SUBCLIP A 005 Design.

2 Dans le viewer source, placez la tête de lecture sur le deuxième groupe de 
formes d’onde. 

Il s’agit de l’extrait sonore que vous allez ajouter. Par contre, il va falloir être précis pour 
saisir le point d’entrée, car il faut uniquement capturer le moment où Chris répète le 
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mot « that ». En regardant les formes d’onde, vous pourrez facilement repérer la courte 
pause entre les deux « that ».

3 Dans le menu d’options du viewer source, sélectionnez Afficher les formes d’onde 
zoomées (Show Zoomed Audio Waveform).

4 Pour positionner la tête de lecture entre ces deux formes d’onde, vous pouvez soit 
utiliser la molette, soit appuyer sur les flèches vers la gauche et/ou vers la droite, soit 
appuyer sur les touches K et J ou L.

5 Lorsque la tête de lecture se trouve juste après le premier « that », mais avant le 
deuxième, appuyez sur I pour saisir le point d’entrée.

6 Ajoutez un point de sortie à la fin du plan de l’interview, après que Chris ait dit,  
«…that’s really where the design process starts ».

En revanche, est-ce vraiment logique de laisser ce plan à la fin de la timeline ? Il serait 
préférable de l’insérer entre deux plans précédents. Avant de faire quoi que ce soit, 
regardez où se trouve la tête de lecture.

Pour le moment, tout plan inséré à la timeline serait ajouté à la fin, sauf si vous faites 
un glisser-déposer. Cette fonctionnalité est très pratique si vous faites un montage 
rapide des plans. Par contre, pour ajouter des plans à différents moments de la 
timeline, vous devrez positionner la tête de lecture au bon endroit (voir la section « Les 
règles du montage à trois points »).

Comme la tête de lecture est positionnée à la fin de la timeline, vous allez devoir 
indiquer à Resolve où ajouter le plan en déplaçant la tête de lecture.
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7 Appuyez sur la touche Q pour aller sur le viewer timeline, et appuyez sur la flèche vers 
le haut pour positionner la tête de lecture au début du troisième plan.

8 Faites glisser ce plan du viewer source au viewer timeline, et placez-le sur l’option 
Insérer (Insert).

Le plan est inséré dans la timeline au niveau de la tête de lecture.
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Option de montage Ajouter à la fin
L’option Ajouter à la fin (Append at End) est également très utile. Comme son nom 
l’indique, elle permet d’ajouter un plan à la fin de la timeline. 

REMARQUE Vous en apprendrez plus sur les pistes cibles au chapitre 2 « Affiner 
le bout à bout ».

1 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez sur la flèche vers 
le bas pour aller sur le sous-plan SUBCLIP A 007 Tagline.

2 Lancez la lecture du plan dans le viewer et saisissez les points d’entrée et de sortie 
autour de la phrase « That’s why we say… experience the southwest. »

Vous allez ajouter ce segment à la fin de la timeline en utilisant l’option de montage 
Ajouter à la fin (Append at End). En suivant les règles du montage à trois points, la tête 
de lecture de la timeline devrait se positionner au bon endroit. Resolve propose une 
option permettant d’ajouter le segment sélectionné à la fin de la timeline, sans tenir 
compte de la position de la tête de lecture.
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3 Faites glisser le sous-plan sélectionné du viewer source sur l’option Ajouter à la fin 
(Append at End) dans le viewer timeline.

L’extrait sonore a été positionné à la fin de la timeline même si la tête de lecture n’y 
était pas.

REMARQUE Si vous voulez utiliser une version préparée pour vous avant de 
continuer, sélectionnez le chutier TIMELINES, puis choisissez Fichier > Importer 
> Timeline (File > Import > Timeline), allez sur R18 Editors Guide/Lessons/
Lesson 01/Timelines et sélectionnez OMO Promo Catchup 1.drt. Enfin, cliquez 
sur Ouvrir (Open).
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Les « règles » du montage à trois points
À quelques exceptions près, tous les montages que vous effectuez sont des 
montages à trois points. En effet, DaVinci Resolve calcule ce que vous souhaitez 
monter, et l’endroit où vous souhaitez le monter dans la timeline. 

Dans les étapes précédentes, les points d’entrée et de sortie que vous avez 
marqués dans le viewer source représentaient les deux premiers points essentiels 
au montage. Le troisième point est représenté par la position de la tête de lecture 
dans la timeline. 

Même si vous n’avez saisi aucun point d’entrée ou de sortie sur un plan avant de 
le monter dans la timeline, le logiciel a utilisé le début et la fin du plan comme 
points implicites.

Par ailleurs, en faisant glisser un plan directement à la position de votre choix 
sur la timeline, vous écrasez manuellement le troisième point par défaut 
(emplacement où le plan va débuter).

L’option de montage Ajouter à la fin (Append at End) est-elle un montage à trois 
points ? Oui. Elle respecte les règles du montage à trois points, car elle utilise les 
points d’entrée et de sortie saisis dans le viewer source, ainsi que la fin du dernier 
plan dans la timeline pour établir les trois points nécessaires.

Plus tard dans ce chapitre, vous apprendrez comment faire des montages à trois 
points plus complexes en utilisant différentes combinaisons de points d’entrée 
et de sortie dans les viewers source et timeline. Essayez donc de comprendre 
comment Resolve calcule le montage à trois points et comment les points d’entrée 
et de sortie (réels ou implicite) sont utilisés pour réaliser ces montages. 

Dans les prochains chapitres, vous réaliserez également des montages à quatre 
points et vous utiliserez les points d’entrée et de sortie de différentes manières !
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Ajouter un plan de coupe et 
régler les extraits sonores 
Maintenant que les extraits sonores sont dans la timeline, vous pouvez commencer à 
monter les plans de coupe. Il faut tout d’abord connaître les éléments dont vous disposez 
pour avoir une meilleure vue d’ensemble. Et comme pour tout processus créatif, il faut un 
peu d’imagination, ainsi qu’une bonne dose de patience.

Vous allez commencer par ajouter une prise au début et à la fin du montage. Elle servira 
de séquence d’ouverture et de fermeture à votre petit film.

1 Sélectionnez le chutier B-ROLL.

Tous les plans de coupe se trouvent dans ce chutier, mais en fonction de la quantité 
d’images que vous utilisez, il peut être un peu difficile de vous y retrouver. Vous 
pourriez organiser ces images dans des chutiers séparés. Comme pour les sous-plans 
que vous avez précédemment utilisés, nous avons déjà tout préparé pour vous, en 
créant des chutiers paramétrables sous Keywords.
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2 En bas de la liste des chutiers se trouve les chutiers paramétrables. Sélectionnez le 
dossier Keywords et cliquez sur la flèche de déroulement pour afficher la liste.

ASTUCE Vous pouvez redimensionner la zone dédiée aux chutiers 
paramétrables en faisant glisser la ligne de division vers le haut.

3 Sélectionnez le chutier paramétrable SCENERY.

Ce chutier contient tous les plans identifiés par le mot clé SCENERY.

REMARQUE Vous en apprendrez plus sur l’ajout et la gestion des mots clés et 
des métadonnées et la façon de créer des chutiers paramétrables au chapitre 6 
« Organisation du projet ».

4 Double-cliquez sur le premier plan dans le chutier paramétrable 
Organ Mountain Timelapse pour l'ouvrir dans le viewer source.
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Il s’agit d’une prise en timelapse qui servira d’arrière-plan aux génériques d'ouverture 
et de fermeture que vous ajouterez au chapitre 2.

Ce plan contient des points d’entrée et de sortie qui représentent une durée de 
7 secondes.

Pour l’insérer au début de la timeline, vous allez devoir placer la tête de lecture de la 
timeline au bon endroit.

5 Appuyez sur la touche Q pour passer sur le viewer timeline, puis sur la touche Home 
pour placer la tête de lecture au début de la timeline.

6 Dans la barre d’outils, sélectionnez la fonction de montage Insérer (Insert) ou 
appuyez sur F9.

Le plan est inséré au début de la timeline.

Pour ajouter ce plan de 7 secondes à la fin de la timeline, vous allez utiliser le bouton 
Ajouter à la fin (Append at End). Cette option n’est pas disponible directement dans la 
barre d’outils, mais vous pouvez y accéder via le menu ou le raccourci clavier.

7 Choisissez Édition > Ajouter à la fin de la timeline (Edit > Append to End of Timeline) ou 
appuyez sur Majuscule-F12.

Le plan de 7 secondes est inséré à la fin de la timeline. 
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Vous allez maintenant régler les extraits sonores de façon plus harmonieuse. Vous 
commencerez par créer un espace vide après la première phrase de Chris. 

8 Déplacez la tête de lecture sur le troisième plan dans la timeline.

9 Choisissez Timeline > Sélectionner les plans suivants > Sur cette piste (Timeline > 
Select Clips Forward > Select Clips Forward on This Track), ou appuyez sur Y.

Cette commande sélectionne les plans suivant la tête de lecture sur la piste ciblée. 

REMARQUE Vous en apprendrez plus sur les pistes cibles au chapitre 2 
« Affiner le bout à bout ».

Une fois tous les plans sélectionnés, il est plus facile de les déplacer.

10 Gardez les plans sélectionnés, et saisissez +200 dans le timecode du viewer timeline, 
puis appuyez sur Entrée.

Les plans sélectionnés sont déplacés de deux secondes vers la droite, ouvrant un 
espace vide. Ces deux secondes pourront être modifiées plus tard si besoin.
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11 Appuyez sur la flèche vers le bas pour aller sur la coupe suivante dans la timeline (la 
tête de lecture se positionne alors au début du troisième plan d’interview), et appuyez 
sur Y pour sélectionner tous les plans sur la piste ciblée.

12 Saisissez +100, puis appuyez sur Entrée pour ajouter un espace vide d’une seconde 
entre les deuxième et troisième plans.

13 Dans la timeline, déplacez la tête de lecture où vous voulez sur le cinquième plan et 
appuyez sur Y pour sélectionner tous les plans suivant la tête de lecture.

14 Saisissez de nouveau +200, puis appuyez sur Entrée pour déplacer les trois derniers 
plans de deux secondes, créant un autre espace vide sur la timeline.

15 Enfin, placez la tête de lecture sur le dernier plan et appuyez sur Y.

16 Saisissez +100 et appuyez sur Entrée pour créer un espace vide d’une seconde avant 
que Chris prononce le slogan « Experience the southwest ».

Ces espaces vides donnent un peu de respirations aux extraits sonores. Dans le 
monde réel, Chris reprendrait son souffle, donnant ainsi aux spectateurs le temps 
d’assimiler ses paroles. Il s’agit en quelque sorte de la ponctuation d’un film.
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Enrichir l’interview
Maintenant que l’interview a été montée dans la timeline, vous pouvez ajouter des plans de 
coupe. Ils donneront vie aux paroles de Chris, et recouvriront les espaces vides. Vous aurez 
alors un film beaucoup plus dynamique. Ce processus consiste à enrichir l’histoire grâce 
à des images. Pour y parvenir, vous pouvez régler les points d’entrée et de sortie dans la 
timeline afin de spécifier la durée des prises dont vous avez besoin.

1 Placez la tête de lecture à la fin du deuxième plan dans la timeline, au niveau du 
premier espace vide.

ASTUCE Appuyez sur N pour activer ou désactiver l’aimant.

2 Appuyez sur I pour saisir le point d’entrée dans la timeline.

3 Lancez la lecture jusqu’à ce que Chris dise « …experience the southwest because… », 
puis interrompez la lecture.

4 Appuyez sur O pour saisir le point de sortie.

Maintenant que vous avez balisé une portion de cette timeline, vous savez où 
positionner le plan de coupe.

5 Dans le chutier paramétrable ACTIVITIES, double-cliquez sur le plan 
PINE TREE WALKING pour l’ouvrir dans le viewer source.

Il s’agit d’une prise de trois amis portant des vêtements Organ Mountain Outfitters en 
train de marcher dans la montagne.
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6 Lancez la lecture du plan, puis saisissez un point d’entrée après que le réalisateur ait 
dit « Go ahead », et que la fille soit prête à faire son deuxième pas.

REMARQUE Avant de continuer, comptez combien de points d’entrée et de 
sortie vous avez saisi pour cette coupe. Trois : Les points d’entrée et de sortie 
dans la timeline et le point d’entrée sur le viewer source.

En général, les plans de coupe sont montés au-dessus de l’interview. DaVinci Resolve 
offre une option de montage pour y parvenir facilement.

7 Faites glisser le plan PINE TREE WALKING sur l’option Placer au-dessus (Place on Top) 
dans le viewer timeline.
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Grâce aux règles de montage à trois points, le plan est monté entre les points d’entrée 
et de sortie dans la timeline, en commençant par le point d’entrée réglé dans le viewer. 
L’option Placer au-dessus (Place on top) ajoute une piste audio/vidéo pour accueillir le 
nouveau plan, sans écraser les images additionnelles.

Le viewer timeline est désormais actif, et la tête de lecture se positionne 
automatiquement à la fin du plan que vous venez d’ajouter. Elle est prête à accueillir la 
coupe suivante.

8 Sans déplacer la tête de lecture, appuyez sur I pour saisir le point d’entrée.

9 Lancez la lecture de la timeline, et ajoutez un point de sortie après que Chris ait dit, 
« there’s nothing like it ».

10 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez sur la flèche 
vers le haut pour ouvrir le plan précédent des trois amis en train de marcher 
PINE TREE TRAIL STEPS.
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11 Réglez le point d’entrée quand le deuxième personnage entre dans l’image et écarte 
les jambes.

12 Choisissez Édition > Placer au-dessus (Edit > Place on Top) ou appuyez sur F12 pour 
ajouter le plan sur la même piste que précédemment.

13 Sur la timeline active, appuyez sur I pour ajouter un point d’entrée, lisez les images et 
saisissez le point de sortie juste après que Chris ait dit « …ever experienced ».
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14 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez sur la flèche vers 
le bas jusqu’à la prise WHITE SANDS FRIENDS.

15 Ajoutez un point d’entrée quand la fille de gauche relève la tête et sourit pour la photo.

Le bruit du vent capturé par le micro de la caméra est un peu embêtant.

16 Dans le viewer source, cliquez et tirez l’option représentant uniquement la vidéo 
sur l’option Placer au-dessus (Place on Top) dans le viewer timeline pour insérer 
uniquement la vidéo.

17 Ajoutez un point d’entrée au niveau de la tête de lecture et un point de sortie après 
que Chris ait dit « …the culture, the food… ».
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18 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez sur la flèche vers 
le haut pour aller sur le plan PINA BLANCA FIRE DANCER. Ajoutez un point d’entrée 
vers le début du plan de la fille qui fait tournoyer les torches enflammées.

19 Dans la timeline, cliquez sur la commande de destination A1 pour la désactiver. 

De cette façon, l’audio du plan source n’est pas monté dans la timeline, tout en 
permettant d’utiliser les raccourcis.

20 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).
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21 Appuyez sur I pour saisir le point d’entrée et sur O pour saisir le point de sortie après 
la phrase « …really inspires us… ».

22 Appuyez sur la touche Q pour aller sur le viewer source, puis appuyez sur la flèche vers 
le haut pour aller sur le plan PENA BLANCA JUMPING ROCKS.

23 Ajoutez un point d’entrée au moment où le garçon saute sur le rocher. 

24 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).
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Vous voyez sans doute désormais à quel point le montage à trois points est puissant et 
facilite le travail. Ces plans de coupe vont devoir être rognés, mais avant de se lancer là-
dedans, vous allez ajouter quelques plans de coupe à la fin de l’interview avec différentes 
techniques.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > 
Timeline), puis R18 Editors Guide/Lessons/Lesson 01/Timelines et sélectionnez 
OMO Promo Catchup 2.drt, puis cliquez sur Ouvrir (Open).

Montage en backtiming
Quand vous ajoutiez les plans de coupe dans l’interview, vous spécifiez où chaque prise 
devait être positionnée en fonction du point de coupe. Mais parfois, vous pourriez vouloir 
monter un plan dans la timeline en spécifiant où la prise devrait finir. Il s’agit d’une 
technique de backtiming, facile à comprendre quand on suit les règles du montage à 
trois points.

1 Lancez la lecture du troisième plan d’interview et ajoutez un point d’entrée après que 
Chris ait dit « …we bring it back to the store…. ».

Pour ajouter rapidement un point de sortie à la fin du plan, vous pouvez utiliser 
la commande pour aller sur le point de sortie disponible sous la tête de lecture. 
Cette méthode est différente du passage à la coupe suivante. En effet, avec 
cette technique, la tête de lecture est positionnée sur la dernière image du 
plan actuel, et non sur la première image du plan suivant. De cette façon, le 
point de sortie peut être positionné avec précision.

2 Choisissez Lecture > Aller à > Dernière image (Playback > Go To > Last Frame), ou 
appuyez sur ’ (apostrophe).
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La tête de lecture se positionne sur la dernière image du plan, que vous pouvez voir 
par la présence du point de sortie en bas à droite du viewer timeline. 

3 Appuyez sur O pour saisir un point de sortie.

REMARQUE Comme la tête de lecture de Davinci Resolve inclut l’image sur 
laquelle elle se trouve, les points d’entrée sont toujours ajoutés en tête de 
l’image et les points de sortie, en queue. La durée minimale que vous pouvez 
saisir correspond à une image.

4 Dans le chutier paramétrable RETAIL, double-cliquez sur le plan 
STORE COMPUTER DESIGN pour l’ouvrir dans le viewer source.

Ce plan montre un designer de Organ Moutain Outfitter en train de créer un t-shirt sur 
son ordinateur.
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5 Repérez l’image, vers le début du plan, juste avant qu’il ajoute le cercle noir au centre 
du t-shirt.

C’est à ce moment-là que l’extrait doit s’interrompre.

6 Ajoutez un point de sortie à cette image.

Vous avez ajouté trois points d’entrée et de sortie sur la timeline et le viewer source (un 
point d’entrée et de sortie dans la timeline et un point de sortie dans le viewer source). 
Dans ce cas, comme il n’y a qu’un point de sortie et pas de point d’entrée dans le 
viewer source, les règles du montage à trois points établissent que le plan sera monté 
sur la timeline comme prévu. En revanche, les deux points de sortie seront alignés, le 
backtiming sera donc appliqué vers le point d’entrée.

ASTUCE Au besoin, vous pouvez supprimer un point d’entrée en choisissant 
Marque > Supprimer le point d’entrée (Mark > Clear In) ou en appuyant sur 
Option-I (macOS) ou Alt-I (Windows). De la même façon, pour supprimer le 
point de sortie, choisissez Marque > Supprimer le point de sortie (Mark > Clear 
Out) ou en appuyant sur Option-O (macOS) ou Alt-O (Windows). Choisissez 
Marque > Supprimer les points d’entrée et de sortie (Mark > Clear In and Out), 
ou appuyez sur Opt-X (macOS) ou Alt-X (Windows) pour supprimer les deux 
points simultanément.

7 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).

Ensuite, vous allez ajouter un plan de coupe pour remplir un autre espace vide.
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8 Ajoutez un point d’entrée au début de l’espace vide sur la timeline.

9 Continuez de lire l’interview et ajoutez un point de sortie juste avant que Chris dise 
« Our brand is really a reflection of….». 

10 Dans le chutier paramétrable RETAIL, double-cliquez sur le plan 
STORE HANGING SHIRT pour l’ouvrir dans le viewer source.

Ce plan un peu long montre le chemin que parcourt un t-shirt du studio de design à la 
boutique. Vous n’aurez besoin que de la dernière partie de cette prise.

11 Dans le viewer, repérez l’image où la fille pend le t-shirt et sort de l’image (vers la 
fin du plan).

12 Appuyez sur O pour saisir le point de sortie.
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13 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).

14 Ajoutez un autre point d’entrée sur la tête de lecture dans la timeline.

15 Ajoutez un point de sortie après « That’s why we say… », au moment où il pose ses 
mains sur ses genoux.

16 Dans le chutier paramétrable RETAIL, double-cliquez sur le plan 
STORE EXTERIOR SIGN pour l’ouvrir dans le viewer source.

17 Saisissez le point de sortie quand la fille au chapeau noir sort de la boutique et 
lâche la porte.
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18 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).

Parfait ! Maintenant que les plans de coupe sont en place, tous les jump cut et les 
espaces vides ont été comblés. Il reste une chose à faire pour finaliser ce bout à bout.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > 
Timeline), puis R18 Editors Guide/Lessons/Lesson 01/Timelines et sélectionnez 
OMO Promo Catchup 3.drt, puis cliquez sur Ouvrir (Open).

Ajouter de la musique
Dans un montage, la musique a énormément d’importance. Si les paroles (dialogue, 
interviews ou narration) donnent des indications sur le sujet, la musique quant à elle 
permet de communiquer l’émotion d’une scène ou d’un sujet. Un mauvais choix de 
musique peut ruiner un film !

Heureusement, pour ce projet, la musique a été soigneusement sélectionnée. Il suffit de 
l’ajouter à la timeline.

1 Assurez-vous que le viewer timeline est sélectionné et appuyez sur Home pour 
positionner la tête de lecture au début de la timeline.

2 Sélectionnez le chutier MUSIC dans la liste des chutiers et ouvrez le plan ONE MIN  
SOUNDTRACK.wav dans le viewer source.
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Quand vous sélectionnez des plans audio uniquement, le viewer source passe 
automatiquement en mode audio.

Vous pouvez ajouter des points d’entrée et de sortie sur les plans audio, comme vous 
venez de le faire. Dans ce cas en revanche, cela n’est pas nécessaire, car la musique 
dure moins d’une minute, ce qui correspond à la durée nécessaire pour le montage. 

3 Dans la timeline, cliquez sur la commande de destination A1 pour la réactiver et 
permettre à l’audio d’être de nouveau monté sur la timeline.

4 Appuyez sur F12 pour appliquer le raccord Placer au-dessus (Place on Top).

La piste musicale est ajoutée sur la nouvelle piste audio. 

Il faut encore baisser le volume du plan audio pour qu’il s’accorde mieux avec le reste 
des éléments sonores. Le niveau n’a pas besoin d’être précisément réglé pour le 
moment, simplement légèrement baissé pour qu’il n’eclipse pas le reste de la timeline.
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5 Placez la souris sur la courbe de volume du plan audio dans la timeline. Elle est 
représentée par une ligne blanche horizontale.

6 Cliquez et tirez la courbe du volume vers le bas pour réduire le niveau du plan 
jusqu’à -18 dB.

ASTUCE Pour un réglage ecore plus précis, maintenez la touche 
Majuscule enfoncée.

7 Placez la tête de lecture au début de la timeline et lancez la lecture.

Félicitations ! Vous venez de terminer les premières étapes de ce livre. Souvenez-vous que 
ce chapitre était consacré à la réalisation d’un bout à bout à l’aide des outils de montage 
disponibles sur la page Montage. Vous avez sans doute aussi acquis une meilleure 
compréhension de ce qu’est un montage à trois points. Il reste encore pas mal de choses 
à faire avant de pouvoir montrer cette scène à vos clients de chez Organ Mountain 
Outfitters. C’est ce que vous ferez au prochain chapitre.
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Révision
1 Vrai ou faux ? Le bout à bout est une timeline rapidement montée qui ne sera 

pas modifiée.

2 Quels éléments suivants permettent de diviser un long plan en plusieurs segments 
plus facilement gérables ?

a) Plans sources

b) Plans Master

c) Sous-plans

3 Vrai ou faux ? Les options de montage Placer au-dessus et Ajouter à la fin n’ont pas de 
raccourci clavier.

4 Au minimum, combien de points d’entrée et de sortie doivent être saisis pour réaliser 
un montage à trois points ?

a) 0

b) 2

c) 3

5 Comment s’appelle un montage qui repose sur deux points de sortie et un point 
d’entrée ? 

a) Montage inversé

b) Montage Insérer et ajuster

c) Montage en backtiming
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Réponses
1 Faux. Un bout à bout est en général la première étape du processus de montage. 

Cette structure générale du projet est montée rapidement et doit être affinée.

2 b) Sous-plans.

3 Faux. Le raccourci clavier pour l’option de montage Placer au-dessus est F12 et 
Majuscule-F12 pour l’option Ajouter à la fin. Les raccourcis clavier de toutes les options 
de montage sont disponibles dans le menu Affichage.

4 a) 0. La plupart des options de montage reposent sur les règles de montage à trois 
points, que vous ajoutiez ou non les points d’entrée et de sortie dans la timeline ou le 
viewer source. Si aucun point d’entrée ou de sortie ne se trouve dans le viewer source, 
la première image du plan sert de point d’entrée, et la dernière image de point de 
sortie. Si aucun point d’entrée ou de sortie ne se trouve dans la timeline, la tête de 
lecture sert en général de point d’entrée (sauf pour l’option Ajouter à la fin). Si vous 
faites glisser un plan directement sur la timeline, le « troisième » point se situe à 
l’endroit où vous relâchez la souris.

5 c) Montage en backtiming.
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Chapitre 2

Affiner le 
bout à bout

Dans le chapitre précédent, vous avez 
créé le bout à bout d’une publicité 
pour la marque de vêtements Organ 
Mountain Outfitters. Pour certains, 
savoir comment créer un montage de 
ce type est suffisant. Pour d’autres, il 
ne s’agit que d’un début. Maintenant 
que la structure de base du montage 
est terminée, il est temps d’appliquer 
des modifications aux coupes pour 
améliorer le tout.

Si l’on applique la règle du 80/20 : 
le bout à bout créé au chapitre 1 a 
permis de réaliser 80 % du montage 
en 20 % de temps. Les 20 % restants 
(rognage, mixage audio, graphiques, 
etc.) vont prendre 80 % du temps. 
Comme vous le voyez, votre travail est 
loin d’être terminé.
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Bien entendu, en tant que monteur vous êtes tenu de livrer le projet final dans les temps 
(il ne faudrait quand même pas rater l’avant-première !), il n’est donc pas surprenant 
d’avoir l’impression de ne jamais avoir « terminé » son travail. Ce qu’il vous manque, c’est 
simplement un peu plus de temps et d’argent.

Configurer le projet
Ce chapitre reprend le projet réalisé au chapitre 1. Si vous avez effectué toutes les étapes 
du chapitre 1, vous pouvez aller directement à la section : Dupliquer la timeline

Par contre, si vous n’avez pas fait les exercices du chapitre précédent, ou si vous n'êtes 
pas satisfait du résultat, vous pouvez importer une timeline préparée pour démarrer 
ce chapitre.

REMARQUE Les étapes suivantes nécessitent d’avoir terminé au moins la 
première partie du chapitre 1 et d’avoir créé une nouvelle bibliothèque de projets, 
d’avoir importé le fichier OMO Promo (Organ Mountain Outfitters) et d’avoir relié 
les médias offline. Si vous n’avez pas réalisé ces étapes, consultez le début du 
chapitre 1 avant de commencer.

1 Lancez DaVinci Resolve, dans le gestionnaire de projet (Project manager), double-
cliquez sur le projet OMO Promo pour l’ouvrir.

2 Si la page Montage n’est pas ouverte, cliquez sur l’onglet correspondant.

3 Dans la liste des chutiers, sélectionnez le chutier TIMELINES, et choisissez Fichier > 
Importer > Timeline (File > Import > Timeline).

4 Sélectionnez le projet R18 Editors Guide/Lesson 02/Timelines, sélectionnez le fichier 
OMO Promo Catchup 4.drt et cliquez sur Ouvrir (Open).

La timeline est importée dans le chutier sélectionné et s’ouvre automatiquement dans 
le viewer timeline. Vous pouvez désormais continuer.
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Dupliquer la timeline
Il est préférable de dupliquer la timeline sur laquelle vous travaillez avant de commencer. 
De cette façon, si vous (ou le client/réalisateur) n’aimez pas les modifications apportées, 
vous aurez toujours une copie de la timeline en sauvegarde. 

1 Choisissez Timeline > Rechercher la timeline actuelle dans la bibliothèque de médias 
(Timeline > Find Current Timeline in Media Pool) pour retrouver rapidement la timeline 
actuelle dans son chutier.

2 Faites un clic droit sur la timeline actuelle et choisissez Dupliquer la timeline 
(Duplicate Timeline).

Une copie de la timeline apparaît dans le même chutier.
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Cette copie porte le même nom, mais le mot copy a été ajouté à la fin pour indiquer 
qu’il s’agit d’une copie.

ASTUCE Si vous n’arrivez pas à lire tout le nom de la timeline dans la 
bibliothèque de médias, utilisez le curseur pour redimensionner les vignettes.

Beaucoup de monteurs préfèrent renommer la timeline dupliquée, en général en 
remplaçant le mot « copy » par la version (v1, v2, v3 etc), pour s’y retrouver plus 
facilement. Si vous ne changez pas le nom de la timeline dupliquée, les copies 
suivantes auront un chiffre ajouté à la fin (copy, copy 1, copy 2, etc). Cette façon de 
renommer les fichiers est utile pour deux raisons. Tout d’abord, cela signifie que la 
version sur laquelle vous travaillez est toujours la plus récente, mais aussi parce que 
les noms générés automatiquement permettent de retrouver rapidement une version 
antérieure.

REMARQUE Les projets peuvent contenir plusieurs timelines. Vous pouvez 
utiliser les chutiers pour organiser ces timelines dupliquées. De cette façon, 
vous savez toujours sur quelle timeline vous devez travailler. Autrement, vous 
pouvez toujours désactiver la timeline que vous n’utilisez pas en faisant un clic 
droit sur la timeline dans la bibliothèque de médias et en choisissant Désactiver 
la timeline (Disable Timeline). Les timelines désactivées ne peuvent pas être 
ouvertes. Elles n’apparaîtront pas dans le menu déroulant de la timeline.

Une fois la timeline dupliquée, il est temps de peaufiner votre montage.
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L’art du monteur
Le rognage permet de régler les points d’entrée et de sortie d’un plan une fois 
qu’il est sur la timeline. C’est sans doute la compétence la plus importante que doit 
posséder un monteur. Le rognage permet de régler le début et la fin des plans. 

DaVinci Resolve comporte les outils de rognage les plus performants du marché, 
offrant ainsi des capacités de réglage de la timeline extrêmement précis. Dans les 
chapitres suivants, vous apprendrez à utiliser ces outils pour être parés à toutes 
les situations.

Au-delà du simple fait de couper un plan et de supprimer des images, le rognage 
sur DaVinci Resolve repose sur deux modes : le mode Sélection (Selection) et le 
mode Trim (Trim Edit).

Le mode Sélection permet de déplacer les plans dans la timeline et de régler 
facilement leur durée. Il s’agit de la manière la plus intuitive pour rogner les plans 
dans une timeline Resolve.

Le mode Trim donne accès à la véritable puissance des fonctions de rognage. 
Dans ce mode, vous pouvez rogner les points de coupe, mais aussi faire glisser 
le contenu d’une prise et faire coulisser la position d’une prise en fonction des 
autres plans.

Toutes les fonctionnalités de rognage de Resolve peuvent également être 
appliquées à plusieurs plans ou à plusieurs points de coupe simultanément. 
Vous pouvez utiliser la souris ou bien les raccourcis clavier pour encore plus 
de précision.

Les modes Sélection et Trim peuvent être utilisés avec le mode Raccord 
dynamique (Trim Dynamic). Vous en apprendrez plus sur le Raccord dynamique au 
chapitre 4 « Découper une scène dramatique ».



58 Chapitre 2 Affiner le bout à bout

Affiner les plans dans la timeline
Dans le chapitre précédent, vous avez ajouté une série de plans de coupe pour habiller 
l’interview en saisissant des points d’entrée et de sortie dans la timeline et en les montant 
rapidement avec l’option Placer au-dessus (Place on top). Jusqu’à maintenant vous vous 
êtes concentré sur le montage de la timeline, vous n’avez donc pas encore assez revu les 
coupes. Vous pouvez désormais regarder si les prises fonctionnent bien ensemble et les 
rogner individuellement.

Vous allez commencer par rogner certains plans de la timeline OMO Promo avec l’outil de 
sélection.

1 Placez la tête de lecture au début du premier plan d’interview et regardez le premier 
groupe de plans de coupe sur la piste V2.

Les coupes fonctionnent, mais ne sont pas très précises, en particulier entre le plan de 
l’interview et la prise où les quatre amis marchent.

2 Placez la tête de lecture au début du premier plan sur V2.

3 Cliquez sur le bouton Zoom détail (Detail Zoom) pour zoomer sur la position de la tête 
de lecture.
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4 Sélectionnez le plan sur V2 et faites-le glisser vers l’arrière d’environ 1 
seconde (-01:00).

Malheureusement, en déplaçant le plan vous avez créé un espace vide, faisant 
apparaître le plan situé sous l’interview. Vous allez devoir rogner le début du plan 
suivant sur V2 pour remplir cet espace.

5 Cliquez sur le début du deuxième plan sur V2, et déplacez-le vers l’arrière jusqu’à ce 
qu’il s’aimante au plan précédent.

Cette modification a rallongé le deuxième plan d’une seconde pour remplir l’espace 
vide précédemment créé.

6 Positionnez la tête de lecture au début du premier plan d’interview, et lancez la lecture 
pour voir les modifications.

En déplaçant légèrement le plan de coupe, vous donnez un effet plus « resserré » à 
la séquence. En revanche, la coupe entre le premier et le deuxième plan est un peu 
étrange, parce que vous avez changé l’endroit où débute le deuxième plan. Pour 
affiner le point de coupe, vous allez faire coulisser les prises avec l’outil Mode Trim 
(Trim Edit mode).
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7 Cliquez sur le bouton Mode Trim (Trim Edit mode), ou appuyez sur la touche T.

Le bouton s’allume alors en rouge pour indiquer que ce mode est activé. Vous verrez 
que la souris se transforme en outil de rognage.

8 Déplacez la souris sur le premier plan de coupe sur V2.

Le mode Trim (Trim Edit mode) est un outil contextuel, c’est-à-dire qu’il se transforme 
en fonction de l’endroit où est placée la souris. Lorsque vous placez la souris au milieu 
du plan, le pointeur se transforme en un curseur par coulissement, reflétant ainsi le 
type de rognage qui sera effectué.

9 Une fois l’icône affichée, cliquez sur le plan et tirez vers la gauche.

Cette fois, comme vous êtes en mode Trim (Trim Edit Mode), le plan ne bouge pas. 
Cette fonction modifie la partie du clip affichée dans la timeline en déplaçant ses 
points d’entrée et de sortie. 

Le viewer timeline change automatiquement en un écran multiview à 4 fenêtres.
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Les deux images du haut affichent le début et la fin du plan sélectionné et les deux 
images du bas affichent la dernière image du plan précédent (Interview de Chris sur 
V1) et la première image du plan suivant (deuxième plan de coupe sur V2).

Quand vous rognez un plan, un contour blanc s’affiche autour du plan. 

Ce contour affiche les poignées disponibles, c’est-à-dire la portion du plan qui n’est 
pas utilisée dans la timeline.

10 Une fois le plan sélectionné, faites-le glisser vers la gauche jusqu’à ce que l’image en 
haut à droite du viewer affiche l’homme en rouge en train de marcher (-00:15), puis 
lancez la lecture du premier plan sur V2 pour visualiser le changement.

En modifiant ce premier plan, vous avez détérioré le deuxième plan de coupe.
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11 Sélectionnez le deuxième plan de coupe et faites-le coulisser d’une seconde vers la 
gauche (-01:00) afin que l’image en haut à gauche du viewer affiche la même image. 

ASTUCE Vous pouvez utiliser l’image en bas à droite (qui affiche la dernière 
image du plan précédent) pour faire correspondre les deux images.

12 Positionnez la tête de lecture au début du premier plan d’interview sur V1 et visionnez 
les changements apportés.

Même si vous n’avez pas modifié le timing de l’espace vide entre les deux plans 
d’interview sur V1, le fait de rogner et d’affiner la coupe entre les plans de coupe rend 
le montage un peu plus propre.

REMARQUE En général, vous devrez appliquer plusieurs opérations de 
montage en parallèle. Aux étapes précédentes, vous avez rogné le début d’un 
plan, mais vous avez dû faire coulisser les deux plans pour affiner l’alignement 
des coupes. Comme vous allez le voir, il s’agit d’une opération de rognage 
très courante.
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Montage Roll
Une autre fonction de rognage très utile est le montage Roll, qui permet de repositionner 
un point de coupe en rognant deux plans adjacents simultanément.

1 Placez la tête de lecture au début du deuxième plan de coupe sur la piste V2,  
PINE TRAIL WALKING et lancez la lecture pour voir les quatre plans de 
coupe suivants.

Le plan où les quatre amis sourient à la caméra, WHITE SANDS LAUGHING FRIENDS,  
 est un peu court relativement aux autres.

2 Placez le pointeur de la souris au centre de la coupe pour faire apparaître l’outil Roll.

3 Cliquez pour sélectionner les deux côtés de la coupe.

4 Rognez la coupe sélectionnée d’une seconde vers la droite (+01:00).

Le rognage Roll ajoute une seconde au plan aval et rogne le plan amont d’une 
seconde, ne créant pas d’espace vide.

REMARQUE Un raccord Roll peut être réalisé indifféremment avec les modes 
Sélection et Trim.
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5 Retournez au début du plan WHITE SANDS FRIEND et visionnez les 
changements apportés.

6 Le timing semble plus approprié. Cliquez sur Zoom min (Full Extent Zoom) ou appuyez 
sur Majuscule-Z pour voir toute la timeline.

Effectuer un raccord fin Ripple 
sur plusieurs points de coupe
Le Mode Trim (Trim Edit) permet de décaler tous les plans de la timeline sans laisser 
d’espace vide. L’option Ripple est utile quand vous voulez affiner le timing des prises, car, 
contrairement au mode Sélection, les changements que vous apportez se répercutent sur 
toute la timeline. 

Dans le montage actuel, vous pouvez utiliser la fonctionnalité Ripple pour régler le timing 
des espaces vides entre les plans d’interview.

1 Avec le mode Trim (Trim Edit) sélectionné, cliquez à gauche du début du troisième plan 
d’interview sur V1.

Cela sélectionne la partie « sortante » de l’espace vide.

2 Tirez le point de coupe sélectionné vers la droite pour allonger l’espace vide.

À mesure que vous faites glisser ce point de coupe, vous remarquerez que tous les 
autres plans suivant cette coupe sont également modifiés. Comme vous le voyez, 
l’option Ripple est très puissante.
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Vous voyez également que le plan qui recouvre l’espace vide entre les deuxième 
et troisième plans d’interview n’est pas inclus, car il commence avant la coupe 
sélectionnée. Ainsi, la durée et la position du plan restent inchangées, il va donc falloir 
découper l’interview de Chris à un autre endroit.

Même si vous pouvez appliquer un montage Roll à la fin du plan de coupe montrant 
le garçon sur le rocher, il est parfois plus facile de rogner plusieurs points de coupe 
à la fois.

3 Relâchez la souris et choisissez Édition > Annuler (Edit > Undo) pour annuler tous les 
changements apportés.

ASTUCE Vous pouvez voir la liste complète des étapes que vous pouvez 
annuler et restaurer en choisissant Édition > Historique > Ouvrir la fenêtre 
Historique (Edit > History > Open History Window).

4 Sélectionnez l’espace vide, puis appuyez sur Command (macOS) ou Ctrl (Windows), et 
cliquez sur la fin du cinquième plan sur V2.

Maintenant que les deux points de coupe sont sélectionnés, vous allez pouvoir les 
rogner ensemble.

5 Tirez la coupe sélectionnée sur V2 vers la droite pour ajouter une seconde au plan et à 
l’espace vide sélectionné en dessous.

6 Pour visionner le raccord existant, choisissez Lecture > Lire autour/jusqu’à > Lire 
autour de l’image sélectionnée (Playback > Play Around/To > Play Around Current 
Frame), ou appuyez sur / (barre oblique). 
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Montage par glissement
Le quatrième type de raccord que vous pouvez réaliser en mode Trim (Trim Edit) est le 
montage par glissement (Slide). Le montage par glissement est sans doute le type de 
rognage le moins utilisé, mais il est utile de savoir à quoi il sert.

Comme avec le montage par coulissement, le montage par glissement est appliqué aux 
plans sélectionnés, mais il affecte également les plans amont et aval de part et d’autre du 
ou des plan(s) sélectionné(s).

1 Vérifiez que la timeline est toujours en mode Trim (Trim Edit), et positionnez la souris 
sur la partie inférieure à l’endroit où est affiché STORE HANGING SHIRT.

En mode Trim (Trim Edit), lorsque la souris se trouve sur la partie inférieure d’un plan, il 
se transforme en curseur de glissement.

2 Une fois l’icône affichée, sélectionnez le plan STORE HANGING SHIRT et tirez-le d’une 
seconde (+01:00) vers la droite, en appuyant sur N pour désactiver l’aimant (au besoin).

ASTUCE Vous pouvez désactiver l’aimant en appuyant sur N pendant le 
rognage. La fonction sera automatiquement réactivée quand vous relâcherez 
la souris.
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3 Déplacez le début du plan STORE EXTERIOR SIGN d’une seconde (-01:00).

Le rognage Ripple appliqué au début du plan sur V2 se répercute sur tous les plans 
suivants. Cela entraîne l'allongement de la durée de l’espace vide sous le plan 
STORE EXTERIOR SIGN.

Parfait ! Vous devriez désormais avoir une meilleure compréhension du mode Trim 
(TRim Edit).

REMARQUE Si vous voulez voir la version finalisée réalisée par l’équipe 
Resolve, sélectionnez le chutier TIMELINES et choisissez Fichier > Importer > 
Timeline (File > Import > Timeline). Allez ensuite sur R18 Editors Guide/Lessons/
Lesson 02/Timelines, sélectionnez OMO Promo Catchup 5.drt et cliquez sur 
Ouvrir (Open).

Remplacer les plans
La fonction Remplacer (Remplace) permet d’échanger rapidement un plan par un autre : 
soit un plan complètement différent, soit une autre prise de ce même plan. 

Pour commencer, vous allez utiliser la fonction de montage Remplacer (Remplace) pour 
changer les angles de la caméra utilisés pour l’interview de Chris. Vous allez commencer 
par le dernier plan d’interview, qui sera remplacé par une prise en gros plan.

REMARQUE Dans les exemples suivants, le timecode des plans remplacés 
correspond. Cela facilitera la compréhension. Attention, il ne s’agit pas d’un 
workflow multicaméra. Vous verrez comment synchroniser, couper et remplacer 
les angles des images multicaméras au chapitre 5 « Montage multicaméra ».
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1 Dans la timeline, positionnez la tête de lecture au début du dernier plan de l’interview.

2 Dans le viewer timeline, faites un clic droit sur le champ du timecode et choisissez 
Timecode source (Source Timecode).

Désormais, le timecode source des plans s’affiche dans le champ Timecode.
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3 Faites un clic droit sur le champ Timecode source et choisissez Copier le timecode 
(Copy Timecode).

4 Dans la bibliothèque de médias, sélectionnez le chutier B CAM.

5 Grâce au nom du plan dans la timeline, SUBCLIP A 007 Tagline, vous pouvez identifier 
les extraits sonores qui proviennent de la prise « 007 ».

6 Ouvrez le plan OMO_B_007 dans le viewer source.
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7 Faites un clic droit sur le champ timecode dans viewer source et choisissez Coller le 
timecode (Paste Timecode).

La tête de lecture se positionne directement sur le nouveau timecode dans le 
viewer source.
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ASTUCE Vous pouvez voir le timecode source de chaque plan au niveau de la 
tête de lecture en sélectionnant le menu Options (…) du viewer timeline et en 
choisissant Afficher les informations du timecode (Show Timecode Overlays). 

Même si ces informations ne servent que de références et ne peuvent pas être 
copiées, vous pouvez tout le même vérifier le timecode source d’un plan sur 
une piste en particulier, puis le saisir manuellement dans le champ Timecode 
du viewer source.

Avant de continuer, sachez que l’option de montage Remplacer (Replace) est très 
puissante, mais ne suit pas les règles du montage à trois points. L’option Remplacer 
(Replace) utilise la position des deux têtes de lecture dans les viewers source et 
timeline pour connaître l’alignement du plan source dans la timeline. En cas d’absence 
de points d’entrée et de sortie sur la timeline, les points d’entrée et de sortie du plan 
serviront à déterminer la durée du plan.

Cela peut paraître un peu compliqué, mais souvenez-vous que l’option Remplacer 
(Replace) permet de faire un montage à quatre points sur la page Montage de 
DaVinci Resolve : les deux têtes de lecture représentent les deux premiers points, et le 
début et la fin du plan, les deux autres points.
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REMARQUE L’option Remplacer (Replace) ignore les points d'entrée et de 
sortie réglés dans le viewer source.

8 Faites glisser le plan du viewer source sur l’option de montage Remplacer (Replace).

Le gros plan de la caméra B remplace le plan d'ensemble sur la timeline. Les viewers 
source et timeline affichent désormais la même image.

9 Appuyez sur / (barre oblique) pour prévisualiser le nouveau plan dans la timeline.

Comme par magie, l’audio et la vidéo que vous avez montés précédemment dans la 
timeline ont été remplacés par l’audio et la vidéo du gros plan. Comme vous le voyez, 
l’option Remplacer est très puissante.
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Remplacer une partie du plan
Vous pouvez aussi utiliser l’option Remplacer (Replace) pour remplacer une partie du plan 
dans la timeline.

1 Positionnez la tête de lecture au milieu du troisième plan d’interview, juste après que 
Chris a dit « …we take that inspiration… ».

2 Dans la barre d’outils de la timeline, cliquez sur le mode Rasoir (Blade Edit Mode) ou 
appuyez sur B.

3 Placez la souris sur le plan d’interview afin que le mode Rasoir (Blade) s’aimante à la 
tête de lecture.

4 Cliquez sur le plan pour ajouter un point de coupe.
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5 Cliquez sur Timecode dans le viewer timeline et appuyez sur Cmd-C (macOS) ou Ctrl-C 
(Windows) pour le copier sur le plan de l’interview.

6 Dans le chutier C CAM, ouvrez le plan OMO_C_005 dans le viewer source.

7 Sélectionnez le champ Timecode dans le viewer source et appuyez sur Cmd-V (macOS) 
ou Ctrl-V (Windows).

8 Cliquez sur le bouton Remplacer le plan (Replace Clip) dans la barre d’outils ou appuyez 
sur F11 pour remplacer le plan après la coupe.

REMARQUE Sur macOS, vous devrez peut-être modifier les touches de 
fonction du clavier pour utiliser le raccourci F11. Ouvrez Préférences > Système 
(Preferences > System), et choisissez Clavier > Raccourcis > Mission Control 
(Keyboard > Shortcuts > Mission Control), et désélectionner ou changer le 
raccourci utilisé pour Afficher Bureau (Show Desktop).

9 Appuyez ensuite sur / (barre oblique) pour visionner la coupe. Au besoin, sélectionnez 
le mode Trim (Trim Edit) et appliquez un raccord Roll sur le point de coupe pour 
affiner la coupe.
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Vous pouvez aussi utiliser les points d’entrée et de sortie de la timeline avec l’option 
Remplacer (Replace) pour limiter la quantité d’images remplacées dans la timeline, puis 
utiliser les commandes de destination de la piste pour indiquer s’il faut remplacer les 
parties vidéo et audio du plan.

10 Cliquez sur le bouton Mode Sélection (Selection Mode), ou appuyez sur la touche A.

11 Lancez la lecture du plan et ajoutez un point d’entrée avant que Chris dise « store in 
Las Cruces… »

12 Choisissez Lecture > Aller à > Dernière image (Playback > Go To > Last Frame), ou 
appuyez sur ’ (apostrophe) pour aller sur la dernière image de ce plan et ajouter un 
point de sortie.

Malheureusement, vous ne pouvez pas simplement copier le timecode source comme 
vous l’avez fait précédemment, car le plan de coupe est affiché. Le timecode source est 
en réalité celui du plan PINE TRAIL WALKING. Vous allez donc faire un Match Frame 
pour ouvrir le plan source de l’interview dans le viewer source.

13 Sélectionnez le premier plan de l’interview dans la timeline et choisissez Plan > Match 
Frame sur plan source (Clip > Match Frame to Source Clip) ou appuyez sur F.

REMARQUE Vous pouvez aussi sélectionner le bouton Match Frame à droite 
des commandes du viewer timeline.



76 Chapitre 2 Affiner le bout à bout

Le plan source du plan d’interview s’ouvre dans le viewer source sur l’image où se 
trouve la tête de lecture dans la timeline.

14 Sélectionnez le timecode dans le viewer source et appuyez sur Command-C (macOS) 
ou Ctrl-C (Windows) pour le copier.

15 Dans le chutier C CAM, ouvrez le plan OMO_C_002 et collez le timecode sur le 
champ timecode.
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Comme vous n’allez utiliser que la vidéo de ce plan, vous devez indiquer que l’audio ne 
doit pas remplacer l’audio déjà présent dans la timeline.

16 Dans l’en-tête de la piste, cliquez sur la commande de destination A1 ou appuyez sur 
Option-Command-1 (macOS) ou Alt-Ctrl-1 (Windows).

17 Appuyez sur F11 pour appliquer l’option de montage Remplacer (Replace). Cela permet 
de ne remplacer que la partie vidéo du plan dans la timeline.

En saisissant les points d'entrée et de sortie dans la timeline, vous limitez la quantité 
d’images remplacées. En utilisant d’autres angles caméra de l’interview, vous ajoutez 
davantage de rythme.

Spécifier les pistes de destination
Dans le chapitre précédent, vous avez monté une série de plans sur les premières pistes 
vidéo et audio de la timeline : Vidéo 1 et Audio 1. Les plans que vous avez ensuite ajoutés 
comme plans de coupe ont été montés sur les pistes additionnelles (Vidéo 2 et Audio 2, 
puis Audio 3 pour la musique) en utilisant l’option Placer au-dessus (Place on Top). 

Par contre, si vous souhaitez monter les plans sur une piste existante, vous devrez spécifier 
la piste à l’aide des commandes de destination.
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1 Placez la tête de lecture au début du cinquième plan sur V2, PENA BLANCA JUMPING  
ROCKS, et ajoutez le point d’entrée.

2 Ajoutez un point de sortie deux secondes plus tard, au moment où le garçon atteint le 
haut du rocher.

3 Dans le chutier paramétrable ACTIVITIES, ouvrez le planPENA BLANCA LOOKOUT 
dans le viewer source et repérez l’image au milieu du plan qui correspond à l’image 
dans le viewer timeline.

Vous allez devoir assigner la bonne piste dans la timeline.
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4 Cliquez sur la commande de destination V2 pour cibler la vidéo source (V1) sur la piste 
Vidéo 2 ou appuyez sur Option-2 (macOS) ou Alt-2 (Windows).

ASTUCE Une série de commandes permettant de changer les commandes de 
destination audio et vidéo se trouve dans Timeline > Sélectionner la piste de 
destination (Timeline > Track Destination Selection).

5 Appuyez sur F11 pour appliquer le raccord Remplacer (Replacer) sur la piste Vidéo 2.

6 Appuyez ensuite sur / (barre oblique) pour visionner le raccord.

L’avantage d’utiliser l’option Remplacer (Remplace), au lieu de l’option Écraser en 
backtiming (Backtimed Overwrite), c’est que vous n’avez pas à ajouter de points 
d’entrée ou de sortie dans le viewer source. L’option Remplacer (Replace) ignore la 
position des points d'entrée et de sortie dans le viewer source. En outre, quand vous 
réalisez un montage Remplacer (Replace), les têtes de lecture des viewers source 
et timeline pourraient se trouver en dehors des points d’entrée et de sortie de la 
timeline. En revanche, la portion des images sources situées entre les points d’entrée 
et de sortie sera, elle, calculée en décalage des points d’entrée et de sortie des têtes 
de lecture.

7 Faites un clic droit sur le champ Timecode dans le viewer timeline et choisissez 
Timecode d'enregistrement (Record Timecode) pour afficher le timecode de 
la timeline.
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REMARQUE Si vous voulez voir la version finalisée, sélectionnez le chutier 
TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > Timeline). 
Allez ensuite sur R18 Editors Guide/Lessons/Lesson 02/Timelines, sélectionnez 
OMO Promo Catchup 6.drt et cliquez sur Ouvrir (Open).

Mixage audio
Dans ce chapitre, vous avez continué d’affiner les plans vidéo dans la timeline. Le montage 
consiste en effet à appliquer beaucoup de réglages en fonction du résultat auquel vous 
voulez parvenir, qu’il s’agisse de remplacer l’intégralité ou une partie d’une prise, ou 
encore de rogner des plans pour modifier le rythme et la durée du montage. Par contre, 
n’oubliez pas de rester raisonnable si vous voulez rendre votre projet à temps.

Maintenant que les coupes sont de meilleure qualité, vous allez retravailler l’audio.

En général, on passe autant de temps sur l’audio que sur la vidéo. Au cours des étapes 
suivantes, vous allez utiliser certaines techniques courantes pour corriger le niveau audio. 
Vous allez commencer par normaliser les niveaux des interviews de Chris.

REMARQUE Vous en apprendrez plus sur les techniques de montage et de 
mixage audio au chapitre 8 « Montage et mixage audio ».

1 En haut à droite de l’interface, cliquez sur le bouton Mixeur (Mixer).
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ASTUCE Si vous n’avez pas assez de place sur votre écran, cliquez sur le 
bouton de la bibliothèque de médias en haut à gauche pour la refermer.

2 Dans le mixeur, double-cliquez sur le bouton Mute de la piste A3. De cette façon, vous 
pourrez vous concentrer sur les niveaux audio des interviews de Chris.

3 Lancez la lecture de la timeline du début, et regardez les niveaux sur la piste A1 dans 
le mixeur.

Même si l’audio de ces plans provient de la même interview, les niveaux sont très 
différents. Certains peak sont à -3 dBFS, alors que d’autres sont à -18 dBFS. 
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4 Sélectionnez tous les plans sur la piste A1, puis faites un clic droit sur un des plans 
sélectionnés et choisissez Normaliser les niveaux audio (Normalize Audio Levels).

La fenêtre qui s’ouvre affiche plusieurs options pour normaliser les niveaux audio des 
plans sélectionnés.

5 Gardez le mode de normalisation (Normalization Mode) sur Sample Peak Program, et 
réglez Niveau cible (Target Level) sur -9 dBFS. 

Le menu de normalisation permet de choisir la méthode de normalisation des niveaux. 
Vous pouvez choisir la normalisation du loudness basée sur des algorithmes afin de 
répondre aux standards internationaux. Cette option est particulièrement utile pour 
équilibrer le loudness dans plusieurs plans, quels que soient les niveaux de transition. 
Vous pouvez aussi appliquer la normalisation du Peak avec les options Sample Peak et 
True Peak. Quelle que soit la méthode choisie, le résultat sera presque identique : le 
niveau audio des plans est analysé, puis ajusté en fonction des réglages.

6 Réglez le Niveau prédéfini (Set Level) sur Indépendant.
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Quand le niveau prédéfini est réglé sur Relatif (Relative), tous les plans sélectionnés 
sont traités comme s’il s’agissait d’un plan. Ainsi, le peak le plus haut et le niveau de 
loudness de tous les plans sélectionnés définissent le réglage, et le volume des plans 
est réglé en conséquence. Quand le niveau prédéfini est réglé sur Indépendant, le 
niveau de peak et de loudness d’un plan définit le réglage de ce plan en particulier. 
Ce réglage permet de régler le niveau en fonction des plans, de façon à mieux les 
faire correspondre. L’option Relatif est utile si vous normalisez une série de plans 
enregistrés au même niveau, par exemple en cas d’enregistrement des dialogues dans 
un environnement contrôlé. L’option Indépendant est préférable si les plans n’ont pas 
le même niveau (subtil ou non), par exemple des interviews ou tout autre élément 
audio enregistré sur place, dans un environnement moins contrôlé.

7 Cliquez sur Normaliser (Normalize).

Les niveaux audio des plans sélectionnés sont réglés afin que le niveau du peak de 
chaque plan se situe à -9 dBFS sur le vumètre.

8 Pour vérifier, lancez de nouveau la lecture, et regardez les niveaux de la piste A1 dans 
le mixeur.

Le niveau de chaque plan est désormais plus cohérent, car il est réglé en fonction 
du niveau d’enregistrement initial. Par exemple, les premier et cinquième plans 
d’interview sont réglés 6 dB plus bas que les autres plans. La raison est simple, ces 
deux plans ont un peak d’entrée plus important, ce qui affecte la façon dont le reste du 
plan a été normalisé.
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9 Zoomez sur le premier plan sur A1 pour bien voir la forme d’onde.

10 Appuyez sur Option (macOS) ou Alt (Windows) et cliquez sur la courbe de volume pour 
ajouter deux images clés entre les premier et deuxième peak.

11 Cliquez et maintenez le volume après la deuxième image clé pour voir le réglage 
appliqué au plan au cours du processus de normalisation.

La souris affiche -3 dB. Pour que le reste du niveau du plan s’aligne avec les autres 
plans, vous devez appliquer +6 dB, relevant le réglage de -3 dB à +3 dB.
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12 Faites glisser la courbe de volume jusqu’à ce qu’il atteigne 3 dB.

13 Répétez les étapes pour le cinquième plan sur la piste A1 
SUBCLIP A 008 Brand - Chris. Ajoutez des images clés juste après le peak et réglez le 
niveau après la deuxième image clé sur 4 dB.

Félicitations ! Vous avez réussi à normaliser et à équilibrer les plans de l’interview. 

Utiliser des images clés pour 
supprimer l’audio indésirable
Vous pouvez aussi utiliser des images clés pour supprimer l’audio indésirable.

1 Lancez le dernier plan de l’interview sur la piste A1, OMO_B_007, et écoutez ce que dit 
Chris après : “That’s why we say….”

Au moment où il pose ses mains sur ses genoux, on entend un clap (cette action est 
recouverte par le plan de coupe en extérieur).
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2 Zoomez dans le plan pour bien voir la forme d’onde et repérer ce son.

3 Appuyez sur Option (macOS) ou Alt (Windows) et cliquez sur la courbe de volume pour 
ajouter deux images clés après le premier son et avant le deuxième, et une troisième 
au-dessus du peak provoqué par ce clap.

4 Tirez l’image clé du milieu pour réduire le niveau du clap jusqu’à ce qu’on ne 
l’entende plus.
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Régler les niveaux des plans SOT
Vous pouvez aussi normaliser les plans d’effets, comme ceux qui se trouvent sur la piste 
A2. Ce type d’audio est souvent appelé SOT (Sound on Tape), un terme datant du temps où 
l’audio était enregistré sur bande. Il fait référence au son enregistré par la caméra.

1 Ensuite, faites un clic droit sur un des plans de la piste A2 et choisissez Normaliser les 
niveaux audio (Normalize Audio Levels).

2 Dans la fenêtre, réglez Niveau cible (Target Level) sur -18 dBFs, qui correspond mieux 
au niveau attendu pour des effets sonores, puis cliquez sur Normaliser (Normalize).

Les plans sont normalisés au bon niveau.

3 Ajoutez deux images clés sur le premier plan SOT, juste avant le deuxième plan 
d’interview de Chris, et augmentez la première partie du plan de 6 dB (de 12 dB à 18 
dB), afin de mieux entendre le bruit des pas entre les plans d’interview.

4 Appliquez un fondu en ouverture d’une seconde à l’aide de la poignée sur le 
premier plan SOT.
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5 Appliquez un fondu en fermeture d’une seconde à l’aide de la poignée sur le 
deuxième plan SOT.

Grâce à ces quelques changements, les plans SOT s’intègrent mieux dans le reste de la 
scène. Ensuite, vous allez ajouter un peu de musique.

Baisser le volume musical 
(Ducking) pendant les dialogues
La touche finale consiste à ajouter une piste musicale et réduire son volume pendant les 
interviews ou autres dialogues. Cette technique s’appelle le Ducking.

Le niveau audio de la musique est pour le moment réglé sur -18 dB, un bon point de 
départ. Comme vous avez déjà réglé le niveau des plans d’interview, vous allez simplement 
augmenter l’audio dans les espaces vides, entre les phrases de Chris.

1 Cliquez sur le bouton Mute de la piste A3 dans les commandes de la piste ou dans le 
mixeur, pour réactiver la piste musicale et lisez la timeline du début. Écoutez la façon 
dont la musique cohabite avec le reste de la scène.

2 Ajoutez deux images clés au moment où Chris se met à parler.

3 Faites glisser la courbe de volume avant la première de ces images clés de 6 dB (autour 
de - 12 dB).
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Lancez la timeline du début pour entendre le volume de la musique se réduire pendant 
l’interview.

4 Répétez ces étapes, ajoutez deux images clés à la fin du plan musical, augmentez le 
volume après la deuxième image clé de 6 dB. De cette façon, la musique augmente 
après le slogan « …experience the southwest ». Lancez la lecture de la timeline pour 
visualiser le contenu de cette timeline.

Il y a d’autres espaces vides dans l’interview où la musique pourrait être augmentée.

5 Maintenez la touche Option (macOS) ou Alt (Windows) enfoncée et cliquez pour ajouter 
quatre images clés sur le plan musical autour de l’espace vide entre les premier et 
deuxième plans d’interview de Chris.

6 Tirez la barre de volume entre les deuxième et troisième images clés pour augmenter 
le niveau de cette partie du plan de 6 dB. 

7 Répétez ces étapes pour augmenter la musique sur les autres espaces vides entre les 
plans d’interview.

Vous pouvez lire la timeline du début pour entendre la musique se réduire quand Chris 
parle. Une fois que vous êtes satisfait des niveaux, vous pouvez refermer le mixeur.
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REMARQUE Si vous voulez voir la version finalisée, sélectionnez le chutier 
TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > Timeline). 
Allez ensuite sur R18 Editors Guide/Lessons/Lesson 02/Timelines, sélectionnez 
OMO Promo Catchup 7.drt et cliquez sur Ouvrir (Open).

Ajouter le logo
Le montage est presque fini. Juste avant d’appliquer la touche finale, vous aurez besoin 
d’ajouter le logo d’Organ Mountain Outfitters à la prise d’ouverture et un générique à la 
prise de fermeture afin d’inciter les spectateurs à se rendre sur le site d’Organ Mountain 
Outfitter et de répéter leur slogan « Experience the Southwest ».

1 Dans la timeline, positionnez la tête de lecture sur le premier plan, 
ORGAN MOUNTAIN TL.mov, puis choisissez Lecture > Aller à > Dernière image 
(Playback > Go To > Last Frame) ou appuyez sur ’ (apostrophe) pour aller à la dernière 
image de ce plan.

2 Appuyez sur O pour régler le point de sortie à cet endroit.

3 Dans le chutier GRAPHICS, ouvrez le plan OMO LOGO.png dans le viewer source.
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REMARQUE Si vous avez refermé la bibliothèque de médias, vous aurez 
besoin de la rouvrir en cliquant sur le bouton Bibliothèque de médias (Media 
Pool) en haut à gauche de l’interface.

4 Dans la barre d’outils, sélectionnez Écraser le clip (Overwrite Clip) ou appuyez sur F10 
pour écraser le plan sur la piste V2.

REMARQUE Si V1 est la piste cible, vous pouvez changer la commande de 
destination ou appliquer l’option de montage Placer au-dessus (Place on Top) 
au lieu d’Écraser (Overwrite).

DaVinci Resolve fonctionne avec divers formats graphiques et fichiers audio et vidéo. 
Quand vous utilisez des fichiers graphiques, la durée du plan par défaut est de 5 
secondes, ce qui est suffisant pour appliquer le montage en backtiming que vous avez 
déjà réalisé à l’étape précédente. En revanche, comme les fichiers graphiques sont 
simplement les mêmes images répétées, le plan peut être rogné pour être plus long 
ou plus court. 

ASTUCE Vous pouvez changer la durée par défaut d’une photo dans le menu 
Préférences > Utilisateur (Preferences > User), puis sous l’onglet Montage (Editing), 
modifiez la valeur Durée par défaut des photographies (Standard still duration).

5 Dans la timeline, tirez la poignée de fondu au début du plan vers la droite pour 
appliquer un fondu de 12 images (+00:12). 
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6 Positionnez la tête de lecture sur le plan OMO LOGO.png et en haut à gauche de 
l’interface, cliquez sur la bibliothèque d’effets pour l’ouvrir.

Cette bibliothèque contient des transitions audio et vidéo, titres et générateurs.

7 Dans la barre latérale, sélectionnez Open FX et allez sur Resolve FX Style (Stylize).

8 Double-cliquez sur le filtre Ombres portées (Drop Shadow) pour appliquer l’effet au 
plan OMO LOGO.png.

L’ombre portée met mieux en valeur le logo contre le plan d’arrière-plan sur V1. Pour 
régler les paramètres de ce plan, vous devez utiliser les commandes disponibles dans 
l’inspecteur.
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REMARQUE DaVinci Resolve « sélectionne » automatiquement le plan situé 
sur la piste vidéo la plus en haut. Le fait de cliquer et sélectionner un plan évite 
ce comportement, vous permettant de choisir manuellement sur quel plan 
l’effet est appliqué. Sinon, vous pouvez glisser le filtre directement sur le plan 
ou les plans sélectionnés, dans la timeline.

9 Cliquez sur le bouton Inspecteur en haut à droite de l’interface pour ouvrir la fenêtre à 
droite du viewer timeline.

REMARQUE Si vous travaillez sur un écran de petite taille, l’ouverture de 
l’inspecteur entraînera peut-être une réduction des viewers source et timeline 
en viewer unique (Single View).

L’inspecteur donne accès à tous les paramètres des plans dans la timeline ou la 
bibliothèque de médias. Vous apprendrez à l’utiliser ultérieurement. Pour le moment, il 
vous suffit de régler les paramètres de l’ombre portée. 

10 Cliquez sur l’onglet Effets (Effects) dans l’inspecteur pour afficher les effets appliqués 
au plan sélectionné.
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11 Diminuez la distance (Drop Distance) sur 0.020 et augmentez le Flou (Blur) sur 0.40 
pour créer une ombre plus précise.

Une fois l’ombre portée appliquée et affinée, vous pouvez ajouter un autre effet sur le 
graphique pour apporter un peu de mouvement.

12 Dans l’inspecteur, cliquez sur l’onglet Vidéo (Video).

L’inspecteur permet de régler les commandes les plus courantes associées au plan, 
dont la taille et la position. Vous apprendrez à contrôler ces réglages pour créer des 
effets époustouflants au chapitre 7 « Créer une composition dans la page Montage ».

13 Cliquez sur Zoom dynamique (Dynamic Zoom) de l’inspecteur pour afficher les 
commandes et réglez Lissage (Dynamic Zoom Ease) sur Fin amorti (Ease Out).
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Lisez le plan OMO LOGO.png pour voir le résultat. Vous remarquerez que les fondus 
et les zooms évoluent vers la fin du plan.

Vous pouvez également affiner le début et la fin du cadrage sur zoom dynamique.

14 Choisissez Affichage > Option du viewer > Zoom Dynamique (View > Viewer Overlay > 
Dynamic Zoom ) pour afficher les commandes à l’écran du zoom dynamique.

ASTUCE Vous pouvez aussi afficher les commandes dans le viewer timeline en 
cliquant sur le menu déroulant Mode Transformation (Transform Mode).

15 Réglez le cadrage de départ du zoom dynamique en décalant légèrement les coins du 
cadre vert du bord de l’image. 



96 Chapitre 2 Affiner le bout à bout

16 Une fois que vous êtes satisfait du cadrage de départ et de fin, choisissez Affichage 
> Option du viewer > Activer/Désactiver (View > Viewer Overlay > Toggle On/Off ) ou 
appuyez sur Majuscule-` (accent grave) pour désactiver les commandes à l’écran. 

Parfait ! En utilisant les effets et les commandes intégrés dans l’inspecteur, une image fixe 
peut être transformée en une scène d’ouverture spectaculaire. Vous en saurez plus sur la 
façon de compositer les images dans la page Montage au chapitre 7.

Ajouter un générique
Désormais, il est temps d’utiliser les modèles de titres Fusion disponibles sur Resolve.

1 Allez jusqu’à la fin de la timeline et lancez le plan final ORGAN MOUNTAIN  
TIMELAPSE. Utilisez les formes d’onde comme guides, et interrompez la lecture 
quand vous entendez la dernière note de musique.

2 Dans la bibliothèque d’effets, sélectionnez la catégorie Titres (Titles) et allez jusqu’au 
titre Fusion Horizontal Line Reveal.

ASTUCE Vous pouvez prévisualiser les titres Fusion.
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Vous ne pouvez pas ouvrir un titre directement dans la bibliothèque d’effets, vous 
devez préalablement l’ajouter à la timeline. Mais cela ne signifie pas pour autant que 
vous ne pouvez pas utiliser des techniques de montage à trois points.

3 Faites glisser le titre Horizontal Line Reveal de la bibliothèque d’effets au viewer 
timeline pour réaliser un montage Écraser (Overwrite) sur la piste vidéo ciblée (V2).

REMARQUE Si la timeline cible la piste V1, vous devez utiliser le montage 
Placer au-dessus (Place on Top).

4 Dans la timeline, placez la tête de lecture sur le plan titre.
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5 Dans l’inspecteur, sélectionnez le texte SAMPLE UPPER dans la section Upper Text 
Controls et saisissez organmountainoutfitters.com.

6 Choisissez Affichage > Réserve Cadre > On (View > Safe Area > On).

Les Réserves Cadres (Safe Area) permettent de voir si les titres sont correctement 
affichés sur les écrans comportant un surbalayage. Elles sont nécessaires pour les 
programmes broadcast. 

7 Réglez la taille sur 0.08 (assurez-vous que le texte reste dans la Réserve Cadre).

http://organmountainoutfitters.com
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ASTUCE Vous pouvez régler la taille de l’action et des réserves cadre en activant 
Utiliser les informations de la réserve cadre personnalisée (Use Custom Safe 
Area Overlays) dans la section Montage (Editing) des préférences utilisateurs.

8 Dans l’inspecteur, allez jusqu’à la section Lower Text Controls, sélectionnez le texte 
SAMPLE et saisissez #experiencethesouthwest.

9 Réglez l’espacement (Lower Text Spacing) sur 1.09 afin que le texte soit de la même 
taille que la ligne.

ASTUCE Vous pouvez également ajuster les valeurs d’un champ du ou des 
plans sélectionnés dans l’inspecteur avec les flèches directionnelles.

Pour rendre le texte encore plus visible, vous pouvez modifier les couleurs.

10 Allez jusqu’à la section Upper Text Controls.

11 Réglez l’option Type 1 sur Dégradé (Gradient).
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12 Sous l’option Ombre dégradée 1 (Shading Gradient 1), cliquez sur le triangle de gauche 
et réglez la couleur sur un orange vif.

13 Cliquez sur le triangle de droite, puis réglez la couleur sur un jaune chaud.

14 Faites défiler l’inspecteur jusqu’à la fin, jusqu’à la section Couleur (Line Color).

15 Réglez le menu Type sur Dégradé (Gradient).
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16 Cliquez sur le triangle de gauche, puis réglez la couleur sur un orange profond.

17 Cliquez sur le triangle de droite, puis réglez la couleur sur un jaune chaud.

18 Dans l’inspecteur, cliquez sur l’onglet Paramètres (Settings) en haut de la fenêtre.

19 Réglez la Position Y sur -360.00 pour déplacer le titre vers le bas (assurez-vous que le 
texte reste dans la Réserve Cadre).
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20 Dans la timeline, utilisez la poignée de fondu du plan titre pour appliquer un fondu de 
fermeture de 12 images (-00:12).

21 Rognez la fin du plan ORGAN MOUNTAIN TL.mov sur V1 pour qu’il s’aimante à la fin 
du plan audio sur A3 et appliquez un fondu de fermeture d’une seconde (-01:00).

22 Choisissez Affichage > Réserve Cadre > On (View > Safe Area > On) pour masquer 
les repères.

REMARQUE Si vous voulez voir la version finalisée, sélectionnez le chutier 
TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > Timeline). 
Allez ensuite sur R18 Editors Guide/Lessons/Lesson 02/Timelines et sélectionnez 
OMO Promo Catchup 8.drt, puis cliquez sur Ouvrir (Open).

Changements de dernière minute
Le montage de ce petit film est presque terminé et quasiment prêt à être montré à vos 
clients. D’ailleurs, ils sont en chemin pour vous rencontrer. Grâce aux quelques minutes 
qu’il vous reste, vous allez pouvoir corriger encore un peu les images. 
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Atténuer les tremblements de l’image
Vous allez commencer par stabiliser la prise dans laquelle le garçon se trouve sur 
les rochers.

1 Dans la timeline, lancez la lecture du deuxième plan PENA BLANCA JUMPING ROCKS.

Ce plan est de bonne qualité, mais les mouvements de la caméra sont trop visibles et 
détournent l’attention.

2 Placez la tête de lecture sur le plan dans la timeline, et dans l’inspecteur, ouvrez les 
commandes Stabilisation (Stabilization) et cliquez sur Stabiliser (Stabilize).

Resolve analyse l’image et tente de réduire le mouvement de la caméra. Une fois 
l'analyse terminée, appuyez sur la barre d'espace pour visionner de nouveau le plan.

La prise est beaucoup plus stable, mais le mouvement est encore présent.

3 Augmentez le paramètre Lisser (Smooth) sur 0.900 et cliquez de nouveau sur le 
bouton Stabiliser (Stabilize) pour appliquer les changements.

Cette action permet de réduire les mouvements de la caméra, offrant ainsi une prise 
de bien meilleure qualité.
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Changer la vitesse des plans
Vous pouvez également rapidement ajuster la vitesse de lecture des plans.

1 Positionnez la tête de lecture sur le plan PENA BLANCA FIRE DANCER et dans 
l’inspecteur, ouvrez les commandes Variation de vitesse (Speed Change).

2 Changez la valeur % sur 50.00 pour lire le plan à 50 %.

REMARQUE Vous apprendrez à apporter des changements plus fins au 
chapitre 7.
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Ajouter des transitions
Les clients sortent de l’ascenseur, il ne vous reste que quelques secondes pour ajouter des 
transitions aux plans.

1 Dans la timeline, sélectionnez le point de coupe entre le dernier plan d’interview et le 
plan ORGAN MOUNTAIN TIMELAPSE.

2 Dans la bibliothèque d’effets, sélectionnez le groupe Transitions Vidéo (Video 
Transitions) et double-cliquez sur la transition Fondu enchaîné (Cross Dissolve) pour 
l’appliquer au point sélectionné.

3 Sélectionnez la transition dans la timeline et appuyez sur Command-D (macOS) ou 
Ctrl-D (Windows) pour ouvrir la fenêtre Modifier la durée de la transition (Change 
Transition Duration).
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4 Dans la fenêtre Changer la durée (Change Duration), saisissez 12 et cliquez sur 
Changer (Change).

5 Choisissez Command-C (macOS) ou Ctrl-C (Windows) pour copier la transition 
sélectionnée.

6 Appuyez sur T pour passer en mode Trim (Trim Edit Mode), puis cliquez et sélectionnez 
les deux points de coupe entre les trois derniers plans de coupe sur V2 pour les 
sélectionner.

7 Appuyez sur Cmd-V (macOS) ou Ctrl-V (Windows) pour coller la transition.

Juste à temps ! Les clients viennent d’arriver et s’installent pour découvrir votre travail.

Visualiser en plein écran
Félicitations ! Vous venez de monter un court film publicitaire pour Organ Mountain 
Outfitters. Avant d’exporter le fichier final et de le télécharger sur les réseaux sociaux, 
nous vous conseillons de le regarder en plein écran. Votre client et vous-même aurez ainsi 
l’occasion de voir le résultat sans être déconcentrés.
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1 Choisissez Espace de travail > Mode Viewer > Affichage Cinéma (Workspace > Viewer 
Mode > Cinema Viewer) ou appuyez sur Cmd-F (macOS) ou Ctrl-F (Windows).

DaVinci Resolve affiche la timeline en plein écran. Les commandes de lecture et de 
navigation sont affichées.

ASTUCE Vous pouvez toujours utiliser les raccourcis clavier que vous 
connaissez pour vous déplacer dans la timeline : le bouton Home pour 
retourner au début, les commandes JKL pour lire les plans, etc.

2 Les commandes à l’écran permettent de retourner au début et de lancer la lecture. 
Les commandes et la souris disparaissent au bout de quelques secondes.

3 Quand vous avez terminé, bougez légèrement la souris pour faire réapparaître les 
commandes, et cliquez sur l’icône représentant quatre flèches, ou appuyez sur 
Esc pour retourner sur l’interface Resolve.

De cette façon, vous visualisez le montage comme le verront les spectateurs. 
Regardez attentivement pour voir si certaines parties du montage doivent 
encore être modifiées. Si vous voyez quoi que ce soit qui ne vous convient pas, 
corrigez-le maintenant.

REMARQUE Si vous voulez voir la version finalisée, sélectionnez le chutier 
TIMELINES et choisissez Fichier > Importer > Timeline (File > Import > Timeline). 
Allez ensuite sur R18 Editors Guide/Lessons/Lesson 02/Timeline, sélectionnez 
OMO Promo Catchup FINISHED.drt et cliquez sur Ouvrir (Open).
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Exportation rapide
Votre client adore le montage ! Il ne reste plus qu’à l’exporter et à le poster sur vos 
plateformes et réseaux sociaux préférés. Vous allez pouvoir le faire rapidement avec la 
fonction d’exportation rapide de DaVinci Resolve.

1 Choisissez Fichier > Exportation rapide (File > Quick Export).

La fenêtre Exportation rapide (Quick Export) comporte les préréglages couramment 
utilisés pour créer un fichier vidéo de la timeline, et pour partager les fichiers 
directement sur les réseaux sociaux, tels que YouTube, Vimeo, Twitter ou Dropbox.

REMARQUE DaVinci Resolve Studio fournit d’autres options de partage, 
comme Frame.io et Dropbox Replay.

2 Sélectionnez l’option YouTube. 
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Ce préréglage permet de créer un fichier et de télécharger la vidéo directement sur 
YouTube. Si vous n’êtes pas encore connecté, vous devrez le faire avant de pouvoir aller 
plus loin. 

3 Dans ce cas, cliquez sur le bouton Gérer le compte (Manage account). 

Les préférences système de DaVinci Resolve s’ouvrent alors. Vous pouvez saisir vos 
informations et télécharger directement la vidéo sur le site de votre choix. 

ASTUCE Vous pouvez accéder à ces préférences en choisissant 
DaVinci Resolve > Préférences > Comptes Internet (DaVinci Resolve > 
Preferences > Internet Accounts).

Pour se connecter à un de vos comptes, cliquez sur le bouton Connexion (Sign in) 
de la plateforme de votre choix, et saisissez les informations du compte. Cliquez 
sur Enregistrer (Save). Une fois ces étapes terminées, la fenêtre Exportation rapide 
(Quick Export) affiche la case Télécharger directement (Directly Upload). Cette case 
permet de saisir le titre, les paramètres de confidentialité et une description. 

Au lieu de télécharger le fichier directement sur la plateforme, vous pourriez 
simplement créer un fichier simple. Il faudra ensuite manuellement le télécharger ou le 
distribuer de la façon que vous préférez.
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4 Cliquez sur Annuler (Cancel) pour retourner sur la fenêtre Exportation rapide (Quick 
Export) et sélectionnez le paramètre H.264 Master.

5 Cliquez sur Exporter (Export), choisissez l’emplacement sur l’ordinateur, puis cliquez 
sur Enregistrer (Save).

ASTUCE Par défaut, le nom du fichier correspond au nom de la timeline. Vous 
pouvez donc également renommer la vidéo à ce moment du processus.

Une fenêtre d’exportation affiche la durée de l’opération. Une fois l’exportation 
terminée, la vidéo sera disponible à l’emplacement choisi. Refermez la fenêtre 
Exportation rapide (Quick Export). Vous pouvez désormais la lire avec le lecteur par 
défaut de l’ordinateur.

Félicitations ! Au cours de ces deux premiers chapitres, vous êtes parvenu à créer un 
court, quoi que complexe, film promotionnel à l’aide des outils disponibles sur la page 
Montage de DaVinci Resolve. Nous espérons que ces chapitres vous ont donné une bonne 
vue d’ensemble des fonctionnalités de ces outils, et la façon de les utiliser sur vos projets. 
Mais vous n’êtes qu’au début de votre apprentissage. Dans les chapitres suivants, vous 
apprendrez à utiliser DaVinci Resolve pour monter différents types de projets : interview, 
scènes dramatiques et productions multicaméras.

Pour le moment, profitez de ces quelques instants de satisfaction.
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Révision
1 Quel mode permet de rogner le début ou la fin d’un plan dans la timeline ?

a) Mode Sélection

b) Mode Trim

c) Mode Rasoir

2 Quel mode permet de faire glisser un plan dans la timeline ?

a) Mode Sélection

b) Mode Trim

c) Mode Rasoir

3 Vrai ou faux ? L’option de montage Remplacer utilise la position de la timeline et des 
têtes de lecture dans le viewer source, mais ignore les points d’entrée et de sortie dans 
la timeline.

4 Quelle touche permet d’ajouter des images clés sur la courbe de volume d’un plan 
dans la timeline ?

5 Où se connecte-t-on pour télécharger automatiquement les vidéos sur les plateformes 
d’hébergement de vidéo ?

a) Dans la fenêtre Exportation rapide

b) Dans l’onglet Partage de l’inspecteur

c) Dans Préférences > Système, sous Comptes Internet 
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Réponses
1 a) et b). Les modes Sélection et Trim permettent de rogner le début et la fin d’un plan 

dans la timeline.

2 b). Le mode Trim permet de faire glisser un plan dans la timeline en réglant les points 
d’entrée et de sortie simultanément.

3 Faux. L’option de montage Remplacer utilise les points d’entrée et de sortie de la 
timeline pour restreindre la quantité remplacée, mais ignore les points d’entrée et de 
sortie qui se trouvent sur le viewer source.

4 Appuyez sur Option (macOS) ou Alt (Windows), puis cliquez sur la courbe de volume 
pour ajouter une image clé.

5 c). Vous pouvez vous connecter aux plateformes d’hébergement de vidéo dans la 
section Comptes Internet des Préférences > Système. Vous pouvez également y 
accéder dans la fenêtre Exportation rapide.
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Chapitre 3

Peaufiner 
une interview

Pour réussir à bien mettre en valeur 
une personne interviewée, vous allez 
devoir beaucoup vous entraîner et être 
très attentif à ce que vous entendez.

Quand on monte une interview, il est 
courant de s’occuper uniquement de la 
bande-son, sans prêter attention à la 
vidéo. Ce mode de montage est appelé 
un « radio edit », car il se rapproche 
des montages réalisés pour la radio. 
Une fois cette étape terminée, vous 
pourrez alors regarder les images qui 
accompagnent l’audio.

Dans ce chapitre, vous allez utiliser 
les techniques de montage audio/
vidéo et les fonctionnalités proposées 
par DaVinci Resolve pour finaliser le 
petit film promotionnel du restaurant 
végane Miss Rachel’s Pantry.
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Démarrer un projet
Commençons par ouvrir le projet DaVinci Resolve sur lequel se trouve la majorité des 
fichiers audio déjà coupés, mais dont la qualité de certains n’a pas été vérifiée. Vous 
allez d’abord écouter les fichiers audio, puis vous supprimerez les petites hésitations 
que prononce la personne interviewée. De cette façon, ce petit clip sera plus agréable 
à regarder.

1 Dans la fenêtre Gestionnaire de projet (Project Manager), faites un clic droit et 
choisissez Importer (Import).

2 Allez sur R18 Editing Lessons > Lesson 03 et sélectionnez 
WELCOME TO THE PANTRY.drp.

3 Double-cliquez sur le projet importé dans le Gestionnaire de projet (Project Manager).

4 Cliquez sur le bouton de la page Montage si celle-ci n’est pas déjà ouverte.

5 Cliquez sur le bouton Relier les médias (Relink Media) dans la bibliothèque de médias 
et reliez les plans offline aux fichiers médias dans le dossier R18 Editors Guide.

6 Choisissez Espace de travail > Réinitialiser l’espace de travail (Workspace > Reset 
UI Layout).

7 Cliquez sur le bouton Zoom min (Full Extent Zoom) pour voir toute la timeline. 

Cette timeline est la première partie de la vidéo, elle est déjà montée.
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8 Placez la tête de lecture au début de la timeline et lancez la lecture.

L’interview se concentre sur Miss Rachel, la propriétaire et cheffe de Miss Rachel’s 
Pantry. Comme vous le voyez, ce fichier est propre, il ne comporte ni pause 
inappropriée, ni hésitations, ni tournures inadaptées. 

REMARQUE Visionnez les rushes dans le sous-chutier Interview Clips (sous le 
chutier Rushes) pour les comparer avec la timeline fournie et pour comprendre 
comment ces fichiers ont été retravaillés. 

Vous remarquerez aussi que les pauses ont été conservées afin de faciliter la transition 
entre les changements d’idées et de sujets. Cela permet à la personne interviewée et 
aux téléspectateurs de « respirer ». Des plans audio de sons d’ambiance permettent 
de remplir les silences. La plupart des jump cut qui distrairaient le public ont été 
recouverts par des plans de coupe sur la piste V2.

Deux marqueurs rouges sont également présents sur la timeline pour indiquer des 
emplacements spécifiques.

ASTUCE Vous pouvez ajouter vos propres marqueurs sur une timeline 
en cliquant sur le bouton Marqueurs (Markers) dans la barre d’outils ou en 
appuyant sur la touche M. Si vous double-cliquez sur un marqueur existant, 
vous pouvez modifier la couleur, le nom et les autres propriétés du marqueur.

Si vous voulez entendre la prise sans les plans de coupe, il faut désactiver la piste V2.
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9 Dans l’en-tête de la piste des plans de coupe (V2), cliquez sur le bouton Désactiver la 
piste vidéo (Disable Video Track).

Tous les plans sur cette piste sont désactivés.

10 Placez de nouveau la tête de lecture au début de la timeline et relancez la lecture.

Ouah ! Le changement est radical ! Les jump cut entre les éléments sonores attirent 
beaucoup plus l’attention. Les silences qui donnaient un peu d’air sont maintenant 
assourdissants.

Ce n’est peut-être pas très beau pour le moment, mais le son est correct. C’est pour 
cela que l’on appelle ce type de montage un radio edit, on se concentre davantage sur 
l’audio que sur la vidéo. Quand on crée un radio edit, il est important d’enlever tous 
les éléments qui pourraient distraire le spectateur du message que vous essayez de 
transmettre. 

ASTUCE Pour avoir une meilleure idée de son fonctionnement, fermez les 
yeux pour écouter attentivement la bande-son. Si vous n’entendez pas de 
coupe trop brusque et si le débit de parole est correct, on peut dire que c’est 
un radio edit réussi.

11 Réactivez les plans sur la piste V2 en cliquant sur Activer la piste vidéo (Enable Video 
Track) dans l’en-tête de la timeline.
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Utiliser la transition Smooth Cut
Maintenant que vous avez vu comment se crée un montage radio, et comment les plans 
de coupe peuvent servir à couvrir les jump cup de l’interview, il est temps d’apporter la 
touche finale à cette timeline en ajoutant quelques éléments sonores enregistrés lors de 
l’interview.

Tout d’abord, vous allez corriger le jump cut au début du montage.

1 En haut à gauche de l’interface, appuyez sur le bouton Index.

La fenêtre s’ouvre sous la bibliothèque de médias.

2 Cliquez sur un onglet Marqueurs (Markers) dans la fenêtre Index pour afficher les 
marqueurs présents sur la timeline.
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3 Double-cliquez sur la vignette où se trouve le premier marqueur appelé « Jump 
Cut » pour positionner la tête de lecture au niveau de la coupe entre les premier et 
deuxième plans. 

ASTUCE Vous pouvez appliquer un filtre de couleur pour sélectionner les 
marqueurs à afficher dans l’index. Pour cela, utilisez le menu Options (…) en 
haut à droite.

4 Cliquez sur le bouton Zoom détail (Detail Zoom) et appuyez sur / pour 
prévisualiser la coupe.

Il s’agit d’un jump cut assez typique qui en général tend à détourner l’attention du 
spectateur. Cependant le réalisateur préfère voir Rachel à l’écran et éviter les plans de 
coupe autant que possible.

5 Ouvrez la bibliothèque d’effets, sélectionnez le groupe Transitions vidéo (Video 
Transitions) et dans la catégorie Fondu au noir (Dissolve category), choisissez 
Smooth Cut.

REMARQUE Avec la fenêtre Index ouverte, la bibliothèque d’effets s’ouvre à la 
place de la bibliothèque de médias. 

6 Double-cliquez sur la transition Smooth Cut pour l’ajouter au point de coupe.
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7 Dans la timeline, rognez la transition Smooth Cut de 4 images (00:04 sous la souris).

ASTUCE Quand vous rognez la transition, les chiffres en gris qui apparaissent 
au bout de la souris représentent le réglage en cours, alors que les chiffres en 
blanc font référence à la durée totale.

8 Cliquez sur le bouton Zoom min (Full Extent Zoom) et sur / (barre oblique) pour 
visionner toute la sélection.

Resolve parvient à mélanger les deux jump cut pour ne former plus qu’une 
seule séquence.

Même si vous avez l’impression qu’il s’agit d’une recette miracle pour éviter d’ajouter des 
plans de coupe sur un plan, essayez de ne pas abuser de cette transition. Il ne faut en 
aucun cas l’utiliser pour modifier le propos de la personne interviewée. 

Importer une timeline « Selects »
Vous allez maintenant continuer de travailler sur ce montage, en commençant par la fin de 
l’interview de Rachel. Vous pourriez choisir de regarder toutes les séquences d’interview 
et d’organiser lentement les différents éléments d’interviews que vous voulez garder. Mais 
en général, les réalisateurs, monteurs et assistants monteurs préfèrent rassembler une 
sélection de plans à utiliser ou qu’ils pensent être utiles au montage. Ils travaillent souvent 
sur leur propre ordinateur pour revoir les images avant de vous envoyer une timeline 
« Selects » qu’il faudra affiner et incorporer dans le montage principal.

C’est ce qui s’est passé dans ce cas. Le réalisateur de la vidéo « Welcome to the Pantry » 
possède une copie des fichiers médias sur lesquels vous travaillez et utilise la version 
gratuite de DaVinci Resolve 18 pour réaliser la dernière partie de l’interview de Rachel, 
ainsi que quelques plans qu’il voudrait utiliser comme plans de coupe.

Plutôt que d’envoyer une copie de tout le projet et de devoir trouver la bonne version de la 
timeline, il peut simplement vous envoyer la timeline en format .drt.
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REMARQUE L’extension .drt correspond à un fichier timeline DaVinci Resolve 
et est efficace pour transférer des timelines d’un projet, ou d’un logiciel, à un 
autre. Comme pour les fichiers .xml ou .aaf, .drt est un fichier binaire qui contient 
uniquement les informations dont vous avez besoin pour reconstruire une timeline 
dans un projet DaVinci Resolve. Les fichiers timeline DaVinci Resolve ne contiennent 
pas de médias. Le système destinataire doit donc avoir une copie des médias 
pour pouvoir lire la timeline importée. Le fichier est très léger, ce qui permet d’être 
facilement transféré, via le cloud ou email. Vous pouvez créer un fichier .drt de 
votre timeline active en choisissant Fichier > Exporter > Timeline ou en appuyant 
sur Majuscule-Command-O (macOS) ou Majuscule-Ctrl-O (Windows) et en 
choisissant Fichier Timeline DaVinci Resolve (.drt) dans le menu déroulant.

1 Dans la bibliothèque de médias, ouvrez le chutier Timelines. C’est là que vous 
importerez le fichier .drt.

2 Choisissez File > Importer > Timeline ou appuyez sur  
Majuscule-Command-I (macOS) ou Majuscule-Ctrl-I (Windows).

3 Allez sur R18 Editors Guide/Lessons/Lesson 03, sélectionnez RADIO EDIT START.drt, 
et cliquez sur Ouvrir (Open).
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La timeline importée apparaît dans le chutier Timelines et s’ouvre automatiquement 
dans la fenêtre Timeline.

Cette timeline contient un montage rapide des trois plans d’interview, suivi par 
quatre plans de coupe. Il s’agit des images que le réalisateur veut intégrer à son 
montage principal. Cependant, comme les réalisateurs ne sont pas toujours de bons 
monteurs, ils font souvent confiance au savoir-faire des monteurs pour prendre les 
meilleures décisions.

Un workflow typique consiste à utiliser plusieurs timelines différentes sur des petites 
parties de la vidéo, par exemple les scènes d’un long métrage, les différentes parties 
d’une série TV ou d’une vidéo d’entreprise. Ces scènes ou sections doivent souvent être 
retravaillées et modifiées, avant d’être montées ensemble dans la timeline finale envoyée 
au distributeur, broadcaster ou à la plateforme en ligne.
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Travailler sur plusieurs timelines
Dans les étapes suivantes, vous utiliserez la timeline que vous venez d’importer pour 
retravailler la nouvelle section de l’interview. Ensuite, vous l’intègrerez, ainsi que les plans 
de coupe, à la timeline principale WTTP « Welcome to the Pantry ».

1 Dans la timeline RADIO EDIT START cliquez sur Zoom Min (Full Extent Zoom) pour 
voir toute la timeline et ajustez la hauteur des pistes audio pour afficher les formes 
d’onde audio. 

2 Lancez la lecture des trois premiers plans pour revoir les parties de l’interview que le 
réalisateur a choisies.

La première chose que vous remarquerez, c’est sans doute que le son de l’interview 
ne sort que du haut-parleur gauche. C’est un problème assez courant si la timeline 
« selects » a été assemblée par le réalisateur. Il n’est pas rare qu’il ne sache pas que 
Resolve ne gère pas l’audio de la même façon. Dans ce cas, le réalisateur a simplement 
placé les plans sur la timeline sans savoir que l’audio est en mono et la piste timeline 
en stéréo. Même si ce n’est pas un gros problème, c’est un peu embêtant.

3 Faites un clic droit sur l’en-tête de la piste A1 sur la timeline RADIO EDIT START et 
choisissez Mettre la piste en > Mono (Change Track Type To > Mono) pour corriger 
l’audio de l’interview.
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Quand vous montez une interview comme celle-ci (ou tout dialogue), il est utile d’avoir 
une vue claire de la forme d’onde des plans. Pour augmenter la hauteur des formes 
d’ondes, vous pouvez régler le niveau audio des plans. Dans ce cas, vous pouvez 
normaliser le plan audio pour avoir un meilleur aperçu. Ne vous inquiétez pas, vous 
pouvez aussi le normaliser plus tard au besoin.

4 Sélectionnez tous les plans d’interview dans la timeline, puis faites un clic droit et 
choisissez Normaliser les niveaux audio (Normalize Audio Levels).

5 Gardez le mode de normalisation sur Sample Peak Program, réglez Niveau 
cible (Target Level) sur -9 dBFS et Niveau prédéfini (Set Level) sur Indépendant 
(Independent). Ensuite, cliquez sur Normaliser (Normalize).

ASTUCE Vous pouvez aussi régler la hauteur directement dans la forme 
d’onde en tirant la ligne de séparation entre les pistes ou en utilisant les 
curseurs relatifs à la hauteur des pistes Video et Audio dans le menu Affichages 
de la timeline (Timeline View Options).

6 Lancez de nouveau la lecture du premier plan orange, puis interrompez-la lorsque la 
jeune femme dit « umm », environ 2 secondes après le début du plan.

7 Cliquez sur le bouton Zoom détail (Detail Zoom) dans la barre d’outils ou maintenez 
Option (macOS) ou Alt (Windows) et utilisez la molette de la souris ou du trackpad pour 
zoomer dans la timeline.

Vous devriez repérer rapidement ce « umm ». 
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8 Appuyez sur la touche B pour passer en mode Rasoir (Blade) et cliquez juste avant et 
après le son « hum » afin de l’isoler en un plan séparé. 

Les lignes en pointillé qui apparaissent sur les points de coupe représentent des 
fausses coupes. Il s’agit de coupes visibles sur la timeline qui sont lues sans problème, 
car aucune image n’a été supprimée de part et d’autre de ces coupes. Elles ont été 
appliquées à la fois sur la vidéo et sur l’audio, car les plans étaient groupés.

ASTUCE Pour supprimer une fausse coupe inutile, placez la tête de lecture 
dans la timeline après la fausse coupe en question, puis choisissez Timeline > 
Grouper les plans (Timeline > Join Clips), ou appuyez sur Option-\ (barre oblique 
inversée) sur macOS ou Alt-\ (barre oblique inversée) sur Windows.

9 Appuyez sur A pour retourner en mode Sélection.

10 Sélectionnez le son « hum » et appuyez sur Majuscule-Supprimer pour supprimer la 
partie sélectionnée et décaler la timeline.

11 Placez la tête de lecture sur le nouveau point de coupe et appuyez sur / (barre oblique) 
pour lire autour.

Il faut que cette coupe audio soit indétectable. Quand vous lisez la coupe, essayez de 
ne pas regarder la vidéo. Entendez-vous une rupture dans les propos de Rachel ? Si 
vous la remarquez, il va falloir affiner un peu le résultat.
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ASTUCE Quand vous réalisez un raccord, vous ne pourrez savoir s’il est 
réussi qu’en le jouant dans la timeline. Il est probable que le résultat ne soit 
pas encore parfait, car dans la majorité des cas, les coupes ont besoin d’être 
affinées. Ne vous inquiétez pas si vous ne réussissez pas du premier coup.

12 Lisez le deuxième plan jusqu’à ce que Rachel dise « We’re taking dishes and flavors. » 
Elle répète le mot « and » deux fois. Nous allons régler ce problème rapidement.

13 Appuyez sur les touches JKL pour lire le plan plusieurs fois et placez la tête de lecture 
juste avant le premier « and ».

ASTUCE Souvenez-vous que vous pouvez déplacer la tête de lecture en 
maintenant la touche K enfoncée et en appuyant sur les touches L ou K. Il est 
également utile d’activer l’option Scrub Audio afin d’entendre le début et la fin 
des mots. Choisissez Timeline > Scrub Audio (Timeline > Audio Scrubbing), ou 
appuyez sur Majuscule-S pour activer et désactiver cet outil.

14 Appuyez sur Cmd-B (macOS) ou Ctrl-B (Windows) pour couper le plan.

ASTUCE Ces raccourcis clavier ajoutent des points de coupe au(x) plan(s) 
sélectionné(s), au niveau de la tête de lecture sans devoir activer le mode 
Rasoir (Blade).

15 Avancez la tête de lecture et positionnez-la juste avant le deuxième « and ». Appuyez 
sur Cmd-B (macOS) ou Ctrl-B (Windows) pour appliquer la deuxième fausse coupe.
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16 Déplacez la tête de lecture sur le mot « and », et dans la timeline, appuyez sur 
Majuscule-V pour sélectionner le plan sous la tête de lecture.

17 Appuyez sur Majuscule-Supprimer pour supprimer la partie sélectionnée et décaler 
la timeline.

18 Appuyez sur / (barre oblique) pour lire les images.

Encore une fois, écoutez l’audio sans regarder le jump cut. Et n’oubliez pas, même si 
votre but est de réaliser une interview de bonne qualité, les imperfections que vous 
voyez seront corrigées au fur et à mesure.

19 Continuez la lecture de l’interview. Vous allez de nouveau supprimer le son « hum » 
qu’elle prononce après le mot « texture ». Cette fois-ci, vous allez placer des points 
d’entrée et de sortie sur la timeline pour supprimer l’élément inutile.

20 Dans la timeline, placez la tête de lecture juste avant le « hum », et appuyez sur I pour 
saisir le point d’entrée.

21 Avancez de six à sept images jusqu’à ce qu’elle dise « and really making them ». 
Appuyez sur O pour ajouter un point de sortie avant qu’elle dise « and ».
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ASTUCE Comme la tête de lecture de Resolve inclut l’image sur laquelle elle se 
trouve, les points d’entrée sont toujours ajoutés en tête de l’image et les points 
de sortie, en queue. Avant d’ajouter un point de sortie, il est utile de repérer 
l’image que vous voulez conserver (en général le début du mot suivant), puis 
de reculer la tête de lecture d’une image. De cette façon, vous êtes certain de 
conserver toutes les images que vous voulez absolument conserver.

Vous venez d’ajouter les points d’entrée et de sortie autour de la partie de la vidéo que 
vous voulez supprimer. 

22 Appuyez sur Majuscule-Supprimer pour appliquer l’option Supprimer et ripple (Ripple 
Delete) aux points d’entrée et de sortie que vous avez placés sur la timeline.

23 Appuyez ensuite sur / (barre oblique) pour visualiser le résultat.

Bravo ! Vous venez de supprimer trois petites parties de l’interview en utilisant des 
techniques légèrement différentes. Bien souvent en montage, il n’existe pas de 
bonnes ou de mauvaises techniques, mais simplement des façons plus ou moins 
rapides de parvenir à ses fins. En tant que monteur, c’est à vous de choisir les outils et 
les techniques qui vous conviennent le mieux.

Petit truc en plus
La réalisatrice veut également que vous affiniez la fin de ce plan. Elle considère 
en effet que le mot « palatable » (« agréable » en français) n’est pas très approprié 
pour décrire de la nourriture. Ce raccord n’est pas indispensable, mais quand on 
parle de nourriture, il est préférable de la décrire avec des mots plus positifs qu’un 
simple « agréable ». Pensez-vous réussir à supprimer le mot « palatable » pour que 
Miss Rachel ne dise que « make them delicious » ?
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Affiner le radio edit
Comme vous le savez, DaVinci Resolve offre des options de rognage accessibles avec 
la souris. Cependant, lorsque vous apportez de petites modifications (par exemple, s’il 
faut supprimer ou ajouter une seule image), il est possible de réaliser ces opérations en 
n’utilisant que le clavier. De cette façon, vous aurez un meilleur contrôle sur les coupes que 
vous effectuez. Il est important de connaître toutes les options de raccords disponibles sur 
Resolve pour choisir la solution la mieux adaptée.

Vous allez utiliser uniquement les raccourcis clavier pour sélectionner et rogner les coupes 
que vous venez de faire.

1 Appuyez sur la touche Home pour placer la tête de lecture à la fin des plans 
d’interview.

2 Appuyez sur la flèche vers le bas pour placer la tête de lecture sur le point de 
coupe suivant.

3 Appuyez ensuite sur / (barre oblique) pour visualiser le raccord.

Écoutez attentivement la coupe audio que vous avez réalisée précédemment. Vous 
semble-t-elle naturelle ? Le mot est-il clair ? Avez-vous repéré le problème sur la 
forme d’onde ? 

La forme d’onde indique que le 
plan sortant devrait être rogné

La forme d’onde indique que le 
plan entrant devrait être rogné

Seule l’expérience vous permettra de savoir quand il sera nécessaire d’ajouter ou de 
supprimer des images des plans entrants ou sortants.

Ne vous inquiétez pas si vous avez l’impression d’être un peu perdu. Pour le moment, 
vous allez uniquement apprendre à modifier les coupes faites dans l’interview en 
utilisant le clavier.

4 Appuyez sur T pour sélectionner le mode Trim.

5 Appuyez sur V pour sélectionner le point de montage le plus proche de la tête 
de lecture. 
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6 Appuyez plusieurs fois sur la touche U jusqu’à ce que seul le côté gauche du point de 
coupe soit sélectionné.

7 Une fois le bon côté sélectionné, appuyez sur , (virgule) pour rogner la coupe 
sélectionnée d’une image vers la gauche ou . (point) pour rogner d’une image vers 
la droite.

REMARQUE Dans l’exemple des images précédentes, une image a été rognée 
à partir de la fin du plan sortant avec la virgule.

8 Appuyez sur / (barre oblique) pour lire les images autour de la coupe.

9 Appuyez deux fois sur la touche U pour sélectionner le raccord en tête du plan entrant.
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10 Ici comme le plan entrant est sélectionné, appuyez sur , (virgule) pour ajouter une 
image, ou sur . (point) pour supprimer une image.

REMARQUE Dans l’exemple des images précédentes, une image a été ajoutée 
au début du plan entrant avec le point.

11 Appuyez sur / (barre oblique) pour lire autour du point de coupe et vérifiez la précision 
de votre raccord.

Continuez les modifications jusqu’à ce que vous soyez satisfait. Vous pouvez 
désormais vous attaquer au raccord suivant.

12 Appuyez sur la flèche vers le bas pour passer à la coupe suivante. Le côté sélectionné 
pour cette coupe est le même que pour la coupe précédente.

13 Appuyez sur / (barre oblique) pour lire les images autour du point de coupe et vérifiez 
ce qu’il faut rogner.

14 C’est à vous de décider si vous voulez ou non affiner ce raccord. Si vous souhaitez 
apporter des modifications, appuyez sur U pour sélectionner le bon côté de la coupe.

15 Appuyez sur , (virgule) ou sur . (point) pour ajouter ou supprimer des images à 
la coupe. 

16 N’hésitez pas à visionner vos modifications, et à continuer d’affiner la coupe.

Quand vous êtes satisfait de ce raccord, passez au suivant.

17 Appuyez sur la flèche vers le bas pour aller au raccord suivant.

18 Appuyez sur / (barre oblique) pour lire les images autour du point de coupe et vérifiez 
ce qu’il faut rogner.

19 Appuyez sur U pour sélectionner le bon côté de la coupe, puis sur , (virgule) ou sur . 
(point) pour la modifier. Appuyez sur / (barre oblique) pour visionner le résultat.

20 Lorsque vous avez terminé, appuyez sur A pour désélectionner le mode Raccord fin et 
retourner en mode Sélection.
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Vous venez de modifier une petite partie de l’interview grâce à différentes techniques. 
Elle est désormais plus concise et plus pertinente. Lorsque vous raccourcissez des plans, 
les touches JKL permettent de voir et d’entendre les éléments que vous êtes en train 
de modifier.

Terminer le radio edit
Continuez de monter les deux plans d’interview que le réalisateur a inclus dans la timeline.

 — Rognez le plan suivant de manière à entendre Miss Rachel dire « …vegan food is 
starting to get the recognition it deserves ».

 — Modifiez le dernier plan d’interview afin d’entendre « Because it seems like it’s a diet 
or a lifestyle of cutting things out when, in reality, we’re just doing things completely 
differently ».

Maintenant que le radio edit est terminé, il est temps d’ajouter de nouveaux plans 
d’interview dans la timeline principale et de terminer le montage.

Monter des sous-images audio
Alors que le rognage de la vidéo est limité par la fréquence d’images du 
projet, l’audio comporte des dizaines de milliers d’échantillons par seconde. 
DaVinci Resolve permet de monter de l’audio au niveau des sous-images dans la 
page Montage. Le niveau de précision est beaucoup plus grand qu’avec un trim 
normal. Vous pouvez donc isoler des syllabes et des mots très facilement. 

Cette fonctionnalité n’a pas besoin d’être activée, cela est fait automatiquement. 
Cependant, quand vous utilisez cette option, il est important que les outils 
Aimanter (Snapping) et Relier la sélection (Linked Selection) soit désactivés. 
Zoomez autant que possible et réalisez le rognage avec la souris. 

Si vous avez besoin de plus de précision, vous devrez utiliser les fonctions de 
montage sur la page Fairlight pour rogner au niveau de l’échantillon.
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Monter d’une timeline à une autre
Maintenant que le radio edit est satisfaisant, vous allez l’intégrer dans une partie plus 
longue de l’interview déjà montée. DaVinci Resolve permet d’ajouter des images d’une 
timeline sur une autre.

Une version finalisée de la timeline radio edit est disponible. Vous pouvez l’importer pour 
continuer.

1 Sélectionnez le chutier Timelines et choisissez Fichier > Importer > Timeline 
(File > Import > Timeline), allez sur DR18 Editors Guide/Lessons/Lesson 03 /
RADIO EDIT FINISHED.drt, puis cliquez sur Ouvrir (Open).

La nouvelle timeline est ajoutée au chutier sélectionné et s’ouvre dans la 
fenêtre Timeline.

2 Cliquez sur le bouton Zoom min (Full Extent Zoom) pour voir toute la timeline.

Il s’agit de la version montée de l’interview et d’une suggestion de plans de coupe. Un 
espace vide a été ajouté pour donner du rythme à l’interview.

3 Appuyez sur Home pour positionner la tête de lecture au début de cette timeline et 
lancez l’interview montée.

Vous devez incorporer cette interview montée dans la timeline principale 
WTTP FINE CUT.

DaVinci Resolve offre plusieurs options pour déplacer les plans d’une timeline à 
une autre. Par exemple, vous pouvez simplement copier les plans et les coller sur 
la timeline de destination. Dans l’étape suivante, vous allez apprendre à utiliser des 
techniques sophistiquées pour faire un montage entre des timelines.

Pour travailler sur plusieurs timelines à la fois, vous allez commencer par ouvrir la 
timeline existante dans le viewer source.
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4 Dans la bibliothèque de médias, trouvez la timeline WTTP FINE CUT et faites-la glisser 
sur le viewer source.

Le scrubbing sur le viewer source permet de survoler la timeline WTTP FINE CUT .

Maintenant que deux timelines sont ouvertes, RADIO EDIT FINISHED dans le viewer 
timeline et WTTP FINE CUT dans le viewer source, vous n’avez plus besoin de la 
bibliothèque de médias. En effet, les plans d’une timeline deviendront les sources 
de l’autre.

Vous pouvez désormais marquer les plans que vous voulez monter de la timeline 
RADIO EDIT FINISHED.
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5 Sélectionnez tous les plans d’interview montés dans la timeline RADIO EDIT FINISHED 
et appuyez sur Majuscule-A pour marquer toute la durée.

Pour le moment, la timeline WTTP FINE CUT est la source de la timeline 
RADIO EDIT FINISHED, alors que vous voulez que ce soit l’inverse.

6 Choisissez Timeline > Inverser les viewer Source et Timeline (Timeline > Swap Timeline 
and Source Viewer), ou appuyez sur Cmd-Page Up (macOS) ou Ctrl-Page Up (Windows).

La timeline du viewer source WTTP FINE CUT est désormais ouverte dans le viewer 
timeline et la timeline qui était dans le viewer timeline RADIO EDIT FINISHED 
est désormais la source, tout comme les points d’entrée et de sortie des 
plans marqués.

7 Dans l’index des marqueurs, double-cliquez sur la vignette pour ouvrir le deuxième 
marqueur rouge, appelé « New Interview Here ».

ASTUCE Vous pouvez facilement passer d’un marqueur à l’autre en choisissant 
Lecture > Suivant > Marqueur (Playback > Next > Marker) ou Lecture > 
Précédent > Marqueur (Playback > Previous > Marker), ou appuyez sur 
Majuscule-flèche vers le bas pour aller au marqueur suivant et majuscule flèche 
vers le haut pour aller au marqueur précédent.
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8 Veillez à ce que les commandes de destination vidéo et audio soient respectivement 
réglées sur V1 et A1, et appliquez l’option de montage Écraser (Overwrite).

Ces plans sont ajoutés à la timeline de destination comme n’importe quel autre plan. 
En revanche, les plans sont affichés comme plan composé simple.

REMARQUE Vous en apprendrez plus sur les plans composés et leur 
fonctionnement au chapitre 7.

9 Dans la timeline, sélectionnez le plan composé et choisissez Plan > Décomposer le plan 
(Clip > Decompose in Place).

Les plans sources originaux de RADIO EDIT FINISHED sont désormais affichés et 
peuvent être montés comme n’importe quel autre plan.

REMARQUE Ces plans sont désormais complètement indépendants des plans 
de la timeline source originale, comme s’ils avaient été montés d’une timeline 
complètement distincte.
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Décomposer les plans composés au montage
Vous pouvez utiliser la timeline source comme s’il s’agissait d’un plan ouvert dans le 
viewer source. Vous allez maintenant utiliser les plans de coupe inclus dans la timeline 
RADIO EDIT FINISHED sur le montage principal.

1 Dans la timeline WTTP FINE CUT déplacez la tête de lecture sur la coupe entre les 
premier et deuxième plans que vous venez de monter dans la timeline.

2 Choisissez Timeline > Inverser les viewers Source et Timeline (Timeline > 
Swap Timeline and Source Viewer), ou appuyez sur Cmd-Page Up (macOS) ou Ctrl-
Page Up (Windows).

Les timelines ont de nouveau changé de place.

3 Sélectionnez les deux premiers plans de coupe sur la timeline RADIO EDIT FINISHED  
et appuyez sur Majuscule-A pour marquer les plans sélectionnés.

4 Choisissez Timeline > Inverser les viewers Source et Timeline (Timeline > Swap 
Timeline and Source Viewer), ou appuyez sur Cmd-Page Up (macOS) ou Ctrl-Page Up 
(Windows).

5 Choisissez Édition > Décomposer les plans composés au montage (Edit > Decompose 
Compound Clips on Edit).

6 Dans la timeline, cliquez sur la commande de destination V2 ou appuyez sur Option-2 
(macOS) ou Alt-2 (Windows) pour cibler la piste V2.
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7 Cliquez sur la commande de destination A1 ou appuyez sur Option-Command-1 
(macOS) ou Alt-Ctrl-1 (Windows) pour désactiver le ciblage de la piste pour l’audio.

8 Appliquez un montage Écraser (Overwrite).

Les plans de la timeline source sont montés directement sur la timeline principale sans 
devoir préalablement décomposer le plan composé.

Vous pouvez aussi ajouter des points d’entrée et de sortie sans ouvrir la timeline source.

9 Dans la timeline, appuyez sur la flèche vers le bas pour aller jusqu’à la coupe suivante, 
sélectionnez les deux plans suivants, et appuyez sur Majuscule-A pour marquer la sélection.

10 Appuyez sur Q pour retourner sur le viewer source et appuyez de nouveau sur la flèche 
vers le bas jusqu’à ce que vous voyiez les deux clients en train de parler avec Rachel.

11 Appuyez sur I pour saisir le point d’entrée au niveau de la première image du plan.
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12 Appliquez un montage Écraser (Overwrite).

Comme tout autre montage à trois points, le plan du viewer source est monté dans la 
timeline comme plan de coupe sur V2.

Remplir les espaces vides avec Atmos
Désormais, vous aurez besoin de remplir les espaces vides dans l’interview avec un peu de 
son d’ambiance. Heureusement, comme vous disposez déjà d’éléments sonores Atmos sur 
A2, vous allez simplement les copier sur les nouveaux espaces vides.

1 Sélectionnez le troisième plan sur la piste audio ATMOS (A2) et appuyez sur 
Command-C (macOS) ou Ctrl-C (Windows) pour copier le plan.

2 Placez la tête de lecture au début de l’espace vide, juste avant le dernier marqueur 
rouge de la timeline.

3 Appuyez sur Cmd-V (macOS) ou Ctrl-V (Windows) pour coller le plan.

4 Choisissez Lecture > Suivante > Espace vide (Playback > Next > Gap) ou appuyez sur 
Option-Command-’ (apostrophe) sur macOS ou Alt-Ctrl-’ (apostrophe) sur Windows 
pour aller sur l’espace suivant.

REMARQUE Les commandes Espace vide suivant (Next Gap) et Espace vide 
précédent (Previous Gap) positionnent la tête de lecture sur le bon espace vide 
(tant que la sélection automatique des pistes est activée).
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5 Appuyez de nouveau sur Cmd-V (macOS) ou Ctrl-V (Windows) pour coller le plan.

6 Zoomez dans la timeline et déplacez et rognez les plans audio collés pour qu’ils 
recouvrent les espaces vides dans l’interview. 

7 Quand vous avez terminé d’affiner la position des nouveaux plans Atmos, cliquez sur 
Zoom min (Full Extent Zoom) pour dézoomer et voir toute la timeline.

Travailler avec des 
timelines superposées
Les étapes précédentes permettent de monter les médias d’une timeline à une autre. Par 
contre, on ne voit le contenu que d’une timeline à la fois. Parfois, vous pourriez vouloir 
voir le contenu des deux timelines simultanément. Heureusement, la timeline de la page 
Montage peut afficher plusieurs timelines dans différents onglets, ou superposées les 
unes sur les autres.

1 Dans la bibliothèque de médias, assurez-vous que le chutier de la timeline est toujours 
sélectionné et choisissez Fichier > Importer > Timeline (File > Import > Timeline) ou 
appuyez sur Majuscule-Command-I (macOS) ou Majuscule-Control-I (Windows).

2 Au besoin, allez sur R18 Editors Guide/Lessons/Lesson 03/Timelines et sélectionnez le 
fichier CLOSING TITLES.drt et cliquez sur Ouvrir (Open).
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La timeline CLOSING TITLES est importée et ajoutée au chutier Timelines dans la 
bibliothèque de médias. Elle s’ouvre dans la fenêtre de la timeline.

Cette timeline comprend quatre titres qui clôtureront cette publicité. Chaque titre 
disparaît avec un effet de fondu (sauf le premier titre) et de zoom.

3 En haut à gauche de la barre d’outils, cliquez sur le bouton Affichages de la timeline 
(Timeline View Options) et choisissez la première option pour activer la superposition 
des timelines.

Les onglets apparaissent au-dessus de la timeline, avec le nom de la timeline. Vous 
pouvez utiliser le menu contextuel de cet onglet pour accéder à toutes les timelines de 
ce projet (identique au menu du Viewer Timeline) ou ouvrir de nouveaux onglets avec 
le bouton +.
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ASTUCE Vous pouvez faire glisser les onglets horizontalement pour modifier 
l’ordre et refermer les onglets existants en cliquant sur la croix à gauche. Si 
votre souris comporte un bouton central, cliquez sur l’onglet avec ce bouton.

En plus des onglets, un autre bouton permettant d’ajouter une timeline apparaît en 
haut à droite de la fenêtre Timeline.

4 Cliquez sur ce bouton.

Une deuxième fenêtre Timeline apparaît alors sous la timeline active.

5 Au besoin, redimensionnez les plans dans la fenêtre de la timeline du haut pour voir 
tous les plans.

6 Dans la timeline du haut, refermez l’onglet de la timeline CLOSING TITLES.

7 Dans la timeline du bas, cliquez sur le menu déroulant Sélectionner la timeline (Select 
Timeline) et choisissez la timeline CLOSING TITLES.
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La timeline CLOSING TITLES s’ouvre de nouveau dans la fenêtre de la timeline du bas.

8 Prenez le temps d’ajuster la hauteur des pistes dans la timeline du haut pour bien voir 
le contenu de la timeline WTTP FINE CUT.

9 Sélectionnez tous les plans titres dans la timeline du bas, puis déplacez-les après le 
dernier plan d’interview dans la timeline du haut.
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Les plans sont instantanément copiés de la timeline CLOSING TITLES à la timeline 
principale WTTP FINE CUT. 

Maintenant que vous avez monté les titres sur la timeline principale, vous pouvez 
refermer tous les onglets dont vous n’avez plus besoin.

10 Avec la timeline WTTP FINE CUT active (indiqué par l’onglet rouge), cliquez sur 
le menu Affichages de la timeline (Timeline View Options) et cliquez sur l’option 
Superposition des timelines (Stacked Timelines) pour désactiver les timelines 
superposées et retourner en vue simple.

Il suffit maintenant de rogner les nouveaux titres sur la bonne durée. 

11 Avec le mode Sélection, sélectionnez les quatre plans titres que vous venez d’ajouter à 
la timeline.

12 Une fois les plans sélectionnés, appuyez sur T pour passer en mode Raccord fin 
(Trim Edit).
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13 Choisissez Plan > Changer la durée du plan (Clip > Change Clip Duration) ou appuyez 
sur Command-D (macOS) ou Ctrl-D (Windows).

14 Dans la fenêtre Modifier la durée du plan (Change Clip Duration), saisissez 300 dans le 
champ Durée et cliquez sur Changer (Change).

Tous les plans sont rognés pour durer 3 secondes, et comme vous étiez en mode 
Raccord fin (Trim Edit), les modifications ont été appliquées en Ripple, ne laissant ainsi 
aucun espace vide.

15 Positionnez la tête de lecture au début de la timeline et visionnez le résultat.

REMARQUE Vous pouvez importer une version finalisée de la timeline WTTP FINE 
 CUT en choisissant Fichier > Importer > Timeline (File > Import > Timeline), en allant 
 sur R18 Editors Guide/Lessons/Lesson 03, en sélectionnant WTTP FINE CUT  
FINISHED.drt, puis en cliquant sur Ouvrir (Open).

Les modifications complexes sont souvent réalisées sur plusieurs timelines, chacune 
nécessitant plusieurs versions avant d’être assemblée sur le programme final. Soyez bien 
attentif à la façon dont vous gérez ces timelines. Il est en général plus efficace de travailler 
sur des timelines indépendantes que sur une seule.
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Révision
1 Qu’est-ce qu’un montage « radio edit » ?

a) Un montage utilisé pour la radio et la télévision

b) Une version réduite de votre film utilisée pour le contrôle

c) Une technique de montage qui permet de se concentrer sur l’audio avant de 
regarder les images 

2 Quelle transition permet d’atténuer l’effet des jump cut ?

a) Smooth wipe

b) Smooth dissolve

c) Smooth cut

3 Où se trouve l’option qui permet d’afficher les timelines superposées ?

a) Placez une timeline sur l’autre pour afficher les deux fenêtres

b) Cliquez sur le bouton Affichages de la timeline

c) Cliquez sur Plan > Décomposer le plan 

4 Comment ouvre-t-on une timeline dans le viewer source ?

a) En double-cliquant sur la timeline dans la bibliothèque de médias

b) En faisant un clic droit sur la timeline dans la bibliothèque de médias et en 
choisissant Ouvrir dans la source

c) En faisant glisser la timeline de la bibliothèque de médias sur le viewer source.

5 Quelle option empêche DaVinci Resolve de monter automatiquement le contenu d’une 
timeline sur une autre en tant que plan composé ?

a) Plan > Décomposer le plan

b) Timeline > Décomposer les plans composés au montage

c) Il est impossible d’empêcher DaVinci Resolve de monter automatiquement le 
contenu d’une timeline sur une autre en tant que plan composé
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Réponses
1 c) Un « radio edit » consiste à se concentrer sur le montage de l’audio afin de rendre 

l’interview la plus naturelle possible, avant même de se tourner vers l’image.

2 c) Le terme Smooth Cut désigne une transition qui rend les jump cut moins visibles 
grâce au traitement par flux optique.

3 b) Cliquez sur le bouton Affichages de la timeline.

4 c) En faisant glisser la timeline de la bibliothèque de médias sur le viewer source.

5 b) Timeline > Décomposer les plans composés au montage
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Chapitre 4

Découper une scène 
d'un film de fiction

La première étape pour réussir une 
scène d'un film de fiction consiste à bien 
identifier le lieu où se déroule l’action, puis 
à découper les prises de vue de manière 
à créer le rythme voulu par le réalisateur. 
Connue sous le nom de montage en 
continuité, cette technique consiste à 
alterner les prises montrant tour à tour 
les personnages et leurs réactions. 
Ce chapitre explore ces techniques 
de continuité dans un dialogue. Vous 
allez commencer par utiliser une des 
techniques les plus utilisées du cinéma : 
la technique du champ-contrechamp. 
Grâce aux outils de montage, de 
rognage et à la fonction Match Frame de 
DaVinci Resolve 18, vous réaliserez un 
montage en un rien de temps.

Dans ce chapitre, vous allez monter un 
court dialogue entre deux personnages 
du film de science-fiction Sync. Cette 
histoire écrite, produite et réalisée par 
Hasraf “Haz” Dulull met en scène un 
robot sur lequel les humains ont perdu 
le contrôle. 
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Travailler sur des prises séparées
Même si un projet de ce genre est souvent écrit, répété et tourné dans un environnement 
contrôlé, un grand nombre de choix créatifs peuvent être faits au cours du montage.

Même si cette étape initiale prend du temps, il est important de regarder toutes les scènes 
qui ont été tournées avant de commencer le montage. Cela vous permettra non seulement 
de choisir les meilleurs moments, mais aussi d’avoir un meilleur aperçu du contenu. Souvent, 
il faut travailler avec différentes parties des prises pour obtenir les meilleures performances. 

Vous allez commencer par importer le projet de ce chapitre et relier les fichiers média.

1 Ouvrez DaVinci Resolve, et dans la fenêtre Gestionnaire de projet (Project manager) 
choisissez Importer (Import). 

2 Allez sur R18 Editors Guide/Lesson 04, sélectionnez le fichier SYNC SCENE.drp et 
cliquez sur Ouvrir (Open).

3 Une fois le projet importé, double-cliquez pour l’ouvrir et au besoin, sélectionnez la 
page Montage. 

4 Dans la bibliothèque de médias, cliquez sur le bouton Relier les médias (Relink Media).

5 Choisissez Espace de travail > Réinitialiser l’espace de travail (Workspace > Reset 
UI Layout).

6 Dans la timeline, cliquez sur Zoom Min (Full Extent Zoom) et redimensionnez les pistes 
pour voir tous les plans dans la fenêtre de la timeline.

Le projet est organisé en chutiers regroupant les plans de l’agent Jenkins et du docteur 
Kominsky. Ils sont appelés AGENT J et DR K.



149Travailler sur des prises séparées

7 Dans la timeline, placez la tête de lecture au début de la timeline et lancez la lecture.

La première prise de la timeline montre Dr K en train de marcher à la fin de sa 
présentation lors d’une conférence sur la cybersécurité. La partie principale de 
la timeline comporte une prise montrant l’intégralité de la scène filmée de l’angle 
de prise de vues de l’agent J. On parle alors de prise master, car on y voit toute la 
structure de la scène. En revanche, les prises en contre champ du Dr K en train de 
parler et d’interagir avec l’agent ne sont pas visibles.

REMARQUE Bien qu’on ait l’impression que la scène a été filmée par plusieurs 
caméras, il ne s’agit pas d’une prise multicaméra. En fait, la prise a été filmée 
par une seule caméra, de plusieurs points de vue différents. Les acteurs ont 
donc dû rejouer la scène plusieurs fois. Les plans capturés par différents angles 
de prise de vues sont ensuite montés ensemble. Si la continuité est assurée, 
le résultat devrait être fluide. Tourner les prises avec une seule caméra coûte 
moins cher et est plus simple à mettre en place, en revanche, cette solution 
demande davantage de temps sur le plateau, car chaque scène doit être 
tournée plusieurs fois, à différents angles. En outre, le montage doit ensuite 
être réalisé minutieusement, et comme les angles et prises seront sans aucun 
doute différents, les techniques de montage multicaméra ne seront pas 
adaptées. Vous en apprendrez plus sur le montage multicaméra au chapitre 5 
« Montage multicaméra ».

8 Sélectionnez le chutier DR K CAM.

Ce chutier contient toutes les prises du Dr K.
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9 Sélectionnez les trois plans et faites-les glisser du chutier vers le viewer source.

En faisant glisser simultanément ces plans, vous pouvez les retrouver dans le menu 
déroulant du viewer source. De cette façon, vous pouvez passer facilement d’un plan à 
un autre (uniquement les dix derniers plans), sans devoir fouiller dans la bibliothèque 
de médias.

10 Dans le menu Options du viewer source, sélectionnez Afficher la forme d'onde du plan 
entier (Show Full Clip Audio Waveform) pour vous aider à voir où commence et où se 
termine le dialogue.
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11 Sélectionnez B_S6_T5 Doctor K WS dans le menu déroulant pour le charger dans le 
viewer source.

12 Visualisez le plan.

Il s’agit de la première des trois prises de la scène du Dr Kominsky.

REMARQUE Dans ce projet, la convention de nommage des plans repose sur 
la configuration de la caméra (« A » pour les angles de l’agent Jenkin et « B » 
pour les angles du Dr Kominsky), le numéro du clap ou du plan (par ex. S5), le 
numéro de la prise (par ex. T1), une description de la prise (par ex. « WS » pour 
Wide Shot ou « CU » pour Close Up), et enfin, le personnage qui apparaît à 
l’écran : B_S6_T5 WS DOCTOR K. Vous en apprendrez plus sur l’organisation et 
le nommage des plans au chapitre 6 « Organisation du projet ».
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Montage en continuité
Vous allez utiliser la prise de la timeline comme référence pour monter les dialogues et 
les mouvements des acteurs. Vous allez aussi utiliser d’autres fonctionnalités propres 
à DaVinci Resolve pour ajouter des gros plans et des plans de réactions créant une 
continuité temporelle et spatiale. 

La prise se concentre sur les agents du FBI (mais ça aurait très bien pu être l’angle de prise 
de vues du Dr K). C’est donc à vous d’ajouter des prises en contrechamp du Dr K. Comme 
dans le chapitre précédent, nous vous recommandons de vous concentrer sur le rythme 
du dialogue pour donner l’impression que les personnages ont une conversation fluide. 
Vous affinerez ce bout à bout au cours des étapes suivantes.

1 Au besoin, lancez de nouveau la lecture de la timeline pour vous rafraîchir la mémoire. 
Souvenez-vous que mieux vous connaissez le dialogue, mieux vous serez en mesure 
de savoir quelles prises vont bien ensemble et faire ainsi les meilleurs choix créatifs.

Pour le moment, une fois le Dr K descendu de l’estrade, la scène « s’ouvre » sur 
une prise vide avant l’arrivée des agents du FBI. Il est préférable de la démarrer en 
montrant le Dr K interrompu par les agents du FBI.

2 Dans la timeline, positionnez la tête de lecture au début du plan 
A_S8_T2 WS Agent J et saisissez le point d’entrée.

3 Lancez la lecture du plan et saisissez le point de sortie avant que l’agent Jenkins dise 
« I’m Agent Jenkins… »

ASTUCE Vous pouvez utiliser les formes d’onde de la timeline pour voir les 
personnages parler, avec Dr K sur la piste A1 et Agent J sur la piste A2.
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4 Appuyez sur Q pour passer sur le viewer source et le plan B_S6_T5 WS Doctor K.

5 Lancez le plan jusqu’à ce que l’homme s’éloigne du Dr K, juste au moment où la femme 
s’approche d’elle (01:02:55:00).

6 Saisissez le point de sortie juste avant que l’agent J dise « I’m Agent Jenkins… ».



154 Chapitre 4 Découper une scène d'un film de fiction

Attendez. Vous avez ajouté quatre points : un point d’entrée et de sortie dans la 
timeline et un point d’entrée et de sortie dans le viewer source. En outre, même si les 
quatre points marqués sont bien placés, les durées des deux sélections diffèrent : en 
haut à gauche des viewers source et timeline, la durée est réglée sur 7 secondes pour 
la source et autour de 5 secondes pour la timeline (en fonction de l’endroit où vous 
avez placé le point de sortie de la timeline).

Vous l’avez sans doute compris, la plupart des options de montage de DaVinci Resolve 
reposent sur un montage à trois points. Seuls trois de ces quatre points sont donc 
utiles pour les options de montage Écraser (Overwrite) ou Insérer (Insert). Vous 
pouvez prévisualiser quelles marques Resolve utilisera.

7 Choisissez Affichage > Afficher les repères de prévisualisation.

Les marques de prévisualisation sont affichées en bleu dans le viewer source pour 
mettre en valeur la durée plus courte saisie dans la timeline. Le point de sortie sur le 
viewer timeline n’est pas pris en compte dans un montage à trois points standard.

8 Dans la barre d’outils, cliquez sur le bouton Écraser (Overwrite) ou sur la touche de 
fonction F10.
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Le montage Écraser (Overwrite) limite le montage par rapport à la durée la plus courte 
saisie sur la timeline. La coupe entre le plan du Dr K et de l’agent Jenkins est trop 
abrupte. Si vous choisissiez de conserver cette coupe, il faudrait rogner le plan sortant 
du Dr K afin de récupérer le dialogue manquant.

Heureusement, Resolve offre des options de montage qui vous aideront dans 
cette situation.

9 Choisissez Édition > Copier (Edit > Copy), ou appuyez sur Command-C (macOS) ou 
Ctrl-C (Windows).

10 Faites glisser le plan du viewer source vers le viewer timeline. Dans les options de 
montage en transparence, choisissez Écraser et Ripple (Ripple Overwrite).

L’option Écraser et Ripple (Ripple Overwrite) écrase la durée marquée sur le plan 
dans le viewer source et l’ajoute au niveau de la durée marquée dans la timeline. Les 
éléments de la timeline se décalent automatiquement, en fonction de la différence 
de durée. Comme vous l’avez sans doute remarqué, l’option Écraser et Ripple (Ripple 
Overwrite) utilise tous les points d’entrée et de sortie que vous avez marqués, il s’agit 
donc d’un montage à quatre points.

Dans la timeline, visualisez les images qui entourent le raccord et assurez-vous que 
vous avez bien écrasé la partie du plan qui ne vous intéressait pas. Le début du plan 
devrait avoir été remplacé par un gros plan de l’actrice. Les images qui avaient été 
ignorées par l’option Écraser (Overwrite) sont désormais incluses grâce à l’option 
Écraser et Ripple (Ripple Overwrite). En conséquence, la timeline est rallongée de 
quelques secondes.
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Toujours avec Écraser et Ripple (Ripple Overwrite), vous pouvez continuer de monter 
cette scène.

11 Lancez la timeline et ajoutez un point d’entrée après que l’agent Jenkins ait dit « We 
need you to come with us right away ». Ajoutez le point de sortie quand il se retourne, 
juste avant que le Dr Kominsky dise « Yeah, yeah ». La durée fait environ 3 secondes.

12 Appuyez sur Q pour retourner sur le viewer source et lancez la lecture du plan 
B_S6_T5 WS Doctor K. Ajoutez le point d’entrée après la réplique « We need you 
to come with us right away, » et le point de sortie au moment où le Dr Kominsky se 
retourne vers sa collègue et dit « Yeah, yeah. I’m sure it’s fine ».

13 Appliquez l’option de montage Écraser et Ripple (Ripple Overwrite) en utilisant les 
commandes sur le viewer timeline ou en appuyant sur Majuscule-F10.
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14 Continuez la lecture et réglez le point d’entrée avant la réplique « Ok » du Dr K et le 
point de sortie juste avant « We need your help » de l’agent J. 

15 Appuyez sur la touche Q pour aller sur le viewer source, réglez le point d’entrée après 
que la collègue du Dr K se soit éloignée et le point de sortie juste après que l’agent 
Jenkins ait dit « We need your help…. ».

16 Appliquez l’option de montage Écraser et Ripple (Ripple Overwrite).

Comme vous le voyez, avec l’aide du dialogue, cette option permet de rapidement 
bloquer la scène. Bien entendu, il y a beaucoup d’éléments à prendre en considération, 
mais pour le moment, concentrez-vous sur la création du bout à bout.
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Utiliser d’autres prises
1 Continuez de lire la timeline, et saisissez le point d’entrée suivant quand le Dr K dit 

« My help ? », et le point de sortie au moment où l’agent J se retourne et avant qu’il dise 
« Ok, we don’t have a lot of time… ».

2 Appuyez sur Q pour retourner sur le viewer source et lancez la lecture pour entendre 
la même réplique dans le plan du Dr K.

Aïe ! L’audio est très mauvais sur cette prise. Bien entendu, l’actrice qui joue Dr 
Kominsky porte un micro, et au moment où elle touche le fil, le micro bouge. Cette 
prise est inutilisable et c’est une des raisons pour lesquelles plusieurs prises sont 
enregistrées.

3 Dans le menu déroulant au-dessus du viewer source, choisissez B_S6_T3 WS Doctor K.

4 Positionnez la tête de lecture aux deux tiers du plan, et recherchez la réplique du Dr K 
« My help ? Sorry, you’ll have to do better than that. » (autour de 01:05:45:00).
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5 Ajoutez un point d’entrée juste avant qu’elle ait dit « My help » et un point de sortie 
juste après « Ok, we don’t have a lot of time here… ».

Vous entendrez peut-être encore le grésillement du micro, mais c’est déjà moins fort. 
En outre, ce n’est pas exactement sur le dialogue, il est donc facile de l’enlever.

6 Appliquez l’option de montage Écraser et Ripple (Ripple Overwrite).

7 Continuez de lire la vidéo et saisissez un point d’entrée juste avant que l’agent J dise 
« …deadly, weaponized package », et un point de sortie juste avant sa phrase suivante 
« Well, it’s possible Doctor Kominsky… ».

8 Appuyez sur Q pour passer sur le viewer source et sélectionnez le plan 
B_S6_T5 WS Doctor K dans le menu des plans récents.
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9 Ajoutez un point d’entrée juste après que l’agent J ait dit « …deadly weaponized 
package ».

REMARQUE Il est peut-être intéressant de noter la réaction du Dr Kominsky. 
On voit qu’elle hoche la tête dans un sentiment d’incrédulité. Ce serait 
intéressant de l’inclure.

10 Réglez le point de sortie dans le viewer source juste avant que l’agent J dise « Oh, It’s 
possible… ».

11 Appliquez l’option de montage Écraser et Ripple (Ripple Overwrite).

Le montage final comportera la prise de la réaction du Dr Kominsky.

12 Lancez la timeline et réglez les points d’entrée et de sortie autour de la réplique de 
l’Agent J « We need you to tell us everything you know about the Sync: the routes, their 
drop points… ».
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13 Appuyez sur Q pour aller sur le viewer source, lancez la lecture, et saisissez un point de 
sortie après que l’agent J ait dit « …their drop points ».

14 Choisissez Marque > Supprimer le point d’entrée (Mark > Clear In), ou appuyez sur 
Opt-I (macOS) ou Alt-I (Windows) pour supprimer le point d’entrée. 

Supprimer le point d’entrée permet d’ajouter la réaction en backtiming quand vous la 
monterez dans la timeline.

15 Dans la timeline, cliquez sur les commandes de destination des pistes A1 et A2 afin de 
désactiver l’audio du plan source.
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16 Appliquer un montage Écraser (Overwrite).

Parfait ! Avec l’option Écraser et Ripple (Ripple Overwrite), vous avez pu monter 
rapidement la scène. Comme toujours, bien entendu, il ne s’agit que de la première 
étape du montage. Vous apprendrez à analyser différentes prises avant de les monter 
en mode Raccord fin (Trim Edit).

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES et choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis sur R18 Editors Guide/Lesson 04/Timelines et sélectionnez 
SYNC SCENE ROUGH CUT CATCHUP 1.drt. Cliquez sur Ouvrir (Open).

Comparer les prises
Lorsque vous montez une scène de dialogue, il peut être tentant de ne faire vos coupes 
qu’en fonction des répliques. Cependant, le montage d’une scène de dialogue est bien 
plus complexe qu’il n’y paraît. Il faut en effet tenir compte des mots, mais aussi du regard, 
des mouvements de lèvres et de la gestuelle des acteurs. Tous ces éléments permettent 
de recréer l’émotion d’une scène. Ainsi, même si la continuité du dialogue est parfaitement 
respectée, il faudra peut-être rechercher d’autres prises où le jeu des acteurs est 
plus adapté.

Si vous comparez plusieurs prises pendant le montage, il est fort à parier que vous 
apporterez de nombreuses modifications à la timeline. Par exemple, imaginez que le 
réalisateur préfère voir le Dr K dans un plan d’ensemble plutôt qu’en gros plan. Il semble 
assez simple de remplacer une prise par une autre, non ? La plupart des monteurs 
vous diront que les réalisateurs ne sont jamais satisfaits et veulent avoir du choix. 
Heureusement, grâce au sélecteur de prises de DaVinci Resolve, le processus est optimisé.

Avant de commencer, il est préférable de dupliquer la timeline actuelle.
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1 Sélectionnez le chutier TIMELINES, faites un clic droit sur la timeline SYNC SCENE  
ROUGH CUT et choisissiez Dupliquer la timeline (Duplicate Timeline) pour créer 
une copie.

2 Retournez sur la timeline actuelle et positionnez la tête de lecture au début du 
quatrième plan, le deuxième plan de B_S6_T5 WS Doctor K.

Le réalisateur se demande si un plan large ne serait pas préférable à un gros plan.

3 Dans la liste des plans du viewer source, sélectionnez B_S5_T1 CU Doctor K pour 
ouvrir la prise en gros plan dans le viewer source.
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4 Saisissez le point d’entrée juste avant que le Dr K dise « Ummm » (autour de 
01:01:00:00) et un point de sortie juste avant qu’elle dise « yeah, yeah… » (2 à 3 
secondes plus tard).

Pour comparer (sans remplacer) ce plan avec celui qui se trouve déjà sur la timeline, 
vous pouvez utiliser le sélecteur de prises de Resolve.

5 Dans la timeline, faites un clic droit sur B_S6_T5 WS Doctor K au niveau de la tête 
de lecture et choisissez Sélecteur de prises (Take Selector) ou sélectionnez le plan et 
choisissez Plan > Sélecteur de prises (Clip > Take Selector).
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Cet outil est activé sur le plan sélectionné.

Il peut par ailleurs contenir plusieurs prises. Un seul plan sera visible lors de la lecture 
de la timeline, même si le sélecteur contient plusieurs autres plans. Ils sont gardés en 
réserve en cas de besoin.

6 Faites glisser le plan B_S5_T1 CU Doctor K du viewer source à la timeline pour l’ajouter 
automatiquement sur le sélecteur de prises actif.

ASTUCE Vous pouvez ajouter autant de prises que vous voulez dans le sélecteur.

Les deux plans s’affichent désormais l’un sur l’autre. 
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La prise que vous venez d’ajouter est active, mais vous pouvez modifier cela en 
cliquant sur le plan que vous voulez voir dans la timeline. Par contre, vous remarquerez 
que la durée du gros plan que vous venez d’ajouter est légèrement différente du 
plan large.

7 En haut à droite du sélecteur, appuyez sur le bouton de décalage (Ripple).

La timeline s’ajuste pour correspondre à la durée de la prise la plus courte.

8 Lancez la lecture pour voir la nouvelle prise sélectionnée. 

Le réalisateur a décidé que le gros plan était finalement plus intéressant, vous allez 
donc l’ajouter à la timeline. 

9 Dans le sélecteur de prises, cliquez sur le plan du haut pour le sélectionner.

10 En haut à gauche du sélecteur, appuyez sur la croix pour refermer l’outil.

ASTUCE Vous pouvez rouvrir le sélecteur et continuer de revoir les différentes 
prises pour choisir la scène d’ouverture. Double-cliquez sur l’icône du sélecteur 
en bas à gauche du plan dans la timeline.

11 Faites un clic droit sur le plan et choisissez Finaliser la prise (Finalize Take).

Finaliser la prise supprime le sélecteur et toutes les autres prises de la timeline. Il ne reste 
que la scène choisie par le réalisateur.
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Nettoyer l’audio
Avant de vous lancer dans le peaufinage de la scène, vous pourriez vouloir nettoyer l’audio 
des plans de dialogue. Cela vous permettra de supprimer toutes les parties que vous ne 
voulez pas, ne gardant ainsi que les répliques des acteurs.

1 Dans la timeline, assurez-vous que les options Aimant (Snapping) et Lier la sélection 
(Linked Selection) sont désactivées. Il sera ainsi plus facile de sélectionner et de rogner 
les plans audio.

2 Veillez à être en mode Sélection et rognez le début du premier plan audio de la piste 
A2 vers l’avant de 5 secondes (+05:00) afin qu’il débute au moment où l’agent J dit sa 
première phrase.

3 Rognez la fin de ce plan vers l’arrière d’une seconde (à la fin de la phrase de l’agent J).

4 Sur le plan suivant, sélectionnez le plan de la piste A1 et appuyez sur la touche 
Supprimer pour l’enlever.
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De cette façon, ce plan de dialogue ne comporte plus que les répliques de l’agent J.

Les deux plans d’après sont dédiés au dialogue du Dr K, même si l’on voit l’agent J 
sur l’un d’eux.

5 Sélectionnez les trois plans audio suivants sur A2 et appuyez sur Supprimer pour les 
supprimer de la timeline.

6 Continuez de travailler sur le reste de la timeline en supprimant les plans dont vous 
n’avez pas besoin sur la piste A1 quand l’agent J parle, et les plans sur A2 quand le 
Dr K parle.

Quand vous avez terminé, la timeline ne devrait contenir que l’audio dont vous avez 
besoin. Chaque personnage aura aussi sa propre piste. Ça rendra aussi le rognage 
des plans plus facile, car vous n’aurez pas à vous soucier des plans dont vous n’avez 
pas besoin. Vous terminerez le mix audio de cette scène au chapitre 8 « Monter et 
mixer l’audio ».

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES et choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis sur R18 Editors Guide/Lesson 04/Timelines et sélectionnez 
SYNC SCENE ROUGH CUT CATCHUP 2.drt. Cliquez sur Ouvrir (Open).
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Utiliser le montage Split
Une coupe franche placée en ouverture et en fermeture de plans audio et vidéo est 
souvent un peu abrupte et inadaptée. Un montage Split, souvent appelé Montage en L 
ou Montage en J, décale l’audio par rapport à la vidéo (et inversement). Cette technique 
permet de créer un rythme plus fluide entre les plans.

Le montage Split le plus connu est le montage en J. Le son du plan se fait entendre 
quelques secondes avant l’image. C’est d’ailleurs comme cela que l’on perçoit le monde : si 
une voiture klaxonne au loin, on va d’abord entendre le bruit du klaxon, puis se retourner 
pour voir ce qu’il se passe. 

Dans un montage en L, la vidéo apparaît avant l’audio. Cette technique est souvent utilisée 
lorsque l’on veut montrer les réactions des personnages.

Dans Resolve, vous pouvez réaliser des montages en J ou en L de différentes manières. 
Vous allez commencer par créer un montage en J dans lequel le plan audio démarre 
avant l’image.
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Déplacer la coupe (à la tête de lecture)
L’option Déplacer la coupe (à la tête de lecture) (Extend edit) permet de créer un montage 
Split, car le point de coupe sélectionné est automatiquement rogné vers la tête de lecture.

1 Assurez-vous que les options Aimanter (Snapping) et Relier la sélection (Linked 
Selection) sont désactivées dans la barre d’outils, puis positionnez la tête de lecture 
entre les deuxième et troisième plans. Cliquez ensuite sur Zoom détail (Detail Zoom), 
et ajustez le zoom de façon à avoir un bon aperçu des plans sur la timeline.

2 Appuyez sur / (barre oblique) pour visualiser le montage.

Au moment où l’agent du FBI se présente, il serait peut-être préférable de rallonger le 
plan du Dr K pour voir sa réaction. En outre, le fait d’entendre la voix de l’agent J avant 
de le voir offre une bonne transition pour la scène suivante où ils parlent ensemble.

3 Sélectionnez le point de coupe entre les plans vidéo B_S6_T5 WS Doctor K et 
A_S8_T2 WS Agent J.

4 À présent, placez la tête de lecture au moment où l’agent J tourne la tête pour 
présenter sa collègue.
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5 Choisissez Trim > Déplacer la coupe (à la tête de lecture), ou appuyez sur la touche E.

Cette opération rogne la coupe sur la tête de lecture de la timeline. Comme les deux 
côtés de la coupe sont sélectionnés, vous avez réalisé un rognage roll qui a créé un 
montage Split. Appuyez sur / (barre oblique) pour visualiser le raccord Split.

La coupe que vous avez réalisée apporte du naturel à la scène, car vous voyez la 
réaction du Dr K en réponse à l’interruption de l’agent J. En revanche, cette coupe 
pourrait être un peu plus rapide.

6 Appuyez sur T pour sélectionner le mode Raccord fin (Trim Edit).

7 Appuyez deux fois sur U pour sélectionner la coupe en queue.

8 Appuyez sur , (virgule) pour supprimer 10 images à partir de la coupe, réduisant ainsi 
le temps entre les répliques du Dr K et de l’agent J.

9 Appuyez sur / (barre oblique) pour visionner les changements.

ASTUCE N’oubliez pas que vous pouvez toujours rajouter les images 
supprimées sur un plan en appuyant sur . (point).

Quand vous êtes satisfait du montage, continuez avec la coupe suivante.

10 Appuyez sur la flèche vers le bas pour aller à la coupe suivante

11 Appuyez sur / (barre oblique) pour visualiser le montage.

Maintenant, vous allez rogner la coupe pour afficher la réaction du Dr K un peu avant.
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12 Sélectionnez la vidéo et positionnez la tête de lecture au moment où l’agent J dit 
« Come with us ».

13 Appuyez sur E pour appliquer le montage Déplacer la coupe (à la tête de lecture) 
(Extend edit).

Cette opération positionne la coupe au niveau de la tête de lecture dans la timeline.

14 Appuyez sur / (barre oblique) pour visualiser le raccord Split.

On voit désormais bien mieux la réaction du Dr K. Vous pouvez encore améliorer cette 
séquence en ralentissant le rythme.

15 Appuyez sur U pour sélectionner la coupe en tête.

16 Dans le champ du timecode du viewer timeline, saisissez -12 (-00:12) et appuyez 
sur Entrée.

Le point de coupe sélectionné est déplacé d’une demi-seconde, donnant au Dr K un 
instant supplémentaire pour comprendre ce que lui dit l’agent J. 

17 Appuyez ensuite sur / (barre oblique) pour visualiser le changement.
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Les montages Split réalisés à l’aide de ces raccourcis sont des techniques très courantes et 
rapides. Elles servent à monter entre autres des scènes de dialogue.

Mode Trim dynamique
Un autre mode que vous pouvez utiliser avec les modes Sélection et Raccord fin (Trim Edit) 
est le mode Rognage dynamique (Rognage dynamique). Les monteurs aiment utiliser le 
rognage dynamique, car il permet de rogner les images en temps réel pendant la lecture. 
Pour l’utiliser efficacement, vous devrez vous entrainer un peu. En revanche, une fois bien 
pris en main, vous pourrez appliquer des modifications rapides sur la timeline.

1 Dans la timeline actuelle, cliquez n’importe où (sauf sur un plan) pour désélectionner 
tous les plans et points de coupe.

2 Placez la tête de lecture entre B_S5_T1 CU Doctor K et A_S8_T2 WS Agent J. 

3 Appuyez ensuite sur / (barre oblique) pour visualiser ce raccord.

Le rythme est un peu trop rapide, il faudrait voir un peu plus longtemps l’expression 
sur le visage de l’agent J quand le Dr K se trouble.

4 Appuyez sur T pour sélectionner le mode Raccord fin (Trim Edit). 

5 Dans la barre d’outils, cliquez sur le bouton Rognage dynamique (Dynamic Trim), ou 
appuyez sur la touche W.

REMARQUE Le rognage dynamique peut être activé quand vous êtes en 
mode Raccord fin (Trim Edit) ou Sélection.
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Quand le mode Raccord fin (Trim Edit) est activé, plusieurs choses peuvent se passer. 
Tout d’abord, la coupe la plus proche de la tête de lecture est automatiquement 
sélectionnée. La tête de lecture et le bouton du rognage dynamique s’affichent en 
jaune pour indiquer que ce mode est activé. 

En revanche, les autres changements ne sont pas aussi visibles. Les raccourcis clavier 
ont également été modifiés. Si vous utilisez la barre d’espace pour commencer 
et arrêter la lecture, cette touche permet désormais de Lire autour de l’image 
sélectionnée (Play Around Current Frame), alors que les touches J et L ajustent le point 
de coupe en temps réel.

6 Appuyez sur U pour que les deux côtés de la vidéo soient sélectionnés.

7 Appuyez et maintenez les touches K et J enfoncées pour faire un rognage lent vers 
l’arrière jusqu’à ce que l’agent J tourne la tête.
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8 Appuyez sur la barre d’espace pour visualiser la coupe et avec les touches K et L ou J, 
continuez de rogner vers l’avant ou vers l’arrière.

ASTUCE Si vous rognez une image à la fois, les touches , (virgule) et . (point) 
continuent de marcher. Sinon, vous pouvez maintenir la touche K enfoncée et 
appuyer sur J ou L.

Quans vous êtes satisfait du résultat, appuyez deux fois sur la flèche vers le bas pour 
aller sur le point de coupe entre A_S8_T2 WS Agent J et B_S6_T5 WS Doctor K.

Les points de coupe audio et vidéo sont automatiquement sélectionnés.

9 Cliquez sur la coupe vidéo pour la sélectionner indépendamment de la coupe audio ou 
appuyez sur Option-U (macOS) ou Alt-U (Windows).

10 Appuyez sur la touche L pour décaler le raccord vers l’avant, au moment où l’agent J 
regarde la collègue du Dr K s’éloigner et qu’il tourne de nouveau la tête.
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11 Appuyez sur la flèche vers le bas pour aller sur le point de coupe suivant.

12 Appuyez sur Option-U (macOS) ou Alt-U (Windows) pour sélectionner uniquement la 
coupe vidéo.

13 Appuyez sur les touches J et L pour décaler le raccord vers l’avant jusqu’à ce que 
l’agent J dise « …matter of national security » et commence à marcher.

14 Appuyez sur la flèche vers le bas pour sélectionner la coupe suivante entre 
A_S8_T2 WS Agent J et B_S6_T3 WS Doctor K, puis appuyez sur Option-U (macOS) ou 
Alt-U (Windows) pour sélectionner la coupe vidéo.
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15 Appuyez sur L pour décaler le raccord vers l’avant au moment où le Dr K dit « My 
help ? », et que l’agent J commence à s’éloigner d’elle.

ASTUCE Toutes les fonctions de rognage que vous connaissez, telles que 
Glissement et Coulissement, sont disponibles en mode Trim dynamique (Dynamic 
Trim). Pour faire glisser ou coulisser un plan avec le rognage dynamique, 
sélectionnez le plan et commencez le rognage avec les touches JKL. Pour passer 
d’une coupe à l’autre, appuyez sur S ou faites un clic droit sur le bouton Rognage 
dynamique (Dynamic Trim) dans la barre d’outils de la timeline.

Testez vos capacités
Continuez d’affiner le montage avec les techniques que vous préférez. Souvenez-
vous qu’il n’y a ni bonne ou mauvaise méthode pour monter une scène, mais 
uniquement des techniques qui correspondent aux besoins des uns et des autres.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES et choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis sur R18 Editors Guide/Lesson 04/Timelines et sélectionnez 
SYNC SCENE ROUGH CUT CATCHUP 3.drt. Cliquez sur Ouvrir (Open).
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Remplir les espaces vides
Une fois que vous aurez bien retravaillé le rythme des scènes, vous vous retrouverez sans 
doute avec des espaces vides entre les plans audio, notamment si vous avez ajouté des 
pauses entre les réactions et les répliques des acteurs. Pour remplir ces silences, vous allez 
ajouter un plan audio de bruit de fond. Ce son seul (Atmos) peut avoir été enregistré sur le 
plateau au moment du tournage, ou provenir de la bibliothèque d’effets.

1 Appuyez sur N pour activer l’aimant dans la timeline.

2 Positionnez la tête de lecture sur la première prise du Dr K en train de parler avec 
sa collègue.

3 Dans le chutier Audio, sélectionnez le plan Atmosphere wild sound, ouvrez-le dans le 
viewer source et ajoutez un point d’entrée à côté du début.

4 Assurez-vous que la commande de destination audio de la piste audio DR K est active.

REMARQUE Si la commande est désactivée, Resolve ne vous permettra pas 
de monter ce plan audio dans la timeline.
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5 Faites glisser le plan audio sous A3.

Le plan est automatiquement ajouté sur la nouvelle piste audio A4, mais il est trop 
court pour recouvrir l’intégralité de la scène.

6 Faites de nouveau glisser ce même plan audio sur une nouvelle piste, au milieu 
de la scène.

7 Rognez la fin du deuxième plan juste avant la dernière prise dans la timeline.
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8 En utilisant les poignées de fondu, ajoutez un court fondu au début du premier plan et 
à la fin du deuxième plan sur la piste A4.

9 Placez la tête de lecture au début de la timeline et lancez la scène.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES, choisissez Fichier > Importer > Timeline (File > Import > 
Timeline), puis R18 Editors Guide/Lesson 04/Timelines. Enfin, sélectionnez 
Age of Airplanes Catchup 3.drt et cliquez sur Ouvrir (Open).

Bravo ! Vous avez réussi à monter une courte scène d’un film de fiction en utilisant une 
variété de techniques, dont Écraser et Ripple (Ripple Overwrite), Déplacer la coupe (à la 
tête de lecture), le montage Split et le raccord dynamique. 

Ce chapitre portait sur le montage d’un film de fiction, mais nous avons également abordé 
le thème de la continuité. Une bonne continuité cinématographique repose sur une unité 
de lieu, de temps et d’action. Vous avez désormais une meilleure compréhension de la 
façon dont les outils de montage de DaVinci Resolve peuvent vous aider à réaliser des 
montages de qualité.
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Révision
1 À quoi correspondent les repères de prévisualisation sur la timeline ?

a) Ils montrent où peuvent être positionnés les marqueurs.

b) Ils permettent de déterminer la position des plans dans un montage à trois points.

c) Ils montrent où s’aligneront le texte et les graphiques dans le viewer Timeline.

2 Vrai ou faux ? L’option Écraser et Ripple applique un montage à trois points.

3 Vrai ou faux ? Tous les plans du Sélecteur de prises (Take Selector) doivent être de la 
même durée.

4 Lequel des montages suivants correspond à un montage Split ?

a) Montage en J.

b) Montage en K.

c) Montage en L.

5 Vrai ou faux ? Le rognage dynamique est uniquement accessible si la timeline est en 
mode Raccord fin.
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Réponses
1 b) Les repères de prévisualisation vous permettent de déterminer la position des plans 

dans un montage à trois points.

2 Faux. Écraser et Ripple applique un montage à quatre points. Ce type de montage 
sert si la durée du plan source sur lequel on a saisi des points d’entrée et de sortie est 
différente de la durée marquée sur la timeline, et si vous voulez appliquer un ripple à la 
timeline pour que les plans restent intacts.

3 Faux. Le sélecteur de prises peut inclure des plans de différentes durées. Lorsque vous 
passez d’un plan à l’autre, vous pouvez activer le bouton Ripple, en haut à droite (à 
gauche de la corbeille).

4 a) et c) Dans un montage en J, l’audio précède la vidéo et dans un montage en L, la 
vidéo précède l’audio.

5 Faux. Le rognage dynamique est accessible si la timeline est en mode Sélection ou 
Raccord fin.
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Chapitre 5

Montage 
multicaméra

Un grand nombre de productions 
capturent une même scène de 
plusieurs angles de vue. On pense 
notamment aux émissions de 
télé-réalité, et aux clips musicaux, 
mais aussi aux interviews.

Le workflow multicaméra de la page 
Montage vous permet de synchroniser 
plusieurs plans à la fois, puis de 
facilement modifier les différents 
angles de la caméra sans vous soucier 
des problèmes de synchronisation. 
Les métadonnées donnent encore 
plus de souplesse pour renommer 
et organiser les angles des caméras.

Dans ce chapitre, vous allez explorer 
la fonctionnalité multicaméra 
de la page Montage sur deux 
projets, et vous apprendrez à faire 
face aux difficultés rencontrées.
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Montage d’une interview multicaméra
Il est primordial de bien synchroniser les différents angles de caméra pour avoir un 
montage de qualité.

1 Ouvrez DaVinci Resolve, faites un clic droit dans la fenêtre Gestionnaire de projet 
(Project manager) et choisissez Importer (Import). 

2 Allez sur R18 Editors Guide/Lesson 05. Sélectionnez le fichier 
OMO MULTICAM INTERVIEW.drp et appuyez sur Ouvrir (Open), puis faites un 
double-clic sur le gestionnaire de projet (Project Manager) pour l’ouvrir.

3 Allez sur la page Montage et utilisez le bouton Relier les médias (Relink Media) pour 
relier les fichiers.

Ce projet contient les images d’une interview avec Chris Lang de la marque Organ 
Mountain Outfitters.

4 Dans la timeline, visionnez le montage OMO_Multicam_EDIT.

La scène s’ouvre sur une prise en timelapse où apparaît le logo de la marque Organ 
Mountain Outfitters. Il s’agit de la vidéo que vous avez montée aux chapitres 1 & 2. 
Ensuite, on voit le plan de coupe d’une pancarte sur laquelle est écrit « Buy a Shirt, 
Give a Lunch Forever ».

Le réalisateur veut qu’une partie de l’interview soit insérée entre le logo et l’image de 
la pancarte.

5 Placez la tête de lecture sur la première image du plan SHIRT SIGN.

6 Dans la bibliothèque de médias, sélectionnez le chutier OMO et visualisez les images.
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Ce chutier contient trois plans d’interview dans lesquels Chris se présente et explique 
le concept « Buy a Shirt, Give a Lunch » promu par Organ Mountain Outfitters. 
Heureusement, l’interview a été filmée par plusieurs caméras, vous n’êtes donc pas 
obligé d’ajouter des plans de coupe ou des transitions Smooth cut sur les jump cut. 
Par contre, avant de commencer à monter les images, il faut les synchroniser.

Il existe plusieurs manières de synchroniser les images multicaméras dans la page 
Montage. Dans ce premier exercice, vous allez manuellement synchroniser les images 
dans la timeline afin de bien comprendre l’organisation des plans multicaméras.

7 Dans la bibliothèque de médias, faites un clic droit sur le chutier Interviews et 
choisissez Créer une nouvelle timeline avec le chutier sélectionné (Create Timeline 
Using Selected Bin).

8 Dans la fenêtre Nouvelle fenêtre (New Window), renommez la timeline OMO 
Interview, désélectionnez Utiliser les points d’entrée et de sortie sélectionnés 
(Use Selected Mark In/Out) et cliquez sur Créer (Create).
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Une nouvelle timeline est ajoutée au chutier Interview et s’ouvre automatiquement 
dans la timeline.

9 Dans la timeline supérieure, sélectionnez le deuxième plan B 0002.mov, et faites-le 
glisser vers le haut pour créer deux nouvelles pistes V2 et A2.

10 Déplacez le troisième plan C 002.mov vers le haut pour créer deux nouvelles 
pistes V3 et A3.
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Ensuite, vous allez faire synchroniser ces trois plans par Resolve. Il y a deux manières 
d’y parvenir : si les timecodes des plans sont correctement réglés, il est facile de les 
synchroniser. Sinon, vous pouvez utiliser les formes d’onde.

Comme les timecodes de ces trois plans sont bien réglés, vous allez pouvoir les utiliser 
pour les synchroniser.

11 Dans la timeline, sélectionnez les trois plans, puis choisissez Plan > Synchroniser Plans > 
 En fonction du timecode (Clip > Auto Align Clips > Based on Timecode).

Après une brève analyse, Resolve synchronise correctement les deux plans dans la 
timeline. 

Maintenant que les angles sont synchronisés, vous devez convertir la timeline 
OMO Interview en un plan multicaméra.

12 Dans le chutier Interview, faites un clic droit sur la timeline OMO Interview 
et choisissez Convertir la timeline en plan multicaméra (Convert Timeline to 
Multicam Clip).
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La timeline se referme (il ne s’agit plus d’une timeline) et l’icône se transforme en icône 
multicaméra.

ASTUCE Vous pouvez repérer les plans multicaméra dans la timeline, car ils 
comportent une icône à côté du nom du plan.

Vous pouvez maintenant insérer cette interview dans la timeline principale et 
commencer à monter les différents angles.

Visualiser et rogner le plan multicaméra
Vous pouvez travailler sur un plan multicaméra comme sur n’importe quel autre plan. 
N’oubliez pas que vous pouvez passer d’un angle à l’autre quand vous le souhaitez, car 
tous les angles de vue sont inclus.

1 Dans le menu Options (…) du viewer source, choisissez Afficher la forme d'onde du 
plan entier (Show Full Clip Audio Waveform).

REMARQUE Si un plan multicaméra est ouvert dans le viewer source, vous ne 
pourrez pas accéder aux formes d’onde. Si c’est le cas, ouvrez simplement un 
des plans d’interview dans le viewer source pour activer les formes d’onde, puis 
rouvrez le plan multicaméra. 
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2 Double-cliquez sur le plan multicaméra OMO Interview pour l’ouvrir dans le 
viewer source.

Comme il s’agit d’un plan multicaméra, Resolve affiche automatiquement les angles 
simultanément. Le plan entouré d’une bordure rouge représente l’angle de vue que 
vous regardez et que vous entendez.

REMARQUE Les noms des angles « Vidéo 1 », « Vidéo 2 » et « Vidéo 3 » 
correspondent à ceux utilisés sur la timeline originale (à partir de laquelle le 
plan multicaméra a été créé). Vous apprendrez à renommer les angles plus tard.

3 Lancez la lecture du plan multicaméra dans le viewer source. Tous les angles 
sont synchronisés.

4 Dans le viewer source, saisissez le point d’entrée juste avant que Chris dise « My name 
is Chris Lang… » et le point de sortie après qu’il ait dit « …our communities that we 
live in. ».
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5 Appuyez sur F9 ou cliquez sur le bouton Insérer (Insert) dans la barre d’outils de 
la timeline pour insérer ce plan multicaméra dans la timeline au niveau de la tête 
de lecture.

Lorsque vous lisez un plan multicaméra dans la timeline, vous ne voyez que le plan 
actif. Les autres angles sont masqués.

Maintenant que l’interview a été montée dans la timeline, vous pouvez améliorer le 
rythme de la prise.

6 Au besoin, redimensionnez la piste audio afin de voir toute la forme d’onde de 
l’interview.

7 Dans la timeline, lancez le plan jusqu’à ce que Chris dise « …Organ Mountain 
Outfitters ». Appuyez sur I pour saisir le point d’entrée.

8 Continuez de lire l’interview jusqu’à la question suivante, et juste avant que Chris dise 
« …a lifestyle and outdoor brand. ». Appuyez sur O pour saisir le point de sortie.
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9 Appuyez sur Majuscule-supprimer pour supprimer la partie sélectionnée et décaler 
la timeline.

10 Appuyez ensuite sur / (barre oblique) pour visualiser le raccord.

11 Au besoin, sélectionnez le mode Raccord fin (Trim Edit) et affinez la coupe pour 
n’entendre que « My name is Chris Lang, and I’m the founder of Organ Mountain 
Outfitters, a lifestyle and outdoor brand…. ».

12 Continuez de lire l’interview et saisissez les points d’entrée et de sortie autour de la 
respiration, après « outdoor brand » et avant « That not only promotes…. ».

13 Appuyez de nouveau sur Majuscule-Supprimer pour supprimer et ripple la partie 
marquée de l’interview. Appuyez sur / (barre oblique) pour revoir la coupe et l’affiner 
en utilisant le mode Raccord fin.

Vous êtes dorénavant sans doute plus à l’aise avec ce type d’opération. Vous pouvez 
apporter des modifications au plan multicaméra de la même manière. Une fois le 
radio edit correctement réalisé, vous pouvez ajouter des angles supplémentaires du 
plan multicaméra.
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Échanger les angles multicaméras 
Il n’est pas nécessaire de réaliser les raccords multicaméras à la volée. Vous pouvez bien 
entendu passer d’un angle à un autre comme vous l’entendez.

1 Dans la timeline OMO Multicam EDIT, positionnez la tête de lecture sur la première 
coupe de l’interview.

2 Appuyez ensuite sur / (barre oblique) pour visualiser la coupe.

Aïe ! Vous êtes sans doute d’accord pour dire que ce jump cut est trop visible.

3 Dans la timeline, faites un clic droit sur le deuxième plan multicaméra et choisissez 
Changer d’angle de vue multicaméra > Vidéo 3 (Switch Multicam Clip Angle > Video 3).

4 Appuyez sur / (barre oblique) pour visualiser le raccord.
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En passant au troisième angle vidéo, vous avez recouvert le jump cut entre les deux 
parties de l’interview.

Vous pouvez continuer d’utiliser cette technique pour resserrer l’interview et la rendre 
plus intéressante.

5 Continuez de lire le plan multicaméra dans la timeline et arrêtez la lecture après que 
Chris ait dit « …give back… ».

6 Appuyez sur Command-B (macOS) ou Ctrl-B (Windows) pour ajouter une coupe à cet 
endroit du plan multicaméra.

7 Faites un clic droit sur le plan entrant à droite de cette nouvelle coupe, et choisissez 
Changer d’angle de vue multicaméra > Vidéo 2 (Switch Multicam Clip Angle > Video 2).
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8 Avec le mode Raccord fin sélectionné, rognez le plan multicaméra entrant de 21 
images jusqu’à ce que Chris dise « to our communities… » pour resserrer encore 
davantage l’interview.

9 Allez au début de la timeline et visionnez les changements apportés.

REMARQUE Les techniques ci-dessus permettent d’échanger la partie vidéo du 
plan multicaméra dans la timeline. Si vous voulez changer l’audio, faites un clic droit 
sur le plan audio et choisissez Changer l’angle multicaméra (Switch Multicam Clip 
Angle) pour trouver les angles de vues disponibles.

Affiner et aplatir les plans multicaméras
Maintenant que l’interview est bien positionnée et que la timeline comporte plusieurs 
angles de vue, il est temps de peaufiner le début et la fin de l’interview.

1 Appuyez sur Majuscule-Command-L (macOS) ou Majuscule-Ctrl-L (Windows) ou cliquez 
sur le bouton Relier la sélection (Linked Selection) pour désactiver cette fonctionnalité.

2 Assurez-vous que vous êtes bien en mode Raccord fin.

Pour commencer, vous allez régler la coupe entre l’interview et le dernier plan de 
la timeline.

3 Sélectionnez la coupe vidéo sortante entre le quatrième plan multicaméra et le plan 
SHIRT SIGN.
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4 Rognez la coupe vers l’arrière de 10 images pour créer un léger montage en L sur les 
derniers mots de Chris « …live in ».

5 Appuyez ensuite sur / (barre oblique) pour visualiser le raccord.

Ce changement simple a permis de créer un montage Split qui adoucit la fin de 
l’interview.

Maintenant, regardons le début de l’interview.

6 Avec le mode Rognage fin (Trim Edit) activé, sélectionnez le côté entrant du premier 
plan d’interview.

7 Positionnez la tête de lecture sur le premier plan d’interview, au moment où Chris dit 
« …Chris Lang…. ».
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8 Appuyez sur E pour appliquer un montage Déplacer la coupe (à la tête de lecture) 
(Extend Edit) et créer rapidement un montage Split.

9 Appuyez ensuite sur / (barre oblique) pour visualiser le raccord.

Le décalage d’une ou de deux images peut améliorer considérablement le rendu.

Quand vous montez des images multicaméras, les dernières étapes consistent à 
les aplatir afin de supprimer tous les angles inutilisés et de ne conserver que les 
plans actifs. 

ASTUCE Une fois aplatis, vous ne pouvez plus modifier les angles. Nous vous 
recommandons de dupliquer la timeline avant d’aplatir les plans multicaméra. 
De cette façon, une version non aplatie pourra être modifiée au besoin.

10 Appuyez sur la touche A pour passer en mode Sélection et sélectionnez tous les 
plans multicaméras de la timeline (audio et vidéo). Faites un clic droit sur un des plans 
sélectionnés et choisissez Aplatir le plan multicaméra (Flatten Multicam Clip).

Cette opération est importante pour plusieurs raisons. Tout d’abord, elle permet 
d’étalonner indépendamment les plans sur la page Étalonnage. S’ils n’avaient pas été 
aplatis, le plan multicaméra serait celui qui est étalonné, et non les angles individuels. 
Par ailleurs, si la configuration de canaux audio des plans multicaméras est complexe, 
l’aplatissement permet d’accéder à ces canaux.
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En filmant une interview avec plusieurs caméras, vous pouvez monter un film sans 
avoir recours à des solutions « cache-misère » (entre autres les plans de coupes ou les 
transitions Smooth Cut).

REMARQUE Si vous souhaitez visualiser la version finalisée du montage, 
sélectionnez le chutier TIMELINES et choisissez Fichier > Importer > Timeline 
(File > Import > Timeline). Ensuite, allez sur R18 Editors Guide/Lesson 05/
Timelines et ouvrez OMO MULTICAM EDIT FINISHED.drt.

Créer un clip musical multicaméra 
Dans le prochain exercice, vous allez retravailler un clip musical, qui vous permettra 
d’explorer des fonctionnalités plus poussées de montage multicaméra dans la page 
Montage. Vous allez commencer cet exercice en important un projet différent dans le 
gestionnaire de projet (Project Manager).

1 Pour ouvrir le gestionnaire de projet (Project Manager), choisissez Fichier > Project 
Manager (File > Project Manager) ou appuyez sur Majuscule-1.

2 Cliquez sur le bouton Importer (Import) ou faites un clic droit dans une zone vide de la 
fenêtre Gestionnaire de projet (Project manager), puis choisissez Importer un projet 
(Import Project).

3 Allez sur R18 Editors Guide/Lesson 5, sélectionnez le fichier 
MISERABLE GIRL MULTICAM.drp et cliquez sur Ouvrir (Open).

4 Une fois le projet importé, double-cliquez dessus pour l’ouvrir.

5 Cliquez sur le bouton Relier les médias (Relink Media).

Ce projet contient des images du groupe Jitterbug Riot en train de jouer la chanson 
« Miserable Girl ».

6 Sélectionnez le chutier Miserable Girl et visionnez la séquence.
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Ce chutier contient huit plans vidéo séparés du groupe. L’audio de ces plans a été 
enregistré par le micro intégré à la caméra. Un fichier audio .wav contient la version 
enregistrée en studio du morceau.

ASTUCE Vous pouvez activer ou désactiver le scrubbing audio en appuyant 
sur Majuscule-S.

7 Cliquez sur le plan JBR_01.mov pour le sélectionner. 

8 Ouvrez l’inspecteur et sélectionnez l’onglet Fichier (File).

L’inspecteur affiche alors les métadonnées du plan.

Dans l’inspecteur, vous voyez sans doute que ce plan comporte des métadonnées 
Caméra identifiées par « Caméra 01 ».
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9 En bas de la fenêtre, cliquez sur Plan suivant (Next Clip).

Dans le chutier, le plan suivant JBR_02.mov est sélectionné et ses métadonnées sont 
affichées dans l’inspecteur.

Vous voyez sans doute que ce plan comporte des métadonnées Caméra identifiées 
par « 08 » dans l’inspecteur. Les autres plans de ce chutier sont également identifiés 
par les métadonnées de la caméra.

10 Dans le chutier, sélectionnez Miserable Girl Final Mix.aif.
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11 Vous remarquerez sans doute que le plan ne comportant que de l’audio affiche la 
métadonnée « MUSIC ».

Créer un plan multicaméra
Comme dans l’exercice précédent, la première étape pour monter une séquence 
multicaméra consiste à synchroniser les plans. Dans l’exercice précédent, vous avez 
organisé les plans manuellement sur différentes pistes dans la timeline. Ensuite, Resolve 
les a synchronisés en utilisant le timecode. Dans cet exemple, vous allez laisser Resolve 
organiser le plan multicaméra en utilisant les métadonnées de la caméra.
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1 Faites un clic droit sur le chutier Miserable Girl et choisissez Créer un nouveau plan 
multicaméra avec le chutier sélectionné (Create New Multicam Clip Using Selected Bin).

REMARQUE Vous pouvez aussi créer un plan multicaméra à partir de plans 
sélectionnés individuellement au lieu de tout un chutier.

La fenêtre qui s’ouvre permet de créer un plan multicaméra et choisir la méthode de 
synchronisation.
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2 Dans le champ Plan Multicaméra (Multicam Clip), saisissez MISERABLE GIRL SYNC.

3 Dans le menu déroulant Synchronisation des angles (Angle Sync), choisissez 
Son (Sound).

En sélectionnant Son (Sound), les plans sont synchronisés en fonction de leur 
contenu audio.

REMARQUE Les options de synchronisation des plans multicaméras 
comprennent l’utilisation des points d’entrée et de sortie, ainsi que des 
timecodes et des marqueurs correspondants.

4 Réglez le menu Nom des angles (Angle Name) sur Metadonnées - Caméra 
(Metadata – Camera).

REMARQUE L’option Nom des angles (Angle Name) permet d’organiser les 
plans. Si vous choisissez l’option Séquentiel (Sequential), Resolve renomme 
les angles et les trie sous Angle 1, Angle2, etc., en fonction de leur timecode 
de départ. Si vous choisissez Nom du plan (Clip Name), les plans sont rangés 
en ordre alphanumérique et les angles sont renommés. De même, si vous 
choisissez de les trier par Métadonnées - Angle (Metadata – Angle) ou 
Métadonnées - Caméra (Metadata – Camera), ceux-ci sont rangés en fonction 
des métadonnées.

5 Assurez-vous que l’option Placer les plans sources dans le chutier « Plans originaux » 
(Move Source Clips to ‘Original Clips’ Bin) est sélectionnée.



203Montage Multicaméra en temps réel

6 Cliquez sur Créer (Create) pour créer le plan multicaméra.

Resolve analyse l’audio des plans et crée un nouveau plan multicaméra dans le chutier 
sélectionné. Un nouveau chutier appelé Plans originaux (Original Clips) apparaît 
également. Il contient les deux plans de l’interview.

Ce plan multicaméra est prêt à être monté.

Montage Multicaméra 
en temps réel
L’un des aspects amusants du montage multicaméra dans la page Montage, c’est de 
pouvoir réaliser les raccords en temps réel, comme si vous réalisiez un montage en direct. 
Bien maîtrisée, cette méthode en temps réel vous fera gagner de nombreuses heures de 
travail. Vous pourrez en effet réaliser votre montage à mesure que la timeline défile.

1 Double-cliquez sur le plan multicaméra Miserable Girl SYNC pour l’ouvrir dans le 
viewer source.
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Le plan multicaméra apparaît dans le viewer source et affiche les neuf plans (ou 
angles). On voit les métadonnées de la caméra correspondantes. Le viewer source 
organise les angles de gauche à droite et de bas en haut. Le premier angle, (dans ce 
cas JBR_01.mov identifié par « Camera 01 ») apparaît en haut à gauche et le neuvième 
angle (Miserable Girl Final Mix.aif identifié par « Camera MUSIC ») apparaît en bas à 
droite. Vous avez sans doute remarqué que le nom des angles porte les informations 
des métadonnées Camera #.

REMARQUE Si la tête de lecture se situe au début du plan multicaméra, vous 
verrez des images vides sur la plupart des angles. L’enregistrement n’a pas 
débuté au même moment. Déplacez la tête de lecture vers l’avant dans le plan 
multicaméra pour voir les images de tous les angles.

2 Lancez le plan multicaméra dans le viewer Source pour vérifier que tous les plans sont 
correctement synchronisés.

Comme Camera 01, dans le coin supérieur droit du viewer, est sélectionné par défaut, 
c’est l’angle que vous entendez quand vous lancez la lecture.

3 Positionnez la tête de lecture au début du plan multicaméra et saisissez le point 
d’entrée juste avant que la musique débute (autour de 01:00:19:00).
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4 Appliquez un montage Écraser (Overwrite) pour ajouter le plan dans la timeline 
MISERABLE GIRL EDIT vide, et appuyez sur Home pour positionner la tête de lecture 
au début de la timeline.

5 Cliquez sur la bibliothèque de médias et sur le bouton Inspecteur pour masquer ces 
panneaux et avoir un peu plus de place pour visionner les images.

Dans le viewer timeline, seul le premier angle Camera 01 est affiché, car il s’agit de la 
caméra active. Pour passer d’un angle de caméra à un autre et garder le viewer source 
synchronisé avec le plan timeline, vous devez activer le mode multicaméra dans le 
viewer source.

6 Pour ouvrir le mode multicaméra, choisissez l’option Multicaméra (Multicam) dans le 
menu déroulant du viewer source.

Le mode multicaméra remplace les commandes de transport sous le viewer par des 
commandes dédiées. Les commandes de transport ne sont plus nécessaires, car 
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quand vous déplacez la tête de lecture de la timeline, vous déplacez également les 
plans source dans le viewer multicaméra. De cette façon, les plans sont synchronisés.

7 Lancez la lecture et faites bien attention à la synchronisation dans le viewer timeline.
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8 Dans la timeline, faites un clic droit sur l’audio du plan multicaméra et choisissez 
Changer l’angle multicaméra > MUSIC (Switch Multicam Clip Angle > MUSIC).

L’audio du plan multicaméra change pour lire l’audio du fichier 
Miserable Girl Final Mix.aif, comme indiqué par le nom du plan dans la timeline.

Le viewer multicaméra affiche aussi un cadre vert autour de l’angle MUSIC pour 
indiquer qu’il s’agit de l’audio actif.
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9 Dans la timeline, faites un clic droit sur l’audio du plan multicaméra et choisissez 
Changer l’angle multicaméra > Camera 04 (Switch Multicam Clip Angle > Camera 04).

La vidéo dans le viewer timeline se met à jour pour afficher l’angle 4, et le viewer 
multicaméra affiche un cadre bleu autour de ce même angle pour indiquer qu’il s’agit 
de l’angle actif. 

Vous pouvez désormais dire à Resolve que vous ne voulez monter que la vidéo du plan 
multicaméra.

Sous le viewer multicaméra, vous verrez trois boutons qui représentent les options 
Vidéo uniquement, Vidéo et Audio et Audio uniquement.

10 Cliquez sur le bouton Vidéo uniquement à gauche pour ne modifier que la vidéo de ce 
plan multicaméra.

Et maintenant, amusons-nous un peu.
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11 Placez la tête de lecture au début de la timeline, cliquez sur le bouton lecture et 
cliquez sur les différents angles dans le viewer source pour les monter les uns à la 
suite des autres. Les points de coupe apparaissent dans la timeline au fur et à mesure. 
Continuez jusqu’à ce que vous atteigniez la fin de la timeline.

REMARQUE Vous pouvez aussi appuyer sur les touches 1, 2 et 3 pour monter 
les angles, au lieu de cliquer sur les vignettes dans le viewer.

12 Une fois la chanson terminée, placez la tête de lecture au début de la timeline et lancez 
la lecture pour visualiser le rendu.

Pratique, non ? 

Malheureusement, même si c’était amusant, il est très rare que les premières tentatives de 
montage multicaméra en temps réel soient réussies. 

Voyez-le plutôt comme un bout à bout qu’il va falloir améliorer.
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Techniques de montage multicaméra
Quand vous montez des images multicaméras, n’essayez pas d’avoir un rendu 
parfait du premier coup. Il vaut mieux vous concentrer sur le rythme de la 
musique et sur les différents angles des caméras. Nous vous recommandons de 
visionner les plans multicaméras plusieurs fois avant de réaliser votre première 
coupe. Quand vous commencez le montage, essayez de faire des coupes en 
fonction de ce que vous ressentez et n’ayez pas peur de faire des erreurs. Vous 
apprendrez à affiner les coupes dans les prochains chapitres.

Si vous trouvez qu’il est difficile de travailler sur autant d’angles à la fois, réduisez 
le nombre d’angles affichés. Pour cela, cliquez sur le menu contextuel Multicaméra 
(Multicam) en bas à droite du viewer source et choisissez 2x2. Cette option affiche 
les quatre premiers angles du plan multicaméra. Les angles restants se trouvent 
sur les autres pages. 

En réduisant le nombre d’angles sur lequel vous travaillez, vous serez peut-être 
moins intimidé. Vous pouvez ajouter progressivement les autres angles. Cela 
permet également d’avoir de meilleures performances de lecture en temps réel 
sur les systèmes moins puissants.

Vous pouvez utiliser les métadonnées (comme vous l’avez appris dans la section 
« Ajuster un plan multicaméra » de ce chapitre) pour identifier les plans les plus 
importants de 1 à 4, puis les réorganiser.

Affiner un montage multicaméra
Maintenant que vous avez réalisé le bout à bout, vous vous apercevrez sans doute que les 
raccords n’ont peut-être pas été appliqués au bon endroit ou que vous avez sélectionné le 
mauvais angle de vue.

Ou les deux !

Mais ne vous inquiétez pas, vous n’êtes pas en direct, vous pouvez donc changer d’avis 
sans que personne ne s’en aperçoive. Corriger le problème de la coupe au mauvais endroit 
est assez simple. D’ailleurs, vous savez déjà comment modifier les points de coupe en 
réalisant un simple raccord Roll.

Le deuxième problème (un mauvais angle de vue a été utilisé) est facile à régler en 
échangeant les angles dans le viewer source.
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ASTUCE Lorsque vous travaillez en mode multicaméra, faites bien attention à 
ce que les angles soient synchronisés. Ainsi, il n’est sans doute pas judicieux de 
raccorder les plans avant d’être sûr de bien maîtriser les raccords Ripple, par 
coulissement ou par glissement et d’avoir bien pris connaissance des images.

1 Dans la timeline, lancez le montage multicaméra jusqu’à ce que vous voyiez une 
séquence que vous voulez changer. Interrompez alors la lecture. 

Pendant la lecture, le viewer source se met également à jour. En effet, en mode 
Multicaméra, le viewer source est lié à la position de la timeline.

2 Dans le viewer multicaméra, faites Option clic (macOS) ou Alt clic (Windows) sur les 
différents angles.

Lorsque vous sélectionnez un nouvel angle de vue, le pointeur de la souris se 
transforme en icône de replacement.

Cet outil sert à ajouter de nouveaux raccords au montage multicaméra.
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3 Dans la timeline, placez la tête de lecture au milieu d’un des plans multicaméra et dans 
le viewer source, cliquez sur un autre angle.

Un nouveau point de coupe apparaît sous la tête de lecture et remplace le reste du 
plan multicaméra par ce nouvel angle de vue.

ASTUCE Appuyez sur les touches 1, 2, 3, etc. pour appliquer des coupes au 
niveau de la tête de lecture dans la timeline. Appuyez sur Option (macOS) ou Alt 
(Windows), puis choisissez un chiffre pour échanger l’angle du plan multicaméra 
sur la timeline. Vous pouvez réaliser cela pendant la lecture ou lorsque la tête de 
lecture est à l’arrêt.

Parfait ! Vous avez eu un bon aperçu du fonctionnement d’un montage multicaméra sur 
Resolve. Mais avant de continuer, vous allez apprendre d’autres techniques pour modifier 
les plans multicaméra.
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Montage multicaméra avec le Speed Editor
Sur la page Montage, la fonctionnalité Speed Editor de DaVinci Resolve 18 a été 
améliorée pour le montage multicaméra.

Le bouton Chutier synchro active le 
mode multicaméra du viewer source.

Appuyer deux fois et maintenir 
enfoncé pour redimensionner la 
timeline avec la molette de la souris.

Les boutons CAM# pour changer d’angles : 
Appuyer sur # pour couper sur le numéro de l’angle. 

Appuyer deux fois sur # pour échanger l’angle.
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Ajuster un plan multicaméra
Un plan multicaméra est en fait un type de conteneur de timeline, comme le serait un plan 
composé. Vous travaillerez sur les plans composés au chapitre 7 « Créer une composition 
dans la page Montage », mais pour le moment, sachez que vous pouvez ouvrir le plan 
multicaméra sur sa propre timeline afin d’y appliquer des modifications, par exemple, 
modifier l’ordre des angles ou leur nom.

1 Cliquez sur le bouton Affichages de la timeline (Timeline View Options) et choisissez la 
première option pour activer la superposition des timelines.

La timeline actuelle apparaît comme un onglet individuel en haut de la 
fenêtre timeline.
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2 Sélectionnez un plan multicaméra dans la timeline et choisissez Plan > Ouvrir dans la 
timeline (Clip > Open in Timeline) ou faites un clic droit sur un des plans multicaméras 
et choisissez Ouvrir dans la timeline (Open in Timeline).

Le plan multicaméra s’ouvre dans un onglet.

3 Pour bien voir toutes les pistes, réduisez la hauteur des pistes vidéo et audio au 
minimum et agrandissez la taille de la fenêtre timeline en tirant vers le haut la ligne de 
division entre les viewers et la barre d’outils.

Vous pouvez voir comment Resolve organise un plan multicaméra. La méthode est 
assez proche de la façon dont les plans d’interview de Chris ont été arrangés avant 
de créer le premier plan multicaméra de ce chapitre. L’organisation est simple : Le 
contenu des pistes Vidéo 1 et Audio 1 correspondent à l’angle 1. De la même façon, le 
contenu de la piste Vidéo 2 correspond à l’angle 2, etc. Vous remarquerez que le nom 
de la piste correspond au nom des angles affichés dans le viewer source multicaméra.
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REMARQUE Vous voyez que la piste V9 est vide. La raison, c’est que l’audio 
Miserable Girl Final Mix.aif se trouve sur la piste A9. La musique est donc 
disponible sur l’angle 9.

Vous allez maintenant ajouter un angle et changer l’ordre des angles dans le plan 
multicaméra.

4 Dans l’en-tête des pistes de la timeline, faites un clic droit et choisissez Ajouter un 
angle (Add Angle).

Un nouvel angle est ajouté (sur V10 et A10), appelé Angle 10.

5 Dans la bibliothèque de médias, sélectionnez le chutier Extra Angle.

Un dixième angle, non utilisé pour l’instant se trouve dans le chutier JBR_09.mov.
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6 Tirez le plan JBR_09.mov sur la nouvelle timeline multicaméra V10.

7 Refermez la bibliothèque de médias.

Vous allez maintenant devoir synchroniser ce nouvel angle avec les autres angles de 
cette timeline.

8 Assurez-vous que l’option Lier la sélection (Link Selection) est activée, sélectionnez 
le plan sur V10/A10 et appuyez sur la touche Majuscule en cliquant sur un autre plan 
dans la timeline.

9 Faites un clic droit sur une des vidéos et choisissez Plans alignés automatiquement > 
En fonction de la forme d’onde (Auto Align Clips > Based on Waveform).
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Resolve synchronise instantanément le nouvel angle avec les autres.

Vous allez maintenant renommer le nouvel angle pour être sûr que le plan 
multicaméra est bien organisé. 

10 Faites un clic-droit sur l’en-tête de la piste pour V10 et choisissez Déplacer l’angle vers 
le bas (Move Angle Down).

Resolve réorganise les angles V10 et V9 (ainsi que A10 et A9).

En revanche, vous voyez sans doute que le nouvel angle est appelé Angle 10.
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11 Cliquez sur le nom du plan et saisissez Camera 09 pour qu’il s’harmonise avec les 
autres noms des angles.

Vous pouvez désormais utiliser ce nouvel angle pour votre montage multicaméra.

12 Avec le bouton central de la souris, cliquez sur l’onglet de la timeline MISERABLE GIRL  
SYNC pour refermer la timeline du plan multicaméra et retournez sur la timeline 
principale.

13 Redimensionnez la fenêtre timeline pour la réduire. Vous n’avez plus besoin de voir 
toutes les pistes.

14 Pour ouvrir le mode multicaméra, choisissez l’option Multicaméra (Multicam) dans le 
menu déroulant du viewer source.

Le viewer multicaméra affiche désormais le nouvel angle de caméra sous Camera 09.

15 Dans le menu déroulant, choisissez 3x3 pour voir les neuf angles vidéo. L’angle 
MUSIC est accessible via les commandes de la page Multicaméra qui apparaissent à 
gauche du menu déroulant, disponibles quand le nombre d’angles est plus élevé que 
l’affichage le permet.

REMARQUE Même si les plans multicaméras peuvent avoir un nombre illimité 
d’angles, le nombre maximum d’angles qu’il est possible d’afficher sur un 
seul écran est de 5x5 (25). Tout angle supplémentaire sera affiché dans les 
« pages » suivantes.
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16 Regardez de nouveau votre montage et faites les derniers petits réglages. N’oubliez 
pas d’inclure le nouvel angle de la caméra et d’aplatir les plans multicaméra une fois 
que vous avez fini.

REMARQUE Si vous souhaitez visualiser la version finalisée du montage, 
sélectionnez le chutier TIMELINES et choisissez Fichier > Importer > 
Timeline (File > Import > Timeline). Ensuite, allez sur R18 Editors Guide/
Lesson 05/Timelines. Vous y trouverez deux versions de la timeline finalisée. 
MISERABLE GIRL FINISHED.drt est une version montée que vous pouvez 
utiliser pour vous entrainer. Cette timeline importera également le plan 
multicaméra associé, car il s’agit d’un plan différent de celui que vous avez créé 
dans ce chapitre. MISERABLE GIRL FINISHED_FLATTENED.drt correspond au 
même montage, mais il a été aplati. Les angles de remplacement ne sont donc 
plus disponibles. 

Félicitations ! Vous avez désormais les compétences pour bien gérer les montages 
multicaméras dans la page Montage de DaVinci Resolve. 

Lorsque vous montez des projets multicaméras en temps réel, il est important d’adapter 
vos coupes au rythme du programme. Essayez plusieurs techniques de montage pour 
créer le film que vous avez en tête. Mais quelle que soit la manière dont vous montez 
le projet, chaque coupe nécessitera plusieurs retouches avant d’être à la hauteur de 
vos attentes.
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Révision
1 De quelles options disposez-vous pour synchroniser les angles d’un plan multicaméra 

qui ne comporte pas de son ?

a) Les points d’entrée ou de sortie

b) Les marqueurs

c) Le timecode

2 Quel est le nombre maximum d’angles que vous pouvez visualiser simultanément dans 
un plan multicaméra ?

a) 9

b) 16

c) 25

3 Quelle touche doit-on maintenir enfoncée pour passer du plan multicaméra à un autre 
angle, au lieu d’ajouter un point de coupe ?

a) Cmd (macOS) ou Ctrl (Windows)

b) Opt (macOS) ou Alt (Windows)

c) Majuscule

4 Vrai ou faux ? Il est impossible de changer le nom ou l’ordre des angles ou encore 
d’ajouter de nouveaux angles sur un plan multicaméra existant.

5 Vrai ou faux ? Lorsque vous choisissez d’aplatir un plan multicaméra, vous perdez tous 
les angles synchronisés dans le ou les plan(s) multicaméra(s) de la timeline.
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Réponses
1 a), b) et c) En plus du son, vous pouvez choisir de synchroniser les angles avec les 

points d’entrée et de sortie, le timecode ou les marqueurs. 

2 c) 25. Le nombre d’angles de vue maximal par page est de 25 (5x5).

3 b) Il faut appuyer sur Option (macOS) ou Alt (Windows) et cliquer sur un angle pour 
passer d’un angle à un autre. 

4 Faux. Faites un clic droit sur un plan multicaméra et choisissez Ouvrir dans la timeline 
pour le modifier.

5 Vrai. En aplatissant un plan multicaméra, tous les angles non utilisés sont supprimés et 
seuls les angles actifs sont conservés sur la timeline.
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DaVinci Resolve dispose d’une page spécifique pour vous aider à préparer et à organiser 
les médias de votre projet : la page Média. C’est là que vous aurez le plus d’espace pour 
explorer les plans sur lesquels vous devez travailler, sans voir la fenêtre timeline, les 
commandes d’étalonnage et les mixeurs audio.

Mais ne vous y méprenez pas, l’organisation d’un projet ne se limite pas au début d’un 
projet. Il s’agit d’un processus au long cours, qui démarre à l’importation des plans et se 
termine quand vous les exportez. Ainsi, même si ce chapitre est conçu pour mettre en 
valeur les fonctionnalités de la page Média, la plupart des étapes présentées peuvent être 
réalisées directement dans la page Montage.

Afin de pouvoir suivre ces étapes et de les appliquer à vos propres projets, vous allez 
configurer un nouveau projet et importer les images de la publicité Organ Mountain 
Outfitters, sur laquelle vous avez travaillé au chapitre 1.

Créer un nouveau projet et 
régler les paramètres de projet
La première étape pour tout nouveau projet consiste à créer un nouveau projet dans le 
Gestionnaire de projet.

1 Ouvrez DaVinci Resolve et, dans la fenêtre Gestionnaire de projet (Project manager), 
choisissez Nouveau Projet (New Project).

2 Dans la fenêtre Créer un nouveau projet, saisissez My Project comme nom pour 
ce projet.

3 Cliquez sur Créer (Créer).

4 Cliquez sur l’onglet de la page Média, et choisissez Espace de travail > Réinitialiser 
l’espace de travail (Workspace > Reset UI Layout).

Comme mentionné dans l’introduction de ce chapitre, la page Média permet de 
revoir et d’organiser les médias sources, en particulier les vidéos, les audios et les 
éléments graphiques.
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Emplacements des 
espaces de stockage

Navigateur Espaces 
de stockage Viewer Audio

Liste des chutiers Bibliothèque de médias Métadonnées

Quand vous créez un nouveau projet dans DaVinci Resolve, il comporte des 
paramètres par défaut. La prochaine étape consiste à vérifier ces paramètres de base.

5 Pour ouvrir la fenêtre Paramètres du projet (Project Settings), choisissez Fichier > 
Paramètres du projet (File > Project Settings) ou appuyez sur Majuscule-9.
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En tant que monteur, les principaux paramètres sur lesquels il faut s’attarder se 
trouvent dans la Configuration du projet (Master Settings). Ce groupe de paramètres 
principaux inclut Paramètres de la timeline (Timeline Settings) et Monitoring vidéo 
(Video Monitoring).

Par défaut, tous les projets ont une résolution de la timeline de 1920 x 1080 HD et une 
fréquence d’images de 24 images par seconde. Ce sont donc cette résolution et cette 
fréquence d’images qui seront utilisées quand vous créez une nouvelle timeline avec 
l’option Paramètres du projet (Project Settings). Ces paramètres peuvent être modifiés 
quand vous créez une nouvelle timeline. Chaque timeline d’un projet peut être réglée 
différemment, mais la plupart des projets ont tendance à avoir les mêmes réglages, 
il est donc utile de configurer les paramètres généraux dans la fenêtre Paramètres du 
projet (Project Settings).

Quels paramètres faut-il utiliser ? Eh bien, cela dépend principalement de la 
destination de l’exportation. Par exemple, si vous travaillez sur un long métrage, 
il faudra sans doute exporter la timeline en 3840 x 2160 Ultra HD à 24 images par 
seconde. S’il s’agit d’un projet télé, alors la timeline devrait être en 1920 x 1080 HD 
à 29.97 images par seconde (ou 25 images par seconde pour le Royaume-Uni et 
l’Europe), en revanche, si vous exportez pour le streaming en ligne (YouTube ou 
Vimeo par exemple), le choix sera plus vaste et devra être fait en fonction des images 
sources. En cas de doute, n’hésitez pas à parler avec le réalisateur pour déterminer les 
meilleurs paramètres pour le projet.

REMARQUE Si vous réalisez des projets pour la télé, vous devrez travailler 
en format entrelacé, ce que DaVinci Resolve prend parfaitement en charge. 
Pour activer cette option, sélectionnez Activer le traitement entrelacé (Enable 
interlace processing) dans la section Format de la timeline (Timeline Format) 
des Paramètres du projet (Project Settings) ou dans l’onglet Format de la 
fenêtre Nouvelle timeline (New Timeline). La fréquence d'images des timelines 
entrelacées est mesurée en trames par seconde, et peut être réglée sur 50, 
59.94 ou 60, soit 25, 29.97 et 30 images par seconde. Tous les éléments d’une 
timeline entrelacée, y compris les graphiques, les compositions Fusion et les 
plans vidéo, sont gérés au niveau de la trame pour des compositions et des 
titrages haute qualité.

Bien que les images de ce projet, prévu pour être diffusé sur des plateformes de 
streaming, aient été tournées en différentes résolutions et fréquences d’images, 
l’enregistrement principal a été filmé en 1920 x 1080 HD à 23.976 images par seconde. 
C’est donc avec ces paramètres que vous allez travailler.
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6 Sélectionnez 1920 x 1080 HD dans le menu déroulant Résolution de la timeline 
(Timeline Resolution) et 23.976 images par seconde dans Fréquence d'images de 
la timeline (Timeline Frame Rate).

REMARQUE Quand vous changez le nombre d’images par seconde, les 
options Fréquence d'images de lecture (Playback Frame Rate) et Format 
vidéo (Video Format) dans la section Monitoring vidéo (Video Monitoring) 
changent également. En général, c’est la bonne méthode, mais parfois il peut 
être préférable d’ajuster séparément ces paramètres. En particulier si vous 
travaillez sur une résolution ou une fréquence d’images non prise en charge 
par l’appareil de monitoring.

Enregistrer les paramètres de 
projet et les paramètres par défaut
Si vous travaillez souvent sur des projets dont le réglage du format de la timeline est 
différent du réglage standard (1920 x 1080 HD à 24 Im/s) ou s’il doit être réglé en fonction 
des projets, il peut être utile de sauvegarder différents paramètres pour les retrouver 
facilement. Vous pouvez aussi choisir d’enregistrer les préréglages par défaut pour qu’ils 
soient appliqués à tous les nouveaux projets de la bibliothèque de projet (Project Library).
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1 Cliquez sur le menu Option dans la fenêtre Paramètres du projet (Project Settings) 
et choisissez Sauvegarder les paramètres actuels comme préréglage (Save Current 
Settings as Preset).

2 Dans la fenêtre Nom du préréglage (Preset Name), saisissez 1080p23.976 et 
cliquez sur OK.

Tous les paramètres du projet actuel ont été enregistrés comme préréglage. 

3 Cliquez de nouveau sur le menu Options (…) et choisissez Préréglage par défaut > 
Charger le préréglage (Default Preset > Load Preset) pour charger les paramètres par 
défaut, et remettre les paramètres Format de la timeline (Timeline Format) sur les 
valeurs initiales.

4 Cliquez sur le menu Options (…) et choisissez 1080p23.976 > Charger le préréglage 
(Load Preset) pour le charger.

REMARQUE L’enregistrement des préréglages d’un projet sauvegarde tous 
les paramètres dans la fenêtre Paramètres du projet (Project Settings), et pas 
uniquement ceux qui se trouvent dans les paramètres Master (Master Settings). 

Vous pouvez aussi exporter les préréglages du projet pour charger rapidement les 
mêmes paramètres sur un autre logiciel DaVinci Resolve 18.
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5 Cliquez sur le menu Options et choisissez 1080p23.976 > Exporter le préréglage 
(Export Preset).

6 Dans le champ Enregistrer sous (Save As), saisissez 1080p23.976, choisissez 
un emplacement, et cliquez sur Sauvegarder (Save) pour sauvegarder le fichier 
.preset exporté.

REMARQUE Pour importer ce fichier .preset sur un autre logiciel 
DaVinci Resolve 18, sélectionnez le menu Options dans Paramètres du projet 
(Project Settings) et choisissez Importer le préréglage (Import Preset).

Vous pouvez aussi choisir des préréglages enregistrés pour tous les projets 
DaVinci Resolve dans la bibliothèque de projet (Project Library) actuelle. 

7 Cliquez sur le menu Options (…) des paramètres du projet (Project Settings) et 
choisissez 1080p23.976 > Régler comme paramètre par défaut (Set as Default Preset).

Une fenêtre s’ouvre pour confirmer si vous voulez vraiment choisir 1080p23.976 
comme préréglage par défaut pour tous les projets.

8 Cliquez sur Configurer (Set).

À partir de maintenant, tous les projets créés dans la bibliothèque de projet utiliseront 
ce préréglage par défaut.
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Importer des médias
Il existe plusieurs façons d’importer des fichiers dans un projet DaVinci Resolve. Par 
exemple, vous pouvez choisir Fichier > Importer > Médias (File > Import > Media) sur 
toutes les pages qui comportent le bouton Bibliothèque de médias (toutes sauf la page 
Exportation). Vous pouvez aussi faire glisser les plans directement du Finder (macOS) ou 
d’Explorer (Windows) vers la bibliothèque de médias. Ces deux techniques offrent des 
options limitées. Par contre, la page Média est très performante en termes d’importation 
des plans.

REMARQUE Quand vous importez les médias, DaVinci Resolve crée un lien vers le 
plan d’origine sur le disque dur. Le processus d’importation ne copie, ne déplace ou 
ne convertit en aucun cas les médias sources.

1 Dans l’espace de stockage (Media Storage), allez sur le dossier R18 Editors Guide > 
Media > Organ Mountain Outfitters.

Le navigateur de l’espace de stockage affiche quatre dossiers contenant les plans 
utilisés dans la publicité Organ Mountain Outfitter. 

2 Double-cliquez sur le dossier INTERVIEW pour l’ouvrir.

Ce dossier contient deux dossiers supplémentaires : AUDIO et VIDÉO. 
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3 Ouvrez le dossier VIDÉO et déplacez la souris sur un des plans pour le visionner dans 
le viewer.

ASTUCE Vous pouvez désactiver et activer la prévisualisation en direct via le 
menu Options du viewer (…).

4 Sélectionnez un plan pour l’afficher dans le viewer.

Quand un plan est sélectionné, le panneau des métadonnées affiche les informations 
concernant le plan (codec, résolution, fréquence d’image et nombre de canaux audio). 
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5 Appuyez sur la barre d’espace ou sur la touche L pour lire le plan dans le viewer.

En cours de lecture, vous voyez que le panneau Audio affiche les niveaux des canaux 
audio intégrés.

REMARQUE Les raccourcis clavier pour lire les plans sont les mêmes sur la 
page Média et sur la page Montage.

6 Dans le navigateur de l’espace de stockage, cliquez deux fois sur le bouton de retour 
pour retourner sur le dossier Organ Mountain Outfitters.

7 Double-cliquez sur le dossier B-ROLL pour afficher les plans qui se trouvent dans 
le dossier.

8 Au-dessus du navigateur, cliquez sur l'icône Liste (List).

Cet affichage montre davantage d’informations que l’affichage par vignette. Vous 
voyez en effet que la résolution de ces plans est de 3840 x 2160 et la fréquence 
d’images à 23.976 ou 59.94 Im/s. Ainsi, en utilisant le navigateur de l’espace de 
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stockage, vous pouvez accéder aux images que vous avez précédemment importées 
et même choisir quel plan vous voulez importer dans le projet. Les autres méthodes 
d’importation sont moins utiles.

9 Cliquez sur le bouton de retour pour retourner sur le dossier précédent.

10 Sélectionnez les quatre dossiers dans le dossier Organ Mountain Outfitter.

11 Faites un clic droit sur un des dossiers sélectionnés pour afficher les options 
d’importation.

Il y a trois options principales pour importer les plans du navigateur de 
l’espace de stockage :

 — Ajouter le dossier à la bibliothèque de médias (Add Folder into Media Pool) 
importe le contenu sous le dossier sélectionné.

 — Ajouter le dossier et les sous-dossiers à la bibliothèque de médias (Add 
Folder and SubFolders into Media Pool) importe le contenu du dossier actuel 
et tous les sous-dossiers qu’il contient. Cela revient à faire glisser un dossier du 
navigateur de l’espace de stockage, du Finder (macOS) ou d’Explorer (Windows) à la 
bibliothèque de médias. Il s’agit d’une option utile pour importer plusieurs fichiers 
provenant de différents dossiers à partir d’une carte caméra à la structure de 
répertoire complexe.

 — Ajouter le dossier et les sous-dossiers à la bibliothèque de médias (Créer des 
chutiers) (Add Folder and SubFolders into Media Pool (Create Bins)) importe 
le contenu du dossier actuel et tous les dossiers qu’il contient. Elle conserve la 
structure du dossier et crée des chutiers. Cette option est particulièrement utile si 
vous voulez importer plusieurs plans déjà organisés sur le disque dur.

12 Choisissez Ajouter le dossier et les sous-dossiers à la bibliothèque de médias (Créer 
des chutiers) (Add Folder and SubFolders into Media Pool (Create Bins)).
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REMARQUE Si une fenêtre s’ouvre pour confirmer ou non le changement 
de fréquence d’images du projet (mais que vous avez déjà réglé le projet sur 
23.976 Im/s), cliquez sur Ne pas changer (Don’t Change), sinon, le projet sera 
converti en 59.94 Im/s.

Les plans sont ajoutés à la bibliothèque de médias dans une série de chutiers qui 
reflète la structure du dossier Organ Mountain Outfitters. 

Générer des fichiers proxys
Les fichiers vidéo numériques modernes sont très complexes et contiennent une grande 
quantité d’informations, comme vous pouvez le voir par leur taille, allant souvent de 
dizaines de gigaoctets (Gb) à des téraoctets. 

En dehors de l’étape d’étalonnage, il est déconseillé de travailler sur les médias originaux, 
car ils réduisent les performances de votre ordinateur. Les essais de différentes prises, le 
rognage et le réglage des plans demandent de la réactivité. Un ordinateur qui n’arrive pas 
à traiter les médias efficacement ou un disque dur trop lent pour lire les images dans la 
résolution choisie mettraient votre patience à l’épreuve.

Resolve propose une méthode pratique pour créer des plans de basse résolution en 
médias proxys tout en conservant un lien vers les médias originaux. Générer des médias 
proxys permet d’accélérer la vitesse du montage, mais aussi de conserver à portée de 
main les médias originaux pour l’étalonnage ou les travaux de VFX.

Vous pouvez générer les fichiers proxys directement de DaVinci Resolve ou utiliser le 
Blackmagic Proxy Generator. Les deux ont des avantages. Le choix repose surtout sur 
votre workflow.
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Utiliser le Blackmagic Proxy Generator 
Le Blackmagic Proxy Generator est un programme indépendant installé en même temps 
que DaVinci Resolve et qui permet de créer automatiquement des médias proxys des 
fichiers vidéo sources dans un dossier dédié. Le Proxy Generator est une application 
légère qui travaille en arrière-plan. DaVinci Resolve reconnaît automatiquement les médias 
proxys et s’en sert à mesure qu’ils deviennent disponibles. En outre, le Proxy Generator 
permet de gérer les fichiers proxys rapidement et sans effort.

REMARQUE Si vous utilisez la version gratuite de DaVinci Resolve, le programme 
Proxy Generator s’appellera alors Blackmagic Proxy Generator Lite.

1 Ouvrez l’application Blackmagic Proxy Generator. Si une fenêtre s’ouvre, cliquez sur 
Annuler (Cancel).

Le Proxy Generator est un programme assez simple.

La première étape consiste à configurer le dossier de contrôle. Un dossier de contrôle 
est un simple dossier sur votre ordinateur qui contient tous les fichiers sources.
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2 Cliquez sur le bouton Ajouter (Add) pour ajouter un dossier de contrôle.

3 Allez sur R18 Editors Guide/Media/Organ Mountain Outfitters/B-ROLL et cliquez sur 
Ouvrir (Open). 

Le dossier de contrôle est ajouté à la liste, où l’on voit le volume, le dossier en question 
et son statut. Vous pouvez ajouter autant de dossiers de contrôle que vous voulez à 
cette liste. 

ASTUCE Vous pouvez faire glisser les dossiers directement sur la liste des 
dossiers de contrôle du Finder (macOS) ou d’Explorer (Windows).

Vous pouvez choisir un des quatre préréglages (trois pour les utilisateurs Windows) 
pour vos médias proxys. La valeur en bas à droite de la liste des dossiers de contrôle 
indique l’espace vide nécessaire pour générer les proxys sur l’emplacement choisi.

4 Dans la section Format proxys, choisissez l’option H.264 8 bits 4:2:0 Demi 
résolution 1080p.
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Cette option crée un média proxy d’une résolution équivalente à la moitié de 1080 
HD (960 x 540) et utilise le codec vidéo H.264. Cette configuration sera utile pour le 
montage, mais pas pour l’étalonnage, en particulier à cause du sous-échantillonnage 
chroma 4:2:0 et 8 bits de ce fichier.

5 Cliquez sur Démarrer (Start).

Le Proxy Generator démarre le traitement des plans sources dans le dossier de 
contrôle, plaçant le média proxy généré au même emplacement que le média source. 
Cela permet à Resolve de voir automatiquement les bons médias proxys pour les plans 
dans ce dossier source.

6 Retournez sur DaVinci Resolve et sélectionnez le chutier B-ROLL dans la bibliothèque 
de médias.
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REMARQUE À moins ce que vous cliquiez sur le bouton d’arrêt, le Proxy 
Generator continue de surveiller les dossiers de contrôle que vous avez choisis. 
Si un nouveau fichier source est placé dans un de ces dossiers, le média proxy 
sera automatiquement généré sans devoir relancer le processus.

Les plans de ce chutier comportent une icône qui indique qu’un média proxy y est 
associé. Cette icône sera affichée sur tous les plans de la bibliothèque de médias, sur 
la page Montage et sur les timelines de la page Étalonnage, dès que Resolve utilisera 
le média proxy d’un plan.

7 Dans la bibliothèque de médias, cliquez sur l'icône Liste (List).

8 Faites un clic droit en haut de la colonne Nom du plan (Clip Name), et dans la liste qui 
apparaît, sélectionnez la colonne Proxy.

La colonne Proxy apparaît à droite de la colonne Nom du plan (Clip Name) et de 
la résolution du fichier. Resolve utilise désormais les fichiers proxys H.264 d’une 
résolution plus basse quand ces plans sont lus. Cela signifie que la lecture en temps 
réel sera plus fluide, vous donnant ainsi l’occasion de vous concentrer sur le montage.
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REMARQUE Dans notre exemple, les colonnes affichent encore les résolutions 
et les codecs des médias originaux. Souvenez-vous que les médias proxys 
n’ont pas remplacé les fichiers originaux. Ils ont été créés sur votre disque dur 
et sont reliés à ces plans. Resolve affiche donc toujours les paramètres des 
fichiers originaux.

La génération des médias proxys par le Proxy Generator est facile et rapide. 
L’utilisation de fichiers de qualité moindre permet d’améliorer le workflow de montage, 
en particulier si vous utilisez des médias sources de haute qualité et à haute fréquence 
d’images. En revanche, il faudra faire attention à ne pas utiliser les médias proxys par 
inadvertance pendant l’étalonnage. Vous pouvez facilement passer des médias proxys 
aux fichiers d’origine dans le menu Lecture (Playback).

9 Choisissez Lecture > Gestion des proxys > Désactiver Tous les proxys (Playback > 
Proxy Handling > Disable All Proxies).

Les icônes de ces plans dans la bibliothèque de médias reviennent à leur statut 
normal, indiquant que les fichiers proxys ne sont plus utilisés. En revanche, ils 
restent disponibles.



240 Chapitre 6 Organisation du projet

10 Choisissez Lecture > Gestion des proxys > Préférer les proxys (Playback > Proxy 
Handling > Prefer Proxies) pour réactiver les proxys pour ce projet.

Vous pouvez aussi utiliser le Proxy Generator pour gérer les médias proxys.

11 Retournez sur l’application Blackmagic Proxy Generator et cliquez sur Stop.

12 Sélectionnez le dossier B-ROLL dans la liste des dossiers de contrôle et cliquez sur 
Afficher (Show).

Le Finder (macOS) ou l’Explorer (Windows) s’ouvre et affiche le dossier B-ROLL.
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13 Ouvrez le dossier pour afficher le sous-dossier Proxy contenant les proxys.

14 Dans le Proxy Generator, cliquez sur Supprimer les proxys (Delete Proxies).
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15 Une fenêtre d’avertissement vous demande de confirmer si vous voulez supprimer 
tous les dossiers et les plans proxys.

Ne vous inquiétez pas ! Cet avertissement ne fait référence qu’aux fichiers et aux 
dossiers proxys. Les plans sources originaux ne seront pas supprimés.

16 Cliquez sur Supprimer (Delete), puis sur Terminer (Done).

Les proxys et le sous-dossier sont immédiatement supprimés.

17 Pour générer de nouveau les fichiers proxys dans le dossier de contrôle, cliquez sur 
Démarrer (Start).

REMARQUE Le Proxy Generator comporte également un bouton pour 
Extraire les proxys (Extract Proxies). Cela permet de copier les proxys du 
dossier de contrôle sélectionné vers l’emplacement de votre choix. Cette option 
peut être utile pour créer un dossier séparé contenant uniquement les proxys. 
De cette façon, vous pouvez facilement le transférer via le cloud ou le donner 
sur un disque dur à un autre monteur.
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Générer les médias proxys à partir 
de la bibliothèque de médias
Le Proxy Generator est un outil pratique et intuitif pour créer rapidement des médias 
proxys. En revanche, il existe une alternative pour les créer directement à partir de la 
bibliothèque de médias dans Resolve. Cela peut être utile si vous voulez générer des 
médias proxys pour un nombre limité de plans. En effet, le Proxy Generator génère des 
proxys pour tous les médias dans le dossier de contrôle.

1 Dans Davinci Resolve, appuyez sur Majuscule-9 pour ouvrir les paramètres de projet.

2 Dans les Paramètres Master, faites défiler la fenêtre jusqu’à la section Média optimisé 
et rendu (Optimized Media and Render Cache), qui inclut les paramètres pour créer les 
médias proxys.

3 Réglez le menu déroulant Résolution des médias proxys (Proxy media resolution) sur 
Quart (Quarter).



244 Chapitre 6 Organisation du projet

Ce réglage créera des médias proxys dont la résolution est d’un quart celle du fichier 
source. Ce paramètre est relatif, ainsi la résolution des proxys émanant des médias de 
1080 HD sera de 480 x 720, et celle des plans UHD sera de 960 x 540.

4 Réglez le menu déroulant Format des médias proxys (Proxy media format) sur H.264.

5 Allez jusqu’à la section Dossiers de travail (Working Folders).

Le paramètre Emplacement de génération du proxy (Proxy generation location) 
indique l’emplacement des médias proxys créés pour ce projet. Gardez ce 
champ inchangé.

6 Dans la fenêtre Paramètres du projet (Project Settings), cliquez sur le bouton 
Enregistrer (Save).

7 Choisissez DaVinci Resolve > Preferences.
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La fenêtre Préférences Système s’ouvre sur les paramètres Espaces de stockage 
(Media Storage). Ici, vous trouverez trois options d’emplacement de génération des 
proxys (Proxy Generation Location) :

 — Sous-dossiers Proxy dans les emplacements des fichiers média (Proxy 
subfolders in media file locations) crée un dossier « Proxy » au même endroit 
que le fichier média source.

 — Utiliser les paramètres du projet (Use project setting) crée un média proxy sur 
l’emplacement indiqué dans les paramètres de projet (Project Settings).

 — Demander pendant la création (Ask when creating) permet de sélectionner 
manuellement l’emplacement où les médias proxy seront créés.

REMARQUE L’option « Sous-dossiers Proxy dans les emplacements des 
fichiers média » (Proxy subfolders in media file locations) génère des fichiers 
proxys au même endroit que l’application Proxy Generator. En choisissant 
cette option, les fichiers proxys peuvent être supprimés et extraits par le Proxy 
Generator si le dossier est ajouté comme dossier de contrôle.

8 Choisissez Sous-dossiers Proxy dans les emplacements des fichiers média (Proxy 
subfolders in media file locations) et cliquez sur Enregistrer (Save).

9 Sélectionnez tous les plans dans le chutier B-ROLL, faites un clic-droit et choisissez 
Générer un média proxy (Generate Proxy Media).

Les médias proxys seront alors générés. Contrairement au Proxy Generator, vous 
devrez attendre jusqu’à ce que les proxys soient générés avant de continuer.
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Synchroniser l’audio et la vidéo
Vous allez maintenant importer les rushes dans votre projet et générer les médias proxys, 
vous pouvez commencer à organiser les images en synchronisant les plans audio et vidéo 
qui ont été enregistrés sur différents appareils. 

L’audio de certaines productions est enregistré sur des appareils séparés, afin de 
capturer le meilleur son possible. Quand cela n’est pas possible, l’audio est simplement 
enregistré par la caméra. Ainsi, quand les images tournées pendant la journée arrivent 
vous devrez les synchroniser avec l’audio. Ce processus s’appelle « Synchronisation des 
rushes ». Heureusement, Resolve rend tout ce processus très facile. Et, comme pour la 
synchronisation multicaméra faite au chapitre précédent, vous pouvez soit utiliser le 
timecode, soit l’audio des plans.

1 Dans la liste des chutiers, sélectionnez les chutiers AUDIO et VIDEO sous le chutier 
INTERVIEW pour afficher leur contenu dans la bibliothèque de médias.

2 Lancez la lecture du premier plan A 0002.mov dans le viewer.
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Il s’agit d’un des plans d’interview de Chris sur lequel vous avez travaillé au chapitre 1. 
Malheureusement, le son n’est pas terrible. Dans les vumètres du panneau Audio, vous 
pouvez voir que ce plan comporte deux canaux audio assez bas.

3 Faites un clic-droit sur le plan et choisissez Attributs du plan (Clip Attributes).

La fenêtre Attributs du plan (Clip Attributes) s’ouvre. C’est là que vous pouvez modifier 
certaines propriétés du plan. 

4 Sélectionnez l’onglet Audio.

Comme vous pouvez le voir, l’onglet audio des attributs du plan vous indique qu’il 
comporte deux canaux audio intégrés, configurés comme piste audio stéréo.
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5 Cliquez sur Annuler (Cancel) pour refermer la fenêtre Attributs du plan (Clip Attributes) 
sans enregistrer les changements.

6 Sélectionnez le premier plan audio, A-002.WAV, et lancez la lecture.

Ce plan audio comporte quatre canaux audio, affichés en forme d’onde séparée dans 
le viewer audio, dont les niveaux sont corrects.

7 Faites un clic-droit sur le plan et choisissez Attributs du plan (Clip Attributes).

La fenêtre Attributs du plan (Clip Attributes) s’ouvre, affichant l’onglet Audio. Ce plan 
comporte quatre canaux mono individuels appelés « Mix », « Mix-R », « Boom » et 
« Chris ». Le son enregistré par le micro perche se trouve sur le canal 3, la voix de Chris 
sur le canal 4. Les canaux 1 et 2 sont un mélange des deux. 

REMARQUE Les noms des pistes ont été importés avec les métadonnées 
des fichiers audio. Vous pouvez voir le nom des pistes (ou ajouter le vôtre) en 
choisissant Pistes audio (Audio Tracks) dans le menu Trier (Sort) du panneau 
Métadonnées.
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8 Cliquez sur Annuler (Cancel) pour refermer la fenêtre Attributs du plan (Clip Attributes) 
sans enregistrer les changements.

Maintenant que vous comprenez comment l’audio de ces plans a été enregistré, vous 
pouvez les synchroniser et choisir la manière la plus adaptée pour travailler avec.

9 Dans la bibliothèque de médias, sélectionnez tous les plans dans les chutiers 
sélectionnés, faites un clic droit et choisissez Synchroniser automatiquement l’audio > 
En fonction de la forme d’onde et ajouter des pistes (Auto Sync Audio > Based on 
Waveform and Append Tracks).

Après l’analyse, Resolve a synchronisé l’audio et la vidéo.

10 Sélectionnez de nouveau le plan vidéo A 0002.mov et lancez la lecture.

Le plan comporte désormais 6 canaux audio. Dans les vumètres, les quatre derniers 
indicateurs sont plus hauts que les deux premiers.

ASTUCE Vous pouvez vérifier si l’audio des plans est bien synchronisé dans la 
colonne Audio synchro (Synced Audio) en affichage Liste.
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Modifier les canaux audio dans 
les attributs du plan
Vous pouvez continuer d’utiliser l’audio de ces plans tel quel. Le fait d’avoir plusieurs pistes 
audio sur un plan vous donne la possibilité de choisir le micro à utiliser en fonction des 
besoins. En revanche, il est parfois aussi simple de configurer l’audio d’un plan afin qu’il 
utilise uniquement la piste que vous voulez.

1 Dans la liste des chutiers, appuyez sur Command (macOS) ou Ctrl (Windows) et cliquez 
sur le chutier AUDIO pour le désélectionner. Seuls les plans d’interview synchronisés 
sont alors conservés dans la bibliothèque de médias.

2 Sélectionnez tous les plans d’interview, faites un clic droit et choisissez Attributs du 
plan (Clip Attribute).

L’onglet Audio de la fenêtre Attributs du plan (Clip Attributes) montre désormais que 
ces plans comportent six canaux audio : les deux premiers correspondent aux canaux 
intégrés et les quatre derniers correspondent aux plans audio reliés. Comme vous 
n’avez besoin que de l’audio enregistré par le micro de Chris, vous pouvez enlever les 
canaux audio dont vous n’avez pas besoin.
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3 Cliquez sur l’icône poubelle de la piste stéréo intégrée pour la supprimer.

4 Répétez ces étapes pour les trois pistes mono reliées (Mix-L, Mix-R, et Boom).

Il ne reste alors que le micro de Chris (piste mono).

5 Cliquez sur OK pour accepter les changements et fermer la fenêtre.

Les plans d’interview sont désormais configurés avec le bon canal audio mono.

REMARQUE La suppression des canaux dans la fenêtre Attributs du plan 
(Clip Attributes) n’a pas supprimé l’audio. Les pistes de ce plan ont simplement 
été désactivées, ce qui vous permet de les configurer de nouveau en rouvrant 
la fenêtre Attributs du plan (Clip Attributes). 

Le menu Attributs du plan (Clip Attributes) comporte de nombreuses options très 
utiles. Nous vous recommandons de les configurer avant de monter les plans dans la 
timeline. En effet, une fois dans la timeline, les modifications apportées aux attributs 
d’un plan ne s’appliqueront qu’aux autres plans ajoutés sur cette timeline. Les plans 
existants ne sont pas modifiés. Vous pouvez modifier les plans existants dans la 
timeline en faisant un clic droit sur le plan et en choisissant Attributs du plan (Clip 
Attributes) dans le menu contextuel.
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Configurer les préréglages 
des métadonnées
Les métadonnées sont rapidement devenues des outils indispensables du montage, 
en particulier pour organiser et trouver des plans spécifiques. Malgré tout, même si les 
métadonnées sont très utiles, elles peuvent être un peu compliquées à utiliser au début. 

Resolve dispose d’outils permettant de réduire le nombre de métadonnées affichées. Vous 
pouvez d’ailleurs créer des préréglages pour n’afficher que celles dont vous avez besoin.

1 Choisissez DaVinci Resolve > Préférences ou appuyez sur Cmd-, (virgule) (macOS) ou 
Ctrl-, (virgule) (Windows).

2 Dans cette fenêtre, cliquez sur l’onglet Utilisateur (User), puis sur l’onglet 
Métadonnées (Metadata).

Dans cet espace, vous pouvez créer, modifier et supprimer les préréglages relatifs 
aux métadonnées.
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3 Cliquez sur le bouton Nouveau (New) pour créer un nouveau préréglage de 
métadonnées et renommez-le Favorite Metadata. Cliquez sur OK.

Ce préréglage apparaît dans la liste des préréglages Métadonnées. 

Dans la partie inférieure du panneau, vous verrez toutes les métadonnées que vous 
pouvez ajouter au préréglage.
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4 Cochez les cases Description, Mots clés, Commentaires, Caméra #, Personnes, Scène 
et Plan (Description, Keywords, Comments, Camera #, People, Scene, et Shot). Il s’agit 
des métadonnées dont vous aurez besoin pour le reste de ce chapitre.
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5 En haut à droite de la section Options des métadonnées (Metadata options), cliquez 
sur Enregistrer (Save).

6 Cliquez sur Enregistrer (Save) en bas de la fenêtre des préférences.

7 Dans la bibliothèque de médias, sélectionnez un plan dans le chutier B-ROLL.

8 Dans le panneau Métadonnées (Metadata), cliquez sur le menu Trier (Sort) et 
choisissez l’option Toutes catégories (All Groups).



256 Chapitre 6 Organisation du projet

9 Cliquez sur le bouton Options (…) et choisissez le préréglage Favorite Metadata. 

ASTUCE Si l’éditeur de métadonnées reste vide, choisissez l’option d’affichage 
Toutes catégories (All Groups).

Avec ce préréglage, vous voyez que seules les métadonnées sélectionnées sont 
visibles dans l’éditeur de métadonnées. 

Vous pouvez continuer de saisir les métadonnées manuellement, ou si ces 
informations existent en dehors de DaVinci Resolve, vous pouvez les importer.
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Importer et utiliser 
les métadonnées
Il existe plusieurs méthodes pour générer les métadonnées d’un plan. Vous pouvez les 
saisir dans la caméra pendant la production (même si les métadonnées sont rarement une 
priorité pour l’assistant caméra). Vous pouvez aussi les saisir vous-même manuellement, si 
vous avez le temps (et l’envie). Ou alors, vous pouvez demander à quelqu’un sur le plateau 
de les saisir sur une feuille de calcul ou sur une application de clap. Vous pouvez ensuite 
importer les données dans Resolve au format CSV et ainsi gagner un temps précieux.

1 Sélectionnez Fichier > Importer les métadonnées dans > Bibliothèque de médias 
(File > Import Metadata To > Media Pool).

2 Dans la fenêtre Fichier, allez sur R18 Editors Guide/Lesson 06 et sélectionnez le fichier 
OMO metadata.csv.

Ce fichier .csv a été exporté à partir d’une simple feuille de calcul.

3 Cliquez sur Ouvrir (Open).

La fenêtre Metadata Import (Importer les métadonnées) s’ouvre. Elle permet de 
choisir les options d’importation que Resolve va utiliser pour faire correspondre les 
métadonnées externes avec les plans. Dans notre cas, vous pouvez faire correspondre 
les plans en fonction de leur nom de fichier, mais pas de leur timecode. En effet, cette 
information n’est pas incluse dans le fichier .csv.

4 Désélectionnez la case Faire correspondre avec le timecode de départ et de fin (Match 
using clip start and end Timecode), car le fichier .csv ne contient pas ces informations. 
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5 Dans le menu Options de fusion (Merge Options), sélectionnez Mettre à jour toutes les 
métadonnées présentes sur le fichier source (Update all metadata fields available in 
the source file).

Les métadonnées importées de cette façon remplacent les métadonnées existantes 
dans les champs du fichier .csv. Les champs de métadonnées qui ne sont pas listés 
dans le fichier .csv restent inchangés.

6 Cliquez sur OK.

Une fenêtre de confirmation apparaît et vous informe que les informations du fichier 
.csv ont bien été importées et ont été ajoutées aux 24 plans.
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7 Vérifiez si les informations du fichier .csv ont été ajoutées aux plans de la bibliothèque 
de médias en sélectionnant quelques plans et en regardant les métadonnées dans le 
panneau Métadonnées (Metadata).

Chaque plan dispose désormais d’informations relatives aux scènes, aux plans et offre 
également une description et des mots clés. Ces métadonnées vous permettront 
d’organiser et de donner des noms plus clairs que les noms générés automatiquement 
par la caméra.
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Exporter des métadonnées et des chutiers
En plus de pouvoir importer les métadonnées sur les plans dans la bibliothèque 
de médias, comme expliqué dans les étapes précédentes, vous pouvez choisir 
d’exporter les métadonnées de la bibliothèque de médias ou de plans sélectionnés 
dans la bibliothèque de médias. Pour cela, il faut simplement choisir Fichier > 
Exporter les métadonnées de > Bibliothèque de médias (File > Export Metadata 
From > Media Pool) ou Fichier > Exporter les métadonnées de > Plans sélectionnés 
de la bibliothèque de médias (File > Export Metadata From > Selected Media 
Pool Clips). Les métadonnées des plans choisis seront exportées en fichier .csv 
et permettront de transférer facilement les métadonnées d’un projet utilisant les 
mêmes médias à un autre, même si ce projet se trouve sur un autre logiciel Resolve.

Vous pouvez aussi exporter tout un chutier en choisissant Fichier > Exporter 
> Exporter le chutier (File > Export > Export Bin). Cela permet d’exporter les 
métadonnées du plan (pas le média) du chutier sélectionné au format .drb. 
Comme pour les métadonnées exportées, vous pouvez utiliser ces options pour 
transférer les chutiers entre les différents projets Resolve ou les systèmes en 
choisissant Fichier > Importer > Importer le chutier (File > Import > Import Bin). 

Tous les plans listés dans ce fichier .drb seront automatiquement importés dans 
le projet actuel, avec les métadonnées associées. Si le média source se trouve au 
même emplacement que là où le chutier a été exporté, il sera automatiquement 
relié au plan nouvellement importé. Si le média est dans un emplacement 
différent, il faudra alors le relier manuellement.

Rechercher à l’aide des métadonnées
Vous pouvez aussi utiliser ces métadonnées pour retrouver un plan rapidement. Le fait de 
pouvoir retrouver rapidement un plan permet de se concentrer uniquement sur l’histoire 
que vous voulez raconter.

1 Dans la liste des chutiers, sélectionnez le chutier Master.

2 En haut à droite de la bibliothèque de médias, cliquez sur la loupe pour ouvrir le 
champ de recherche.

Par défaut, la recherche ne se fait que sur les noms de fichier dans le chutier actuel.
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3 Cliquez sur Rechercher (Search) et choisissez Tous les chutiers (All Bins).

4 Dans le menu déroulant Trier par (Filter by) à droite du champ de recherche, choisissez 
Tous les champs (All Fields).

Resolve recherche alors parmi tous les chutiers et toutes les métadonnées 
disponibles.

5 Dans la barre de recherche, saisissez Chris pour afficher toutes les prises qui 
contiennent le mot Chris dans leurs métadonnées.
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6 Dans la barre de recherche, mettez le mot Chris en surbrillance et saisissez Pine pour 
afficher les deux prises qui contiennent le mot « pine » (ici, il s’agit de PINE TRAIL).

7 Cliquez de nouveau sur le bouton de recherche pour le refermer.

Les outils de recherche de Resolve vous permettent de trouver rapidement les plans dans 
la bibliothèque de médias, même si vous travaillez sur un très gros projet.

Utiliser les chutiers 
paramétrables automatiques
Un autre avantage qu’apportent les métadonnées, c’est la possibilité de créer des chutiers 
paramétrables. Mots clés, scène et prise peuvent être utilisés pour créer automatiquement 
une série de chutiers paramétrables.

1 Dans la zone des chutiers paramétrables de la bibliothèque de médias, cliquez sur la 
flèche de déroulement pour voir la liste des chutiers paramétrables.

Ces chutiers paramétrables ont été créés automatiquement en fonction des mots clés 
appliqués au plan dans ce projet. Si vous réglez les métadonnées Mots clés des plans 
dans ce projet, la liste des chutiers paramétrables sera mise à jour.

Pour afficher des chutiers paramétrables supplémentaires d’autres métadonnées, 
vous devez ouvrir les préférences utilisateur.
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2 Choisissez DaVinci Resolve > Préférences, cliquez sur l’onglet Utilisateur (User), puis 
cliquez sur la catégorie Montage (Editing).

Les préférences de montage permettent d’afficher d’autres chutiers paramétrables 
automatiques et pas uniquement avec les mots clés, tels que les scènes, les prises 
et les personnes.

3 Cochez les cases Ajout automatique de chutier pour chaque Métadonnée - Scène  
(Automatic Smart Bin for Scene Metadata) et Métadonnées - Personnes 
(Metadata - People), puis cliquez sur Enregistrer (Save) pour sauvegarder les 
changements et refermer les préférences.

Les dossiers Scène (Scene) et Personnes (People) apparaissent dans la liste des 
chutiers paramétrables.
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4 Cliquez sur la flèche de déroulement du chutier paramétrable Scene afin d’afficher les 
métadonnées des plans.

ASTUCE Vous pouvez faire glisser les plans sur un chutier paramétrable existant 
pour ajouter rapidement les plans au chutier en leur assignant automatiquement 
les métadonnées. Par exemple, tirer un plan sur un chutier paramétrable de mots 
clés ajoute le mot clé au plan.

Analyser les plans pour trouver 
des personnes (Version Studio uniquement)

REMARQUE Les chutiers paramétrables pour chaque métadonnée - Personnes 
est uniquement disponible sur DaVinci Resolve Studio. Si vous utilisez la version 
gratuite de DaVinci Resolve, vous pouvez passer cet exercice. Vous ne pourrez pas 
réaliser les étapes suivantes.

Resolve est capable d’analyser les plans pour retrouver les visages des protagonistes. 
Il s’agit de métadonnées utiles pour organiser les plans. Cela permet de générer les mots 
clés Personnes (People), créant une série de chutiers paramétrables. Ainsi vous pouvez 
repérer les plans contenant certaines personnes : acteur, actrice, personne interviewée, 
ou présentateur.
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1 Sélectionnez tous les plans dans le chutier B-ROLL, faites un clic droit et choisissez 
Analyser les personnes dans les plans (Analyze Clips for People).

Les plans sont analysés par DaVinci Resolve Neural Engine, les données résultantes 
sont stockées dans la base de données Visage (Face) du projet. 

Une fois l’analyse terminée, les visages qui ont été identifiés sont affichés dans la 
fenêtre Personnes (People), vous permettant de gérer facilement ces métadonnées.
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2 Dans la fenêtre Personnes (People), sélectionnez le plan identifié par « Person 1 ».

Cette collection contient trois plans de la même personne, avec un cadre rouge 
qui identifie le visage analysé. Vous pouvez ajouter un nom pour l’identifier plus 
facilement.

3 Retournez sur Personne et sélectionnez la première icône affichant le visage de la 
« Personne 1 ».

4 Cliquez sous la vignette « Saisir le nom ici » et saisissez Bobby comme nom de 
personnage.

Vous pouvez aussi supprimer le visage des personnes qui ne vous intéressent pas, par 
exemple, des passants ou d’autres personnages secondaires.
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5 Sélectionnez Personne 2, faites un clic droit sur le plan, et choisissez 
Not Person 2 > Remove.

6 Répétez les mêmes étapes pour Personne 3, 4 et 5.

7 Renommez Personne 6 Fire Dancer.

8 Sélectionnez le groupe Other People.
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Ce groupe contient les visages qui n’ont pas pu être identifiés par l’analyse, dont ceux 
que vous avez supprimés.

9 Sélectionnez les deux premiers plans, qui correspondent aux plans de Bobby sur les 
rochers, puis faites un clic droit et choisissez Taguer > Bobby (Tag As > Bobby).

REMARQUE Vous ne verrez pas d’autres plans apparaître dans le groupe 
Bobby, car les plans ont déjà été tagués. En revanche, Resolve a identifié un 
visage qu’il n’arrive pas à analyser dans une autre partie du plan. En confirmant 
qu’il s’agit bien de Bobby, vous évitez toute mauvaise identification.

10 Faites un clic droit à un autre endroit du plan dans lequel un danseur jongle avec le feu 
et choisissez Taguer > Fire Dancer (Tag As > Fire Dancer).

Vous pouvez également ajouter des personnes dans la fenêtre Personnes (People).

11 Sélectionnez les deux visages de la fille qui porte le t-shirt.

12 Faites un clic droit et choisissez Taguer > Nouvelle personne (Tag As > New Person).
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13 Dans la fenêtre Saisir le nouveau nom (Input New Name), saisissez Kayleigh pour 
renommer cette personne et cliquez sur OK. 

14 Cliquez sur Fermer (Close) pour refermer la fenêtre.

REMARQUE Pour affiner encore davantage les métadonnées des personnes, 
allez sur Espace de travail > Personnes (Workspace > People). Pour réinitialiser 
la base de données Visage (Face) du projet actuel, ouvrez la fenêtre Personnes 
(People) et choisissez Réinitialiser la Base de Données (Reset Face Database) 
dans le menu Options (…).

15 Dans la liste des chutiers paramétrables, cliquez sur la flèche de déroulement du 
groupe People pour les afficher.
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Vous pouvez aussi voir les tags associés aux plans dans le panneau 
Métadonnées (Metadata).

Renommer les plans à 
l’aide des métadonnées
Les noms générés par la caméra sont en général une longue suite de chiffres et de lettres 
(souvent la date et l’heure du tournage) plus ou moins incompréhensibles. Pour retrouver 
les plans facilement, nous vous conseillons de les renommer. Vous pouvez donc choisir de 
saisir le nom manuellement ou d’utiliser une autre méthode plus efficace.

Les éléments variables font référence à certaines métadonnées du plan, telles que le 
numéro des scènes, des prises et des plans. Ces éléments s’appellent Variables, car leur 
contenu varie en fonction du plan. Vous pouvez ajouter une variable au nom d’un plan 
pour que Resolve génère automatiquement l’information correspondante (si elle existe). 
Vous pouvez utiliser les métadonnées que vous venez de charger pour modifier les noms 
génériques des plans contenus dans la bibliothèque de médias.
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1 Sélectionnez le chutier B-ROLL et appuyez sur Cmd-A (macOS) ou Ctrl-A (Windows) 
pour sélectionner tous les plans de la bibliothèque de médias.

2 Faites un clic-droit sur un des plans sélectionnés, choisissez Attributs du plan (Clip 
Attributes) et sélectionnez l’onglet Nom (Name).

3 Dans le champ Nom du plan, saisissez % (signe pourcentage).

Ce signe permet d’ajouter une variable. Vous voyez d’ailleurs qu’une liste de 
métadonnées apparaît.

4 Saisissez sc. 

Une liste de variables, comprenant les lettres « sc » apparaît.
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5 Dans le menu déroulant, cliquez sur Scène (Scene) pour l’ajouter au champ 
Nom du plan (Clip Name).

6 Appuyez sur la barre d’espace après cette variable, puis saisissez %comm et choisissez 
Commentaires (Comments) dans la liste des variables.



273Importer et utiliser les métadonnées

7 Cliquez sur OK pour appliquer les changements que vous venez d’effectuer.

Les noms des plans affichent un mélange de mots clés et de descriptions pour chaque 
plan, informations issues des champs de métadonnées des plans.
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REMARQUE En changeant le nom des plans, vous ne modifiez pas le nom des 
fichiers originaux. Les noms des plans sont souvent utilisés par les monteurs 
pour identifier plus rapidement les plans et les séries de plans. Si vous souhaitez 
voir les noms de fichiers originaux au lieu des noms de plans, choisissez 
Affichage > Afficher les noms des fichiers (View > Show File Names). Vous pouvez 
aussi rechercher un nom de fichier en particulier. Les fichiers EDL, XML ou AAF 
générés par Resolve font toujours référence aux noms de fichiers originaux.

Vous êtes libre de choisir le texte et les variables pour générer un nom sur mesure.

8 Sélectionnez tous les plans dans le chutier VIDEO, faites un clic droit et choisissez 
Attributs du plan (Clip Attributes).

9 Dans l’onglet Nom (Name), sélectionnez le champ du nom et saisissez LANG 
%Motsclés %Nº de la caméra %Prise, puis cliquez sur OK. 
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À présent les plans d’interview de Chris ont été renommés avec son nom de famille, les 
mots clés, le numéro de la caméra et de la prise.

ASTUCE Pour réinitialiser les noms personnalisés que vous avez appliqués aux 
plans, ouvrez la fenêtre Attributs du plan (Clip Attributes), supprimez le texte 
dans le champ Nom du plan (Clip Name). Comme un plan doit obligatoirement 
avoir un nom, le nom de fichier original est utilisé.

Renommer les plans à l’aide des métadonnées peut vous faire gagner un temps 
précieux, car ils seront sans aucun doute plus compréhensibles.

Créer des chutiers paramétrables
L’utilisation des options automatiques des chutiers paramétrable permet de mieux 
organiser les projets. Mais la puissance des chutiers paramétrables se cache aussi 
dans leurs règles personnalisables. Dans cet exercice, vous allez créer des chutiers 
paramétrables pour retrouver et retravailler certains médias du projet.

1 Choisissez Fichier > Nouveau chutier paramétrable (File > New Smart Bin).

La fenêtre Créer un chutier paramétrable (Create Smart Bin) apparaît. Vous allez 
utiliser ce chutier paramétrable pour retrouver tous les plans d’interview capturés d’un 
angle en particulier.

2 Renommez le chutier INTERVIEW A CAM.
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3 Cliquez sur le deuxième menu contextuel (Nom de fichier) et choisissez Mots Clés 
(Keywords).

4 Vérifiez que le troisième menu déroulant est réglé sur « contient » et saisissez 
interview dans le dernier champ.

Cela signifie que tout plan qui contient le mot clé « interview » sera inclus dans ce 
chutier paramétrable.

5 Cliquez de nouveau sur l’icône Plus (+) pour ajouter un filtre supplémentaire.

6 Changez la métadonnée « Propriétés Bibliothèque de médias » pour « Métadonnées - 
Prise & Scène ».
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7 Changez le deuxième menu déroulant par « Nº de la caméra », le troisième par « est » 
et saisissez A dans le dernier menu.

ASTUCE Pour naviguer rapidement dans la liste des options, saisissez la 
première lettre de la métadonnée dont vous avez besoin. L’option suivante 
commençant par cette lettre s’affiche alors. Vous pouvez ensuite sélectionner 
le mot clé dans la liste. Continuez d’appuyer sur la même lettre pour naviguer 
dans les options.

Le contenu est alors trié afin d’inclure uniquement les plans d’interview capturés par la 
caméra « A ».

8 Cliquez sur Créer (Créer).

Le nouveau chutier paramétrable est ajouté à la liste.

Sinon, vous pouvez aussi créer un chutier paramétrable multicaméra contenant 
certains plans spécifiques.
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9 Faites un clic droit sur le chutier paramétrable INTERVIEW A CAM et choisissez 
Dupliquer (Duplicate).

10 Changez le nom du chutier dupliqué par INTERVIEW TAKE 2.

11 Faites un clic droit sur le chutier paramétrable INTERVIEW TAKE 2 et choisissez 
Modifier (Edit).

12 Dans la fenêtre Modifier le chutier paramétrable (Edit Smart Bin), réglez 
« Nº de la caméra» sur « Prise » (Take), et vérifiez que le troisième menu est réglé sur 
« contient » (contains).
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13 Dans le dernier champ, saisissez 2 et cliquez sur OK.

Le chutier paramétrable contient désormais trois plans de la deuxième prise 
d’interview.

Pour organiser les chutiers paramétrables, vous pouvez les ajouter aux dossiers, 
comme les chutiers paramétrables Keywords et Scene.

14 Faites un clic droit sur un espace vide dans la liste des chutiers paramétrables et 
choisissez Ajouter un dossier (Add Folder) pour créer un nouveau dossier appelé 
« Dossier 1 ».
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15 Mettez le nom Dossier 1 en surbrillance et saisissez My Smart Bins.

16 Appuyez sur Majuscule et cliquez sur les chutiers paramétrables INTERVIEW A CAM et 
INTERVIEW TAKE 2. Ensuite, faites-les glisser dans le dossier My Smart Bins.

Comme vous venez de le voir, l’association de la fonction de recherche de Resolve et 
des métadonnées permet de retrouver facilement vos médias. Attention toutefois, 
il faut que les métadonnées soient de bonne qualité pour que les recherches 
soient efficaces. Parfois, une simple faute d’orthographe peut réduire à néant tous 
vos efforts.

ASTUCE Pour qu’un chutier paramétrable soit disponible dans différents projets, 
cochez la case Afficher dans tous les projets (Show In All Projects). Bien que cette 
option ne donne pas accès au contenu du chutier dans les autres projets (voir la 
section « Chutiers partagés »), elle permet de réutiliser les règles de ce chutier dans 
d’autres projets (dont des projets anciens). Ceci est très utile si vous utilisez souvent 
les mêmes règles sur vos chutiers paramétrables. Ces chutiers paramétrables 
sont disponibles dans le dossier Chutier paramétrable appelé Utiliser les chutiers 
paramétrables (User Smart Bin).
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Utiliser les options Match
Les chutiers paramétrables peuvent être personnalisés avec l’option Match 
« Toutes les » ou « L’une des ». Mais vous pouvez aussi ajouter d’autres options 
en appuyant sur la touche Option (macOS) ou Alt (Windows) et en cliquant sur 
l’icône +. Cela permet d’ajouter des sous-groupes de règles pour lesquelles 
l’option Match est disponible.

Par exemple, dans l’image précédente, le chutier paramétrable est réglé de 
manière à inclure le contenu de la bibliothèque de médias dont la résolution est de 
3840 x 2160. Mais cette valeur peut aussi inclure des images dont vous ne voulez 
pas (timelines ou plans multicaméras). Une nouvelle règle a été ajoutée, réglée 
cette fois-ci sur « L’une des ». De cette façon, seuls les plans vidéo, les plans audio/
vidéo et les images fixes sont inclus.

Créer des sous-plans
Une autre technique utilisée par les monteurs qui gèrent une grande quantité d’images, en 
particulier des plans longs, consiste à créer des sous-plans. Vous avez déjà entendu parler 
des sous-plans dans le chapitre 1 quand vous avez monté les éléments sonores de l’interview. 
Les sous-plans permettent de travailler plus facilement sur de petites parties de l’image.

Souvenez-vous que les sous-plans, bien que créés à partir d’un plan long, correspondent 
aux fichiers médias sources sur votre ordinateur. De cette façon, ils ne prennent pas trop 
de place, peu importe le nombre que vous créez.

En outre, bien que les métadonnées soient initialement présentes sur les sous-plans, 
ceux-ci sont complètement indépendants. Cela signifie que vous pouvez les stocker dans 
différents chutiers, et qu’ils peuvent chacun avoir leurs propres métadonnées.
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Vous pouvez créer une série de sous-plans de l’interview capturée par la caméra principale 
utilisée dans le chapitre 1.

REMARQUE Dans cet exercice, vous allez créer des sous-plans dans la page 
Média. Les mêmes techniques pourraient être utilisées dans la page Montage.

1 Dans le chutier INTERVIEW, créez un nouveau chutier et renommez-le SUBCLIPS.

2 Sélectionnez tous les plans dans le chutier paramétrable INTERVIEW A CAM et faites-
les glisser dans le viewer.

3 Sélectionnez le chutier SUBCLIPS.

4 Vérifiez que le plan LANG INTERVIEW A 002 est actif dans le viewer, cliquez sur le 
menu Options du viewer, et choisissez Afficher la forme d'onde du plan entier (Show 
Full Clip Audio Waveform).
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5 Saisissez un point d’entrée juste avant que Chris dise « My name’s Chris Lang… » et un 
point de sortie après « …Las Cruces, New Mexico ».

ASTUCE Vous n’avez pas besoin d’être trop précis quand vous saisissez les 
points d’entrée et de sortie sur les sous-plans. Il est d’ailleurs recommandé 
de sélectionner un peu plus que ce dont vous avez besoin (voir barre latérale 
« Ajuster les limites d’un sous-plan » dans ce chapitre).

6 Choisissez Marque > Créer un sous-plan (Mark > Create Subclip), ou appuyez sur 
Option-B (Mac) ou Alt-B (Windows).

La fenêtre Nouveau sous plan (New Subclip) s’ouvre, vous demandant de confirmer le 
nom (également le nom de fichier d’origine auquel est apposé le mot « Subclip »). 

7 Cliquez sur Créer (Create) pour ajouter un sous-plan au chutier actuel.
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8 Dans le menu déroulant du viewer, choisissez le plan LANG INTERVIEW A 005 et 
réglez le point d’entrée avant que Chris dise « That’s what really inspires us… » et le 
point de sortie après « …the design process starts ».

9 Faites un clic-droit sur la barre de défilement et choisissez Créer un sous-plan 
(Create Subclip).

10 Cliquez sur Créer (Create) dans la fenêtre Nouveau sous-plan (New subclip).

11 Dans le menu déroulant du viewer, choisissez le plan LANG INTERVIEW A 008.



285Créer des sous-plans

12 Réglez le point d’entrée avant que Chris dise « We want people to experience… » et le 
point de sortie après « …the landscapes ».

13 Faites glisser le plan du viewer vers le chutier SUBCLIPS.

14 Cliquez de nouveau sur Créer (Create) dans la fenêtre Nouveau sous-plan 
(New subclip).
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15 Continuez de lire le plan dans le viewer et réglez deux autres points d’entrée et de 
sortie autour de la dernière réplique de Chris : « That’s why we say experience the 
southwest ».

16 Choisissez votre méthode préférée pour créer le sous-plan du dernier élément sonore, 
et cliquez sur Créer (Create) dans la fenêtre Nouveau Sous-plan (New Subclip).

Vous avez désormais quatre sous-plans dans le chutier SUBCLIPS.



287Créer des sous-plans

Modifier les métadonnées des sous-plans
Maintenant que vous avez créé les sous-plans, vous pouvez utiliser les astuces que vous 
avez apprises dans ce chapitre pour bien utiliser les métadonnées.

1 Sélectionnez le premier sous-plan et dans le champ Commentaires (Comments) du 
panneau Métadonnées (Metadata), saisissez intro.

2 Sélectionnez le deuxième sous-plan et dans le champ Commentaires (Comments), 
saisissez inspires us.

3 Sélectionnez le troisième sous-plan et saisissez so unique dans le champ 
Commentaires (Comments).

4 Sélectionnez le dernier sous-plan et saisissez tagline dans le champ Commentaires 
(Comments).
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5 Sélectionnez tous les plans dans le chutier SUBCLIPS et, dans le panneau 
Métadonnées, supprimez le mot clé INTERVIEW et saisissez SUBCLIP dans le champ 
Mot clé (Keyword).

6 Cliquez sur Enregistrer (Save) en bas du panneau.

7 Faites un clic-droit sur les sous-plans et choisissez Attributs du plan (Clip Attributes).

8 Dans le champ Nom du plan, saisissez LANG %Keyword - %Comments, en 
sélectionnant les options du menu à mesure qu’elles apparaissent.
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9 Cliquez sur Ok pour renommer les sous-plans.

Vous pouvez maintenant modifier les sous-plans comme n’importe quel autre plan, 
comme vous l’avez appris au chapitre 1.

Régler les limites des sous-plans
Un inconvénient des sous-clips, c’est que même s’ils renvoient sur les fichiers 
média originaux, ils sont limités par les points d’entrée et de sortie que vous avez 
créés. Nous vous recommandons donc de régler les points d’entrée et de sortie 
légèrement avant et après les images que vous voulez intégrer au plan. De cette 
façon, vous disposez d’un peu de marge pour rogner vos plans ultérieurement.

Parfois, même en prenant cette précaution, il est possible que vous n’ayez pas 
suffisamment d’images dans les poignées. Il faudra alors rallonger le sous-plan en 
faisant un clic droit dessus et en choisissant Modifier le sous-plan (Edit Subclip). 

Cela permet de régler le début et la fin du timecode du sous-plan, mettant à jour 
ses limites dans la bibliothèque de médias et la timeline.
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Comprendre les chutiers partagés
Dans ce chapitre, vous avez utilisé des chutiers standards et des chutiers paramétrables, 
qui offrent de belles options d’organisation dans le projet. Par contre, le troisième type de 
chutier disponible dans DaVinci Resolve s’appelle le chutier partagé. Contrairement aux 
chutiers standards ou paramétrables qui n’existent que dans le projet actuel, les chutiers 
partagés sont disponibles dans tous les projets de la bibliothèque de projet. Ils servent 
notamment à stocker les éléments que vous souhaitez réutiliser dans différents projets, 
tels que les graphiques, les titres, les effets sonores et les fichiers musicaux.

1 Cliquez sur le menu Options de la bibliothèque de médias et choisissez Afficher les 
chutiers partagés (Show Power Bins).

Les chutiers partagés sont affichés dans la bibliothèque de médias, au-dessus des 
chutiers paramétrables.
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2 Sélectionnez le chutier Master dans la fenêtre Chutiers Partagés (Power Bin) et 
appuyez sur Majuscule-Cmd-N (macOS) ou Majuscule-Ctrl-N (Windows) pour ajouter 
un chutier partagé. Renommez ce chutier LOGOS.

3 Sélectionnez le chutier Graphics qui se trouve dans le projet. Il contient le fichier 
graphique appelé OMO LOGO.png.

4 Tirez ce plan dans le chutier partagé LOGOS.

Les chutiers partagés sont accessibles dans tous les projets de la bibliothèque 
de projet, ainsi, ce fichier image (et les métadonnées qui y sont associées) seront 
facilement accessibles dans tous les projets. La prochaine fois que vous travaillez 
sur un projet qui comporte des éléments partagés (effets sonores, graphiques ou 
éléments vidéo), souvenez-vous que les chutiers partagés pourront vous faire gagner 
un temps précieux.
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REMARQUE Les fichiers multicaméras, les plans composés, les plans Fusion et les 
timelines ne peuvent pas être placées dans les chutiers partagés.

Vous devriez maintenant avoir une meilleure compréhension de la puissance 
d’organisation offerte par Resolve. Souvenez-vous que, même si certains projets 
nécessitent une plus grande organisation que d’autres, les techniques présentées dans 
ce chapitre peuvent être appliquées à n’importe quel moment, sur la page Montage et 
sur la page Média. L’organisation ne se fait pas uniquement au début du projet, il faut 
constamment l’affiner au cours du montage.
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Révision
1 Vrai ou faux ? Vous pouvez sauvegarder un préréglage du projet actuel pour l’utiliser 

sur vos prochains projets.

2 Quelle application permet de créer facilement des médias proxys pour le montage ?

a) Resolve Proxy Maker

b) Blackmagic Proxy Generator

c) Blackmagic Proxy Creator

3 Vrai ou faux ? Les médias proxys remplacent les fichiers médias sources utilisés dans 
le projet.

4 Quels outils permettent de synchroniser automatiquement l’audio et la vidéo sur la 
page Média ?

a) L’oscilloscope

b) Le timecode

c) Les marqueurs

5 Quel type de chutier permet d’accéder au contenu sur les différents projets d’une 
bibliothèque de projet ?

a) Chutiers paramétrables

b) Super chutiers

c) Chutiers partagés
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Réponses
1 Vrai. Les préréglages du projet sont sauvegardés dans l’onglet Préréglage du menu 

Paramètres du projet

2 b) Blackmagic Proxy Generator

3 Faux. Les fichiers proxys sont créés avec les fichiers sources. Les fichiers pleine 
résolution originaux restent intacts. Les médias proxys peuvent être désactivés 
en choisissant Lecture > Gestion du proxy > Désactiver Tous les proxies

4 a) Oscilloscope et b) Timecode.

5 c) Chutiers partagés
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combinent de la vidéo, de l’audio, des 
graphiques et du texte (en général 
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DaVinci Resolve 18. Vous y trouverez 
également des effets pour vous 
aider à réaliser les tâches courantes 
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Configurer un projet
Pour commencer, vous allez importer le projet DaVinci Resolve et configurer l’espace de la 
page Montage.

1 Ouvrez DaVinci Resolve, faites un clic droit dans la fenêtre Gestionnaire de projet 
(Project manager) et choisissez Importer un projet (Import Project). Allez sur R18 
Editors Guide/Lesson 07. 

2 Sélectionnez le projet EDIT PAGE EFFECTS.drp et cliquez sur Ouvrir (Open).

Le projet est restauré et apparaît alors dans la fenêtre Gestionnaire de projet 
(Project Manager).

3 Ouvrez le projet, cliquez sur la page Montage et reliez les médias.

4 Au besoin, restaurez la configuration par défaut en choisissant Espace de travail > 
Réinitialiser l’espace de travail (Workspace > Reset UI Layout).

Ce projet contient plusieurs chutiers avec des timelines destinées à réaliser les 
différents exercices de ce chapitre.

5 Cliquez sur le menu déroulant Timeline au-dessus du viewer timeline.
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Le menu déroulant Timeline liste toutes les timelines du projet et permet de passer 
rapidement de l’une à l’autre. Par défaut, Resolve trie cette liste de timelines par ordre 
Utilisé récemment (Recently Used). Les timelines que vous avez ouvertes récemment 
sont donc affichées tout en haut.

6 Cliquez sur le menu Options du viewer timeline et choisissez Trier par timeline > 
Alphabétique (Timeline Sort Order > Alphabetical).

7 Cliquez sur le menu déroulant Sélectionner la Timeline (Select Timeline) pour afficher 
le changement d’ordre et vérifiez que la timeline 01 Title Composite est ouverte.

ASTUCE Vous pouvez choisir la façon dont les timelines des projets sont 
organisées dans DaVinci Resolve > Préférences > Utilisateur > Interface 
(DaVinci Resolve > Preferences > User > UI Settings), et dans le menu déroulant 
Trier par timeline (Timeline Sort Order).

Vous êtes prêt à commencer le premier exercice de ce chapitre.
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Réaliser le compositing 
avec des caches mobiles
En général, les monteurs doivent redimensionner les plans, qu’il s’agisse d’une simple 
modification du cadre pour enlever un micro mal positionné ou des changements 
plus importants.

Dans ce premier exercice, vous allez compositer une prise comportant un cache mobile, 
puis redimensionner et positionner le tout sur la composition.

La timeline 01 Title Composite est une courte séquence d’images d’archive compositées 
sur un arrière-plan. Chaque plan d’archive comporte un contour peint stylisé.  Après 
une seconde, un titre Fusion animé apparaît pour afficher le titre du film : Living In The 
Age Of Airplanes.

Votre travail consiste à utiliser les fonctions de compositing disponibles dans la page 
Montage pour styliser l’image d’archive et la placer en bas à droite du viewer timeline.

Tout d’abord, vous devrez créer une nouvelle piste vidéo dans la timeline pour accueillir le 
nouveau plan.

1 Dans la liste des plans, sélectionnez le chutier Archive et ouvrez le plan AOA Archive 4 
dans le viewer source.

Ces images d’archive montrent les débuts des vols propulsés.

2 Dans l’en-tête des pistes de la timeline, faites un clic droit et choisissez Ajouter des 
pistes (Add Tracks).
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La fenêtre Ajouter des pistes (Add tracks) apparaît. Vous allez ajouter une nouvelle 
piste entre V4 et V5.

3 Gardez Nombre de pistes vidéo sur 1 et changez Positionnement sur (Insert 
position to) Au-dessus d’Archive 3. Réglez Nombre de pistes audio sur 0 et cliquez 
sur Ajouter des pistes (Add Tracks).

Une nouvelle piste vide V5 est créée dans la timeline.

4 Renommez la nouvelle piste V5 Archive 4.
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Vous devez saisir la durée du nouveau plan et cibler la nouvelle piste.

5 Sélectionnez le plan sous la piste que vous venez d’ajouter et appuyez sur Majuscule-A 
pour marquer la durée des plans sélectionnés.

6 Dans l’en-tête de la piste, cliquez sur la commande de destination V5 pour sélectionner 
la nouvelle piste.

Vous avez marqué une durée de 5 secondes dans la timeline, mais vous ne disposez 
que d’un plan source de 3 secondes.

Pour que le plan source remplisse correctement la durée marquée dans la timeline, 
vous allez utiliser l’option de montage Écraser et adapter la vitesse (Fit to Fill). 
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L’option de montage Écraser et adapter la vitesse (Fit to Fill) est une autre façon de 
réaliser le montage. Il s’agit d’un montage à quatre points. Elle utilise la durée des 
points d’entrée et de sortie des viewers timeline et source, puis règle la vitesse du plan 
source pour qu’il corresponde.

7 Faites glisser ce plan du viewer source vers l’option Écraser et adapter la vitesse 
(Fit to Fill) dans le viewer timeline.

Le plan est monté sur la piste cible, et sa vitesse est automatiquement ajustée comme 
indiqué par l’icône de vitesse à côté du nom du plan.

8 Pour voir la nouvelle vitesse du plan, sélectionnez le plan AOA Archive 4 dans 
la timeline, ouvrez l’inspecteur, et affichez les commandes Variation de vitesse 
(Speed Change).

Le plan est lu à 65 % de la vitesse d’origine.

9 Refermez l'inspecteur.

REMARQUE Quand vous montez un plan source dont la durée dépasse celle 
de la timeline, la vitesse du plan source augmente proportionnellement. 
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Créer un plan composé
Pour créer un effet de « contour peint » sur un plan, vous devez combiner le plan avec 
un cache sur une autre piste. Par contre, pour la conserver aussi simple que possible 
et ne pas ajouter de pistes inutilement, vous allez imbriquer le plan dans son propre 
plan composé.

REMARQUE Au chapitre 3, vous avez rencontré les plans composés quand vous 
montiez les plans dans les timelines. Les plans composés permettent de regrouper 
les plans sur une seule timeline (comme pour les plans multicaméras), et sont 
souvent utilisés dans les tâches de compositing comme celle-ci pour obtenir un 
certain résultat.

1 Dans la bibliothèque de médias, sélectionnez le chutier Compound Clips.

Ce chutier comprend plusieurs plans composés déjà créés pour ce projet.

2 Dans la timeline, vérifiez que le plan AOA Archive 4 est toujours sélectionné et 
choisissez Plan > Nouveau plan composé (Clip > New Compound Clip).

La fenêtre Nouveau plan composé (New Compound Clip) s’ouvre.
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3 Renommez le plan composé Archive 4 et cliquez sur créer (Create).

Le plan sélectionné est désormais imbriqué sous le nouveau plan composé Archive 4. 
Vous pouvez voir cette information grâce à l’icône apposée à côté du nom du plan 
composé dans la timeline.

Le nouveau plan composé est ajouté au chutier sélectionné dans la bibliothèque 
de médias.
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Ajouter un cache mobile
Vous allez maintenant créer un contour stylisé de votre plan. Pour cela, vous allez ajouter 
un fichier image à utiliser comme cache dans le plan composé.

1 Cliquez sur le bouton Affichages de la timeline (Timeline View Options) et activez 
l’option Superposition des timelines (Stacked Timelines) pour afficher les onglets.

2 Dans la timeline, vérifiez que le plan composé Archive 4 est toujours sélectionné et 
choisissez Plan > Nouveau plan composé (Clip > New Compound Clip).

Le plan composé s’ouvre dans son propre onglet timeline, comme c’était le cas pour le 
plan multicaméra au chapitre 5. Comme avec ce plan multicaméra, les changements 
apportés dans la timeline seront visibles dans le plan composé sur la timeline 
principale 01 Title Composite.
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3 Sélectionnez le plan AOA Archive 4 dans la timeline du plan composé et déplacez-le 
vers le haut pour créer une nouvelle piste V2.

4 Avec le plan AOA Archive 4 toujours sélectionné, appuyez sur Majuscule A pour 
marquer sa durée.

5 Dans le chutier Mattes de la bibliothèque de médias, ouvrez le plan 
matte 4 alpha.png dans le viewer source.

Cette image a été créée avec des packages graphique et sauvegardée comme fichier 
PNG avec une couche alpha. Vous allez l’utiliser pour le compositer avec le plan 
AOA Archive 4.
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REMARQUE Une couche alpha est un canal noir et blanc supplémentaire 
enregistré avec les canaux RGB d’une image. Elle peut aider au compositing 
dans le logiciel de montage image et vidéo. Si une image ne comporte pas 
de couche alpha, vous pouvez toujours l’utiliser comme cache en utilisant la 
luminance, ou luma, de l’image.

6 Faites glisser le cache du viewer source vers l’option de montage Écraser et adapter 
la vitesse (Fit to Fill), ou appuyez sur Majuscule-F11 pour monter le plan sur la piste 
cible V1, à la bonne durée.

Vous devez dire à Resolve comment ces deux couches interagissent dans la timeline.

7 Sélectionnez le plan matte 4 alpha.png dans la timeline, ouvrez l’inspecteur et dans 
les commandes Compositing, réglez le menu déroulant Mode de fusion (Composite 
Mode) sur Alpha.

REMARQUE Si vous utilisez le cache sans couche alpha, vous pouvez utiliser 
Lum (pour Luma) au lieu d’Alpha.

8 Sélectionnez le plan AOA Archive 4 dans la timeline, et réglez le mode Compositing 
sur Premier plan (Foreground).
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Le plan Premier plan est composité avec le cache à l’aide du canal alpha du 
plan inférieur.

9 Fermez l’onglet de la timeline Archive 4 et retournez sur la timeline 
01 Title Composite.

Vous voyez désormais que le plan est composité dans la timeline principale 
01 Title Composite.
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Redimensionner l’image composite
La dernière étape consiste à régler la taille et la position du plan dans la composition finale.

1 Sélectionnez le plan composite Archive 4 dans la timeline et choisissez Affichage > 
Option du viewer > Transformation (View > Viewer Overlay > Transform) pour activer 
les commandes à l’écran.

2 Utilisez les poignées pour réduire la taille de l’image sélectionnée à un tiers de sa taille 
d’origine.

ASTUCE Vous pouvez utiliser les commandes Zoom dans l’onglet Vidéo de 
l’inspecteur pour indiquer précisément les valeurs.

3 Faites glisser l’image en bas à droite du viewer timeline.
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Enfin, vous ajouterez une mise en perspective présente sur les autres plans composités.

4 Dans l’inspecteur, réglez Inclinaison V (Yaw) du plan sélectionné sur 0.05 pour ajouter 
une légère torsion à l’image dans le viewer timeline.

5 Une fois les réglages effectués, choisissez Affichage > Options du viewer > On/Off 
(View > Viewer Overlays > Toggle On/Off) ou cliquez sur les commandes à l’écran du 
viewer timeline pour les désactiver. Lancez la lecture des titres composités.

Appliquer des changements 
de vitesse variable
Appliquer un changement de vitesse aux plans est relativement courant et facilement 
réalisable dans les commandes Variation de vitesse (Speed Change) de l’inspecteur. En 
revanche, les monteurs sont souvent amenés à faire des choix créatifs qui nécessitent de 
modifier la vitesse à mesure que le plan est lu, certaines parties seront donc lues plus ou 
moins rapidement. Cette technique s’appelle le changement de vitesse variable, qui repose 
sur les commandes de vitesse de Resolve.

1 Dans le menu déroulant Timeline, choisissez la timeline 02 Speed Changes . 
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2 En haut du viewer timeline, sélectionnez le mode Single Viewer.

La timeline actuelle contient deux plans sur lesquels vous allez appliquer différents 
changements de vitesse. Le premier plan DISPLAYING SHIRT, montre le parcours d’un 
t-shirt Organ Mountain Outfitter, de la salle d’impression à son arrivée en boutique.

Pour le moment, le plan dure environ 40 secondes, du début à la fin. Vous pouvez 
rendre cette séquence beaucoup plus intéressante, et réduire sa durée en modifiant la 
vitesse du plan.

3 Dans les commandes Variation de vitesse (Speed Change), sélectionnez l’option 
Timeline Ripple (Ripple Timeline), puis réglez Vitesse % (Speed  %) sur 800.

Comme vous avez changé l’option Timeline Ripple avant de régler la vitesse du plan, le 
reste de l’image est décalé afin de tenir dans la nouvelle durée du plan.
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Ajouter des points de vitesse
Pour créer un changement de vitesse variable, vous devez ajouter un ou plusieurs points 
de vitesse.

1 Dans la timeline, placez la tête de lecture au moment où la première fille passe le 
t-shirt à la deuxième (à un tiers du plan environ). 

2 Sélectionnez le plan dans la timeline et choisissez Plan > Commandes de variation 
de vitesse (Clip > Retime Controls) ou appuyez sur Command-R (macOS) ou Ctrl-R 
(Windows) pour afficher les commandes de vitesse du plan.

3 Cliquez sur la flèche en bas du plan, et choisissez Ajouter un point de vitesse (Add 
Speed Point).
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Un point de vitesse est ajouté au niveau de la tête de lecture, et les commandes de 
variation de la vitesse affichent désormais deux segments de 800 % sur le plan.

4 Positionnez la tête de lecture au moment où la deuxième jeune femme prend le t-shirt 
et l’accroche sur le cintre.

5 Cliquez sur la flèche en bas du deuxième segment du plan et choisissez Ajouter un 
point de vitesse (Add Speed Point) pour ajouter un point de vitesse au niveau de la tête 
de lecture, créant ainsi un troisième segment.

6 Ajoutez un troisième point de vitesse au moment où elle accroche le t-shirt dans 
la boutique.
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En ajoutant trois points de vitesse, vous avez créé quatre segments sur le plan. Chaque 
segment peut avoir ses propres réglages.

7 Appuyez sur T pour sélectionner le mode Trim.

Une fois le mode Trim activé, les réglages appliqués affectent toute la durée du plan et 
entraineront un ripple de la timeline.

8 Cliquez sur la flèche en bas du deuxième segment du plan (après le premier point de 
vitesse) et choisissez Modifier la vitesse > 400% (Change Speed > 400%).

Ce segment du plan, entre les premier et deuxième points de vitesse, sera lu à une 
vitesse de 400 % par rapport à la vitesse d’origine.

9 Cliquez sur la flèche en bas du quatrième segment du plan (après le troisième point de 
vitesse) et choisissez Modifier la vitesse > 200% (Change Speed > 200%).

Vous pouvez aussi régler la vitesse de chaque plan manuellement.

10 Sélectionnez la partie supérieure du deuxième point de vitesse et tirez vers la droite 
pour régler la vitesse du segment qui le précède sur 300 %.

REMARQUE En réglant manuellement les points de contrôle de cette manière, 
vous modifiez la vitesse du segment à gauche du point de vitesse. Pour régler 
la vitesse du dernier segment (après le dernier point de vitesse), sélectionnez et 
tirez le côté droit de la barre de vitesse en haut du plan. 
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Vous pouvez aussi affiner la position de chaque point de vitesse, en réglant l’image de 
départ de chaque segment de vitesse.

11 Sélectionnez le bas du point de vitesse et tirez-le vers la gauche jusqu’à ce qu’on voie 
la jeune femme devant la porte de l’arrière-boutique.

Cela positionne ce point de vitesse (entre les premier et deuxième segments de 
vitesse) sur une image antérieure.

12 Tirez la commande vers la droite jusqu’à ce que la jeune femme donne le t-shirt.

Cette fois-ci, la position des points de vitesse est repoussée sur une image ultérieure.
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Ajuster la courbe de vitesse
Vous pouvez apporter d’autres changements à la vitesse du segment entre les points 
de vitesse, ainsi que l’interpolation entre les segments avec la Courbe de vitesse (Retime 
Curve) du plan.

1 Faites un clic droit sur le plan DISPLAYING SHIRT dans la timeline et choisissez 
Courbe de vitesse (Retime Curve) pour afficher la courbe sous le plan dans la timeline.

Vous pouvez utiliser les deux courbes de vitesse pour affiner la vitesse du plan. Par 
défaut, la courbe de vitesse apparaît sous le plan. Une ligne diagonale représente les 
vitesses auxquelles les différentes parties du plan sont lues. Les parties raides de la 
courbe représentent les sections les plus rapides. En déplaçant les points de contrôle 
horizontalement, l’emplacement du point de vitesse est modifié dans le plan. En 
déplaçant les points de contrôle verticalement, la vitesse des segments est modifiée : 
déplacer le point vers le haut augmente la vitesse du segment précédent et réduit la 
vitesse du segment suivant. L’inverse se produit quand le point de contrôle est abaissé. 
La durée du plan n’est pas modifiée dans la timeline.

2 Cliquez sur la flèche Variation de la vitesse de l’image (Retime Frame) en haut à gauche 
de la courbe de vitesse.
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3 Dans le menu déroulant, décochez la case Variation de la vitesse de l’image (Retime 
Frame) et cochez la case Variation de la vitesse (Retime Speed).

Cela modifie la courbe et affiche la vitesse sur une ligne horizontale, avec les vitesses 
relatives des segments indiquées en fonction de la hauteur de la barre sur  
la courbe : les segments dont la barre est la plus haute sur la courbe sont lus plus 
rapidement que les autres.

4 Tirez la courbe horizontale entre les deuxième et troisième points de vitesse 
jusqu’à 900 %.
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5 Dans le graphique Variation de la vitesse (Retime Curve), sélectionnez le premier point 
de vitesse.

6 Cliquez sur la courbe de bézier pour ajouter les poignées de bézier au 
point sélectionné.

Les poignées de bézier modifient la façon dont les vitesses des deux segments sont 
interpolées. Désormais, au lieu de passer d’une vitesse à une autre, le changement 
se produit graduellement sur plusieurs images.

7 En écartant les poignées de bézier, vous rendez l’interpolation plus progressive et en 
les rapprochant, le changement est plus abrupt.

8 Sélectionnez les deux autres points de vitesse sur la courbe, et ajoutez-y les poignées 
de bézier. Ensuite, réglez l’interpolation entre les segments de vitesse.

REMARQUE Pour refermer la courbe de vitesse quand vous avez terminé, 
choisissez Plan > Afficher l’éditeur de courbes (Clip > Show Curve Editor) ou 
appuyez sur Majuscule-C.
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9 Quand vous avez terminé d’appliquer vos réglages, faites un clic droit sur le plan 
et choisissez Courbe de vitesse (Retime Curve) pour la refermer, puis appuyez 
sur Command-R (macOS) ou Ctrl-R (Windows) pour refermer les commandes de 
vitesse du plan.

Les différentes commandes de vitesse peuvent être utilisées ensemble ou 
indépendamment, en fonction de vos besoins. Par exemple, vous pourriez vouloir 
ajouter et régler les points de vitesse avec les commandes intuitives avant d’affiner 
l’interpolation. Vous pouvez aussi ajouter et régler les points de vitesse d’un plan 
avec uniquement la courbe Variation de la vitesse de l’image (Retime Frame). Le choix 
vous appartient.

Créer un arrêt sur image
Il n’est pas rare non plus de devoir insérer un arrêt sur image dans les projets. Cette 
technique permet en général de présenter les personnages d’un film, ou d’apporter des 
informations complémentaires dans une vidéo de formation.

1 Zoomez et faites défiler la timeline pour aller sur le plan suivant, appelé 
ST MAARTEN OVERHEAD.

2 Placez la tête de lecture sur une image où le train de l’avion est encore visible.

3 Sélectionnez le plan ST MAARTEN OVERHEAD dans la timeline et appuyez sur 
Command-R (macOS) ou Ctrl-R (Windows) pour afficher les commandes de variation 
de vitesse de ce plan.
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4 Dans le menu contextuel sous le plan, choisissez Arrêt sur image (Freeze Frame).

Deux points de vitesse sont ajoutés au plan, avec deux secondes d’arrêt sur image 
entre eux.

5 Faites un clic droit sur le plan ST MAARTEN OVERHEAD et choisissez Courbe de 
vitesse (Retime Curve).

6 Dans le menu déroulant Courbe (Curve), désélectionnez la courbe de variation de la 
vitesse de l’image (Retime Frame), et sélectionnez la courbe Variation de la vitesse 
(Retime Speed).

7 Ajoutez des poignées de bézier sur chaque point de vitesse sur la courbe Variation de 
la vitesse (Retime Speed).

8 Lancez la lecture du plan ST MAARTEN OVERHEAD pour voir l’interpolation aller de 
100% à 0%, puis de nouveau à 100%.
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Modifier le traitement de la vitesse 
et l’estimation du mouvement
Vous avez sans doute remarqué que le changement entre les segments de vitesse n’est 
pas aussi fluide que vous le voudriez. C’est dû au traitement de la vitesse utilisé par le plan.

1 En bas de l’inspecteur, affichez les paramètres Vitesse et Mise à l'échelle (Retime 
and Scaling).

Pour le moment, le plan utilise les paramètres du projet, qui, pour ce projet, sont 
réglés par défaut sur Plus près (Nearest). Cette option répète les images vidéo en 
fonction du ralentissement de la vitesse du plan, donnant un effet un peu haché au 
plan autour de l’arrêt sur image. Deux autres options sont disponibles dans ce menu : 
Fusion en Opacité (Frame Blend) et Flux optique (Optical Flow).

2 Réglez Traitement Vitesse (Retime Process) sur Fusion en Opacité (Frame Blend) et 
lisez le plan pour visualiser le changement.

L’option Fusion en Opacité (Frame Blend) applique un court fondu entre les plans 
dupliqués afin de fluidifier le mouvement du plan ralenti. En fonction des images, cela 
peut créer un résultat plus fluide qu’avec Plus près (Nearest).

3 Réglez l’option Traitement Vitesse (Retime Process) sur Flux optique (Optical Flow), puis 
visualisez de nouveau le changement.

ASTUCE Si vous travaillez sur un ordinateur moins puissant, vous pourriez 
choisir Lecture > Rendus > Smart (Playback > Render Cache > Smart) pour 
mettre en cache les changements de vitesse dans la timeline. En effet, le 
traitement Flux optique (Optical Flow) est gourmand en temps processeur.
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Le flux optique est un traitement de haute qualité, mais qui demande beaucoup de 
puissance à l’ordinateur, car il repose sur une estimation du mouvement pour générer 
les nouvelles images à partir des images sources. Il produit souvent des résultats 
de meilleure qualité quand le plan est lu à une vitesse plus lente que la fréquence 
d’images d’origine. Si c’est votre cas, vous pourriez remarquer des artéfacts de 
décalage sur les contours des objets, encore visibles dans ce plan.

En revanche, DaVinci Resolve propose d’autres paramètres qui aident à réduire ces 
problèmes en réglant l’estimation du mouvement utilisée par le traitement en flux optique.

REMARQUE L’estimation du mouvement s’applique uniquement si le 
traitement de la vitesse est réglé sur Flux Optique dans le plan ou dans les 
paramètres du projet.

L’estimation du mouvement comporte plusieurs paramètres très puissants. Les 
traitements Standard Plus rapide (Standard Faster) et Standard Meilleure qualité 
(Standard Better) produisent en général des résultats de bonne qualité. Par défaut, le 
paramètre est réglé sur Standard Plus rapide (Standard Faster).

Les traitements Améliorée Plus rapide (Enhanced Faster) et Améliorée Meilleure qualité 
(Enhanced Better) produisent quant à eux de meilleurs résultats. Les options standards 
en revanche, affiche des artéfacts. Ces deux options requièrent un ordinateur plus 
puissant que les options standards, elles sont donc plus longues à traiter. 

Enfin, l’option Speed Warp permet d’obtenir des résultats encore meilleurs quand la 
vitesse du plan est réduite sous la fréquence d’images originale. Cette option utilise le 
DaVinci Resolve Neural Engine pour réduire les artéfacts au maximum. En raison de 
ses demandes importantes en puissance de calcul, il n’est disponible que sur les plans 
individuels et ne peut pas être réglé comme option dans les paramètres du projet. 

Comme toujours, les résultats obtenus par chaque paramètre varient en fonction 
de l’image. 

4 Réglez le paramètre d’estimation du mouvement du plan 
ST MAARTEN OVERHEAD sur Améliorée Meilleure qualité (Enhanced Better).

Même avec ce réglage, vous remarquerez sans doute un léger problème dans 
l’interpolation du bout de l’aile.
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5 Choisissez Lecture > Rendus > User (Playback > Render Cache > Utilisateur).

6 Faites un clic droit sur le plan ST MAARTEN OVERHEAD dans la timeline et choisissez 
Exporter la page Étalonnage (Render Cache Color Output).

REMARQUE Les paramètres du format Rendus (Render Cache) et les autres 
commandes sont disponibles sous Média optimisé (Optimized Media) et 
Rendus (Render Cache) dans Paramètres du projet > Paramètres Master 
(Project Settings > Master Settings).

7 Réglez le paramètre d’estimation du mouvement sur Speed Warp.

8 Laissez le traitement Speed Warp se terminer et la timeline mettre en cache le résultat. 
Une fois terminé, lancez la lecture.

Maintenant que le Speed Warp est activé dans les paramètres d’estimation du 
mouvement de ce plan, le résultat est bien meilleur. Speed Warp nécessite beaucoup 
de puissance, il est donc préférable de l’utiliser avec parcimonie sur des appareils très 
performants.

REMARQUE Si vous utilisez la version gratuite de DaVinci Resolve, les plans 
sur lesquels est appliqué le Speed Warp porteront un filigrane.
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Exporter le plan
La page Montage comporte une fonctionnalité supplémentaire qui vous aide si vous 
travaillez avec des effets intensifs, comme c’est le cas pour ce plan Speed Warp. L’option 
Exporter le plan vous permet d’exporter les plans sélectionnés sur un nouveau fichier 
média du disque dur, avec les effets intégrés. Ce média est alors automatiquement ajouté 
à la bibliothèque de médias et remplace le plan original. C’est utile quand vous avez besoin 
d’étalonner un plan avec plusieurs effets, car vous n’avez plus à mettre en cache cette 
portion de la timeline.

REMARQUE L’option Exporter le plan peut être appliquée à plusieurs timelines 
sélectionnées et plans composés. Si vous sélectionnez plusieurs plans, ils seront 
exportés séparément, de façon groupée.

1 Dans la bibliothèque de médias, sélectionnez le chutier Speed Change, et dans 
la timeline, faites un clic droit sur le plan ST MAARTEN OVERHEAD et choisissez 
Exporter le plan (Render in Place).

La fenêtre s’ouvre pour afficher les options qui serviront à créer les nouveaux 
fichiers médias.

2 Conservez toutes les options par défaut et cliquez sur Exporter (Render).

On va vous demander où devra être enregistré le nouveau média sur votre ordinateur.
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3 Allez sur R18 Editors Guide/Lesson 07, sélectionnez Exporter le plan (Render in Place) 
et cliquez sur Ouvrir (Open).

Le nouveau fichier média est immédiatement créé à l’emplacement choisi.

Une fois terminé, le plan ST MAARTEN OVERHEAD original a été remplacé par un 
nouveau fichier appelé ST MAARTEN OVERHEAD Render 1.mov, également ajouté au 
chutier sélectionné dans la bibliothèque de médias. 

Comme l’effet de ralenti est désormais intégré au plan, il sera lu sans être mis en 
cache.  En revanche, les changements de vitesse apportés ne sont plus disponibles.

Heureusement, l’option Exporter le plan (Render in Place) est réversible. Une fois 
le plan exporté, vous pouvez toujours inverser l’opération si vous voulez continuer 
d’affiner les effets.

4 Dans la timeline, faites un clic droit sur ST MAARTEN OVERHEAD Render 1.mov et 
choisissez Décomposer le plan (Decompose to Original).

Le plan d’origine, ainsi que les changements de vitesse personnalisable sont de 
nouveau visibles sur la timeline. La version en cache est toujours disponible dans la 
bibliothèque de médias et sur le disque dur. Cela permet d’affiner davantage l’effet 
avant d’exporter de nouveau le plan.

ASTUCE Il peut être utile d’appliquer un code couleur aux plans pour identifier 
rapidement ceux qui pourront être décomposés ultérieurement. Sinon, vous 
pouvez simplement placer le nouveau plan sur une piste vidéo au-dessus du 
plan d’origine dans la timeline.
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Utiliser l’effet Incrustateur 3D
Il est très courant que les monteurs doivent travailler sur fond vert ou bleu. Les images 
doivent donc ensuite être incrustées sur un autre fond. Cette technique est très courante 
dans les productions de science-fiction ou de fantasy, mais aussi sur des séries télé ou des 
vidéos en ligne dans lesquelles les personnages doivent apparaitre sur un fond virtuel.

Si la prise est finalisée plus tard par un artiste VFX, le monteur peut créer une version 
temporaire de sa composition afin de voir si les éléments fonctionnent bien ensemble. Si 
les prises ne peuvent pas être combinées, il est plus facile pour le monteur d’échanger des 
prises ou de modifier une coupe pour résoudre le problème plutôt que l’artiste VFX s’en 
charge ultérieurement.

Dans cet exercice, vous allez utiliser l’effet Incrustateur 3D (3D Keyer) pour créer une prise 
compositée du court métrage de science-fiction Hyperlight.

1 Dans le menu déroulant Timeline, choisissez la timeline 03 3D Keyer.

2 Lancez la lecture pour voir la scène montée, puis placez la tête de lecture au début du 
plan sur V2.

Il s’agit d’une courte séquence de prises tirées du film de science-fiction Hyperlight. 
Il est clair que la deuxième prise, celle avec l’homme devant le fond vert ruine 
complètement l’effet.
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3 Dans la timeline, sélectionnez le plan de la piste V2, puis appuyez sur D pour le 
désactiver et afficher l’image de la planète en arrière-plan.

Il s’agit de la vue que l’homme devrait voir par le hublot du vaisseau spatial. Pour que 
ce soit réaliste, vous aurez besoin d’appliquer un filtre Incrustateur 3D (3D Keyer).

4 Appuyez sur D pour réactiver le plan dans la timeline.

5 Cliquez sur le bouton Effets (Effects) pour ouvrir la bibliothèque d’effets, sélectionnez 
Open FX > Groupe Filtres (Filters group) et faites défiler la liste des catégories jusqu’à 
Resolve FX Incrustation (Resolve FX Key).
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REMARQUE Les filtres Resolve FX Incrustation (Resolve FX Key) reposent sur 
les qualificateurs de la page Étalonnage. Il existe deux filtres avec lesquels 
vous pouvez travailler. Dans cet exercice, vous allez utiliser le filtre Incrustateur 
3D (3D Keyer), mais vous pourriez aussi choisir Incrustateur HSL (HSL Keyer) 
pour cibler certaines combinaisons de teinte, de saturation et de luminosité. 
L’incrustateur Luma (Luma Keyer) permet de réaliser une incrustation 
uniquement sur la luminance (Luminosité) d’un plan et est souvent utilisé avec 
des modes de fusion. Le filtre Réduire ou agrandir la couche alpha (Alpha 
Matte Shrink and Grow) permet d’affiner davantage les incrustations avec les 
autres filtres.

6 Double-cliquez sur le filtre Incrustateur 3D (3D Keyer) pour l’appliquer sur le plan à 
fond vert sélectionné sur la piste V2.

Pour savoir si cet effet a été appliqué, regardez si les informations du plan de 
la timeline comportent un badge et si l’onglet Effets (Effects) de l’inspecteur 
est en surbrillance.

7 Sélectionnez l’onglet Effets (Effects) dans l’inspecteur pour afficher les commandes du 
filtre Incrustateur 3D (3D Keyer).

Pour commencer le compositing de cette prise avec l’image en arrière-plan, vous allez 
devoir activer les commandes à l’écran dans le viewer.
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8 Choisissez Affichage > Option du viewer > Affichage Open FX (View > Viewer Overlay > 
Open FX Overlay).

De cette façon, vous activez les commandes à l’écran des effets que l’on peut modifier 
directement dans le viewer.

9 Sélectionnez le premier outil pipette dans les commandes Incrustateur 3D (3D Keyer), 
puis cliquez et tirez l’outil à travers la zone centrale de l’écran vert.

Ce mouvement permet d'échantillonner les valeurs de teinte, de saturation et de 
luminance du fond vert à l’aide d’un trait bleu. Cependant, vous remarquerez que 
certaines parties du fond ne sont pas capturées par cette sélection.

10 Cliquez sur la flèche de déroulement Options Utilisation (Usage Options) et 
sélectionnez Afficher les traits (Show Paths) pour afficher le chemin que vous 
avez choisi.

REMARQUE L’option Afficher les traits (Show Paths) désélectionne 
automatiquement l’option Affichage intelligent des chemins (Smart 
Show Paths).
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11 Dans l’inspecteur, cliquez sur l’icône d’ajout de la pipette pour ajouter la partie de 
l’écran vert qui n’était pas initialement sélectionnée.

12 Cliquez et faites glisser la souris sur le fond pour ajouter des nuances de vert.

ASTUCE Si vous avez sélectionné des zones de l’image que vous ne vouliez 
pas inclure, vous pouvez essayer de les enlever à l’aide de l’outil Pipette.
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Maintenant que la sélection est plus complète, vous avez sans doute remarqué le halo 
vert autour de la fenêtre. Pour affiner cette incrustation, il va falloir voir l’image un peu 
plus en détail.

13 Désélectionnez l’option Afficher les traits (Show Paths) dans les options Utilisation.

14 En bas des commandes Incrustateur 3D (3D Keyer) dans l’onglet Effets (Effects) 
de l’inspecteur, réglez le menu déroulant Sortie (Output) sur Alpha N&B (Alpha 
Highlight B/W)

Avec cet affichage, le canal alpha créé pour ce plan est affiché. Les blancs représentent 
les zones opaques, où l’on ne voit pas d’image en arrière-plan. Les noirs représentent 
les zones de transparence, où l’arrière-plan est complètement visible. Les gris 
représentent les zones semi-transparentes.
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15 Réglez le menu déroulant Sortie (Output) sur Alpha N&B (Alpha Highlight B/W).

L’option Alpha (Alpha Highlight) affiche une partie sélectionnée de l’incrustation sous 
forme de zone grise et plate. Cela vous permet de facilement identifier les zones vertes 
autour du hublot.

Pour affiner l’incrustation, vous avez besoin des commandes Ajustement du matte 
(Matte Finesse).

16 Dans l’inspecteur, cliquez sur la flèche de défilement pour refermer les commandes 
Options Utilisation (Usage Options), puis cliquez sur la flèche de déroulement dans les 
commandes Ajustement du matte (Matte Finesse).

Les commandes d’ajustement du matte contiennent les paramètres courants 
pour ajuster la netteté des incrustations. Ici, vous voulez simplement nettoyer les 
zones noires.
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17 Augmentez le curseur Nettoyer Noirs (Clean Black) sur 18.0 pour affiner l’incrustation 
et incluez la dernière portion du fond vert dans votre sélection.

ASTUCE Utilisez la molette de la souris pour zoomer et le bouton du milieu 
pour faire un panoramique dans le plan, dans le viewer timeline afin d’avoir 
un meilleur rendu des ajustements du matte. Quand vous êtes satisfait du 
résultat, appuyez sur Z pour voir toute la prise dans le viewer timeline. 

18 Réglez de nouveau Sortie (Output) sur Compositing final (Final Composite) pour voir 
le résultat.

Utiliser l’option Nettoyer 
Pour le moment, le résultat est satisfaisant. Du moins, le réalisateur est content de voir 
que les éléments du premier plan et de l’arrière-plan fonctionnent ensemble. Par contre, 
comme toujours, il est encore possible d’améliorer la composition, principalement en 
supprimant le débordement sur l’écran vert.

REMARQUE Comme la plupart des filtres d’incrustation reposent sur une plage 
de teinte, de saturation et de luminance pour créer l’incrustation, la sélection des 
valeurs HSL peut être facilitée en éclairant exagérément l’écran vert. Par contre, 
cela peut créer un reflet indésirable ou un débordement de vert sur les éléments 
au premier plan.
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1 Lancez la lecture de la piste V2 jusqu’à ce que l’homme se retourne.

Regardez attentivement, vous verrez sans doute que le visage de l’homme a une teinte 
légèrement verte. En outre, la partie supérieure droite de l’uniforme de l’homme (avec 
le logo USEF) n’est pas censée être verte.

2 Dans l’inspecteur, augmentez le curseur Nettoyer (Despill) dans les commandes 
Options de l’incrustateur (Keyer Option) pour réduire la quantité de débordement sur 
le visage de l’homme et sur son uniforme (il va peut-être falloir exagérer un peu le 
réglage dans ce cas-là).

Ce curseur supprime le débordement dans l’image tout en conservant les couleurs 
d’origine de l’image.

Parfait ! Vous venez de voir qu’il est très facile de créer une composition dans la page 
Montage avec des filtres Incrustateur 3D (3D Keyer). 
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Garbage mattes
Une autre technique courante pour compositer les plans avec des inscrutateurs 
couleur consiste à utiliser des garbage mattes pour exclure certaines parties de 
l’image. C’est particulièrement utile si le fond vert ne couvre pas tout le cadre, ou 
si un spot ou un micro se trouve à l’écran. Cette prise de Hyperlight ne nécessite 
pas de garbage matte, mais les filtres Resolve FX Incrustation (Resolve FX Keyer) 
comprennent des options d’ajouts de mattes rectangles ou circulaires.

Utiliser l’effet Transformation
Une autre tâche que les monteurs doivent souvent réaliser consiste à améliorer les prises 
qui comportent des logos ou d’autres éléments qui devraient mieux s’intégrer à la prise. 
Dans ce chapitre, vous avez redimensionné et positionné le plan pour créer un effet 
d’image dans l’image, en modifiant le réglage Inclinaison V (Yaw). De cette façon, vous avez 
modifié légèrement la perspective du plan. En revanche, dans de nombreux cas, il faudra 
avoir plus de contrôle sur le plan que les paramètres Inclinaison V (Yaw) et Pitch peuvent 
fournir. Ici, vous allez utiliser le filtre de transformation pour épingler une image.

Vous allez explorer cette technique en ajoutant un logo à la devanture de la fenêtre.

1 Cliquez sur le menu déroulant du viewer timeline, cliquez sur la timeline 04 Transform.

Cette timeline contient 3 prises. La première est une version .png du logo 
Citizen Chain.
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2 Dans la timeline, sélectionnez le plan CC-Logo.png et dans la bibliothèque d’effets 
(Effects Library), recherchez la catégorie de filtres Resolve FX Transformation 
(Transform) (Resolve FX Transform).

3 Double-cliquez sur le filtre Tranformation (Transform) pour l’appliquer au plan 
CC-Logo.png de la timeline et cliquez sur l’onglet Effets (Effect) dans l’inspecteur.
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À première vue, il semble que ce filtre ressemble beaucoup aux commandes de 
transformation standard. Il n’en est rien. Il offre des commandes supplémentaires 
pour le flou de bougé, la retouche des bords et le rognage.

4 Réglez le menu déroulant du mode Contrôle sur Interactif – Grille (Interactive 
– Canvas).

Le mode Interactif - Grille (Interactive – Canvas ) affiche des commandes sur le viewer 
timeline sous forme de cadre blanc et de lignes rouges. Vous pouvez les faire glisser 
pour déformer l’image de différentes manières. 

REMARQUE Si vous ne voyez pas les commandes à l’écran activées dans 
l’exercice précédent, vous pouvez aller sur Affichage > Option du viewer > 
Affichage Open FX (View > Viewer Overlay > Open FX Overlay).

5 Assurez-vous que la tête de lecture soit positionnée au début de la timeline, et à l’aide 
des coins, faites glisser les commandes afin que les coins et les bords du graphique 
s’alignent avec les coins et les bords de la fenêtre du plan vidéo.



337Utiliser l’effet Transformation

REMARQUE À vous de choisir où positionner le coin supérieur gauche en 
fonction des bords des deux éléments. Bien entendu, le coin supérieur gauche 
de la fenêtre n’est pas visible dans la prise.

6 Quand vous êtes satisfait de l’alignement du graphique avec la fenêtre, 
lancez la lecture.

Oh mince !  Maintenant, vous voyez que même si le graphique est parfaitement aligné 
avec l’image, dès que la caméra bouge, le graphique reste en place.

Nous allons rapidement régler ce problème. Quelques images clés devraient 
vous y aider.

7 Positionnez la tête de lecture au début du plan et dans l’onglet Effets (Effects) 
de l’inspecteur, cliquez sur la flèche de déroulement pour ouvrir les commandes 
d’animation, puis cliquez sur l’image clé à côté du paramètre Image clé de la grille 
(Canvas Keyframe).

Le bouton de l’image clé s’allume en rouge pour montrer qu’une image clé est 
appliquée au début de pan.
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8 Déplacez la tête de lecture sur la dernière image du plan CC-Logo.png dans la timeline 
et positionnez les coins sur les commandes à l’écran pour aligner de nouveau le 
graphique sur la fenêtre.

Une autre image clé est automatiquement ajoutée à la fin du plan.

9 Appuyez sur Majuscule-` (accent grave) pour désactiver les commandes à l’écran du 
viewer timeline et revoyez les résultats. 

Parfait ! Le graphique semble maintenant appartenir complètement à la scène. Les 
images clés du graphique suivent le mouvement de la caméra. Heureusement, le 
mouvement de la caméra est fluide et constant. Si ce n’était pas le cas, vous pourriez 
tout simplement ajouter des images clés.

Une dernière étape achèvera de réellement transformer le plan. Vous pouvez changer 
le mode de fusion du graphique pour l’intégrer encore mieux au plan.

10 Cliquez sur l’onglet Vidéo dans l’inspecteur pour le plan CC-Logo.png et dans 
les commandes Compositing, réglez le mode de fusion (Compositing Mode) 
sur Surimpression.

Ce mode augmente le contraste du plan vidéo à l’endroit où le graphique est le plus 
lumineux (si le plan est en .png, aucun changement ne se produit).
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11 Réduisez l’opacité sur 60.0 afin de diminuer l’intensité du graphique et mieux l’intégrer 
à la vidéo.

REMARQUE Le dernier mode disponible pour ce filtre est Interactif – Épingles 
(Interactive – Pins). Pour régler l’image avec ce mode, vous devez placer 
manuellement les points de contrôle appelés épingles dans le viewer timeline. 
Une épingle vous donne le contrôle sur la position. Il faut au moins deux points 
pour redimensionner et faire pivoter. Si vous tirez une des épingles, vous 
redimensionnez l’image autour de l’autre épingle. Si vous utilisez trois épingles, 
vous pouvez créer des distorsions en tirant une des épingles. 

Félicitations ! Vous avez appris à déformer et à ajouter des images clés sur un plan pour 
le compositer sur d’autres prises. Même si des outils plus complets sont disponibles sur 
les pages Fusion et Étalonnage, nous vous encourageons à apprendre les techniques plus 
simples de la page Montage.

Comprendre le collage vidéo
Pour finir ce chapitre, vous allez travailler avec le filtre Collage Vidéo (Video Collage). 
Précédemment, vous avez vu comment les paramètres Transformation (Transform) de 
l’inspecteur servent à ajuster le zoom et la position du plan pour créer un effet composite. 
Le filtre Collage Vidéo (Video Collage) est conçu pour créer un effet d’image dans l’image 
uniforme sur grille, ou d’autres effets d’écran divisé. C’est idéal pour créer rapidement un 
mur d'images, qui nécessite un redimensionnement et un positionnement des plans.

Le filtre Collage Vidéo (Video Collage) fonctionne de deux manières différentes. Par défaut, 
l’option Créer un arrière-plan (Create Background) est activée. C’est celle-ci que vous allez 
explorer en premier.
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1 Cliquez sur le menu déroulant du viewer timeline, cliquez sur la timeline 
05 Video Collage Background.

Cette timeline contient plusieurs plans vidéo superposés sur différentes pistes. 

En général, pour créer ce genre d’effet, tous les plans qui se trouvent dans les pistes 
vidéo supérieures doivent être bien redimensionnés et positionnés. Le filtre Collage 
Vidéo (Video Collage) utilise par défaut le plan le plus en haut comme fond. Ce plan 
joue le rôle de cadre, avec des trous pour voir les plans des pistes inférieures.

2 Dans la bibliothèque d’effets, trouvez le groupe de filtres Resolve FX Transformation 
(Transform) et double-cliquez sur le filtre Collage Vidéo (Video Collage) pour l’appliquer 
sur le plan de la piste V4.

Le plan sur V3 est affiché dans quatre cadres. Ces cadres ont été créés grâce au filtre 
Collage Vidéo (Video Collage).
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Configurer la disposition
La première étape pour configurer le filtre Collage Vidéo (Video Collage) consiste à 
organiser les « trous » (appelés Vignettes) avec les commandes de l’inspecteur.

1 Cliquez sur l’onglet Effets (Effects) dans l’inspecteur pour afficher les commandes 
Collage Vidéo (Video Collage).

2 Cochez la case Prévisualiser la disposition (Preview Layout). 

Chaque vignette est mise en évidence et numérotée. Le chiffre qui s’affiche 
correspond aux valeurs dans les colonnes et les rangées de l’inspecteur. La vignette 
avec des rayures hachurées représente la vignette sélectionnée.

3 Par défaut, le nombre de colonnes et de rangs est réglé sur 2. Il s’agit de la bonne 
disposition pour cet exercice.

4 Dans l’inspecteur, cliquez sur le bouton Vignette (Tiles) pour ouvrir les commandes des 
vignettes.

Ces commandes vous permettent de personnaliser les vignettes en groupe ou 
individuellement. Comme vous n’avez pas besoin de la vignette 4, vous pouvez 
la supprimer.
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5 Cliquez sur le menu Vignette active (Active Tile) et choisissez Vignette 4 (Tile 4).

Dans l’affichage, la vignette 4 devient la vignette active, comme indiqué par 
les rayures.

6 Cochez la case Gestion manuelle des vignettes (Manual Tile Management).

7 Cliquez sur Supprimer la vignette (Delete Tile) pour supprimer la vignette 4 de 
l’affichage.

Une fois la vignette 4 supprimée, la vignette 3 est activée par défaut.
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8 Dans le menu Vignette active (Active Tile), choisissez Vignette 2 pour l’activer.

9 Cliquez sur la flèche de déroulement pour personnaliser la taille et la forme.

Pour le moment, la vignette 2 est affichée sur : Colonne 2 et Rangée 1.

10 Réglez la valeur Rangée Fin (End Raw) sur 2 pour afficher la vignette 2 sur l’espace de 
la vignette 4 qui a été supprimée.

Maintenant que l’affichage est réglé, vous allez personnaliser l’ensemble.

11 Cliquez sur la flèche de déroulement à côté de Style (Tile Styling) pour afficher 
les commandes.

12 Réglez le paramètre Bordure (Tile Border) sur 0.025 pour ajouter une bordure 
aux vignettes. 

ASTUCE Vous pouvez décocher la case Appliquer à toutes les vignettes (Apply 
To All Tiles) pour personnaliser uniquement les paramètres de bordure de la 
vignette sélectionnée.
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13 Cliquez sur la flèche de déroulement des commandes Ombres portées (Drop Shadow) 
et augmentez la valeur Intensité (Strength) autour de 0.50, Angle (Drop Angle) sur 90.0, 
Distance (Drop Distance) sur 0.03, et Flou (Blur) sur 0.50 pour personnaliser l’ombre 
portée autour des vignettes.

Enfin, un des éléments les plus puissants du filtre Collage Vidéo (Video Collage), c’est sa 
capacité à créer des « intro » et des « outro » rapidement et facilement. Ces animations 
peuvent être manuellement réalisées avec des images clés, ou générées automatiquement 
sur une durée personnalisable. Vous pouvez choisir entre les animations : Fondu, Envol, 
Réduire, et Rotation (Fade, Fly, Shrink, and Rotate). Par contre, en mode Créer un arrière-
plan (Create Background), seuls les trous créés par les vignettes sont animés, et non 
leur contenu. Pour cela, les modes Fondu (Fade) ou Réduire (Shrink) s’y prêtent bien.

14 Cliquez sur la flèche de déroulement pour afficher les commandes Animation (Tile 
Animation), changez le menu déroulant sur Intro uniquement (Intro Only), décochez la 
case Rétrécir (Shrink), cochez la case Fondu (Fade) et réglez le curseur de durée sur 24 
pour créer une seconde de fondu sur la vignette (la timeline est réglée sur 24 Im/s).

15 Lancez la timeline pour prévisualiser l’effet avec les fondus appliqués à toutes 
les vignettes.

Maintenant que les paramètres de l’effet Collage Vidéo (Video Collage) sont réglés, il 
est temps de remplir les vignettes.
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Redimensionner le contenu
Maintenant que vous avez utilisé l’option Prévisualiser la disposition (Preview Layout) 
pour organiser la grille, il est temps de désactiver le mode Prévisualisation (Preview) et de 
redimensionner les plans pour remplir les trous.

1 Placez la tête de lecture à mi-chemin de la timeline (à environ 2:00), pour que vous 
puissiez clairement voir les trois vignettes, après le fondu de 24 images.

2 En haut des commandes Collage Vidéo (Video Collage), décochez la case Prévisualiser 
la disposition (Preview Layout).

De nouveau, le plan sur la piste V3 devient visible à travers les trous de chaque 
vignette. Vous avez désormais besoin de redimensionner le plan pour qu’il s’insère 
parfaitement dans l’espace de la vignette 1.

3 Sélectionnez le plan sur V3 et choisissez Affichage > Option du viewer > 
Transformation (View > Viewer Overlay > Transform) ou cliquez les commandes 
Transformation (Transform) dans le viewer timeline.

4 Utilisez les commandes à l’écran pour régler le zoom et la position du plan sur la piste 
V3 afin qu’il s’insère dans le trou en haut à gauche de la grille.
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5 Sélectionnez le plan sur la piste V2, et avec les commandes à l’écran, réglez la taille et 
la position pour que le plan s’insère dans l’espace de la vignette 3.

6 Comme le plan déborde de la vignette, choisissez la commande Affichage > Option du 
viewer > Rogner (View > Viewer Overlay > Crop) et redimensionnez le plan.
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7 Enfin, choisissez les commandes Affichage > Option du viewer > Transformation (View 
> Viewer Overlay > Transform), sélectionnez le plan sur la piste V1 et redimensionnez 
l’interview dans le trou créé par Vignette 2.

8 Quand les plans sont bien positionnés, choisissez Affichage > Option du viewer > 
Activer/Désactiver (View > Viewer Overlay > Toggle On/Off) appuyez sur Majuscule-` 
(accent grave) pour désactiver les commandes à l’écran et revoir la timeline.

Beau travail ! Cependant, comme toujours, il reste encore une petite chose à faire.

Superposer et réorganiser les effets
L’effet que vous avez construit avec le filtre Collage Vidéo (Video Collage) est satisfaisant, 
mais pour vraiment mettre en valeur les plans au premier plan, on pourrait ajouter un 
effet de flou.

1 Désélectionnez les plans dans la timeline et dans la bibliothèque d’effets, faites défiler 
la liste des filtres jusqu’à la catégorie Flou (Blur). Faites glisser le filtre Flou gaussien 
(Gaussian Blur) sur le plan de la piste V4.
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Ah mince ! En ajoutant cet effet de flou à l’image, vous avez tout flouté (les bords des 
vignettes, mais aussi l’ombre portée), sans nuance. 

Vous allez devoir réorganiser les effets sur le plan pour garder ces éléments nets et 
simplement flouter l’image des montagnes.

2 Dans l’inspecteur, cliquez sur l’onglet Effets (Effects).

Vous remarquez que le filtre Flou gaussien (Gaussian Blur) est affiché sous le filtre 
Collage Vidéo (Video Collage), car il a été appliqué après celui-ci.
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3 Cliquez sur la flèche vers le haut du filtre Flou Gaussian pour le positionner au-dessus 
de l’effet Collage Vidéo (Video Collage).

Grâce à cette manipulation simple, l’image en arrière-plan reste floutée, mais pas le 
bord des vignettes.

4 Cliquez sur le filtre Flou gaussien (Gaussian Blur) dans l’onglet Effets (Effects) 
de l’inspecteur pour accéder aux commandes et réglez la quantité de Flou à 
votre convenance.

REMARQUE Dans la page Montage, seules les commandes d’un filtre peuvent 
être affichées dans l’onglet Effets (Effects). Par contre, vous pouvez toujours 
accéder aux commandes des autres effets en cliquant sur leur nom, comme 
vous venez de le faire pour le filtre Flou gaussien (Gaussian Blur). 

Parfait ! Vous avez vu comme le filtre Collage Vidéo (Video Collage) permet de créer des 
effets d’image dans l’image plus efficacement qu’avec les commandes de transformation 
en mode Créer un arrière-plan (Create Background). Vous allez maintenant explorer le 
mode Créer une vignette (Create Tile).
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Créer des vignettes avec 
le filtre Collage Vidéo
Une autre manière d’utiliser le filtre Collage Vidéo (Video Collage) consiste à créer et à 
animer les plans en vignette individuelle, comme vous l’avez fait dans le premier exercice 
de ce chapitre. Il s’agit d’une manière plus classique de configurer une composition. La 
couche de l’arrière-plan se trouve alors sur la piste vidéo la plus en bas et les couches 
suivantes sont montées par-dessus.

Comme avant, il est préférable de configurer l’effet Collage vidéo (Video Collage) sur un 
plan en mode Prévisualiser la disposition (Layout Preview).  Une fois que vous êtes heureux 
de l’arrangement et des animations, vous pouvez simplement copier les effets sur un autre 
plan afin de continuer de les modifier.

Comme le reste, vous aurez initialement l’impression que c’est une manipulation 
compliquée, mais vous verrez qu’une fois configurée, le bénéfice est réel. 

1 Dans le menu déroulant du viewer timeline, sélectionnez la timeline 
Video Collage Tiles.

Cette timeline a été configurée avec un plan « d’arrière-plan » sur la piste V1 et un logo 
qui disparaît en fondu enchaîné sur la piste V2. Les pistes V3 à 5 sont désactivées. Elles 
contiennent toutes des plans qui vous seront utiles pour construire une intro animée 
pour le petit film Organ Mountain Outfitters.

2 Activez la piste V3 dans la timeline et visualisez la prise de la fille avec le chapeau.
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3 Placez la tête de lecture au moment où elle tourne la tête vers la caméra (à 
environ 3:00).

4 Dans la bibliothèque d’effets, trouvez le groupe de filtres Resolve FX Transformation 
(Transform) et double-cliquez sur le filtre Collage Vidéo (Video Collage) pour l’appliquer 
sur le plan de la piste V3.

Le filtre par défaut affiche les vidéos sur les pistes les plus en bas dans une grille 2x2.
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5 Sélectionnez le plan sur la piste V3 et cliquez sur l’onglet Effets (Effects) 
dans l’inspecteur.

6 Réglez le menu déroulant Workflow sur Créer une vignette (Create Tile).

La vidéo de la fille avec le chapeau se trouve désormais en image dans l’image.

7 Cochez la case Prévisualiser la disposition (Preview Layout).

8 Changez le chiffre de la colonne sur 3 et la rangée sur 1.

9 Réglez l’arrondi sur 1.0 pour créer des vignettes circulaires.
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10 Réglez Décalage vertical (Vertical Offset) sur 0.20 afin que les vignettes se 
positionnent au-dessus des montagnes et augmentez Espacement horizontal 
(Horizontal Spacing) à 0.125 pour réduire la taille des vignettes.

REMARQUE La taille des vignettes se base sur les marges gauche et droite, 
et haute et basse. Ainsi, si vous augmentez l’espacement horizontal (Horizontal 
Spacing) entre les vignettes, leur taille en sera réduite d’autant, car les marges 
externes n’ont pas changé.

11 Cliquez sur le bouton Vignettes (Tiles) et ouvrez les commandes Style (Tile Styling). 

12 Réglez Bordure (Tile Border) sur 0.025, puis cliquez sur Couleur (Tile Color) et utilisez le 
Sélecteur de couleur pour sélectionner la bordure blanche et la faire correspondre au 
logo Organ Mountain Outfitters. 

13 Ouvrez les commandes d’ombres portées et réglez l’intensité sur 0.350, l’angle (Drop 
angle) sur 90.0, la distance (Drop Distance) sur 0.035, et le flou sur 0.5 pour créer une 
ombre portée diffuse.
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14 Désélectionnez Prévisualiser la disposition (Preview Layout) pour afficher la vignette 
actuelle (Vignette 1) et le plan de la fille qui se tourne vers la caméra.

15 Ouvrez les commandes Redimensionner le contenu (Resize Content) et réglez le Pan 
sur 0.06, Pan V sur 0.35 et le zoom sur 0.85 pour recadrer le visage de la fille dans 
le cercle. Faites bien attention à conserver la marque Organ Mountain Outfitter 
dans la prise.

Les réglages du filtre sont prêts à être copiés sur les autres plans des pistes V4 et 5.
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Copier et coller les attributs
La façon la plus rapide d’appliquer le même effet (avec les mêmes réglages) sur un autre 
plan consiste à utiliser l’option de copier-coller des attributs.

1 Cliquez sur le plan de la piste V3 pour vous assurer qu’il est sélectionné. Ensuite, 
appuyez sur Command-C (macOS) ou Ctrl-C (Windows) ou choisissez Fichier > Copier 
(Edit > Copy) pour copier le plan.

2 Appuyez sur la touche Majuscule et cliquez sur le bouton Activer la piste vidéo des 
pistes V4 et V5 pour activer les pistes désactivées.

3 Sélectionnez les plans sur V4 et V5, puis appuyez sur Option-V (macOS) ou Alt-V 
(Windows) ou choisissez Édition > Coller les attributs (Edit > Paste Attributes).

4 Dans la fenêtre qui s’ouvre, sélectionnez Plug-ins (Plugins) et cliquez sur 
Appliquer (Apply).
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Le filtre de collage vidéo est appliqué aux plans sélectionnés avec les mêmes réglages. 
Vous allez simplement devoir changer quelques petites choses.

5 Appuyez sur Majuscule et cliquez sur le plan de la piste V5 pour le désélectionner. 
Seule la piste V4 est sélectionnée.

6 Cliquez sur l’onglet Effets (Effects) dans l’inspecteur pour afficher les paramètres de 
collage vidéo du plan sélectionné.

7 Dans les commandes Gérer les vignettes (Manage Tiles), réglez le menu Vignette 
active (Active Tile) sur Vignette 2 (Tile 2).

Le plan de la piste V2 apparaît à l’emplacement spécifié pour la vignette 2.
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8 Ouvrez la commande Redimensionner le contenu (Resize Content) et réglez le Pan sur 
0.07, le Pan V (tilt) sur 0.0 et le Zoom sur 0.6.

9 Sélectionnez le plan de la piste V5, réglez le menu Vignette active (Active Tile) sur 
Vignette 3 et dans les commandes Redimensionner le contenu (Resize Content), réglez 
le Pan sur 0.009, le Pan V (Tile) sur 0.0 et le zoom sur 0.57.

Maintenant que les vignettes ont été stylisées, il est temps d’ajouter des animations 
avec des images clés.

Bien que l’effet Collage Vidéo (Video Collage) dispose de ces paramètres d’animation, 
il est souvent plus facile d’animer plusieurs éléments dans le même plan composé. De 
cette façon, si vous souhaitez changer d’animation, vous n’avez à vous soucier que d’un 
groupe d’images clés.

10 Dans la bibliothèque de médias, sélectionnez le chutier Compound Clips.

11 Sélectionnez les plans sur V3, V4, et V5, choisissez Plan > Nouveau plan composé (Clip 
> New Compound Clip) ou faites un clic droit sur les plans sélectionnés et choisissez 
Nouveau plan composé (New Compound Clip).
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12 Renommez le plan composé OMO Tiles et cliquez sur Créer (Create).

Les trois plans dans la timeline sont regroupés en un plan composé, laissant vides les 
deux autres timelines.

13 Faites un clic droit sur les en-têtes et choisissez Delete Empty Tracks (Supprimer les 
pistes vides) pour supprimer les pistes vidéo redondantes.

REMARQUE La piste audio vide ne sera pas supprimée. Chaque timeline doit 
contenir au moins une piste vidéo et une piste audio.
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14 Sur la timeline, placez la tête de lecture au moment où le logo sur V2 a presque 
disparu. Sélectionnez le plan fixe composé OMO Tiles, puis cliquez sur l’image clé du 
paramètre Position dans l’inspecteur.

15 Repositionnez la tête de lecture au début de la timeline et réglez la valeur Position Y 
sur 600, ou jusqu’à ce que les vignettes aient disparu du viewer timeline. Cela ajoute 
automatiquement une nouvelle image clé sur la position.

16 Gardez le plan fixe composé sélectionné, choisissez Choisir le plan > Afficher l’éditeur 
de courbes (Choose Clip > Show Curve Editor) ou appuyez sur Majuscule-C.

17 Cliquez sur le menu déroulant Courbe (Curve) et réglez la courbe sur Position Y.
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18 Sélectionnez la deuxième image clé dans l’éditeur de courbe et cliquez sur Début 
amorti (Ease In) pour ajouter une poignée de bézier à gauche de l’image clé.

19 Tirez la poignée de bézier vers le bas pour aplatir la courbe, ralentissant l’animation à 
mesure qu’elle s’approche de la position de l’image clé.

20 Pour changer le timing de l’animation, sélectionnez le plan composé dans la timeline 
et choisissez Plan > Afficher l’éditeur d’images clés (Clip > Show Keyframe Editor) ou 
appuyez sur Majuscule-Command-C (macOS) ou Majuscule-Ctrl-C (Windows).

21 Tirez la deuxième image clé dans l’éditeur d’image clé de 15 images vers la gauche ou 
jusqu’à ce que le graphique sur V2 ait complètement disparu.

22 Appuyez sur Majuscule-C pour refermer l’éditeur de courbe et appuyez sur Majuscule-
Command-C (macOS) ou Majuscule-Ctrl-C (Windows) pour refermer l’éditeur d’images 
clés et lancez la lecture de la timeline pour visualiser l’animation.

ASTUCE Si vous souhaitez ajouter des images clés aux vignettes créées à 
l’aide de l’effet Collage Vidéo (Video Collage), vous aurez besoin d’imbriquer les 
plans dans leurs propres plans composés. De cette façon, vous réglez l’ordre 
d’exportation des commandes Collage Vidéo (Video Collage) et Transformation 
(Transform).
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Bravo ! Vous avez terminé ce chapitre et vous savez désormais utiliser certains des effets 
de DaVinci Resolve 18 pour réaliser les tâches souvent accomplies par les monteurs. 

REMARQUE Les timelines finalisées des exercices de ce chapitre sont disponibles 
dans R18 Editors Guide/Lesson 07/Timelines.

Révision
1 Quel effet DaVinci Resolve permet d’incruster des fonds bleus et verts sur un 

arrière-plan ?

a) Incrustateur Luma

b) Incrustateur HSL

c) Incrustateur 3D

2 Vrai ou faux ? La seule manière de savoir si un plan comporte un effet Resolve consiste 
à ouvrir l’inspecteur.

3 Quel effet Resolve permet de régler facilement le pitch, l’inclinaison V, la largeur et la 
hauteur avec des commandes à l’écran ?

a) Déformer

b) Perspective

c) Transformation

4 Quel effet Resolve permet de créer rapidement un rendu d’image dans l’image 
complexe ?

a) Grille

b) Collage Vidéo

c) Remplissage Blanking 

5 Vrai ou faux ? L’option Exporter le plan crée un fichier vidéo en utilisant les options de 
rendu des paramètres du projet.
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Réponses
1 b) et c). L’incrustateur Luma ne permet pas de sélectionner les valeurs de teinte et de 

saturation.

2 Faux. Le plan affiche un petit badge FX à côté de son nom.

3 c) Transformation

4 b) Collage Vidéo

5 Faux. Les options Rendus et Exporter le plan utilisent des paramètres différents.
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Chapitre 8

Monter et 
mixer l’audio

La bande-son est un élément essentiel 
d’un film. Vous pourriez avoir créé 
les effets les plus complexes, et un 
étalonnage digne des plus grands films 
d’Hollywood, si la bande-son n’est pas 
claire, les spectateurs ne regarderont 
pas votre film. C’est le cas pour les 
films, les séries TV, les réseaux sociaux 
et les vidéos.

Dans ce chapitre, vous allez explorer 
certaines techniques pour réaliser le 
montage audio, la conception sonore 
et le mixage final de vos timelines. 
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Préparer le projet
Pour ce chapitre, vous allez travailler sur la bande-son d’une courte scène de Sync, que 
vous avez montée au chapitre 4 « Découper une scène d'un film de fiction ».

ASTUCE Nous vous recommandons d’écouter la bande-son sur des haut-parleurs 
de qualité ou avec des écouteurs.

1 Dans la fenêtre Gestionnaire de projet (Project Manager), faites un clic droit et 
choisissez Importer (Import). Allez sur R18 Editors Guide/Lesson 08, sélectionnez le 
projet SYNC SCENE AUDIO.drp et choisissez Ouvrir (Open) pour importer le projet 
dans le gestionnaire de projet (Project Manager).

2 Ouvrez le projet et reliez les fichiers.

3 Choisissez Espace de travail > Réinitialiser l’espace de travail (Workspace > Reset 
UI Layout).

4 Dans le menu déroulant Sélectionner la timeline (Select Timeline), sélectionnez 
SYNC SCENE FINAL MIX. Ajustez la hauteur de la timeline afin de voir autant de plans 
que possible.

5 Lancez la lecture de la timeline SYNC SCENE FINAL MIX pour vous familiariser avec 
son contenu.

Il y a beaucoup de choses sur cette timeline. Vous connaissez déjà la scène entre le 
Dr Kominsky et l’agent Jenkins, montée au chapitre précédent. Il s’agit d’une version 
légèrement améliorée de la scène, plusieurs répliques ont en effet été enlevées. 
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Certains nouveaux éléments ont été ajoutés pour rendre la bande-son plus réaliste. 
Sur la piste A4, on entend notamment un appel radio reçu par les agents du FBI. 
Sur les pistes A6 à A8, on entend des effets sonores et de la musique qui couvrent la 
dernière réplique de l’agent Jenkins.

Pour bien comprendre ce que contient l’audio, vous allez couper le son de 
certaines pistes.

6 Ouvrez la fenêtre Index et sélectionnez l’onglet Pistes (Tracks).

L’index des pistes vous offre un aperçu des commandes et des noms des pistes.

7 Cliquez sur le bouton Mute des pistes A4, A7, A8, et A9, puis lancez de nouveau la 
timeline pour visualiser la scène.

Vous avez sans doute remarqué que la timeline a été organisée de façon à ce que 
chaque personnage dispose de sa propre piste vidéo. Même l’assistante qui n’a qu’une 
seule phrase à dire dans la scène (et qui est enregistrée sur la piste audio du Dr K) 
dispose de sa propre piste. Cette organisation facilite le mixage.



366 Chapitre 8 Monter et mixer l’audio

Quand commencer le mixage ?
Jusqu’à maintenant, vous avez appris à utiliser DaVinci Resolve pour monter l’audio au 
niveau de la sous-image, régler les niveaux audio, ajouter des fondus, etc. Cependant, la 
plupart des opérations sonores se font à la fin du processus de montage, voilà pourquoi ce 
chapitre se situe à la fin du livre.

Vous effectuerez bien entendu des réglages basiques sur l’audio pendant le montage, 
mais vous n’y consacrerez pas trop de temps tant que le montage ne sera pas terminé. 
Une fois le montage image final réalisé et le réalisateur et le client satisfaits du résultat, 
vous pouvez commencer à peaufiner la bande-son. Si vous commencez à monter l’audio 
trop tôt, vous devrez sans doute couper certaines scènes, ou pire, l’intégralité d’une scène. 
Quel gâchis ! C’est aussi pour cette raison que l’étalonnage de l’image commence une fois 
le montage image finalisé.

En pratique, il n’est pas rare que le montage « final » soit retouché alors que le mixage et 
l’étalonnage sont en cours (et parfois même terminés). Dans ces cas, le bénéfice d’avoir 
des outils de montage, de mixage et d’étalonnage dans une seule seule application prend 
tout son sens. Dans Resolve, vous pouvez en effet passer rapidement de l’un à l’autre en 
cliquant simplement sur la bonne page.

En général, les timelines sur lesquelles vous allez travailler comportent : du dialogue (les 
répliques de personnages à l’écran ou la voix off), des effets (des sons à l’écran ou ajoutés 
en post) et de la musique (qui donne l’ambiance de la scène). 

Et souvent, plusieurs plans éparpillés sur les différentes timelines contiennent le même 
type d’audio. Par exemple, cette timeline comporte quatre pistes pour le plan de dialogue : 
une pour chaque acteur, et la quatrième pour l’opérateur radio. Il y a aussi quatre pistes 
d’effets : une pour l’applaudissement du public au début de la scène, une pour les bruits 
de la foule dans la pièce, et deux autres pour les bruits à la fin de la scène. Il y a aussi une 
piste de musique.

Ces sons peuvent appartenir à la scène ou avoir été rajoutés. Le son interne (aussi connu 
sous le nom de diégétique) provient de sources que le spectateur peut identifier dans la 
scène, par exemple d’un acteur en particulier ou une musique entendue à la radio. Le son 
diégétique n’a pas besoin d’être émis par une source visible. Le bruit des voitures, des bus, 
des sirènes etc. permettent de situer la scène en ville par exemple, même si l’on ne voit 
pas un seul véhicule à l’écran. Le son externe (appelé non diégétique) correspond à tous les 
sons qui ne proviennent pas de la scène, par exemple, une voix off ou de la musique.
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Cette scène contient des sons diégétiques et non diégétiques. Réussirez-vous à 
les reconnaitre ?

Les applaudissements au moment où le Dr K sort de scène doivent donner l’impression 
que l’assistance est beaucoup plus grande. Le bruit de fond pendant la scène entre elle et 
l’agent est créé grâce à la présence de figurants (cette piste ATMOS ajoutée au chapitre 4 
permet de produire un bruit de fond constant, aussi appelé présence sonore, et couvre les 
blancs du dialogue). Par contre, les sons et la musique à la fin de la scène sont ajoutés pour 
créer l’ambiance.

Remplacer des répliques 
par d’autres prises
Un problème récurrent auquel font face les monteurs, c’est la différence de qualité 
entre une prise et l’audio qui l’accompagne. Il arrive souvent que les choix soient faits 
en fonction des images plutôt que de l’audio. Dans ces cas, il est facile de remplacer une 
partie de l’audio dans la timeline par l’audio d’une autre prise.

1 Sélectionnez l’onglet Marqueurs (Markers) dans l’index et double-cliquez sur le 
deuxième marqueur REMOVE CLAP?.

La tête de lecture se positionne sur le deuxième marqueur rouge de la timeline.

ASTUCE Appuyez sur Majuscule-flèche vers le haut ou Majuscule-flèche vers 
le bas pour déplacer la tête de lecture entre les marqueurs.
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2 Appuyez sur la barre oblique pour lire les images au niveau de la tête de lecture, en 
faisant attention à la phrase du Dr K.

Aïe ! On a l’impression qu’elle se donne un coup quand elle baisse la main. Ce son 
attire trop l’attention, mais il est assez difficile à couper. Vous allez donc utiliser les 
couches des pistes audio de Resolve pour remplacer cette réplique par une autre.

3 Zoomez sur la tête de lecture et augmentez la hauteur des pistes audio en appuyant 
sur la touche Majuscule et en faisant défiler la molette centrale de la souris.

4 Choisissez Affichage > Afficher les couches des pistes audio (View > Show Audio 
Track Layers).

Toutes les pistes de la timeline apparaissent. Mais en y regardant de plus près, on 
voit un espace vide au-dessus des plans, séparés par une ligne de division. Il s’agit de 
couches des pistes audio.

REMARQUE Les couches des pistes audio fonctionnent presque de la même 
façon que les pistes vidéo. Vous pouvez ajouter des plans audio sur les couches 
des pistes audio. Ils apparaîtront les uns sur les autres. Par contre, seule la 
couche la plus en haut est lue. Le plan le plus en haut est utilisé en priorité. 
Vous ne pouvez pas le mixer avec un plan en dessous, même si vous pouvez 
utiliser les fondus audio des plans du haut pour les mixer avec les plans du bas.
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5 Dans la bibliothèque de médias, sélectionnez le chutier Video dans le chutier Dialogue 
Clips et double-cliquez sur A_S8_T2 WS Agent J pour l’ouvrir dans le viewer source.

Ce plan comporte un marqueur bleu de durée, représentant l’autre prise capturée de 
cette réplique.

6 Choisissez Marque > Définir les points d’entrée/sortie avec la durée du marqueur 
(Mark > Set In and Out from Duration Marker) pour ajouter les points d’entrée et 
de sortie.

7 Appuyez sur Option-/ (barre oblique) sur macOS ou Alt-/ (barre oblique) sur Windows 
pour lire l’audio entre les points d’entrée et de sortie.

Il s’agit d’une version propre de cette réplique.
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8 Dans la timeline, désélectionnez les commandes sources de la piste A2, ou appuyez 
sur Option-Command-2

9 Désactivez l’aimant et utilisez le bouton Surimpression (Overlay) du viewer source pour 
tirer le plan audio sur A1 au-dessus du plan existant (la réplique du Dr Kominsky se 
trouve sur le premier canal source).

10 Rognez le nouveau plan pour qu’il commence au niveau de la forme d’onde, au 
moment où l’actrice commence à parler. Alignez-le avec le début du plan original sur la 
couche en dessous.

11 Appuyez sur / (barre oblique) pour prévisualiser la nouvelle ligne du dialogue.

Le bruit a disparu.
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12 Cliquez et positionnez le plan du dialogue d’origine au-dessus du nouveau plan pour 
inverser l’ordre des couches.

ASTUCE Maintenez la touche Majuscule enfoncée quand vous changez 
l’ordre des couches des plans. Cela empêchera de déplacer la timeline 
horizontalement.

13 Appuyez sur / (barre oblique) pour prévisualiser la prise d’origine.

14 Changez de nouveau l’ordre pour que la nouvelle prise se trouve au-dessus de 
l’ancienne dans les couches.

Vous pourrez sans doute vous en sortir en prenant l’audio dans d’autres prises, car 
l’actrice dit sa réplique quasiment à la même vitesse à chaque fois. Personne ne se 
rendra compte de la légère différence. Par contre, si vous y regardez de plus près, 
vous verrez sans doute que la forme d’onde de la couche supérieure ne s’aligne pas 
complètement avec l’audio original. Mais vous pouvez facilement y remédier en réglant 
la vitesse du plan audio.

15 Faites un clic droit sur le premier plan et choisissez Modifier la vitesse du plan 
(Change Clip Speed).

16 Réglez la vitesse sur 115 %. Assurez-vous que l’option Ripple de la timeline (Ripple 
Timeline) n’est pas sélectionnée, mais que Correction du pitch (Pitch Correction) l’est. 
Ensuite, cliquez sur OK. 
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REMARQUE Vous pouvez, bien entendu, également utiliser les commandes 
Variation de vitesse (Speed Change) de l’onglet Audio dans l’inspecteur pour 
modifier la vitesse du plan audio avec les mêmes options.

La vitesse du plan audio a été augmentée, et le pitch est mis à jour automatiquement 
pour que la nouvelle réplique soit quasiment parfaitement synchronisée.

ASTUCE Vous pouvez aussi utiliser la fonction Onde élastique (Elastic Wave) 
dans la page Fairlight pour régler manuellement la vitesse d’un plan audio et 
créer des réglages de la vitesse variable sans toucher au pitch. Pour davantage 
d’informations, consultez Le guide de la postproduction audio Fairlight avec 
DaVinci Resolve 18.

17 Choisissez Timeline > Aplatir les couches des pistes audio (Timeline > Flatten Audio 
Track Layers) pour supprimer les prises que vous ne voulez plus.

18 Rognez l’audio en trop du nouveau plan, puis choisissez Affichage > Afficher les 
couches des pistes audio (View > Show Audio Track Layers) pour cacher les couches 
des pistes.

19 Sélectionnez l’option Zoom min (Full Extent Zoom) et réglez la hauteur de la piste 
audio pour pouvoir voir toutes les pistes audio dans la timeline.

Les couches des pistes audio sont utiles lorsque vous travaillez avec l’audio dans les 
timelines DaVinci Resolve. Elles peuvent être utilisées de différentes manières, par 
exemple pour naviguer rapidement entre les voix off et la musique. Elles correspondent en 
quelque sorte au Sélecteur de prise (Take Selector) qui n’est pas disponible sur les plans 
audio uniquement.
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Équilibrer les plans de dialogue
Sur les trois types d’audio, le plus important est le dialogue : si le public ne peut pas 
entendre ce qui se dit, il ne pourra pas suivre l’histoire, qu’il s’agisse d’un film comme ici, 
ou d’une interview, comme dans le projet Organ Mountain Outfitters que vous avez monté 
précédemment. Les informations fournies par les dialogues sont cruciales.  Les seuls 
projets où le dialogue n’a pas trop d’importance, c’est dans les clips musicaux (comme 
le clip Jitterbug Riot au chapitre 5 « Montage multicaméra ») ou quand le dialogue est 
intentionnellement mélangé aux autres éléments du mix.

Il n’est donc pas surprenant que le dialogue soit l’élément à privilégier dans le processus 
de mixage audio.

1 Lancez la lecture de la timeline afin d’écouter les dialogues.

L’audio et le montage sont de bonne qualité. Par contre, il faudrait que le niveau 
soit constant.

2 En haut de l’interface, cliquez sur le bouton Mixeur (Mixer).

Le mixeur de la page Montage s'ouvre à droite de la timeline. Si vous ne voyez pas bien 
le mixeur, tirez le côté gauche vers la gauche pour afficher les autres commandes.

ASTUCE Si vous avez besoin de plus de place en bas de l’interface pour mieux 
voir la timeline et le mixeur, vous pouvez cliquer sur le bouton Réduire (Shrink) 
à gauche de la bibliothèque de médias pour réduire la taille des médias et 
refermer l’index. 
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Le mixeur contient des bandes de commandes dédiées à chaque piste de la timeline 
et une bande pour le Main, qui est la commande Master de la timeline, appelée Bus 1. 
Dans DaVinci Resolve, chaque plan peut être ajusté sur la piste, comme vous l’avez 
fait jusqu’à maintenant. Les pistes peuvent ensuite être ajustées en utilisant le mixeur 
avant d’être envoyées vers le bus de sortie. C’est la sortie du Bus 1 que vous entendez. 
Les réglages apportés aux commandes de la piste dans le mixeur affectent les plans 
sur la piste.

3 Lancez de nouveau la timeline, et gardez l’œil sur les niveaux audio de chaque piste.

Vous devriez voir que le niveau des plans du Dr K est beaucoup plus faible que celui de 
l’agent J.

Vous pourriez vouloir utiliser les commandes de niveau audio des pistes, mais il est 
préférable de régler le niveau des plans autant que possible. Ce n’est pas parce qu’un 
plan est réglé d’une certaine façon que les autres le seront aussi.

4 Lancez la lecture du premier plan de dialogue, sur la piste A1, et regardez les niveaux 
sur le mixeur.
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Le niveau atteint à peine -20 dBFS. Il va falloir l’augmenter.

5 Augmentez le volume du plan dans la timeline jusqu’à ce que le pointeur de la souris 
affiche +8 dB. Lancez de nouveau la lecture du plan.

ASTUCE Maintenez la touche Majuscule enfoncée pour régler le volume du 
plan avec plus de précision.

Le volume du plan a augmenté et se trouve désormais dans la zone jaune, autour de 
-15 dBFS. Le résultat est bien meilleur que sur le plan suivant de l’agent J.
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Comment bien ajuster le niveau audio des plans ?
Le mixeur de DaVinci Resolve vous donne une bonne indication du réglage des 
niveaux audio, chaque indicateur affichant une couleur différente (vert, jaune et 
rouge) en fonction de la plage de niveau. Pour le moment, peu importe le niveau 
que vous choisissez tant qu’il est homogène. Nous vous encourageons à régler le 
volume des plans d’une même piste au même niveau. 

En ce qui concerne les dialogues, le bon niveau se situe dans la zone jaune, qui se 
trouve entre -18 dBFS et -8 dBFS dans le mixeur audio. Les répliques murmurées 
se situeront plutôt en bas de la plage, et les répliques criées en haut. Le niveau du 
dialogue quant à lui est réglé sur -12 dBFS. 

Normaliser les niveaux audio
Maintenant, vous allez devoir équilibrer tous les plans de dialogue, pour que le niveau 
sonore soit constant. Souvenez-vous que les spectateurs doivent entendre clairement 
toutes les répliques. Vous pouvez utiliser l’outil de normalisation pour vous aider. Ce n’est 
pas la solution miracle, mais cela permet d’avoir une aide bienvenue dans différentes 
circonstances.

1 Sélectionnez tous les plans sur les trois premières pistes A1, A2 et A3.

2 Faites un clic droit sur un des plans sélectionnés et choisissez Normaliser les niveaux 
audio (Normalize Audio Levels).

La fenêtre apparaît.

3 Gardez le mode de normalisation sur Sample Peak Program, réglez Niveau 
cible (Target Level) sur -9 dBFS et Niveau prédéfini (Set Level) sur Indépendant 
(Independent). Cliquez sur Normaliser (Normalize).
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L’audio des plans sélectionnés est désormais ajusté comme indiqué par le changement 
des formes d’onde. Vous remarquez que les formes d’onde des différents plans sont 
maintenant de tailles identiques. Ils sont donc plus ou moins au même niveau.

4 Lancez de nouveau la lecture des plans et regardez le changement dans les niveaux 
audio du mixeur.

Les niveaux sont désormais constants. Mais comme nous l’avons déjà dit, la 
normalisation des niveaux audio ne fait pas de miracle, elle vous aide un peu. Vous 
pouvez lancer la lecture pour voir si le résultat est satisfaisant.

5 Lancez le troisième plan sur A1. C’est à ce moment que le Dr K murmure quelque 
chose à son assistante.

Le niveau a été augmenté pendant la normalisation, mais ici, il n’est pas du 
tout adapté.
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6 Réglez le niveau sur 12 dB, ce qui positionne le volume dans la zone jaune du vumètre.

Vous pouvez affiner davantage le niveau en ajoutant des images clés.

7 Comme le plan est un peu bruyant à la fin, ajoutez quelques images clés après la 
dernière réplique du professeur en appuyant sur Option (macOS) ou Alt (Windows). 
Ensuite, cliquez sur la courbe du volume et baissez la portion après la deuxième image 
clé sur 4 dB.

Continuez de régler chaque plan de dialogue sur les trois premières pistes pour que le 
résultat soit invisible. 
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Présentation du niveleur de dialogue
DaVinci Resolve 18.1 propose une nouvelle commande de piste audio pour aider 
à harmoniser les niveaux audio du dialogue trop faibles ou trop forts. Comme la 
normalisation, le niveleur de dialogue ne permet pas de tout régler. En revanche, il 
peut régler les niveaux de plusieurs plans à l’aide d’images clés. 

Cet outil est en général utilisé en tant qu’effet Fairlight dans le mixeur de la 
page Fairlight, mais il est également disponible sur la page Montage en ouvrant 
l’inspecteur et en cliquant sur l’en-tête de la piste audio dans la timeline.  

Le niveleur de dialogue comporte des réglages qui permettent d’augmenter les 
parties trop faibles et de réduire les parties trop fortes du dialogue. Il comporte 
également un curseur pour régler le gain de sortie.

En outre, comme pour la normalisation, le niveleur de dialogue n’est pas une 
solution aux mauvais réglages des niveaux. Il faut plutôt le voir comme une 
manière d’harmoniser les niveaux.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier Timelines, choisissez Fichier > Importer > Timeline (File > Import > 
Timeline), puis R18 Editors Guide/Lesson 08/Timelines. Enfin, sélectionnez 
SYNC SCENE FINAL MIX CATCHUP 1.drt et cliquez sur Ouvrir (Open).
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Améliorer une scène
Maintenant que le dialogue a été retouché, il est temps de vous concentrer sur 
l’illustration sonore de cette scène. Dans le scénario, cette scène se déroule pendant 
une pause au cours d’une conférence sur les nouvelles technologies. Même si le plan 
Atmosphere wild sound sur la piste A6 donne l’impression qu’il y a du monde dans 
la pièce, l’illusion n’est pas au rendez-vous. Nous allons essayer de recréer un effet de 
« brouhaha ». Pour commencer, vous allez dupliquer le plan Atmosphere wild sound pour 
donner une impression de foule dans la pièce.

1 Faites un clic droit sur l’en-tête de la piste A6, puis choisissez Ajouter des pistes > Mono 
(Add Tracks > Mono).

Une nouvelle piste audio (A7) s’ajoute à la timeline, sous A6.

REMARQUE Vous pouvez toujours repositionner la piste dans la timeline en 
faisant un clic droit sur l’en-tête de la piste et en choisissant Déplacer la piste 
vers le haut (Move Track Up) ou Déplacer la piste vers le bas (Move Track Down), 
en fonction de vos besoins. Vous pouvez aussi utiliser l’index des pistes pour 
réorganiser les pistes audio. 

2 Dans le mixeur, double-cliquez sur le nom de la piste A7 et saisissez ATMOS.



381Améliorer une scène

3 Dans la timeline, faites un clic droit sur l’en-tête de la piste A7 et choisissez Modifier la 
couleur de la piste > Chocolat (Change Track Color > Chocolate).

4 Appuyez et maintenez la touche Option (macOS) ou Alt (Windows) enfoncée, 
sélectionnez le plan Atmosphere wild sound sur A6, puis faites glisser une copie du 
plan sur A7.

ASTUCE Si l’option Aimant (Snapping) n’est pas activée avant de dupliquer le 
plan, appuyez et maintenez la touche Majuscule enfoncée en suivant les étapes 
ci-dessus. Ne relâchez pas la souris.

Maintenant, écoutez les changements. Vous serez sans doute d’accord pour dire que 
le bruit de fond n’a pas beaucoup changé, le son est simplement plus fort.
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5 Appuyez sur T pour activer le mode Trim et faites coulisser les plans 
Atmosphere wild sound de -10 secondes.

6 Enfin, faites un clic droit sur le plan Atmosphere wild sound sur A7 et choisissez 
Modifier la vitesse du plan (Change Clip Speed). Réglez la vitesse sur 90 % et décochez 
l’option Correction du pitch (Pitch Correction) avant de visualiser les changements.

Vous y êtes presque. En décalant le timing et en modifiant la vitesse d’un plan, on croirait 
la pièce pleine de monde. Félicitations ! Vous avez réussi à augmenter l’impression de 
foule, sans avoir embauché de figurants supplémentaires. Le producteur en sera ravi !

Produire un panoramique 
dans un espace acoustique
Le panoramique vise à répartir le son d’une piste dans un espace sonore panoramique. Au 
même titre que le directeur de la photographie est responsable des éléments visuels dans 
une prise de vue, ce paramètre sert à recréer une impression de relief acoustique dans le 
film. Les signaux des pistes mono sont répartis pour donner l’impression que le son arrive 
de tout côté. DaVinci Resolve propose des outils panoramiques dans le mixeur, permettant 
de positionner le son 2D (stéréo) et 3D (surround).

Dans l’exercice qui suit, vous utiliserez les commandes panoramiques du mixeur pour 
« élargir » l’audio des pistes atmos, afin qu’elles n’empiètent pas sur les pistes de dialogue.



383Produire un panoramique dans un espace acoustique

REMARQUE Pour cet exercice, nous vous recommandons d’utiliser un casque 
afin de bien entendre les changements. 

1 Placez la tête de lecture au début de la scène et lancez la lecture, écoutez 
attentivement en fermant les yeux. Parvenez-vous à identifier d’où sont émis le 
dialogue et le bruit de la foule ? 

Vos yeux vous indiqueront où se trouvent les éléments à l’écran, mais dès que vous les 
fermez, vous avez l’impression qu’ils viennent d’en face. La foule devrait parvenir de 
tout côté et le dialogue d’en face. 

Comme l’audio est lu à partir de pistes mono, le son de ces pistes est réglé de façon 
égale sur les haut-parleurs. Le son est donc centré dans l’environnement sonore.

2 Continuez de lire la scène en utilisant les commandes du Pan dans le mixeur, et tirez la 
poignée bleue de la piste A6 vers le coin supérieur gauche. 

Entendez-vous la différence ? On dirait que vous déplacez le bruit vers un autre endroit 
de la pièce.
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3 Tirez la poignée bleue de la piste A7 vers le coin supérieur droit de la commande. 

4 Lancez la lecture de la timeline du début pour entendre le rendu.

En quelques secondes, vous avez réussi à changer complètement le rendu de la 
scène, donnant l’impression que la pièce est beaucoup plus grande qu’elle ne l’est 
en réalité. De plus, vous avez éloigné les fonds sonores du dialogue, lui donnant une 
meilleure lisibilité. 

ASTUCE Pour davantage de contrôle sur le pan de la piste, double-cliquez sur 
la commande Pan dans le mixeur.
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5 Dans le mixeur, renommez les pistes A6 et A7 ATMOS-L et ATMOS-R.

Une fois le son correctement positionné dans l’espace sonore, vous allez pouvoir 
affiner les niveaux des pistes. En postproduction audio, le volume peut être modifié à 
tout moment.

Créer une impression de foule
Pour vous entraîner davantage, vous pouvez utiliser le plan d’ouverture :

1 Créez une piste Mono sous la piste STAGE existante. Renommez la piste STAGE-R et 
assignez-lui la couleur Turquoise (Teal) pour qu’elle corresponde à la piste A5.

2 Renommez la piste STAGE STAGE-L.

3 Dupliquez l’audio du plan 01_Outro shot from previous scene sur la nouvelle piste.

4 La normalisation des niveaux audio permet de vous assurer que l’audio est au 
bon niveau.

5 Essayez d’ajuster la vitesse de ces plans avec ou sans correction du pitch.
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REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES, choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis R18 Editors Guide/Lesson 08/Timelines, puis sélectionnez 
SYNC SCENE FINAL MIX CATCHUP 2.drt et cliquez sur Ouvrir (Open).

Donner vie à la scène
Dans cette scène, les agents du FBI doivent interrompre le Dr K pendant la conférence. 
Maintenant que le nombre de personnes a été gonflé, il est temps de donner un peu de 
nuance à cette scène.

1 Dans la bibliothèque de médias, sélectionnez le chutier Foley.

REMARQUE Dans le jargon de la réalisation, foley ou bruitage correspond 
aux éléments audio ajoutés à une bande-son. Ils aident à créer des sons 
diégétiques (bruits de pas, klaxon, froissement de vêtements ou un bruit de 
sabre laser). Baptisé ainsi en l’honneur de son créateur, Jack Foley, il s’applique 
également aux studios (foley studio) où sont créés et enregistrés les bruitages, 
ainsi qu’aux bruiteurs (foley artist).

Ce chutier contient le plan original Atmosphere wild sound et un autre plan audio 
Piano dry.aif.
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2 Double-cliquez sur le plan Piano dry.aif pour le charger dans le viewer source et 
lancez le plan pour l’entendre.

Ce plan est un enregistrement stéréo d’un piano enregistré en studio. Une partie de ce 
plan comporte déjà des points d’entrée et de sortie. Vous allez monter ce plan sur une 
nouvelle piste pour ajouter de l’ambiance à la scène, comme si le pianiste se trouvait 
hors champ.

3 Dans la timeline, faites un clic droit sur l’en-tête A8 de la piste ATMOS-R et choisissez 
Ajouter la piste > Stéréo (Add Track > Stereo).
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Une nouvelle piste audio stéréo (A9) est ajoutée à la timeline et au mixeur.

REMARQUE Comme vous avez ajouté un plan audio à la timeline, il devrait 
aussi être ajouté à la piste stéréo pour conserver l’audio dans le mix. Si 
vous ajoutez un plan stéréo sur une piste mono, seuls les deux premiers 
canaux stéréo sont utilisés. Inversement, si vous ajoutez un plan mono à une 
piste stéréo, l’audio mono sera lu sur le premier canal, comme vous l’avez 
rapidement vu au chapitre 3 « Peaufiner une interview ». Les pistes qui ne sont 
pas au bon format peuvent être modifiées en faisant un clic droit sur l’en-tête 
de la piste et en choisissant Mettre la piste en (Change Track Type To). Les 
configurations audio des plans peuvent être ajustées dans les Attributs du plan 
(Clip Attributes).

4 Dans le mixeur, changez le nom de la nouvelle piste A9 par PIANO.
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5 Dans la timeline, changez la couleur de la piste par Marron clair (Tan) et cliquez sur 
Commande de destination (Track Destination Control) pour cibler cette nouvelle piste.

REMARQUE Les raccourcis clavier par défaut permettent de cibler rapidement 
les huit premières pistes vidéo et audio de la timeline (visible dans Timeline > 
Sélectionner la piste de destination (Timeline > Track Destination Selection)). Si 
vous disposez de plus de huit pistes, préférez la souris. 

Vous allez utiliser la durée des plans sur les pistes ATMOS pour saisir rapidement la 
durée du piano.

6 Sélectionnez le plan de la piste A8 et choisissez Marque > Marquer la sélection (Mark > 
Mark Selection), ou appuyez sur Majuscule-1.

Les points d’entrée et de sortie sont ajoutés à la timeline pour la durée du plan 
sélectionné.
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7 Appliquez un montage Écraser (Overwrite). 

8 Augmentez la taille de la piste A9 pour voir clairement la forme d’onde et baissez le 
volume du plan du piano de 25 dB pour que le niveau sonore soit le même que l’audio 
atmos (regardez le niveau de A9 dans le mixeur comme référence).

9 Avec les poignées de fondu du plan Piano, ajoutez un fondu de 10 secondes au début 
et de 2 secondes à la fin. Cela modifie la courbe du fondu de fermeture et crée un 
fondu logarithmique.

Parfait ! On entend maintenant une musique d’ambiance pendant que l’agent J et le Dr K 
discutent.
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Remplir une pièce
Le piano ajoute une ambiance agréable à la scène, qui jusque là était un peu triste. Mais 
le son est tout de même un peu artificiel, car il a été enregistré en studio dans une pièce 
insonorisée. Ce genre de son est idéal pour les bruitages, car vous pouvez ensuite y 
ajouter vos propres réverbérations avec les effets Fairlight de DaVinci Resolve.

1 Cliquez sur la bibliothèque d’effets et sélectionnez Fairlight FX dans la catégorie Audio 
FX, puis repérez l’effet Reverb.

2 Faites glisser l’effet de réverbération sur l’en-tête de la piste A9.
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La fenêtre des commandes de réverbération s’ouvre automatiquement.

3 Dans le menu déroulant Préréglages (Presets) en haut à gauche de la fenêtre, 
choisissez le réglage Concert Hall.

4 Isolez la piste A9 et lancez la lecture pour entendre les effets de 
réverbération du piano.  

ASTUCE Utilisez l’interrupteur rouge en haut à gauche de la commande de 
réverbération pour désactiver ou activer l’effet. Vous pouvez ainsi entendre le 
plan avec ou sans l’effet.

5 Refermez les commandes de réverbération et isolez la piste A9.

REMARQUE Dans la page Montage, pour accéder aux réglages d’un effet 
sonore appliqué à une piste, cliquez sur l’en-tête de la piste dans la timeline et 
ouvrez l’onglet Effets (Effects) dans l’inspecteur.

En ajoutant un effet à une piste, plutôt qu’à des plans individuels, l’effet de réverbération 
est appliqué à tous les plans. Pour savoir si une piste comporte un effet, regardez si l’en-
tête comporte un badge FX, et en haut des commandes de la piste dans le mixeur.
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Créer un effet « radio »
Maintenant que vous avez une meilleure compréhension du travail que requiert 
l’illustration sonore d’une scène, il est temps de régler l’audio provenant de la radio de 
l’agent. Dans ce cas, vous allez appliquer des réglages à l’EQ des plans avant de changer le 
niveau de la piste.

1 Ouvrez l’index des marqueurs et double-cliquez sur la vignette du premier marqueur.

2 Ajustez le zoom de la timeline pour que vous puissiez clairement voir les trois premiers 
plans sur la piste A4.

3 Dans l’en-tête de la piste ou l’index des pistes, cliquez sur le bouton Mute de la piste 
A4 pour rallumer le son, et cliquez sur le bouton Solo de la piste A4 pour l’isoler. 
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4 Appuyez sur / (barre oblique) pour lire les images autour du marqueur.

Cette partie de la timeline comporte un effet sonore au début et à la fin de la réplique 
de l’opérateur radio. Il correspond au bruit que font les radios quand elles reçoivent 
un signal. Les répliques de l’opérateur radio sont dites par un acteur et enregistrées 
directement dans Resolve. Cependant, comme pour le plan du piano, vous aurez 
besoin de manipuler l’audio pour donner l’impression qu’il est émis d’une radio.

REMARQUE Consultez Le guide de la postproduction audio Fairlight avec 
DaVinci Resolve 18 pour plus de détails sur l’enregistrement audio sur la page 
Fairlight.

5 Dans la timeline, sélectionnez le plan Dispatch Recording.wav sur A4.

6 Ouvrez l’inspecteur, cliquez sur l’onglet Audio, et faites défiler la fenêtre jusqu’à voir les 
commandes EQ.
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Dans DaVinci Resolve, chaque plan audio dispose d’un égaliseur paramétrique à 
quatre bandes qui peut être utilisé pour booster ou atténuer différentes plages de 
fréquences d’un plan.

7 Activez l’EQ pour le plan sélectionné.

8 Dans l’inspecteur audio, placez la commande Band 1 sur 650 Hz pour réduire les 
basses fréquences de ce plan.

9 Déplacez la commande Band 4 vers la gauche, autour de 1.5 kHz pour réduire les 
hautes fréquences.

Ces changements limitent les fréquences de la voix à la plage centrale, donnant un 
effet un peu artificiel au plan.
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10 Tirez la commande Band 3 sur la zone entre les commandes Band 1 et 4 (autour de 1 
kHz), puis tirez-la vers le haut, autour de +10 dB.

Cela booste la fréquence 1 kHz de 10 dB.

11 Lancez la lecture du plan pour voir les changements.

Vous vous rendez sans doute compte que la voix de l’acteur a perdu de sa chaleur 
dans les basses fréquences, et de son intensité dans les hautes fréquences. Elle 
semble bien provenir d’une petite radio. 

Copier et coller l’EQ
Maintenant que les fréquences de la première réplique du dialogue radio ont été 
modifiées, vous aurez besoin d’appliquer le même réglage à la deuxième réplique. Comme 
dans les exercices précédents avec les plans vidéo, vous pouvez copier et coller les 
attributs entre les plans audio.
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1 Sélectionnez Dispatch Recording.wav auquel vous avez appliqué l’EQ et choisissez 
Fichier > Copier (Edit > Copy) ou appuyez sur Command-C (macOS) ou Ctrl-C 
(Windows).

2 Sélectionnez la deuxième réplique du dialogue sur A4 (le cinquième plan sur la piste) 
et choisissez Fichier > Coller les attributs ou appuyez sur Option-V (macOS) ou Alt-V 
(Windows).

3 Dans la fenêtre qui s’affiche, cochez la case Égaliseur (Equalizer), puis cliquez sur 
Appliquer (Apply).

Les paramètres d’EQ de la première réplique du dialogue sont appliqués à la 
deuxième réplique.

4 Placez la tête de lecture de la timeline sur la deuxième réplique et appuyez sur / (barre 
oblique) pour entendre le changement.
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Régler le niveau des pistes
Le dialogue radio commence à ressembler à quelque chose. Mais il faut aussi l’écouter 
avec les autres pistes de la scène. Dans ce cas, le dialogue radio n’a pas besoin d’être trop 
clair. Il n’est là que pour créer une tension dans l’échange avec l’agent.

1 Placez la tête de lecture sur le premier marqueur rouge de la timeline.

2 Sur la piste A4, cliquez sur le bouton Solo pour désactiver la piste.

3 Appuyez sur / (barre oblique) pour écouter cette réplique avec les autres 
éléments sonores.

Le dialogue radio fait partie du mix, mais le son est un peu trop fort, il faut donc 
le baisser.

Par contre, les plans de dialogue disposent de deux éléments sur la piste radio. L’un 
d’eux est le bruit sec et caractéristique d’une connexion radio. Si vous ajustiez le 
niveau des plans de dialogue individuellement, vous devriez aussi baisser ce bruit. Il 
est donc préférable de régler le niveau de la piste A4.

4 Dans le mixeur, utilisez le curseur de niveau pour baisser les niveaux audio de la piste 
A4 d’environ -8 dB.



399Simplifier le mix

ASTUCE En haut des curseurs, vous pouvez voir le réglage relatif appliqué au 
niveau de la piste.

5 Une fois que vous avez appliqué vos changements, appuyez sur / (barre oblique) pour 
entendre les résultats. 

Le dialogue radio est désormais mieux intégré dans la scène sans que vous ayez ajusté 
les niveaux des plans individuellement. Cela montre également les avantages d’avoir des 
pistes dédiées à différents types d’audio, ainsi que l’utilisation des niveaux dans le mixeur 
pour affiner le niveau des pistes, une fois les plans correctement équilibrés.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans le 
chutier TIMELINES, choisissez Fichier > Importer > Timeline (File > Import > 
Timeline), puis R18 Editors Guide/Lesson 08/Timelines. Enfin, sélectionnez 
SYNC SCENE FINAL MIX CATCHUP 3.drt et cliquez sur Ouvrir (Open).

Simplifier le mix
Il est maintenant temps de penser à la façon de régler les pistes dans le mixeur. Comme 
vous savez que les niveaux des plans de dialogue sont bien réglés, ils n’auront pas besoin 
de grosses modifications. Cependant, vous devrez peut-être appliquer d’autres réglages 
aux pistes d’effets, en particulier ATMOS et PIANO sur les pistes A7, A8, et A9. Comme il 
s’agit d’une scène relativement simple avec un nombre de pistes limité, il est préférable de 
créer des  bus supplémentaires.

Les bus permettent de contrôler plus précisément le mixage de l’audio. En effet, vous 
pouvez router différentes pistes sur des voies de commandes séparées dans le mixeur. 
De cette façon, vous pouvez régler les niveaux de sortie de ces pistes avec un seul groupe 
de commandes.

Pour mieux comprendre le fonctionnement, vous allez créer trois nouveaux bus : un pour 
le dialogue, un pour les effets diégétiques et un pour les éléments non diégétiques.
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ASTUCE Vous pouvez créer jusqu’à 256 bus stéréo (soit 512 bus mono). Ils peuvent 
ainsi contrôler l’audio de plusieurs pistes, simplifiant grandement le mixage des 
timelines complexes.

1 Choisissez Fairlight > Créer des bus (Fairlight > Bus Format).

La fenêtre Créer des bus (Bus Format) s’ouvre, affichant le bus par défaut sur la 
timeline. Ce bus permet d’exporter l’audio de la timeline entière et par défaut, il est 
réglé sur Stéréo.

Il est important de renommer les bus afin de savoir à quoi ils servent.
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2 Sur le bus 1, cliquez sur le champ du nom et saisissez STEREO MAIN.

REMARQUE Même si vous êtes sur la page Montage, vous pouvez accéder 
aux fonctionnalités Fairlight dans le menu Fairlight. En revanche, certaines 
options spécifiques de la page Fairlight ne seront pas disponibles.

3 Cliquez sur Ajouter un bus (Add Bus) pour ajouter un nouveau bus, appelé Bus 2 sur 
cette timeline.

Vous allez utiliser ce nouveau bus pour régler toutes les pistes de dialogue dans 
la timeline.
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4 Renommez Bus 2 DIALOGUE.

REMARQUE Préférez les mots courts, car ils sont plus faciles à lire dans le 
mixeur ou sur l’en-tête de la piste.

5 Laissez Format sur Mono (il s’agit du dialogue après tout), mais réglez la couleur 
sur orange.

REMARQUE Comme un mixeur Bus ne contient pas de plan audio, le 
changement de couleur permet de l’identifier rapidement dans le mixeur ou la 
fenêtre Assigner les bus (Bus Assign).

Vous allez devoir ajouter deux autres bus pour les effets diégétiques, ainsi que pour 
les éléments non diégétiques et la musique.

6 Cliquez deux fois sur Ajouter un bus (Add Bus) pour ajouter Bus 3 et Bus 4.

7 Ensuite, renommez Bus 3 SFX et Bus 4 MUSIC.

8 Réglez le format des deux bus sur Stéréo.
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9 Réglez la couleur du bus SFX sur Vert citron (Lime) et la couleur du bus Music sur 
Turquoise (Teal).

10 Cliquez sur OK pour sauvegarder les changements et refermer la fenêtre.

11 Dans le mixeur, tirez la zone de séparation à côté du canal Bus 1 pour afficher les 
commandes des bus.
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ASTUCE Vous pouvez changer l’ordre des voies de commandes des bus dans le 
mixeur en les réorganisant dans la fenêtre Créer des bus (Bus Format).

Assigner les pistes aux bus
Vous avez créé trois bus supplémentaires dans cette timeline. Il va maintenant falloir 
router l’audio de chaque piste vers le bon bus, puis de chaque bus vers le Bus Main Stéréo. 

1 Choisissez Fairlight > Assigner les bus (Fairlight > Bus Assign) pour ouvrir la fenêtre.

Cette fenêtre permet de voir et de changer la destination de l’audio une fois qu’il 
quitte la piste. Par défaut, toutes les pistes audio sont automatiquement routées vers 
la sortie Bus 1 (également appelé B1o (Bus 1 out). Il s’agit du mix que vous entendez 
quand vous lancez la timeline.

2 Dans la zone des bus, sélectionnez Sortie B1:STEREO MAIN et cliquez sur Tout dé-
assigner (Un-Assign All).
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Maintenant que les pistes ne sont plus assignées à une destination, vous ne les 
entendrez plus. En effet, elles ne sont plus envoyées au bus de sortie B1.

3 Dans la section des bus en haut de la fenêtre Assigner les bus (Bus Assign), cliquez sur 
Sortie B2:DIALOGUE pour le sélectionner.

4 Dans la zone Pistes disponibles (Available Tracks), cliquez sur la piste de dialogue dans 
la timeline : Dr K, Agent J, Assistant, et Radio.

B2o (Bus 2 out) apparaît sous le nom de chaque piste pour savoir vers quel bus elle 
est routée.

REMARQUE Les pistes peuvent être envoyées vers plusieurs bus 
simultanément, il est donc possible qu’elles aient plusieurs destinations.

5 Dans la section Bus, cliquez sur B3:SFX et sélectionnez le bus SFX.

6 Cliquez sur les pistes qui contiennent un audio diégétique : STAGE-L, STAGE-R, 
WALLA-L, WALLA-R, et PIANO pour les envoyer vers B3o.
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7 Cliquez sur B4:MUSIC Out pour sélectionner le bus final des effets non diégétiques et de 
la musique. Ensuite, cliquez sur les pistes SFX-1, SFX-2 et MUSIC pour les assigner à B4o.

ASTUCE Pour supprimer une piste d’un bus en particulier, cliquez sur le bus 
dans la section Pistes disponibles (Available Tracks) de la fenêtre Assigner les 
bus (Bus Assign), puis cliquez sur la piste en question. Les pistes déjà assignées 
au bus sélectionné seront supprimées.

Enfin, la timeline sera toujours silencieuse, sauf si vous routez les bus sur le bus 
Stereo Main 1.

8 Dans la section Bus, cliquez sur le bouton Sortie B1:STEREO MAIN, puis cliquez sur DIALOGUE, 
SFX, et MUSIC dans la section Pistes disponibles (Available Tracks) pour les router vers B1o.

REMARQUE Vous ne pouvez pas router un bus vers lui-même, il est donc impossible 
de sélectionner la piste STEREO MAIN et le bus B1 STEREO MAIN Out ensemble.

9 Une fois les bus correctement routés comme dans l’image précédente, cliquez sur 
Refermer (Close).
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Mixer dans le mixeur
Vous avez sans doute l’impression que nous avançons à pas de fourmis, mais le résultat 
devrait commencer à se voir. Vous allez maintenant pouvoir facilement mixer l’audio de la 
scène en utilisant les commandes de chaque bus.

1 Dans le mixeur, rallumez le son des pistes A10, A11 et A12.

ASTUCE Faites Majuscule-clic sur le bouton Mute d’une des pistes dont le son 
est coupé pour rallumer le son de toutes ces pistes.

2 Lancez la lecture de la timeline du début, et écoutez attentivement les différents 
éléments de la bande-son.

Que vous disent vos oreilles ? Vous avez sans doute identifié que les effets sonores et 
la musique à la fin sont trop forts.

3 Lancez de nouveau la lecture de la timeline et cette fois, utilisez le curseur Bus Music 
pour réduire le niveau de 10 dB (ou au niveau qui vous semble convenir).

4 En utilisant la même technique, vous allez régler le niveau du bus SFX (si vous ne savez 
pas comment le régler, essayez -6 dB).

Comme vous pouvez le voir (et l’entendre), les bus sont beaucoup plus faciles à utiliser 
pour mixer l’audio de la scène. En outre, si vous voulez davantage de contrôle (par 
exemple, si vous trouvez que la piste de dialogue nécessite plus de changement), nous 
vous recommandons de régler le niveau de cette piste. Vous pouvez également rouvrir 
les plans et apporter des modifications directement au niveau. 

Maintenant que vous avez vu la puissance des bus sur DaVinci Resolve, mixer l’audio 
dans la timeline devrait être plus facile.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans 
le chutier Timelines, choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis R18 Editors Guide/Lesson 08/Timelines et sélectionnez 
SYNC SCENE FINAL MIX CATCHUP 4.drt. Cliquez sur Ouvrir (Open).
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Utiliser les bus pour d’autres mix
En général, les monteurs responsables de l’audio d’un film doivent configurer la timeline 
afin d’exporter différents mix audio. Dans le dernier exercice, vous allez créer deux 
nouveaux bus pour la timeline SYNC SCENE FINAL MIX. Le premier servira à envoyer une 
version M&E (musique & effets) de la bande-son ; la seconde enverra un mix 5.1 surround 
de cette même bande-son.

Vous allez commencer par créer deux bus supplémentaires, qui serviront à chaque mix.

1 Choisissez Fairlight > Créer des bus (Fairlight > Bus Format) pour rouvrir la fenêtre qui 
contient les bus.

2 Cliquez deux fois sur Ajouter des bus (Add bus) : Bus 5 et Bus 6.

3 Renommez Bus 5 M&E, réglez le format sur Stereo, et la couleur sur Mauve (Purple).

4 Renommez Bus 6 SURROUND, réglez le format sur 5.1, et la couleur sur Violet (Violet).

5 Tirez le bus M&E afin qu’il se trouve sous le bus STEREO MAIN.
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6 Faites glisser le bus SURROUND sous le bus M&E.

ASTUCE L’organisation des bus dans la fenêtre Créer des bus (Bus Format) 
reflète l’ordre des commandes dans le mixeur, il est donc important de garder 
ensemble les bus dont l’utilisation est similaire.

7 Cliquez sur OK pour confirmer les changements.

8 Agrandissez le mixeur afin de voir toutes les commandes.



410 Chapitre 8 Monter et mixer l’audio

Les nouveaux bus apparaissent dans le mixeur, mais, comme précédemment, rien ne 
leur est envoyé. 

9 Choisissez Fairlight > Assigner les bus (Fairlight > Bus Assign) pour ouvrir la fenêtre.

10 Dans la section Bus, sélectionnez le bus B5:M&E Out.

Pour créer la sortie M&E de ce bus, il suffit d’envoyer les bus SFX et Music que vous 
avez créés précédemment, au lieu des pistes individuelles.
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11 Dans la section Pistes disponibles (Available Tracks), sélectionnez SFX et MUSIC, afin 
que les deux bus soient envoyés sur les bus B1o et B5o.

Ensuite, vous allez devoir envoyer le mix complet sur le bus SURROUND.

12 Cliquez pour sélectionner le bus B6:SURROUND Out dans la section Bus.
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13 Dans la section Pistes (Tracks), cliquez sur DIALOGUE, SFX et MUSIC pour envoyer ces 
bus sur B6o.

14 Une fois le routage réglé comme dans l’image précédente, cliquez sur Refermer (Close) 
pour refermer la fenêtre Assigner les bus (Bus Assign).

Gérer les différents bus
Pour entendre les différents mix d’une même timeline, vous devez simplement changer le 
bus que vous êtes en train d’écouter. 

1 Placez la tête de lecture au début de la timeline et lancez la scène.

2 Dans le menu Control Room au-dessus du mixeur, sélectionnez le bus M&E.

Il s’agit de la bande-son qui ne contient pas de dialogue.
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3 Sélectionnez DIALOGUE dans le menu déroulant Control Room.

Vous écoutez uniquement le bus Dialogue de cette scène.

4 Réglez le menu Control Room sur le bus SURROUND.

Vous écoutez ce mix en son surround. Malheureusement, et sauf si vous avez un 
système surround branché à votre ordinateur, vous n’entendrez pas la différence. 
Par contre, vous pouvez voir les vumètres bouger dans le mixeur. Vous devez encore 
apporter des changements à la prise en charge de l’audio dans la timeline. En effet, 
trois canaux du Main 5.1 ne sont pas actifs, car les bus Effets et Musique sont 
en stéréo.

5 Choisissez Fairlight > Créer des bus (Fairlight > Bus Format) pour ouvrir la fenêtre.
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6 Réglez le format des bus SFX et MUSIC sur 5.1 et cliquez sur OK.

En changeant les bus de Stéréo à 5.1, l’audio panoramique sera correctement routé.

7 Dans le mixeur, ajustez le pan des pistes STAGE-L, STAGE-R, ATMOS-L et ATMOS-R 
afin qu’il se trouve entre l’avant et l’arrière des canaux du haut-parleur, puis lancez de 
nouveau la lecture de la timeline. 
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Vous voyez désormais que les deux canaux arrière du main 5.1 sont utilisés (même si 
vous ne pouvez pas les entendre).

8 Dans la commande du pan, tirez la poignée bleue de la piste PIANO vers le bas afin 
qu’elle soit lue sur les haut-parleurs arrière. 

En 5.1, le son semble provenir de l’arrière.
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9 Double-cliquez sur les commandes pan de la piste A10 SFX.

Les commandes du pan A10 s’ouvrent dans une grande fenêtre.

10 Tirez la commande bleue vers le centre de la fenêtre du Pan afin que les commandes 
Avant/Arrière soient réglées sur C (pour centre).
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11 Dans les paramètres Boom, cliquez sur On pour envoyer l’audio vers le canal du 
caisson de basses (Subwoofer) et réglez le niveau sur -20.

12 Fermez la fenêtre Audio Pan - SFX.

Les commandes de pan du mixeur se mettent à jour pour afficher les changements 
que vous venez de faire.

13 Répétez les étapes précédentes pour les pistes A11 et A12.
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14 Lancez de nouveau la timeline pour voir comment les canaux du bus SURROUND 
sont utilisés.

15 Réglez le menu Control Room sur STEREO MAIN pour le mix stéréo.

REMARQUE Si vous voulez utiliser une version déjà préparée, allez dans 
le chutier Timelines, choisissez Fichier > Importer > Timeline (File > Import 
> Timeline), puis R18 Editors Guide/Lesson 08/Timelines, sélectionnez 
SYNC SCENE FINAL MIX CATCHUP FINISHED.drt et cliquez sur Ouvrir (Open).

Félicitations ! Vous venez de réaliser une bande-son professionnelle grâce à votre logiciel 
DaVinci Resolve. Nous espérons que ce chapitre vous a permis de mieux comprendre le 
potentiel de la postproduction audio, ainsi que des outils disponibles sur DaVinci Resolve.

Pour plus d’informations sur l’audio et DaVinci Resolve, consultez Le guide de la 
postproduction audio Fairlight avec DaVinci Resolve 18.
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Révision
1 Vrai ou faux ? La normalisation des niveaux audio permet de s’assurer que l’audio est 

au bon niveau.

2 Vrai ou faux ? Vous pouvez changer la vitesse du plan audio dans la page Montage.

3 Vrai ou faux ? Vous pouvez uniquement couper ou isoler le son dans l’en-tête 
de la piste.

4 Quelle fenêtre permet d’ajouter et de supprimer des bus ?

a) La fenêtre Assigner les bus

b) La fenêtre Créer des bus

c) La fenêtre du mixeur audio

5 Vrai ou faux ? Les effets Fairlight doivent être appliqués dans la page Fairlight.
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Réponses
1 Faux. La normalisation de l’audio règle le niveau du plan, pour que le pic soit au 

niveau indiqué.

2 Vrai. Pour régler la vitesse d’un plan, vous pouvez utiliser les commandes de variation 
de vitesse dans l’onglet Audio de l’inspecteur.

3 Faux. Vous pouvez aussi utiliser les mêmes commandes dans le mixeur ou sur l’index 
de la piste.

4 b) La fenêtre Créer des bus permet d’ajouter, de changer et de supprimer les bus.

5 Faux. Les effets Fairlight sont disponibles dans la bibliothèque d’effets des pages Cut, 
Montage et Fairlight.
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Chapitre 9

Exporter les projets

Au chapitre 2, vous avez utilisé la fonction 
Exportation rapide (Quick Export)  
pour exporter un seul fichier vidéo 
vers les sites d’hébergement de 
vidéos ou les réseaux sociaux. 
La fenêtre d’exportation rapide est 
très utile pour générer un fichier final 
ou pour montrer en quelques clics 
le montage au réalisateur ou au client. 
En revanche, si vous voulez davantage 
de contrôle sur le fichier final ou 
si vous voulez travailler sur plusieurs 
fichiers à la fois, il est préférable 
d’utiliser la page Exportation.

Vous apprendrez à personnaliser 
les options d’exportation, ainsi qu’à 
inclure les sous-titres, les différentes 
pistes audio et les bus dans le fichier 
d’exportation.
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Préparer les projets
Dans ce chapitre, vous allez utiliser les trois projets sur lesquels vous avez déjà travaillé. 
Vous allez commencer par importer les trois projets dans des dossiers différents du 
Gestionnaire de projet (Project Manager).

1 Lancez DaVinci Resolve et, dans le Gestionnaire de projet (Project Manager), cliquez 
sur Ajouter un dossier (Add Folder).

2 Dans la fenêtre Créer un nouveau dossier (Create New Folder), saisissez Delivery, puis 
cliquez sur Créer (Create).
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Un nouveau dossier appelé Delivery est créé dans le Gestionnaire de projet 
(Project Manager).

3 Double-cliquez dessus pour l’ouvrir.

ASTUCE Vous pouvez utiliser le chemin du dossier en haut à gauche du 
Gestionnaire de projet (Project Manager) (Project/DELIVERY) pour sortir 
du dossier.

4 Ouvrez le Finder (macOS) ou Explorer (Windows) et allez sur R18 Editors Guide/
Lesson 09.

Ce dossier contient plusieurs fichiers dont vous aurez besoin dans ce chapitre.

5 Sélectionnez les trois fichiers projets DaVinci Resolve (OMO PROMO DELIVERY.drp, 
WTTP DELIVERY.drp, et SYNC SCENE DELIVERY.drp), puis faites-les glisser 
directement dans le Gestionnaire de projet (Project Manager).
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Chacun des projets est importé dans le Gestionnaire de projet (Project Manager). Vous 
êtes désormais prêt à faire les exercices suivants de ce chapitre.

Modifier le format 
d’image de la timeline
Même si la plupart des caméras modernes enregistrent les images en 16:9, cela n’implique 
pas que les images doivent être exportées en 16:9. D’ailleurs, les vidéos étant de plus en 
plus regardées sur des smartphones, les créateurs préfèrent souvent le format 1:1 (carré, 
pour Instagram) ou 9:16 (vertical, pour TikTok). 

DaVinci Resolve vous permet de personnaliser les paramètres de la timeline en fonction du 
format de votre choix.

Dans l’exercice suivant, vous allez apprendre à mettre une timeline en format carré.

1 Dans le Gestionnaire de projet (Project Manager), ouvrez le projet OMO PROMO DELIVERY  
et reliez les médias.

2 Au besoin, choisissez Espace de travail > Réinitialiser l’espace de travail (Workspace > 
Reset UI Layout).
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3 Dans le menu déroulant Sélectionner la Timeline (Select Timeline), ouvrez la timeline 
OMO PROMO.

Il s’agit de la version finale de la vidéo promotionnelle de la marque Organ Mountain 
Outfitter que vous avez montée aux chapitres 1 et 2.

4 Choisissez Timeline > Rechercher la timeline actuelle dans la bibliothèque de médias 
(Timeline > Find Current Timeline in Media Pool).

5 Maintenant que la timeline est sélectionnée dans la bibliothèque de médias, choisissez 
Édition > Dupliquer la timeline (Edit > Duplicate Timeline) et renommez la timeline 
dupliquée OMO PROMO SQUARE.
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6 Double-cliquez dessus pour l’ouvrir.

Ensuite, vous allez devoir ajuster les paramètres de cette timeline au bon 
format d’image.

7 Dans la bibliothèque de médias, faites un clic droit sur la timeline OMO PROMO SQUARE  
et choisissez Timelines > Paramètres de la timeline (Timelines > Timeline Settings).

La fenêtre des paramètres de la timeline s’ouvre. Comme vous le voyez sur les onglets 
grisés Format, Moniteur (Monitor) et Sortie (Output), cette timeline est au format du 
projet, réglé dans les paramètres du projet.
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8 Décochez l’option Utiliser les paramètres du projet (Use Project Settings).

9 Dans le menu déroulant Résolution de la timeline (Timeline resolution), choisissez 
1080 x 1080 HD Square.

ASTUCE DaVinci Resolve contient les préréglages les plus courants, mais vous 
pouvez aussi choisir une résolution personnalisée en choisissant Personnalisé 
dans le menu des préréglages et en indiquant les résolutions horizontales et 
verticales. Pour les résolutions verticales, cochez simplement la case Utiliser 
la résolution verticale (Use vertical resolution) pour inverser les valeurs 
horizontales et verticales.
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10 Cliquez sur OK pour mettre à jour les paramètres de la timeline.

Le viewer de la timeline affiche la résolution mise à jour. Mais les images en 16:9 ont 
simplement été modifiées par un letterbox pour donner ce format carré. Le client 
n’aime pas trop l’espace vide au-dessus et en dessous de la vidéo, et préfèrerait que 
l’image remplisse l’écran.

En effet, comme Resolve est indépendant de la résolution, peu importe la résolution 
de la vidéo, celle-ci sera toujours adaptée à celle de la timeline. Si vous voulez, vous 
pouvez modifier ce réglage dans les paramètres de la timeline.

11 Dans la bibliothèque de médias, faites un clic droit sur la timeline OMO PROMO SQUARE  
et choisissez Timeline > Paramètres de la timeline (Timeline > Timeline Settings) pour 
rouvrir la fenêtre Paramètres de la timeline (Timeline Settings).
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12 Réglez le menu déroulant Résolutions différentes (Mismatched Resolution) sur Rogner 
l’image avec mise à l’échelle (Scale full frame with crop), puis cliquez sur OK.

Désormais, les plans de la timeline sont au bon format. Par contre, et sauf si les images 
ont été filmées avec le format d’image carré en tête, elles ne seront sans doute pas 
bien cadrées.
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Recadrer une prise
Dans le cas où le directeur de la photographie (DoP) ne savait pas que les images devaient 
être filmées en format carré, il est quasi certain que des prises devront être recadrées. 
Heureusement, même si les images sont recadrées, toutes les informations sont 
encore disponibles.

1 Dans la timeline au format carré, positionnez la tête de lecture sur le deuxième plan 
d’interview.

Comme le cadrage était décentré, il manque la moitié de la tête de Chris.

2 Appuyez sur Majuscule -` (accent grave) ou choisissez Affichage > Option du viewer > 
Transformation (View > Viewer Overlay > Transform) pour afficher les commandes de 
transformation.
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3 Maintenez la touche Majuscule enfoncée et dans le viewer timeline, faites glisser la 
prise afin de la positionner au centre du cadre.

REMARQUE Vous pouvez aussi utiliser le paramètre Position X dans la section 
Transformation (Transform) de l’inspecteur.

4 Lancez la lecture des deux plans sur V2 et ajustez le cadrage horizontalement.

Vous pourriez choisir de simplement régler la position X du plan, mais dans certains 
cas, cela engendrera des problèmes.

5 Lancez la lecture du plan sur V2, WHITE SANDS.
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Comme nous vous l’indiquions plus haut, il s’agit d’un plan qui pose problème. Le DoP 
a filmé cette scène en format 16:9, sans prévoir que le format de la prise pourrait être 
modifié. Ici, le résultat est un peu étrange.

6 Positionnez la tête de lecture sur la première image du plan WHITE SANDS et 
ouvrez l’inspecteur.

7 Réglez la valeur de la position X sur 150.000 pour voir les trois amis à gauche du cadre.

8 Cliquez sur le bouton d’ajout d’images clés à côté des champs Positions.

9 Sur V1, désactivez la commande Sélection automatique des pistes (Auto Track Selector).
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10 Appuyez sur ' (apostrophe) pour aller sur la dernière image du plan sur V2.

REMARQUE Si vous gardez l’option Sélection automatique des pistes (Auto 
Track Selector) active sur la piste V1, Resolve utilise la durée du plan sur V1 
quand vous avez positionné la tête de lecture sur la dernière image.

11 Réglez la valeur de la position X sur -20.000 pour voir les trois amis à droite du cadre.

12 Lancez la lecture pour voir le « pan » que vous avez créé.

Pour obtenir un mouvement plus naturel, vous pouvez essayer de rendre l’accélération 
des images clés plus fluide.

13 Assurez-vous que la tête de lecture se trouve sur le plan WHITE SANDS et appuyez sur 
[ (crochet gauche) pour aller sur la première image clé.

14 Dans l’inspecteur, faites un clic droit sur l’image clé rouge à côté des valeurs Positions 
et choisissez Amorti départ (Ease Out) pour appliquer une courbe de bézier par défaut 
à droite de l’image clé.
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15 Dans l’inspecteur, faites un clic droit sur l’image clé rouge à côté des valeurs Positions 
et choisissez Amorti arrivée (Ease In) pour appliquer une courbe de bézier par défaut à 
gauche de l’image clé.

REMARQUE L’option Amorti départ (Ease Out) est disponible uniquement 
si une autre image clé est présente plus tard dans le plan, et l’option Amorti 
arrivée (Ease In), uniquement si une autre image clé est présente plus tôt dans 
le plan. Si des images clés sont présentes avant et après l’image clé, les deux 
options seront disponibles. Sélectionnez le plan et appuyez sur Majuscule-C 
pour afficher la courbe d’images clés du plan dans la timeline. De cette façon, 
vous pouvez manuellement ajouter ou modifier les poignées de bézier.

En ajoutant un amorti aux images clés, vous fluidifiez l’animation.
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Cadrage intelligent 
(Studio uniquement)

REMARQUE L’exercice suivant repose sur la fonctionnalité Cadrage intelligent 
(Smart Reframe), uniquement disponible dans DaVinci Resolve Studio. Si vous 
utilisez la version gratuite de DaVinci Resolve, cette option ne sera pas disponible et 
vous devrez réaliser les étapes suivantes manuellement.

Il est pratique de pouvoir ajouter des images clés et recadrer les images manuellement, 
mais si vous avez un grand nombre de prises, cela peut énormément vous ralentir. Si 
vous avez plusieurs prises à recadrer, utilisez la fonctionnalité Cadrage intelligent (Smart 
Reframe) dans DaVinci Resolve 18.

1 Dans la timeline OMO PROMO SQUARE, placez la tête de lecture sur le plan 
FIRE DANCER.

Une autre prise pourrait aussi être légèrement recadrée.

2 Dans l’inspecteur, cliquez sur la flèche de déroulement dans les commandes Cadrage 
intelligent (Smart Reframe), puis cliquez sur le bouton Recadrage (Reframe).
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Après l’analyse, l’image est recadrée et désormais centrée sur la danseuse.

L’option Cadrage intelligent (Smart Reframe) analyse le plan à l’aide du DaVinci Resolve 
Neural Engine et détermine la meilleure façon de recadrer les prises.

3 Sélectionnez le plan FIRE DANCER dans la timeline, choisissez Plan > Afficher l’éditeur 
d’images clés (Clip > Show Keyframe Editor), puis cliquez sur la flèche de déroulement 
dans les paramètres de transformation.

ASTUCE Si vous ne voyez pas les images clés dans l’éditeur d’images clés, 
zoomez dans le plan.

L’option Cadrage intelligent (Smart Reframe) a automatiquement ajouté les images clés 
sur les paramètres Position X et Y afin de garder le plan centré.

Vous pouvez choisir une zone d’intérêt pour que l’option Cadrage intelligent 
(Smart Reframe) s’y concentre.

4 Appuyez sur Majuscule-C pour masquer l’éditeur d’images clés.

5 Dans la timeline, sélectionnez le plan COMPUTER DESIGN.
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6 Dans les commandes de cadrage intelligent de l’inspecteur, changez le menu Zone 
d’intérêt (Object of Interest) par Point de référence (Reference Point).

La zone du point de référence est affichée dans le viewer timeline sous forme de cadre.

7 Redimensionnez le cadre dans le viewer timeline afin qu’il entoure le t-shirt.

8 Cliquez sur le bouton Recadrage (Reframe) dans les commandes Cadrage intelligent 
(Smart Reframe).

Cela permet de garder le cadre sur le t-shirt.
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Comme vous le voyez, l’option Cadrage intelligent (Smart Reframe) dans DaVinci Resolve 
Studio permet de gagner du temps en recadrant rapidement les prises à votre place.

ASTUCE Vous pouvez sélectionner plusieurs plans et utiliser la fonctionnalité 
Cadrage intelligent (Smart Reframe) sur tous les plans. Chaque plan sera 
analysé séparément pour garantir un résultat optimal.

Personnaliser les préréglages 
de la page Exportation
Au lieu d’utiliser la fonction Exportation rapide (Quick Export) pour exporter cette vidéo, 
vous allez utiliser l’option de la page Exportation, qui offre une meilleure personnalisation 
et un contrôle plus poussé des fichiers finaux.

1 Cliquez sur l’onglet Exportation.

La timeline carrée s’ouvre dans la page Exportation, où vous êtes en mesure de régler 
les paramètres de manière précise.

Timeline—Timeline 
de la page Montage 
servant de référence

Préréglages d’exportation—Accès 
rapide aux préréglages sauvegardés

Paramètres d’export—Permet de personnaliser 
les paramètres Vidéo, Audio et Fichier

Liste d’export—Liste des 
tâches prêtes à être exportées

Plans—Liste des plans 
de la timeline actuelle

Plage d’export—Portion à exporter 
marquée sur la timeline
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REMARQUE La fenêtre Paramètres d'export (Render Settings) comporte une 
liste standard de préréglages d’exportation. Cliquez sur la flèche vers le bas de 
chaque préréglage pour ouvrir les options.

2 Pour exporter une vidéo carrée vers une plateforme qui diffuse des vidéos carrées, 
sélectionnez le préréglage H.264 Master.

3 Dans le champ Nom, saisissez OMO PROMO SQUARE.

ASTUCE Vous pouvez sélectionner le nom par défaut en choisissant l’option 
Nom de la timeline (Timeline name) dans l’onglet Fichier (File).

4 Pour sélectionner l’emplacement, cliquez sur Naviguer (Browse) et dans la fenêtre 
Emplacement de destination (File Destination), allez sur le dossier R18 Editors Guide/
Output Folder et cliquez sur Sauvegarder (Save).

5 Dans l’onglet Vidéo, vérifiez que la résolution est réglée sur 1080 x 1080 et la 
fréquence d’image sur 23.976.

REMARQUE Sauf si spécifié, le préréglage d’exportation sera de nouveau 
réglé sur la résolution et la fréquence d'images de la timeline, nous vous 
recommandons de ne pas modifier ces réglages.  Si vous choisissez une 
résolution plus élevée, un message d’avertissement apparaîtra quand 
vous enverrez les tâches vers la liste d’export. La qualité de l’image sera 
vraisemblablement réduite.
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6 Cliquez sur l’onglet Audio et vérifiez que le codec est réglé sur AAC, le débit sur 320 
Kb/s et la piste de Destination sur Bus 1 (le seul bus de cette timeline).

7 En bas de la fenêtre Paramètres d’export (Render Settings), cliquez sur le bouton 
Ajouter à la liste d’export (Add to Render Queue).

La tâche est ajoutée à la liste d’export sous le nom Tâche 1 ( Job 1). Vous pouvez choisir 
d’exporter la tâche, mais pour le moment, nous allons en ajouter d’autres à la liste.

Comprendre les niveaux
Dans les Paramètres avancés, les niveaux vidéo correspondent aux signaux vidéo 
d’une image par rapport à sa source. L’option Auto exporte les médias à un niveau 
vidéo adapté au codec sélectionné. L’option Vidéo correspond au format YCbCr. 
Ce format utilise le standard Rec.709 pour restreindre la valeur des pixels entre 
64 et 940 sur un système 10 bits. L’option Full se situe entre 4 et 1024, qui sert au 
format numérique, tel que le DPX. En général, il est préférable de ne pas toucher à 
ce paramètre et de laisser DaVinci Resolve choisir le niveau automatiquement. Par 
contre, si vous remarquez que le rendu final diffère de celui vu sur l’écran calibré, 
il est possible que les niveaux vidéo soient incorrectement distribués. Dans de 
rares cas, il sera préférable de régler manuellement les niveaux vidéo pour qu’ils 
s’adaptent parfaitement à vos besoins d’exportation.
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Exporter le format 
AAF pour Pro Tools
Même si Fairlight comporte tous les outils pour mixer et masteriser l’audio, les monteurs 
sont aussi souvent responsables de l’envoi de l’audio vers Pro Tools. Dans cet exercice, 
vous allez apprendre à utiliser les préréglages d’export Pro Tools.

1 Appuyez sur Majuscule-1 pour ouvrir le Gestionnaire de projet (Project Manager).

2 Double-cliquez sur le projet WTTP DELIVERY. Au besoin, sauvegardez le projet actuel 
pour éviter de perdre vos changements.

3 Allez sur la page Montage et utilisez le bouton Relier les médias (Relink Media) pour 
relier les fichiers.

Ce projet correspond à une version de la publicité Welcome to the Pantry que vous 
avez montée au chapitre 3. Vous vous souvenez peut-être que vous n’avez pas passé 
beaucoup de temps à peaufiner l’audio. Vous allez maintenant l’exporter dans un 
format compatible avec Pro Tools, où l’audio sera mixé. 

4 Cliquez sur la page Exportation, et dans la fenêtre Paramètres d'export (Render 
Settings), sélectionnez le préréglage Pro Tools.

REMARQUE Resolve utilise le format AAF (Advanced Authoring Format) pour 
exporter les informations.

Les préréglages de type Pro Tools ne permettent pas de choisir un nom de fichier, car 
vous n’exportez pas un seul fichier. En effet, pour chaque plan sur la timeline, vous 
exportez plusieurs fichiers. Dans le cas de Pro Tools, il ne s’agit que des plans audio.

5 Cliquez sur Parcourir (Browse) et allez sur le dossier R18 Editors Guide/Output Folder. 
Créez un nouveau dossier appelé Pro Tools AAF, et cliquez sur Ouvrir (Open).
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6 Dans l’onglet Audio, assurez-vous que le codec est réglé sur Linear PCM. Cela créera 
une série de fichiers .wav non compressés des plans audio de la timeline, comme le 
souhaitent les utilisateurs Pro Tools.

7 Ajoutez 12 poignées d’images au média que vous allez exporter.

Même si vous exportez les plans audio vers Pro Tools, il vaut mieux fournir un fichier 
référence vidéo pour l’opérateur Pro Tools.

8 Cliquez sur l’onglet Vidéo. Réglez le format sur QuickTime, puis assurez-vous que le 
codec est bien réglé sur H.264 et la résolution sur 1280 x 720 HD 720P (la résolution 
de la timeline).

Il serait utile d’insérer le Burned-in Timecode (BiTC) dans la vidéo de référence.

9 Choisissez Espace de travail > Surimpression d’info. (Workspace > Data Burn In)
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10 Sélectionnez Timecode d'enregistrement (Record Timecode) pour afficher le timecode 
de la timeline sur la vidéo. Augmentez la taille sur 85 et l’opacité à 0.80, puis refermez 
la fenêtre.

Les informations apparaissent dans le viewer pendant que vous apportez les 
modifications.

11 Cliquez sur Ajouter à la liste d’export (Add to Render Queue) pour envoyer une tâche 
dans la Liste d’export (Render Queue).
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Vous avez désormais deux tâches dans la liste d’export. Encore un petit exercice, et vous 
pourrez exporter toutes ces tâches en même temps.

Ajouter des sous-titres
DaVinci Resolve vous permet d’ajouter des sous-titres de différentes manières. Vous 
pouvez les créer manuellement un à un ou les importer avec un fichier en .srt. 

1 Appuyez sur Majuscule-1 pour ouvrir le Gestionnaire de projet (Project Manager) 
et double-cliquez sur le projet SYNC SCENE DELIVERY, en sauvegardant les 
changements apportés au projet en cas de besoin.

2 Appuyez sur Majuscule-4 pour aller sur la page Montage et relier les médias de 
ce projet.

Ce projet contient une version finalisée d’une scène du projet Sync sur lequel vous 
avez travaillé au chapitre précédent. Regardez la scène pour voir comment l’audio 
a été intégré. Il ne vous reste plus qu’à ajouter des sous-titres avant d’exporter les 
fichiers finaux.

3 Ouvrez la bibliothèque d’effets.
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4 Dans ce panneau, sous la catégorie Titres (Titles), allez sur Sous-titre (Subtitle).

5 Faites glisser l’élément Sous-titre au début de la timeline, au-dessus des pistes vidéo. 
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Une nouvelle piste apparaît dans la timeline intitulée « ST1 Sous-titre 1 ». Le texte 
Sous-titre (Subtitle) apparaît alors dans le viewer timeline.

ASTUCE Vous pouvez afficher ou masquer les pistes Sous-titres existantes à 
partir du menu Affichages de la timeline (Timeline View Options).

6 Dans la timeline, sélectionnez le sous-titre et ouvrez l’inspecteur.

L’inspecteur comprend des paramètres permettant de modifier soit la piste entière, 
soit chaque sous-titre individuellement.

7 Dans le champ Sous-titre (Caption), surlignez le mot « Sous-titre » et saisissez 
[applause].
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REMARQUE Les paramètres relatifs aux nombres de lettres maximums par 
ligne et à la durée d’affichage minimum de chaque sous-titre se trouvent dans 
le panneau Sous-titres (Subtitles) des Paramètres du projet (Project Settings).

8 Placez la tête de lecture au début du plan suivant sur V1, et dans l’inspecteur, cliquez 
sur Ajouter nouveau (Add New).

Un nouveau sous-titre est alors ajouté au niveau de la tête de lecture.
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9 Sélectionnez-le et dans l’inspecteur, saisissez les phrases suivantes : Oh, thank you. 
I’m so glad you really liked it.

10 Alignez la fin du deuxième sous-titre avec la fin du deuxième plan sur V1.

Vous pouvez modifier les sous-titres comme n’importe quel autre plan de la timeline.

Importer des fichiers de sous-titres
Vous pourriez continuer d’ajouter manuellement les sous-titres sur cette séquence, mais il 
serait quand même plus efficace d’importer un fichier .srt sur lequel les dialogues ont déjà 
été transcrits.

REMARQUE DaVinci Resolve prend en charge l’exportation des fichiers .srt, .vtt, 
.ttml (IMSC1), et les fichiers de sous-titrage .dfxp.
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1 Dans la bibliothèque de médias, sélectionnez le chutier Subtitles et choisissez Fichier > 
Importer > Sous-titre (File > Import > Subtitle).

2 Allez sur R18 Editors Guide/Lesson 9/Subtitles, puis sélectionnez 
SYNC SUBTITLES US.srt. Cliquez sur Ouvrir.

Le fichier .srt a été ajouté au chutier sélectionné.

3 Sélectionnez le fichier sous-titre SYNC SUBTITLES US, puis faites-le glisser dans la 
timeline afin qu’il s’aimante au marqueur vert.

Tous les sous-titres du fichier .srt sont ajoutés à la piste Sous-titre 1.
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Régler les sous-titres
Les sous-titres fonctionnent comme n’importe quel autre plan, vous pouvez donc 
facilement les modifier.

1 Déplacez la tête de lecture sur le marqueur rouge, au moment où le Dr K dit « That 
wouldn’t be possible. ». Lancez la lecture de la timeline afin de visualiser les dialogues 
et les sous-titres simultanément.

Ce sous-titre s’affiche un peu en retard par rapport à la réplique. Il va falloir ajuster le 
timing du sous-titre pour mieux le synchroniser.

2 Appuyez sur T pour passer en mode Raccord fin (Trim Edit) et faites coulisser le sous-
titre d’une seconde vers la gauche, ou jusqu’à ce qu’il s’aimante au début du plan audio 
de la piste A1.

3 Lorsque vous avez terminé cette opération, appuyez sur / (barre oblique) pour 
visualiser le changement.

4 Appuyez sur A pour retourner en mode Sélection.

Vous pouvez également appliquer des raccords Ripple et Roll sur les sous-titres, mais aussi 
scinder les plans en segments plus courts avec l’outil Rasoir (Blade) et les raccourcis clavier.
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Changer le style des sous-titres
Comme pour n’importe quel autre titre dans Resolve, le style et le positionnement des 
sous-titres peuvent être modifiés. Il est assez courant d’appliquer un rectangle semi-
transparent derrière le texte afin de le faire ressortir.

1 Placez la tête de lecture au début du dernier sous-titre de la timeline.

La fin de la ligne n’est pas très lisible.

2 Sélectionnez le sous-titre et dans l’inspecteur, cliquez sur l’onglet Piste (Track).

3 Faites défiler la fenêtre jusqu’à la section Arrière-plan (Background) et cliquez sur le 
bouton d’activation.

Un cadre semi-transparent apparaît autour du sous-titre. De cette façon, il est plus 
visible sur l’arrière-plan.
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Comme ces changements ont été apportés dans l’onglet Pistes (Track), ils sont 
répercutés sur tous les sous-titres de la piste. Cela est particulièrement pratique 
lorsque vous souhaitez modifier le style des sous-titres de toute une piste.

Vous pouvez cependant ignorer ces paramètres pour un sous-titre en particulier. 
Par exemple si vous voulez ajuster différemment la couleur, la police ou la 
position du texte.

4 Dans la timeline, placez la tête de lecture sur le premier sous-titre.

Ce sous-titre indique la présence d’un effet sonore et non d’un dialogue. Le réalisateur 
voudrait que le style soit différent de celui du dialogue.
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5 Sélectionnez le sous-titre et dans l’inspecteur, cliquez sur l’onglet Sous-titres (Captions). 

6 Cochez la case Sous-titre personnalisé (Customize Caption) pour afficher les 
commandes supplémentaires.

7 Réglez Style (Font Face) sur Italique semi-gras (Semibold Italic ) pour qu’il soit bien 
différent des autres sous-titres. 

Le sous-titre est mis à jour pour refléter le changement de style. En revanche, les 
autres sous-titres de la piste n’ont pas été modifiés.

Vous pouvez ajouter autant de pistes Sous-titres que vous voulez, ce qui est très utile 
si vous devez fournir des sous-titres dans plusieurs langues.
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8 Sur la page Montage, faites un clic droit sur un des en-têtes de la timeline et choisissez 
Ajouter une piste Sous-titres (Add Subtitle Track).

9 Une fois le chutier Subtitles sélectionné, choisissez Fichier > Importer > Sous-titre 
(File > Import > Subtitle). 

10 Dans R18 Editors Guide/Lesson 9/Subtitles, sélectionnez le fichier 
SYNC SUBTITLES FR.ttml et cliquez sur Ouvrir (Open) pour ajouter ce sous-titre à la 
bibliothèque de médias.

11 Placez ce nouveau fichier au début d’une piste Sous-titres vide que vous avez créée.
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Il s’agit de sous-titres en français. Vous pouvez renommer cette piste pour savoir en 
un clin d’œil à quelle langue elle correspond. Il sera ainsi plus facile d’identifier les 
différentes pistes.

12 Cliquez sur Sous-titre 1 et saisissez en_US. Cette piste est destinée aux 
spectateurs américains.

13 Cliquez sur Sous-titre 2 et saisissez fr_FR. Cette piste est destinée aux 
spectateurs français.

ASTUCE Pour choisir la piste Sous-titre qui apparaît dans le viewer timeline, 
cliquez sur l’icône en forme d’œil sur la piste que vous voulez afficher. Vous ne 
pouvez afficher qu’une seule piste à la fois.

Utiliser les régions des sous-titres
Au lieu de personnaliser les sous-titres individuels, vous pouvez les régler par 
région. Chaque piste de sous-titre peut contenir jusqu’à quatre régions, où chaque 
région a son propre style. En déplaçant un sous-titre d’une région à une autre, le 
style est automatiquement modifié. 

Pour créer une nouvelle région, faites un clic-droit sur la piste de sous-titre, et 
choisissez Ajouter une région de sous-titre (Add Subtitle Region). Vous pouvez 
déplacer les sous-titres en les faisant glisser vers le haut et vers le bas sur la piste 
du sous-titre.

Les régions des sous-titres sont uniquement prises en charge par les fichiers .ttml 
et .dfxp. Vérifiez que ces fichiers sont également pris en charge par la plateforme 
de destination avant d’envoyer vos fichiers.
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Inclure les sous-titres 
dans l’exportation
Quand vous devez exporter un programme comportant des sous-titres, vous avez le choix 
entre plusieurs options. En fonction du format d’exportation, vous pouvez inclure les sous-
titres sous forme d’éléments incrustés, de texte intégré (sur les fichiers média compatibles) 
ou de fichiers séparés. 

Dans l’exercice qui suit, vous allez exporter un fichier et les sous-titres séparément.

1 Ouvrez la page Exportation et choisissez le préréglage Personnalisé (Custom).

2 Réglez l’export sur « Plan unique » pour exporter un seul fichier.

3 Dans le champ Noms de fichiers (Filename), saisissez SYNC SCENE MASTER.

4 Cliquez sur Parcourir (Location Browse) et allez sur le dossier R18 Editors Guide/
Output Folder. Créez un nouveau dossier appelé Sync Scene et cliquez sur OK.

5 Dans la fenêtre Paramètres d'export (Render Settings), réglez le menu déroulant 
Format sur MXF OP1A, le Codec sur DNxHD et le Type sur 8 bits 720p 100/85/55/45.

6 En bas de l’onglet Vidéo, ouvrez l’option Paramètres de sous-titrage (Subtitle Settings) 
et cochez la case Exporter les sous-titres (Export Subtitle).

7 Réglez l’option Format sur Fichier séparé (As a separate file).

Si vous choisissez l’option « Incruster sur la vidéo », Resolve incrustera les sous-
titres actifs (et leur style) sur le fichier vidéo final. Les sous-titres feront donc partie 
intégrante de la vidéo. En choisissant l’option « Sous-titres intégrés », la piste de sous-
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titrage active sera exportée sous forme de métadonnées intégrées dans les formats 
média compatibles. Pour le moment, DaVinci Resolve prend en charge le sous-titrage 
Text et CEA608 avec les conteneurs MXF OP1A et QuickTime.

8 Dans le menu déroulant Exporter sous (Export As), choisissez WebVTT et cochez les 
cases « eng_US » et « fr_FR » pour inclure ces deux pistes dans l’export.

Voilà, les paramètres vidéo et fichier sont réglés. Ensuite, vous allez choisir les pistes audio 
à exporter pour le fichier Master.

Exporter les pistes audio
Vous vous souvenez sans doute qu’au chapitre précédent, cette scène contenait trois mix 
différents : stéréo, M&E (musique et effets), et 5.1, en plus de trois sous-groupes pour les 
dialogues, les effets et la musique. Dans les Paramètres d'export (Render Settings), vous 
pouvez choisir d’exporter différentes combinaisons de pistes audio et de bus. De cette 
façon, il est très facile d’exporter un film avec le mix stéréo, surround ou M&E pour le 
doublage, ou simplement le mix 5.1.

1 Dans les paramètres d’export (Render Settings), cliquez sur l’onglet Audio.

2 Laissez le codec audio réglé sur PCM linéaire (Linear PCM) (également appelé 
audio non compressé, ou sans perte) et ne touchez pas à la fréquence d'images et à la 
profondeur d’image.

ASTUCE Par défaut, les fréquences d'échantillonnage du projet sont réglées 
sur 48 kHz, mais peuvent être modifiées dans Paramètres du projet > Fairlight 
(Project Settings > Fairlight).
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3 Dans le menu déroulant Piste de destination 1 (Output Track 1), assurez-vous que le 
bus STEREO MAIN (Stereo) est sélectionné.

4 Cliquez sur + (plus) à droite du menu déroulant pour ajouter une deuxième piste de 
destination.

5 Dans le menu Piste de destination 2 (Output Track 2), choisissez le bus M&E (Stéréo) 
pour ajouter ce bus comme deuxième piste de destination.

Cela exportera le fichier MXF avec deux pistes stéréo : la première comportera le mix 
stéréo complet, la deuxième le mix M&E (sans dialogue, mais avec la musique et les 
effets). C’est cette deuxième piste qui peut être utilisée pour mettre le film dans une 
langue différente.

6 Cliquez sur Ajouter à la liste d’export (Add to Render Queue).

Si vous avez besoin d’utiliser les mêmes paramètres pour plus d’un export, vous 
pouvez sauvegarder les paramètres de rendu comme préréglage. 



459Exporter les pistes audio

7 Allez dans les options du menu Paramètres d’export > Enregistrer comme nouveau 
préréglage (Render Settings > Save as New Preset).

8 Renommez-le MXF DNxHD 720P et cliquez sur OK.

Il apparaît en haut du panneau.

Exporter en AS-11 et dans d’autres formats de fichier
Le plug-in SDK DaVinci Resolve IO permet aux développeurs de créer et de 
distribuer une plage de codecs et de formats bien plus large. Ils peuvent être 
exportés directement de DaVinci Resolve Studio.

On trouve par exemple MainConcept Codec Plug-In for DaVinci Resolve Studio. 
Une fois installé, ce plug-in ajoute des options de formats MainConcept MXF et 
MP4, dont une option spécifique pour exporter directement en AS-11 DPP.

Pour en savoir plus sur ce plug-in, allez sur https://www.mainconcept.com/
products/plugins/blackmagic-design-plugins/bmd.html.

https://www.mainconcept.com/products/plugins/blackmagic-design-plugins/bmd.html
https://www.mainconcept.com/products/plugins/blackmagic-design-plugins/bmd.html
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Exporter et modifier des tâches 
provenant de différents projets
La liste d’export peut afficher soit les tâches du projet actuel, soit les tâches de tous les 
projets qui se trouvent sur une même base de données. Si vous divisez de grands projets 
en plusieurs parties ou si vous travaillez sur plusieurs projets pour le même client, vous 
aurez peut-être besoin d’accéder à toutes les tâches qui se trouvent dans la liste d’export, 
sans attendre que les tâches d’un autre projet soient exportées.

1 Dans le menu Option de la fenêtre Liste d’export, choisissez Afficher tous les projets.

Toute tâche contenue dans la bibliothèque de projet et ajoutée à la liste d’export est 
affichée dans cette fenêtre.
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2 Dans le menu Option de la fenêtre Liste d’export, choisissez Détails des exports.
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Les paramètres de chaque tâche sont affichés, y compris la résolution, le codec et la 
fréquence d’images.

Même après avoir ajouté une tâche à la liste d’export, vous pouvez modifier ses 
paramètres ou tout simplement la supprimer de la liste.
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3 Dans la liste d’export, cliquez sur l’icône en forme de crayon de la tâche 1. Sauvegardez 
le projet, si besoin.

Le projet OMO PROMO DELIVERY s’ouvre de nouveau automatiquement, et les 
paramètres d’export sont disponibles.

Vous pouvez désormais faire les changements que vous voulez avant d’exporter 
le fichier.

4 Dans l’onglet Vidéo, réglez le format en MP4 au lieu de QuickTime.

5 Cliquez sur Actualiser (Update Job) en bas du panneau Paramètres d’export 
(Render Settings).
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Le changement est appliqué à la tâche. Dans ce cas, vous pouvez voir que l’extension 
a changé de .mov à .mp4.

ASTUCE Pour supprimer une tâche, cliquez sur la croix dans le coin supérieur 
droit de la liste d’export.
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6 Enfin, cliquez dans une zone vide de la fenêtre Liste d’export (Render Queue) pour 
désélectionnez Tâche 1 ( Job 1), puis cliquez sur le bouton Tout rendre (Render All) pour 
créer les fichiers finaux.
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DaVinci Resolve exporte toutes les tâches de la liste d'export. 

REMARQUE Resolve exporte quatre tâches de la liste d’export, car le fichier 
AAF contient deux exports séparés : un pour les plans audio et un pour le 
fichier de référence vidéo. 

Une fois les fichiers exportés, vous pouvez choisir d’ouvrir le dossier Output Folder sur 
votre ordinateur et de vérifier les fichiers que vous avez créés.
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7 Faites un clic droit sur une des tâches et choisissez Afficher dans le Finder (Reveal 
in Finder) sur macOS ou Ouvrir l’emplacement du fichier (Open File Location) 
sur Windows.

REMARQUE Même si vous pouvez ouvrir et voir plusieurs fichiers pour vérifier 
s’ils fonctionnent (par exemple les fichiers MP4), le seul vrai test consiste à 
créer un fichier (par exemple AAF pour Pro Tools) et à l’ouvrir de nouveau 
dans Resolve.

Il est très important de bien régler les paramètres d’export pour éviter de rencontrer 
des problèmes techniques ou esthétiques. Nous vous encourageons à bien étudier le 
fonctionnement de ces réglages. Cette compréhension vous permettra d’améliorer vos 
techniques de montage. Vous exporterez ainsi plus rapidement des projets qui répondront 
parfaitement aux normes de l'industrie.

Gérer les médias des timelines
La dernière tâche à effectuer consiste à gérer les fichiers médias source de vos projets 
pour un bon archivage.

1 Appuyez sur Majuscule-1 pour ouvrir le Gestionnaire de projet (Project Manager) et 
double-cliquez sur SYNC SCENE DELIVERY pour rouvrir le projet Sync Scene.

ASTUCE Vous pouvez activer l’option Navigation dynamique entre les projets 
(Dynamic Project Switching) en faisant un clic droit sur une zone vide du 
Gestionnaire de projet (Project Manager) pour naviguer entre les projets sans 
devoir fermer celui sur lequel vous travaillez.
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2 Choisissez Fichier > Gestion des médias (File > Media Management) pour ouvrir le 
gestionnaire de médias.

Cette fenêtre permet de copier et de transcoder les médias du projet, de certaines 
timelines ou de plans.

3 Sélectionnez l’onglet Timeline.

4 Cliquez sur Naviguer (Browse), à côté du champ Destination.

5 Allez sur le dossier R18 Editors Guide/Output Folder et créez un nouveau dossier 
Archive. Cliquez sur Ouvrir (Open).

6 Dans la fenêtre Gestion des médias (Media Management), sélectionnez la timeline 
SYNC SCENE FINAL .

7 Dans l’onglet Copier (Copy), vérifiez que l’option « Média et trim utilisés en conservant 
24 images des poignées » (Used media and trim keeping 24 frame handles) est 
sélectionnée.

Cette option signifie que seules les parties des fichiers utilisés dans la timeline 
sélectionnée seront copiées. En outre, 24 images de part et d’autre des points d’entrée 
et de sortie seront ajoutées, au cas où.
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8 Décochez la case Utiliser le nom de projet du sous dossier (Use project 
name subfolder).

En bas de la fenêtre Gestion des médias (Media Management), l’indicateur de 
taille affiche l’espace de stockage de tous les médias qui se trouvent dans le projet 
(y compris les plans inutilisés). Le nouvel indicateur de la taille indique l’espace de 
stockage utilisé par les médias rognés. Dans notre cas, vous voyez que les médias 
copiés ne prennent qu’un tiers de l’espace de stockage dans le projet.
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9 Cliquez sur Commencer (Start) pour démarrer le traitement.

10 Une fois terminé, ouvrez le dossier Archive pour trouver les médias copiés et le 
fichier .drt.

Il s’agit du dossier que vous pouvez archiver séparément. Pour restaurer le montage 
à partir du contenu archivé, créez simplement un nouveau projet, choisissez Fichier 
> Importer > Timeline (File > Import > Timeline) et importez le fichier .drt. La timeline 
importée est automatiquement reliée aux médias rognés.
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Révision
1 Vrai ou faux ? Vous devez utiliser la page Exportation afin d’exporter une vidéo de 

votre projet.

2 Quelle fonctionnalité repose sur le DaVinci Resolve Neural Engine pour 
automatiquement ajouter des images clés afin de garder les personnages à l’écran 
quand vous changez le format d'image d’une timeline ?

a) Conformation automatique

b) Cadrage intelligent

c) Conformation intelligente

3 Quel format sert à envoyer l’audio à mixer sur un système Pro Tools ?

a) AAF

b) XML

c) EDL

4 Quelle fenêtre permet d’ajouter des métadonnées de timecode incrustées Burned-in 
Timecode (BiTC) à la vidéo exportée ?

a) Fenêtre du timecode

b) Surimpression d’info

c) Text+

5 Vrai ou faux ? Tous les sous-titres doivent être importés en fichier .srt.



472 Chapitre 9 Exporter les projets

Réponses
1 Faux. Vous pouvez utiliser l’option Exportation rapide quand celle-ci est disponible. 

2 b) Cadrage intelligent.

3 a) AAF

4 b) Surimpression d’info

5 Faux. Les sous-titres peuvent être créés manuellement dans la catégorie Sous-titre de 
la bibliothèque d’effets, ou en important un fichier .srt, .vtt, .ttml, ou .dfxp.



Cette page a été laissée volontairement libre.



Techniques avancées  
de montage

Montage multicaméra  
en temps réel

Construction d’effets stupéfiants 

Astuces pour le montage 
et le mixage audio

Le guide de monteur DaVinci Resolve 18 est un guide pas-à-pas 
conçu pour vous apprendre l’art du montage. Grâce à des exercices 
pratiques, vous apprendrez à connaître les différentes fonctionnalités 
de la page Montage, de la découpe d’interview à la création de 
scènes dramatiques, au montage de contenus documentaires et 
musicaux. Vous apprendrez également à créer des effets de qualité 
avec les nouveaux plug-ins Incrustateur 3D et Collage Vidéo, à utiliser 
la variation de la vitesse, à simplifier les mix audio et à exporter votre 
film pour la distribution en ligne, télé ou sur les plateformes de diffusion.

Ce que vous apprendrez dans ce guide
• Appliquer des techniques de montage et de rognage complexes 

utilisés par les pros de l’industrie et les utiliser à bon escient en 
fonction du genre de production.

• Générer et gérer des médias proxys avec le Blackmagic Proxy Generator.

• Appliquer des changements de vitesse variable 
pour mettre en valeur l’action.

• Utiliser des astuces de rognage et modifier les plans en temps réel.

• Appliquer des techniques de montage et de 
synchronisation multicaméra.

• Organiser les grands projets efficacement avec les métadonnées 
et les chutiers paramétrables.

• Créer des compositions complexes sur la page Montage.

• Utiliser des images clés pour créer des animations complexes. 

• Monter et mixer l’audio en stéréo et en Surround Sound.

• Créer, importer et monter les sous-titres en différentes langues.

• Exporter les projets pour la distribution en ligne, 
la télé et les plateformes de diffusion en ligne.

• Mais aussi des dizaines de conseils et d’astuces qui 
transformeront votre façon de travailler !

À qui s’adresse ce livre
Ce guide s’adresse à la fois aux débutants et aux professionnels de la 
postproduction. Les débutants y trouveront des chapitres clairs et concis 
qui leur permettront de faire leurs premières armes en toute sérénité. Les 
professionnels qui souhaitent amorcer une transition vers DaVinci Resolve 
y trouveront des exercices pour comprendre le fonctionnement du logiciel 
ainsi que des outils avancés pour le mixage audio, l’ajout de texte et la 
création d’effets. En outre, vous y découvrirez des dizaines d’astuces de pro 
qui vous aideront à monter vos projets efficacement dans DaVinci Resolve !
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